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SAFETY PRECAUTIONS 
To prevent accidents or personal injuries, please be sure to comply with the following items. 

Prior to installation, operation, maintenance and check, please read this manual carefully for proper use. 
Before using, please fully understand the knowledge related to the equipment, safety precautions and all 

other precautions. 
Safety precautions are divided into two levels in this manual: Warning and Caution. 

WARNING Incorrect operation may lead to death or serious injury.

● Take appropriate safety measures to the external circuit of the product to ensure the security of

the whole system in case of abnormalities caused by product failure or external.

● Do not use this product in areas with inflammable gases.

Otherwise it may lead to an explosion.

● Do not put this product into a fire.

Otherwise it could cause damage to the battery or other electronic parts.

● Do not impact, charge or heat the lithium battery, and do not put it into a fire.

Otherwise it may lead to fire or damage.

CAUTION
 

Incorrect operation may lead to injury or material loss. 

● To prevent the excessive exothermic heat or smoke generation of the product, a certain margin is

required for guaranteed characteristics and performance ratings of relative products.

● Do not decompose or transform it.

Otherwise it will lead to the excessive exothermic heat or smoke generation of the product.

● Do not touch terminal blocks during power-on.

Otherwise it may result in an electric shock.

● Set an emergency stop and interlock circuit in the external devices.

● Connect wires and connectors reliably.

Otherwise it may lead to the excessive exothermic heat or smoke generation of the product.

● Ground the protective earth (PE) terminal with Class D grounding (grounding resistance at 100Ω or below).

Otherwise it may result in an electric shock.

● There shall be no foreign matters such as liquids, flammable materials and metals inside the product.

Otherwise it will lead to the excessive exothermic heat or smoke generation of the product.

● Do not carry out construction (wiring, removal, etc.) during power-on.

Otherwise it may result in an electric shock.

Description on Copyright and Trademarks 

● The copyright of this manual is owned by Panasonic Industry Co., Ltd.
● Unauthorized reproduction of this manual is strictly prohibited.

● Windows is a registered trademark of Microsoft Corporation in the U.S. and other countries.

● Ethernet is a registered trademark of Fuji Xerox Co., Ltd. and Xerox Corporation.

● Other company and product names are trademarks or registered trademarks of their respective companies.
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Introduction 

Thank you for buying a Panasonic product. Before you use the product, please carefully read 
the installation instructions and the user’s manual, and understand their contents in detail to 
use the product properly. 

Type of Manual 

There are different types of users manual for the FP-XH M8N16PD series, as listed below. 
Please refer to a relevant manual for the unit and purpose of your use. 
The manuals can be downloaded on our website: 
https://industry.panasonic.com/global/en/downloads/?tab=manual 

Unit name or purpose of 
use Manual name Manual code 

FP-XH M8N16PD 
Control Unit 

FP-XH M8N16PD 
Control Unit User’s Manual WUME-FPXHM8N16PD 

FP Series Instruction Manual ARCT1F313E 
 Communication Function 

FP-XH User Manual (Communication Section) WUME-FPXHCOM FP-X Expansion 
(Communication) Cassette 

FP-X Expansion Unit 
FP-X Series User Manual ARCT1F409E 

FP-X Function Cassette 

https://industry.panasonic.com/global/en/downloads/?tab=manual
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Control Unit Version 

The version of the control unit can be confirmed according to the nameplate on the side of the 
product body or on the menu of the tool software. 

 Marking of the product body 
2 CPU versions are marked on the nameplate on the side of the product body. 

Ver.1.00 / Ver.1.00
① ②

 

 Description 
① The "Main CPU" version for overall operation is marked. 

② The "Motion CPU" version for motion control is marked. 
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 Confirmation based on the tool software 
The version of the Main CPU can be confirmed according to Status Display of FPWIN GR7. 

 
The version of Motion CPU can be confirmed via the Status Display dialog box of Configurator 
PM7. The dialog box displays the "firmware version". 
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Glossary 

As for the following terms, similar expressions are used in the software, manuals and 
specifications concerning FP-XH M8N Control Unit and Servo Amplifier A6N/A5N. 

FP-XH M8N 
Control Unit A6N/A5N Description 

- General-purpose 
monitor input 

Five inputs of symbols SI-MON1 to SI-MON5 are allocated on 
the A6N/A5N side. 
By default, the general-purpose monitor input (mark: SI-
MON1) is allocatd to the terminal on the servo amplifier side. 
To read the general-purpose input (mark: SI-MON2), it is 
necessary to change the parameter on the servo amplifier 
side. 

RTEX general-
purpose input - 

Up to two points (marks: SI-MON1 to SI-MON2) of the 
general-purpose monitor inputs on the A6N/A5N side can be 
read on the FP-XH M8N control Unit side. They are allocated 
to the I/O input area (WX125). 

- RTEX operation 
output 

On the A6N/A5N side, two outputs of marks EX-OUT1 and 
EX-OUT2 are allocated. 
By default, the RTEX operation output (mark: EX-OUT1) is 
allocatd to the terminal on the servo amplifier side. To use the 
RTEX operation output (mark: EX-OUT2), it is necessary to 
change the parameter on the servo amplifier side. 

RTEX general-
purpose output - 

On the FP-XH M8N Control Unit, the two "RTEX operation 
outputs" connected to the A6N/A5N can be controlled with 
user programs. The FP-XH M8N Control Unit side si allocated 
to the I/O output area (WY125). 

General-purpose 
output part - 

It indicatest the 8-point DC input circuits and 8-point transistor 
output circuits connected to the terminal block of the FP-XH 
M8N Control Unit. 

Motion control part - 
It indicates the parts relating to the motor control, interface for 
the RTEX network and pulse input interface in the FP-XH 
M8N Control Unit. 

Axis number Node number 
The axis numbers controlled by the FP-XH M8N Control Unit 
match the node numbers of the servo amplifier connected to 
the RTEX network. 
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1.1 Overview of System 

1.1.1 Funcntions of Control Unit 

FP-XH
M8N

X2A X2A X2A
A6N
A5N

RX RXRX

X2B X2B X2B
TX TXTX

 

 Conrols the Servo Motor MINAS A6N/A5N series 
The FP-XH M8N Control Unit can control servo motors of up to 8 axes via the motion-
dedicated network Realtime Express (RTEX). It achieves wiring saving by network connection 
and high-speed control. 
(Note): Realtime Express and RTEX are registered trademarks of Panasonic. 

 Frexibly deals with positioning control up to eight axes 
The FP-XH M8N Control Unit supports independent control, interpolation control and 
synchronous control, and deals with simple control through complicated control. 

 Hybrid controller equipped with genera-purpose inputs and outputs 
The general-purpose I/O of 8-point inputs and 8-point outputs and RS-232C port are equipped 
as the standard equipment in addition to the I/F for network servo. 

 Pulse input function usable for high-speed counter and manual pulsar 
A maximum of four-channel inputs are available, and can be used for the high-speed counter 
and pulsar operation. 

 Can use various options of the existing models of FP-X series 
Various add-on cassettes and expansion units can be used. The communication interface, 
digital I/O and analog I/O can be easily expanded. 

 Shortens the startup time by using "Configurator PM7" 
By using the setting monitoring software for positioning control "Configurator PM7", 
positioning parameters and tables can be easily managed. Also, the "Tool operation function" 
which enables the adjustment without ladder programs shortens the startup time. 
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1.1.2 Outline of Specifications 

The unit supports the independent control, interpolation control and synchronous control, and 
the maximum of 8 axes can be used within the following ranges. 

 Combination of control axes 
Item name Specifications 
Number of axes 
controlled Max. 8 axes 

Independent 
control Max. 8 axes 

Combination 
of 
independent, 
interpolation 
and 
synchronous 
controls: 
Max. 8 axes 

Interpolation 
Control 

2-axis linear interpolation, 2-axis circular interpolation, 3-axis linear 
interpolation, 3-axis spiral interpolation: max. 8 axes 

Synchronous 
control 

Master axis (real axis): Max. 4 
axes Combination of real 

and virtual axes: Max. 
4 axes 

Combination 
of master and 
slave axes: 
Max. 8 axes 

Master axis (virtual axis): Max. 
2 axes 

Slave axis: Max. 8 axes 
(Note 1): The pulse input can be used as the input of the synchronous control master axis. 

 Communication specifications of motion control part 
Item Specification 
Physical layer 100BASE-TX （IEEE802.3） 

Baud rate 100 Mbps 
Trasmission distance Between nodes: Max. 100 m, Total length: Max. 200 m 
Topology Ring 

Applicable cable STP cable (category 5e or higher) 
Connector 9-pin RJ45 x 2 
Communication cycle 0.5 ms 
Position command update 1 ms 
No. of connected slaves Max. 8 slaves 
Coonnected slave Panasonic AC Servo Motor A6N series/A5N series 
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1.2 Unit List 

1.2.1 FP-XH M8N Control Unit 

 

Divided into the following types according to points, power supply and output type. 
Points General I/O part: 16 points, motion control part (RTEX I/F and 4-ch pulse input for 8-axis control) 
Power 
supply 24 VDC 

Output 
General output part: transistor (PNP output) 

RTEX I/F port for motion control RX45 x 2 ports (RX/TX) 

1.2.2 FP-X Expansion Unit 

  

Divided into the following types according to points, power supply and output type. Can be 
used with the old models FP-X. 

 FP-X Expansion Unit 
Points 14 points (for output) / 16 points (for input) / 16 

points 30 points 

Power 
supply No power supply 100-240 VAC or 24 VDC 

Output Relay or transistor (NPN output or PNP output) 
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1.2.3 FP-X Expansion FP0 Adapter 

 

Interface adapters enabling connection with FP0/FP0R series expansion unit / high function 
unit. 

1.2.4 FP-X Add-on Cassette (Communication Cassette) 

  

Divided into the following types according to the type of communication interface and the 
number of channels. 

Communication pattern 

RS-232C (5-wire) × 1ch 
RS-232C (3-wire) × 2ch 
RS-485 / RS-422 × 1ch 
RS-485 × 1ch + RS-232C (3-wire) × 1ch 
RS-485 × 2ch 

Ethernet × 1ch + RS-232C (3-wire) × 1ch 

1.2.5 FP-X Add-on Cassette (Function Cassette) 

 

Divided into the following types according to the output type and function. 

Analog input and output 
Analog input × 2ch 
Analog output × 2ch 
Analog input × 2ch + analog output × 1ch 

Digital input and output Input 8 points, transistor output 8 points 
Input 4 points + transistor output 3 points 

Master memory Master memory + real-time clock 
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1.3 Unit Type and Product Number 

1.3.1 FP-XH M8N16PD Control Unit 

Product Name 
Specification 

Product no. 
Input / Output Specifications Power supply 

FP-XH M8N16PD 
Control Unit 

DC input 8 points, transistor output 8 points 
RTEX I/F (for 8 axes) for motion control 
4-channel pulse input 

24 VDC AFPXHM8N16PD 

 

1.3.2 FP-X Expansion Unit 

Product Name 
Specification 

Product no. 
Input / Output Specifications Power supply 

FP-X E16 
expansion I/O unit 

DC input 8 points, relay output 8 points - AFPX-E16R 
DC input 8 points, transistor output (NPN) 8 
points - AFPX-E16T 

DC input 8 points, transistor output (PNP) 8 
points - AFPX-E16P 

FP-X E30 
expansion I/O unit 

DC input 16 points, relay output 14 points 
100-240 VAC AFPX-E30R 
24 VDC AFPX-E30RD 

DC input 16 points, transistor output (NPN) 
14 points 

100-240 VAC AFPX-E30T 
24 VDC AFPX-E30TD 

DC input 16 points, transistor output (PNP) 
14 points 

100-240 VAC AFPX-E30P 

24 VDC AFPX-E30PD 
FP-X E16 
expansion input unit DC input 16 points - AFPX-E16X 

FP-X E14R 
expansion output unit Relay output 14 points - AFPX-E14YR 

(Note) Comes with expansion cables (8 cm type). 
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1.3.3 FP-X Expansion FP0 Adapter 

Name Specification Product no. 
FP-X Expansion FP0 
Adapter Used to connect with the FP0 expansion unit AFPX-EFP0 

(Note) Comes with expansion cables (8 cm type). 

1.3.4 FP-X Add-on Cassette (Communication Cassette) 

Name Specification Product no. 

FP-X communication 
cassette 

RS-232C 5-wire × 1 channel AFPX-COM1 
RS-232C 3-wire × 2 channel AFPX-COM2 

RS-485 / RS-422 (insulated) × 1 channel AFPX-COM3 
RS-485 (insulated) × 1 channel + RS-232C 3-wire × 1 channel AFPX-COM4 
RS-485 (insulated) × 2 channels (non-insulated between 
channels) AFPX-COM6 

Ethernet port + RS-232C 3-wire × 1 channel AFPX-COM5 
 

1.3.5 FP-X Add-on Cassette (Function Cassette) 

Name Specification Product no. 

Analog 
input and 
output 

FP-X analog input 
cassette Analog input (non-isolated) × 2 channels AFPX-AD2 

FP-X analog output 
cassette 

Analog output (insulated) × 2 channels 
(insulated between channels) AFPX-DA2 

FP-X analog I/O cassette 
Analog input (insulated) × 2 channels 
(non-insulated between channels) 
+ analog output (insulated) × 1 channel 

AFPX-A21 

FP-X thermocouple 
cassette 

Thermocouple input (insulated) × 2 channels 
(insulated between channels) AFPX-TC2 

FP-X temperature 
measuring resistor 
cassette 

Temperature measuring resistor input 
(insulated) × 2 channels 
(insulated between channels) 

AFPX-RTD2 

Digit 
input and 
output 

FP-X input cassette 8-point DC input AFPX-IN8 
FP-X output cassette 8-point transistor output (NPN) AFPX-TR8 
FP-X output cassette 6-point transistor output (PNP) AFPX-TR6P 
FP-X input and output 
cassette 

4-point DC input + 3-point transistor output 
(NPN) AFPX-IN4T3 

FP-X master memory cassette Master memory + real-time clock AFPX-MRTC 
 

1.3.6 Options 

Name Specification Product no. 

FP-XH backup battery Required when expanding operation memory keeping area and 
using the clock/calendar function. AFPXHBATT 
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1.3.7 Repair Parts 

 Name Specification Product no. 

 

FP-X expansion 
cable (note) 

8cm AFPX-EC08 

30cm AFPX-EC30 

80cm AFPX-EC80 

 

FP0 
power cable For expansion FP0 adapters, 1 m long AFP0581 

(Note 1): The FP-X expansion unit and high-function unit include 8 cm expansion cables. The total length of the 
expansion cables should be within 160 cm. 

(Note 2): when using long expansion cables, I/O checking error may occur due to noises and other effects. In this 
case, it is recommended to take measures such as using ferrite cores. 
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1.4 Restrictions on Unit Combinations 

1.4.1 Restrictions on FP-X Expansion Units 

 Expansion Number and Order Limitations (1) 
• Connect up to 8 expansion units. 

ON

1 2 3 4

1
2  

① FP-XH M8N control unit ② FP-X Expansion Unit 

 Maximum Control I/O Points 

Type of Control Unit I/O Points for Single 
Control Unit 

I/O Points for  
FP-X-E30 Expansion 

FP-XH M8N control unit 16 points (note) Maximum 256 points 
(Note) Points mentioned in the table above means the I/O points of the general I/O part. 

 Expansion Cable Combination Limitations 
• Please limit the total length of the expansion cable to less than 160 cm. 
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 Expansion Cable Combination Limitations (2) 
• The number of expansion units can be connected and expanded varies with its types. 

 Unit Type Remarks 
① FP-XH M8N control unit  

② FP-X Expansion I/O 
Unit 

E14YR, E16R Expansion I/O unit without built-in 
power supply E16X, E16T, E16P Ver.3.0 or below 

③ FP-X Expansion I/O 
Unit 

E16X, E16T, E16P Ver.3.0 or 
above 

Expansion I/O unit without built-in 
power supply 

④ FP-X Expansion I/O 
Unit E30 Expansion I/O unit with built-in power 

supply 

• In the FP-X expansion I/O unit, continuously connecting two units in group 2 shown in the 
above table is not possible. However, it can be expanded on the right side of the expansion 
I/O unit with built-in power supply. 

1 2
4

2 3 2 341  

•  In the unit without built-in power supply of the FP-X expansion I/O unit, up to three units in 
group 3 shown in the above table can be connected. 

3
1
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1.4.2 Restrictions on FP-X Expansion Adapter 

 Expansion position of FP-X expansion FP0 adapter 
• With the FP-X expansion FP0 adapter, up to three FP0 expansion units can be connected. 

• When using the FP-X expansion FP0 adapter, up to seven FP-X expansion units can be 
connected. 

• The end of the FP-X expansion bus can only connect with one FP-X expansion FP0 adapter. 
Please expand on the right side of FP-X expansion units. 

2 3
4

1
 

① FP-XH M8N 
Control Unit ② 

FP-X 
Expansion 
Unit 

③ 
FP-X 
Expansion FP0 
Adapter 

④ 
FP0 Expansion 
Unit 
High Function Unit 

 Expansion sequence of FP0 expansion unit / FP0 high functional unit 
• Please connect the FP0 thermocouple input unit to the right side of the other FP0 units. 

Connecting to the left side reduces overall accuracy. 

• Please connect the FP0 CC-Link unit to the right side of the other FP0 units. No expansion 
connector. 
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1.4.3 Restrictions on Add-on cassette Combination 

 Add-on cassette installation position (1) 
• The FP-XH M8N control unit contains 2 add-on cassette installation parts. 

1 2

 

① 
Cassette 
installation  
part 1 

② Cassette installation  
part 2 

 Add-on cassette installation position (2) 
• Function and communication cassette can be overlapped and installed into the same 

cassette installation part. In this case, make sure the communication cassette is installed 
over the function cassette. 

 

③ Communication 
cassette ④ Function cassette 

 Number of add-on cassettes that can be Installed 
• Up to 2 function cassettes and 2 communication cassettes can be installed. 
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 Add-on cassette type and installation location (A: Available, C: Conditional, Blank: Not 
available) 

Cassette type Installation part of the control unit 

Type Product Name No. Cassette 
installation part 1 

Cassette 
installation part 2 

Communication 
cassette 
(note 1) 

Communication 
cassette 

AFPX-COM1 A (Note 2) A (Note 2) 
AFPX-COM2 A A 

AFPX-COM3 A A 

AFPX-COM4 A A 

AFPX-COM5 A A 

AFPX-COM6 A A 

Function 
cassette 
(Note 3) 

Analog input cassette AFPX- AD2 A A 

Analog output 
cassette AFPX-DA2 

A A 

Analog I/O cassette AFPX-A21 A A 

Thermocouple 
cassette AFPX-TC2 

A A 

Temperature 
measuring resistor 
cassette 

AFPX-RTD2 
A A 

Input cassette AFPX-IN8 A A 

Output cassette AFPX-TR8 A A 

Output cassette AFPX-TR6P A A 

Input / output 
cassette AFPX-IN4T3 

A A 

Pulse input / output 
cassette AFPX-PLS (Note 4) (Note 4) 

Master memory 
cassette AFPX-MRTC C (note 5) C (note 5) 

(Note 1): When installed with the function cassette together, mount it over the function cassette. 
(Note 2): RS / CS control available for AFPX-COM1. 
(Note 3): When installing the function cassette on FP-XH M8N control unit, it can be installed at cassette installation 

part 1 or cassette installation part 2. 
(Note 4): You can not install pulse input and output cassette on the FP-XH M8N control unit. If installed, a self-

diagnosis error will occur (27: Unit installation is restricted). 
(Note 5): Only one FP-X master memory cassette can be installed. A self-diagnosis error will occur if 2 sets are 

installed (27: Unit installation is restricted). 
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1.4.4 Restrictions on Communication Function 

• When using the standard communication port and communication cassette of the control unit, 
the following limitations exist depending on the different functions of use. 

• The communication port number assigned varies according to the cassette installation 
position. 

 Type of communication port / communication cassette (A: available, Blank: Not available) 

Product no. Communication Interface 

Communication Port No. Assigned 

Main 
unit 

Cassette 
installation part 

1 

Cassette 
installation part 

2 
COM0 COM1 COM2 COM3 COM4 

Control unit 
standard 
configuration 

RS-232C (3-wire) × 1 channel A     

AFPX-COM1 RS-232C (5-wire) × 1 channel  A  A  

AFPX-COM2 RS-232C (3-wire) × 2 channel  A A A A 

AFPX-COM3 RS-485 / RS-422 × 1 channel  A  A  

AFPX-COM4 
RS-485 × 1 channel  A  A  

RS-232C (3-wire) × 1 channel   A  A 

AFPX-COM5 
Ethernet × 1 channel  A  A  

RS-232C (3-wire) × 1 channel   A  A 

AFPX-COM6 RS-485 × 2 channel  A A A A 

(Note 1): With 5-wire RS-232C, the RS / CS control can be enabled for the RS-232C port of the AFPX-COM1. 
(Note 2): Choose either of the RS-485 or RS-422 when using AFPX-COM3. It can be shifted by the switch on the 

communication cassette. 
(Note 3): AFPX-COM4 can use RS-485 × 1 channel and RS-232C (3-wire) × 1 channel. 
(Note 4): AFPX-COM5 can use Ethernet × 1 channel and RS-232C (3-wire) × 1 channel. 

 Function of the communication port (A: Available, C: Conditional, Blank: Not available) 

Communication Function Used 

Communication Port No. Assigned 

Main 
unit 

Cassette 
installation part 

1 

Cassette 
installation part 

2 
COM0 COM1 COM2 COM3 COM4 

PLC Link C C    

MEWTOCOL-COM 
Master station A A A A A 

Slave A A A A A 

MODBUS-RTU 
Master station A A A A  

Slave A A A A  

General Communication A A A A  

(Note 1): PLC link can only use either the COM0 port comes with the control unit or COM1 port on the cassette. 
(Note 2): The COM4 port only supports MEWTOCOL-COM communication. In addition, the communication 

parameters (station number, communication format, communication speed) when the power is ON are same 
as the settings of the COM3 port. After RUN, you can also change the conditions by SYS1 instruction.  
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1.5 Restrictions on Servo Amplifier 

1.5.1 Restrictions on Parameter Settings 

Some parameters of AMPs may affect the control of the control unit.  Set parameters 
according to the following description. 

 A6N/A5N parameters 

No. Parameter name 
Factory 
default 
setting 

Settings 

Pr0.00 Rotational direction 
setup 1 The FP-XH M8N Control Unit automatically changes this 

parameter. Do not change this parameter. 
Pr0.01 Control mode setup 0 Use "setting value 0 (semi-closed control)". 

Pr0.08 Output pulse counts per 
one motor revolution 0 

Factory default setting 
When Pr.0.08=0, Pr.0.09=1, Pr.0.10=1, position 
command input is position command. 
（Note 1） 

Pr0.09 Numerator of electronic 
gear 1 

Pr0.10 Denominator of 
electronic gear 1 

Pr4.00 
-Pr4.07 SI1-SI8 input selection (Note 2) The connection method and settings vary according to 

the home return method used. 

Pr4.31 Positioning complete 
(In-position) range 10 

The FP-XH M8N Control Unit automatically changes this 
parameter. Do not change this parameter. Also, the 
setting unit and the calculation method of deviation 
depend on the Pr5.20 "Position setup unit select". 

Pr5.04 Over-travel inhibit input 
setup 1 Use "setting value 1 (Over-travel inhibit input is 

disabled)". 

Pr5.21 Selection of torque limit 1 The FP-XH M8N Control Unit automatically changes this 
parameter. Do not change this parameter. 

Pr7.20 RTEX communication 
cycle setup 3 Use "setting value 3 (0.5 ms)". 

Pr7.21 
RTEX command 
updating cycle ratio 
setting 

2 Use "setting value 2 (2 times)". 

Pr7.22 RTEX function 
extended setup 1 0 Use "setting value 0 (16-byte mode)". 

Pr7.23 RTEX function 
extended setup 2 18 The FP-XH M8N Control Unit automatically changes this 

parameter. Do not change this parameter. 
Pr7.25 RTEX Speed unit setup 0 Change to "setting value 1 (command unit/s)". 

(Note 1) For details of Pr0.08 to Pr0.10, refer to  "Technical Reference of AC Servo Driver A6N series" or "Technical 
Reference of AC Servo Driver A5N series".  

(Note 2) The factory default settings of Pr4.00 to Pr4.07 vary according to parameter numbers. 

KEY POINTS
 

• In the case of the factory default settings of Pr.0.08=0, Pr.0.09=1 and 
Pr.0.10=1, the electronic gear ratio is 1/1, and the encoder resolution is 
"Command pulse counts per one motor revolution". 

• If you need to increase the rotation speed, set the bot parameters Pr0.08 
and Pr0.09 to "0". The value set in the parameter Pr0.10 functions as 
"Command pulse counts per one motor revolution". 
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1.5.2 Combination of Parameters and Home Return Methods 

When using either "DOG method 2" or "Limit method 2" for the home return method, change 
the parameters on the AMP side to the pattern B described as below.  If the operation is 
executed with the pattern A setting (factory default setting), the latch input allocation error 
protection (error code 0821H:33-8) will occur. 

 Home return method and AMP parameter setting (A: Available, Blank: Not available) 
FP-XH M8N 
Home return 
method 

Reference home position 
A6N/A5N parameters 

Pattern A Pattern B 

DOG method 1 Home (Z phase) A A 

DOG method 2 Near home (DOG)  A 

DOG method 3 Home (Z phase) A A 

Limit method 1 Home (Z phase) A A 
Limit method 2 Limit - (NOT) / Limit + (POT)  A 

Z phase method Home (Z phase) A A 
Stop-on-contact 
method 1 

Mechanical stop mechanism such as a 
stopper A A 

Stop-on-contact 
method 2 Home (Z phase) A A 

Data set method - A A 

 Pattern A (Factory default setting) 

Parameter 
no. 

X4 connector 
Parameter 

value (HEX) Pin assign setting Revised 
items Terminal 

name 
Terminal 

no. 
Pr 4.00 SI1 5 00323232H SI-MON5 A contact  
Pr 4.01 SI2 7 00818181H POT B contact A 
Pr 4.02 SI3 8 00828282H NOT B contact A 
Pr 4.03 SI4 9 002E2E2EH SI-MON1 A contact  
Pr 4.04 SI5 10 00222222H HOME A contact  
Pr 4.05 SI6 11 00212121H EXT2 A contact A 
Pr 4.06 SI7 12 002B2B2BH EXT3 A contact A 
Pr 4.07 SI8 13 00313131H SI-MON4 A contact  

 Pattern B (After change) 

Parameter 
no. 

X4 connector 
Parameter 

value (HEX) Pin assign setting Revised 
items Terminal 

name 
Terminal 

no. 
Pr 4.00 SI1 5 00323232H SI-MON5 A contact  
Pr 4.01 SI2 7 00000000H Invalid  A 
Pr 4.02 SI3 8 00000000H Invalid  A 
Pr 4.03 SI4 9 002E2E2EH SI-MON1 A contact  
Pr 4.04 SI5 10 00222222H HOME A contact  
Pr 4.05 SI6 11 00010101H POT A contact A 
Pr 4.06 SI7 12 00020202H NOT A contact A 
Pr 4.07 SI8 13 00313131H SI-MON4 A contact  
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 Name and Function of Each Part 
No. Name Function 
① Battery cover Backup battery insertion space for options. 

② Operating unit 
cover 

Has built-in battery connector, RUN / PROG. mode switch, USB port connector 
and analog potentiometer. 

③ 
Status indicator 
LEDs / I/O indicator 
LEDs 

Indicates the operation mode, error occurrence state, communication state of 
COM0 port  and input and output states. Also displays the input and output 
states of the interface part for motion control. 

④ COM0 port 3-wire RS-232C port. Also equipped with a 5V power supply terminal for 
connecting to GT series monitor. 

⑤ Output terminal Connect with the output device. 

⑥ Network (RTEX) 
connector Used for the network connection of RTEX. 

⑦ DIN hook Used for DIN rail fixing. 

⑧ Mounting hole Used for mounting the unit with screws. 

⑨ 
Cassette 
installation part 
cover 

Installation space for communication cassette and function cassette of the 
options. 

⑩ I/F for pulse input The pulse input function can be used. Pulse inputs of 4 channels are laid out. 

⑪ Input terminal Connect with input devices. 

⑫ Power supply 
terminals Connected to the drive control unit power supply. 

⑬ Battery holder 
When using the clock/calendar function, it is used to install a special battery 
when expanding the backup area of memory area for operation. The special 
Battery (AFPXHBATT) is required to purchase separately. 

⑭ Battery connector Insert special battery (AFPXHBATT) connector. 

⑮ 
RUN / PROG. 
mode 
switch 

RUN 
(upper) Set to RUN mode. Program execution begins. 

PROG. 
(lower) Set to programming mode. 

⑯ USB port connector Connecting to a PC using the tool software. 

⑰ Analog 
potentiometer 

The special DT value changes when rotating potentiometer. It can be applied to 
analog timers etc. 

⑱ Expansion unit 
connector Connect with an expansion cable for installing expansion unit. 

⑲ Add-on cassette 
connector 

For installing an optional add-on cassette (communication cassette or function 
cassette). 

(Note 1): Whether the switch is on "RUN" or "PROG", the mode can be switched by tool software via remote 
operation. When the power is reconnected, it will operate under the mode at the switch position. 
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2.1.2 Status Indicator LEDs 

  

No. Controller 
Display Color Description 

ⓐ 
X Green Indicate the status of inputs. 
Y Green Indicate the status of outputs. 

ⓑ 

RUN Green 
On Lighted when running the program in RUN mode. 

Flashes When performing the mandatory input and output function,  
RUN / PROGLED will flash alternately. 

PROG. Green 
On Lighted when stopping running in PROG. mode. 

Flashes When performing the mandatory input and output function,  
RUN / PROGLED will flash alternately. 

ERR. Red 
On The light is on during hardware exceptions, program operation 

stagnation and monitoring timer operation. 
Flashes Flashing when detecting errors through self diagnosis. 

ⓒ COM0 
SD Green Flashes when COM0 port is sending data. 
RD Green Flashes when COM0 port is receiving data. 

ⓓ 
RTEX 
I/F 

STATUS Green 
On Network establishment 

Flashes Waiting for network establishment 

LINK Green 

Flashes 
Normal connection 
(The TX of the sending node and the RX of the own node are 
electrically connected properly.) 

Off 
Not connected 
(The power supply of the sending node is not on or a cable is 
disconnected, etc.) 

ⓔ Pulse input 
PA Green Lit during Phase-A pulse input (Note 1) 
PB Green Lit during Phase-B pulse input (Note 1) 

(Note 1): pulse input signals (PA) and  (PB) indicate input status of pulse input circuit part.  
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2.1.3 COM0 Port Specifications 

• General-purpose 3-wire RS-232C port. 

• Equipped with a 5 V power supply terminal for supplying power to the GT02 / GT02L series 
programmable display. 

 Terminal arrangement 

 
Controller 
Display Description 

COM 0 

SD Send data  
(unit → external device) 

General-purpose 3-wire RS-232C port. RD Receive data  
(external device → unit) 

SG Signal ground 

OUT 
5V 

As power supply for GT series display, 5 VDC output. 
0V 
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2.2 Power Supply Specifications 

 DC Power Supply (AFPXHM8N16PD) 
Item Specification 
Rated voltage 24 VDC 

Voltage regulation range 21.6 to 26.4 VDC 

Inrush current 12 A or less (at 25 °C) 

Momentary power off time 10 ms 

Internal power supply part Guaranteed life  30,000 h (at 55 °C) 

Fuse  Built-in (Cannot be replaced) 

Insulation system Non-isolated 

Terminal screw M3 

 List of consumption current 
When using 24 VDC 
200 mA or less 
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2.3 Input / Output Specifications (General-purpose 
input/output part) 

2.3.1 Input Specifications 

 Specification 
Item Specification 
Rated input voltage 24 VDC 

Operating voltage range 21.6 - 26.4 VDC 

Rated input current Approx. 4.7mA 

Input points per common 8 points/ COM (+/- polarity of the input power supply are both allowable) 

Minimum ON voltage / minimum 
ON current 19.2 VDC / 3 mA  

Maximum OFF voltage / 
maximum OFF current 2.4 VDC / 1 mA 

Input impedance Approx. 5.1 kΩ 

Response 
time  

OFF → ON 135 µs or less (general input) 
50 µs or less (high-speed counter, pulse catch, interrupt input setting) 

ON → OFF Ditto 

Operating mode indicator LED 

 Internal circuit diagram 
X0-X7 

 

X0-X7:  R1 = 5.1 kΩ, R2 = 3 kΩ 
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2.3.2 Output Specifications 

 Specification 
Item Specification 
Output type PNP open collector 

Rated load voltage 5 - 24 VDC  

Allowable load voltage 
range 4.75 - 26.4 VDC  

Rated load current 0.5 A 

Max. inrush current 1.5 A 

Off state leakage current 1 µA or less 

ON-state max. voltage drop 0.3 VDC or less 

Output points per common 8 points/common 

Response 
time 

OFF → ON 1 ms or less 

ON → OFF 1 ms or less 

Surge absorber Zener diode 

Operating mode indicator LED 

 Internal circuit diagram 
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2.4 Input Specifications (Pulse Input Part) 

 Pulse input 
Item Specification 
Rated input voltage 5 VDC 

Operating voltage range 3.5-5.25 V DC 

Rated input current Approx. 6.9mA 

Input points per common Independent common 

Minimum ON voltage / minimum 
ON current 3V DC/3.2 mA 

Maximum OFF voltage / 
maximum OFF current 1V DC/0.5 mA 

Input impedance Approx. 720Ω 

Response 
time 

OFF → ON 0.5 µs or less 

ON → OFF 0.5 µs or less 

Operating mode indicator LED 

 Internal circuit diagram 
R2

R1 A1/A3/A5/A7(Pls A+)

B2/B4/B6/B8(Pls B-)
B1/B3/B5/B7(Pls A-)

A2/A4/A6/A8(Pls B+)

R3

 
R1 = Approx. 360Ω,R2 =Approx. 360Ω:,R3 = Approx. 2.7kΩ 

 Terminal layout diagram 

 
Pin no. B1 B2 B3 B4 B5 B6 B7 B8 

Signal 
name PlsA(-) PlsB(-) PlsA(-) PlsB(-) PlsA(-) PlsB(-) PlsA(-) PlsB(-) 

Pin no. A1 A2 A3 A4 A5 A6 A7 A8 
Signal 
name PlsA(+) PlsB(+) PlsA(+) PlsB(+) PlsA(+) PlsB(+) PlsA(+) PlsB(+) 

 CH1 CH2 CH3 CH4 
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3.1 Basic I/O Assignment 

3.1.1 Counting Method of I/O Numbers 

 Counting method and representation of I/O numbers 
• I/O numbers are counted in 16 points, representing the next bit combination of device type 

symbol and decimal and hexadecimal numbers. 

• For external input, represented as X0-X9, XA-XF. For external output, represented as Y0-Y9, 
YA-YF. 

 

3.1.2 I/O Number Assignment Method 

 I/O numbers of control unit 
I/O numbers are assigned a fixed area. 

 I/O numbers of expansion unit 
The starting number assigned to each expansion unit will change depending on the 
installation location. 

 I/O number assigned to each function cassette 
Depending on the installation location, I/O number assigned a fixed area. 

1

2 3

4

 

 

1 2 7 F <Decimal number> 
0, 1, 2, 3...9 

<Hexadecimal number> 
0, 1, 2, 3...9, A, B...F 
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 I/O numbers list 
Unit Type and Installation 

Location 
Input Output 

I/O Number I/O Number 
① Control unit X0-X9F WX0-WX9 Y0-Y9F WY0-WY9 

② Cassette installation part 1 
(slot 0) X100-X19F WX10-WX19 Y100-Y19F WY10-WY19 

③ Cassette installation part 2 
(slot 1) X200-X29F WX20-WX29 Y200-Y29F WY20-WY29 

④ 1st expansion X300-X39F WX30-WX39 Y300-Y39F WY30-WY39 

⑤ 2nd expansion X400-X49F WX40-WX49 Y400-Y49F WY40-WY49 

⑥ 3rd expansion X500-X59F WX50-WX59 Y500-Y59F WY50-WY59 

⑦ 4th expansion X600-X69F WX60-WX69 Y600-Y69F WY60-WY69 

⑧ 5th expansion X700-X79F WX70-WX79 Y700-Y79F WY70-WY79 

⑨ 6th expansion X800-X89F WX80-WX89 Y800-Y89F WY80-WY89 

⑩ 7th expansion X900-X99F WX90-WX99 Y900-Y99F WY90-WY99 

⑪ 8th expansion X1000-X109F WX100-WX109 Y1000-Y109F WY100-WY109 

⑫ Motion Control Part X1100-X141F WX110-WX141 Y1100-Y141F WY110-WY141 

(Note): The I/O number can be used practically varies from the types of cassettes and expansion units. 
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3.2 List of I/O Numbers for Units 

3.2.1 FP-XH M8N Control Unit (General-purpose I/O Part) 

 I/O numbers list (General-purpose input and output part) 
Input Output 
Input 
Points I/O Number Output 

Points I/O Number 

8 points X0-X7 8 points Y0-Y7 
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3.2.2 FP-XH M8N Control Unit (Motion Control Part) 

 List of I/O numbers (input) 

Signal name 
I/O number 

Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 
(Virtual) 

Axis 8 
（Virtual） 

Link establishment 
annunciation X1100 

Cam table reading completion 
annunciation X1102 

Cam table rewriting 
completion annunciation X1103 

Tool operation X1104 

Axis group setting done X1105 

Recalculation done X1107 

System restart annunciation X110F 

Servo lock X1120 X1121 X1122 X1123 X1124 X1125 X1126 X1127 

BUSY X1130 X1131 X1132 X1133 X1134 X1135 X1136 X1137 
Operation done X1140 X1141 X1142 X1143 X1144 X1145 X1146 X1147 

Home return done X1150 X1151 X1152 X1153 X1154 X1155 X1156 X1157 

Near home X1170 X1171 X1172 X1173 X1174 X1175 X1176 X1177 
Each axis connection 
confirmation X1180 X1181 X1182 X1183 X1184 X1185 X1186 X1187 

Auxiliary contact X1190 X1191 X1192 X1193 X1194 X1195 X1196 X1197 

Limit + X1200 X1202 X1204 X1206 X1208 X120A X120C X120E 

Limit - X1201 X1203 X1205 X1207 X1209 X120B X120D X120F 

Error annunciation X1230 X1231 X1232 X1233 X1234 X1235 X1236 X1237 
Warning annunciation X1240 X1241 X1242 X1243 X1244 X1245 X1246 X1247 

RTEX general-purpose input 1 X1250 X1252 X1254 X1256 X1258 X125A X125C X125E 

RTEX general-purpose input 2 X1251 X1253 X1255 X1257 X1259 X125B X125D X125F 

Synchronous setting done X1270 X1271 X1272 X1273 X1274 X1275 X1276 X1277 
Synchronous cancel active 
announciation X1280 X1281 X1282 X1283 X1284 X1285 X1286 X1287 

Synchronous slave gear ratio 
change state annunciation X1310 X1311 X1312 X1313 X1314 X1315 X1316 X1317 

Synchronous slave clutch 
connection state annunciation X1330 X1331 X1332 X1333 X1334 X1335 X1336 X1337 

Positioning speed change 
request reception 
annunciation 

X1380 X1381 X1382 X1383 X1384 X1385 X1386 X1387 

Positioning movement amount 
change request reception 
annunciation 

X1390 X1391 X1392 X1393 X1394 X1395 X1396 X1397 
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 List of I/O numbers (output) 

Signal name 
I/O number 

Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 
(Virtual) 

Axis 8 
（Virtual） 

System stop Y1100 

Cam table reading request Y1102 

Cam table rewriting request Y1103 
Axis group setting change 
request Y1105 

Recalculation request Y1107 

All axes error clear request Y110C 
All axes warning clear request Y110D 

Servo ON request Y1120 Y1121 Y1122 Y1123 Y1124 Y1125 Y1126 Y1127 

Servo OFF request Y1130 Y1131 Y1132 Y1133 Y1134 Y1135 Y1136 Y1137 

Positioning start Y1140 Y1141 Y1142 Y1143 Y1144 Y1145 Y1146 Y1147 

Home return start Y1150 Y1151 Y1152 Y1153 Y1154 Y1155 Y1156 Y1157 

Forward JOG Y1160 Y1162 Y1164 Y1166 Y1168 Y116A Y116C Y116E 
Reverse JOG Y1161 Y1163 Y1165 Y1167 Y1169 Y116B Y116D Y116F 

Emergency stop Y1180 Y1181 Y1182 Y1183 Y1184 Y1185 Y1186 Y1187 

Deceleration stop Y1190 Y1191 Y1192 Y1193 Y1194 Y1195 Y1196 Y1197 

Pulsar input enabled Y1200 Y1201 Y1202 Y1203 Y1204 Y1205 Y1206 Y1207 

J-point speed change Y1210 Y1211 Y1212 Y1213 Y1214 Y1215 Y1216 Y1217 

J point positioning start Y1220 Y1221 Y1222 Y1223 Y1224 Y1225 Y1226 Y1227 
Error clear request Y1230 Y1231 Y1232 Y1233 Y1234 Y1235 Y1236 Y1237 

Warning clear request Y1240 Y1241 Y1242 Y1243 Y1244 Y1245 Y1246 Y1247 
RTEX general-purpose output 
1 Y1250 Y1252 Y1254 Y1256 Y1258 Y125A Y125C Y125E 

RTEX general-purpose output 
2 Y1251 Y1253 Y1255 Y1257 Y1259 Y125B Y125D Y125F 

Synchronous setting request Y1270 Y1271 Y1272 Y1273 Y1274 Y1275 Y1276 Y1277 

Synchronous cancel request Y1280 Y1281 Y1282 Y1283 Y1284 Y1285 Y1286 Y1287 
Synchronous slave gear ratio 
change request Y1310 Y1311 Y1312 Y1313 Y1314 Y1315 Y1316 Y1317 

Synchronous slave clutch ON 
request Y1330 Y1331 Y1332 Y1333 Y1334 Y1335 Y1336 Y1337 

Synchronous slave clutch OFF 
request Y1340 Y1341 Y1342 Y1343 Y1344 Y1345 Y1346 Y1347 

Positioning speed change 
request Y1380 Y1381 Y1382 Y1383 Y1384 Y1385 Y1386 Y1387 

Positioning movement amount 
change request Y1390 Y1391 Y1392 Y1393 Y1394 Y1395 Y1396 Y1397 
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3.2.3 FP-X Expansion Unit 

 I/O numbers list 

Unit Type 
Input Output 
Input 
Points I/O Number Output 

Points I/O Number 

E16 8 points X300-X307 8 points Y300-Y307 

E30 16 points X300-X309, X30A-X30F 14 points Y300-Y309, Y30A-Y30D 

E16X 16 points X300-X309, X30A-X30F - - 

E14YR - - 14 points Y300-Y309, Y30A-Y30D 

(Note): I/O numbers in the above table represent the I/O number for expansion units connected to the first unit. The 
I/O number varies from the installation order. 

 
 



I/O Allocation 

3-8 

3.2.4 FP-X Function Cassette 

 I/O numbers list (analog input and output cassettes) 

Installation 
Location Type 

Input Output 
Input 
Points I/O Number Output 

Points I/O Number 

Cassette 
mounting part 
1 

Analog input cassette AD2 2ch WX10, WX11 - - 

Analog output DA2 - - 2ch WY10, WY11 

Analog input and output 
cassette A21 2ch WX10, WX11 1ch WY10 

TC2 thermocouple input 
cassette 2ch WX10, WX11 - - 

RTD input cassette RTD2 2ch WX10, WX11 - - 

Cassette 
mounting part 
2 

Analog input cassette AD2 2ch WX20, WX21 - - 

Analog output DA2 - - 2ch WY20, WY21 

Analog input and output 
cassette A21 2ch WX20, WX21 1ch WY20 

TC2 thermocouple input 
cassette 2ch WX20, WX21 - - 

RTD input cassette RTD2 2ch WX20, WX21 - - 

 

 I/O numbers list (digital input and output cassettes) 

Installation 
Location Type 

Input Output 
Input 
Points I/O Number Output 

Points I/O Number 

Cassette 
mounting part 
1 

Input cassette IN8 8 points X100-X107 - - 

Output cassette TR8 - - 8 points Y100-Y107 

Output cassette TR6P - - 6 points Y100-Y105 

Input and output cassette 
IN4T3 4 points X100-X103 3 points Y100-Y102 

Cassette 
mounting part 
2 

Input cassette IN8 8 points X200-X207 - - 

Output cassette TR8 - - 8 points Y200-Y207 

Output cassette TR6P - - 6 points Y200-Y205 

Input and output cassette 
IN4T3 4 points 200-X203 3 points Y200-Y202 
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3.3 Assignment of FP0 Expansion Units 

3.3.1 I/O Number Assignment Method 

 I/O numbers of FP0 expansion units and FP0 high function units 
• The starting number assigned to each FP0 expansion block varies from the installation 

location of FP-X expansion FP0 adapters. 

• The starting number assigned to each unit varies from the installation sequences of FP0 
expansion units and FP0 high function units. 

 
 

① 
FP-X 
Expansion FP0 
Adapter 

② FP0 
Expansion Unit 1 ③ FP0 

Expansion Unit 2 ④ FP0 
Expansion Unit 3 

 I/O numbers list 
FP-X 

Expansion 
FP0 

Adapter 
Installation 

Location 

Installation Sequence of FP0 Expansion Units 
Expansion Unit 1 Expansion Unit 2 Expansion Unit 3 

Input Output Input Output Input Output 

1st expansion X300-X31F Y300-Y31F X320-X33F Y320-Y33F X340-X35F Y340-Y35F 

2nd expansion X400-X41F Y400-Y41F X420-X43F Y420-Y43F X440-X45F Y440-Y45F 

3rd expansion X500-X51F Y500-Y51F X520-X53F Y520-Y53F X540-X55F Y540-Y55F 

4th expansion X600-X61F Y600-Y61F X620-X63F Y620-Y63F X640-X65F Y640-Y65F 

5th expansion X700-X71F Y700-Y71F X720-X73F Y720-Y73F X740-X75F Y740-Y75F 

6th expansion X800-X81F Y800-Y81F X820-X83F Y820-Y83F X840-X85F Y840-Y85F 

7th expansion X900-X91F Y900-Y91F X920-X93F Y920-Y93F X940-X95F Y940-Y95F 

8th expansion X1000 
-X101F 

Y1000 
-Y101F 

X1020 
-X103F 

Y1020 
-Y103F 

X1040 
-X105F 

Y1040 
-Y105F 

(Note): The I/O number can be used practically varies from the types of cassettes and expansion units. 
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3.3.2 Types and I/O Numbers of FP0R Expansion Units 

I/O numbers when the FP-X expansion FP0 adapter connecting as the first expansion unit of 
the control unit are shown below. 

 I/O numbers list (first expansion unit) 

Unit Type Points 
Assigned 

Expansion 
Unit 1 

Expansion 
Unit 2 

Expansion 
Unit 3 

FP0R 
expansion 
unit 

AFP0RE8X Input (8 points) X300 - X307 X320 - X327 X340 - X347 

AFP0RE8R 
Input (4 points) X300 - X303 X320 - X323 X340 - X343 
Output (4 points) Y300 - Y303 Y320 - Y323 Y340 - Y343 

AFP0E8YT/P 
AFP0RE8YR Output (8 points) Y300 - Y307 Y320 - Y327 Y340 - Y347 

AFP0RE16X Input (16 points) X300 - X30F X320 - X32F X340 - X34F 

AFP0RE16R 
AFP0RE16T/P 

Input (8 points) X300 - X307 X320 - X327 X340 - X347 
Output (8 points) Y300 - Y307 Y320 - Y327 Y340 - Y347 

AFP0RE16YT/P Input (16 points) Y300 - Y30F Y320 - Y32F Y340 - Y34F 

AFP0RE32T/P 
Input (16 points) X300 - X30F X320 - X32F X340 - X34F 
Output (16 
points) Y300 - Y30F Y320 - Y32F Y340 - Y34F 

FP0R 
analog 
input 
unit 

AFP0RAD4 
(Note 1) 
AFP0RAD8 

Input (16 points) 
CH0,2,4,6 

WX30 
(X300~X30F) 

WX32  
(X320-X32F) 

WX34  
(X340-X34F) 

Input (16 points) 
CH1,3,5,7 

WX31 
(X310-X31F) 

WX33  
(X330~X33F) 

WX35  
(X350~X35F) 

Output (16 
points) 
Range setting 

WY30  
(Y300~Y30F) 

WY32 
(Y320-Y32F) 

WY34  
(Y340-Y34F) 

Output (16 
points) 
Averaging setting 

WY31 
(Y310-Y31F) 

WY33 
(Y330-Y33F) 

WY35 
(Y350-Y35F) 

FP0R 
analog 
output 
unit 

AFP0RDA4 

Input (32 points) 
Status 

WX30 
(X300~X30F) 

WX32  
(X320-X32F) 

WX34  
(X340-X34F) 

WX31 
(X310-X31F) 

WX33  
(X330~X33F) 

WX35  
(X350~X35F) 

Output (16 
points) 
CH0,2 (Note 2) 

WY30  
(Y300~Y30F) 

WY32 
(Y320-Y32F) 

WY34  
(Y340-Y34F) 

Output (16 
points) 
CH0,3 (Note 2) 

WY31 
(Y310-Y31F) 

WY33 
(Y330-Y33F) 

WY35 
(Y350-Y35F) 

FP0R 
analog 
input 
output unit 

AFP0RAD4 
(Note 3) 
AFP0RA42 

Input (16 points) 
CH0,2 

WX30 
(X300~X30F) 

WX32  
(X320-X32F) 

WX34  
(X340-X34F) 

Input (16 points) 
CH1,3 

WX31 
(X310-X31F) 

WX33  
(X330~X33F) 

WX35  
(X350~X35F) 

Output (16 
points) 
CH0 (Note 4) 

WY30  
(Y300~Y30F) 

WY32 
(Y320-Y32F) 

WY34  
(Y340-Y34F) 

Output (16 
points) 
CH1 (Note 4) 

WY31 
(Y310-Y31F) 

WY33 
(Y330-Y33F) 

WY35 
(Y350-Y35F) 

(Note 1): processing data of CH0-CH3 when AFP0RAD4. 
(Note 2): also used for switching output ranges in 14-digit mode. 
(Note 3): processing data of input CH0/CH1 and output CH0 when AFP0RA21. 
(Note 4): also used for switching of output ranges, averaging setting upon input, and output range in 14-digit mode. 
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3.3.3 Types and I/O Numbers of FP0 Expansion Units 

I/O numbers when the FP-X expansion FP0 adapter connecting as the first expansion unit of 
the control unit are shown below. 

 I/O numbers list (first expansion unit) 

Unit Type Points 
Assigned 

Expansion 
Unit 1 

Expansion 
Unit 2 

Expansion 
Unit 3 

FP0 
expansion unit 

FP0-E8X Input (8 points) X300 - X307 X320 - X327 X340 - X347 

FP0-E8R 
Input (4 points) X300 - X303 X320 - X323 X340 - X343 
Output (4 points) Y300 - Y303 Y320 - Y323 Y340 - Y343 

FP0-E8YT/P 
FP0-E8YR Output (8 points) Y300 - Y307 Y320 - Y327 Y340 - Y347 

FP0-E16X Input (16 points) X300 - X30F X320 - X32F X340 - X34F 

FP0-E16R 
FP0-E16T/P 

Input (8 points) X300 - X307 X320 - X327 X340 - X347 
Output (8 points) Y300 - Y307 Y320 - Y327 Y340 - Y347 

FP0-E16YT/P Output (16 
points) Y300 - Y30F Y320 - Y32F Y340 - Y34F 

FP0-E32T/P 
Input (16 points) X300 - X30F X320 - X32F X340 - X34F 
Output (16 
points) Y300 - Y30F Y320 - Y32F Y340 - Y34F 

FP0 
analog 
I/O unit 

FP0-A21 

Input (16 points) 
CH0 

WX30  
(X300-X30F) 

WX32  
(X320-X32F) 

WX34  
(X340-X34F) 

Input (16 points) 
CH1 

WX31 
(X310-X31F) 

WX33  
(X330-X33F) 

WX35  
(X350-X35F) 

Output (16 
points) 

WY30  
(Y300-Y30F) 

WY32 
(Y320-Y32F) 

WY34  
(Y340-Y34F) 

FP0 
A / D converter 
unit 
FP0 
thermocouple 
unit 

FP0-A80 
FP0-TC4 
FP0-TC8 

Input (16 points) 
CH0, 2, 4, 6 

WX30  
(X300-X30F) 

WX32  
(X320-X32F) 

WX34  
(X340-X34F) 

Input (16 points) 
CH1, 3, 5, 7 

WX31 
(X310-X31F) 

WX33  
(X330-X33F) 

WX35  
(X350-X35F) 

FP0 
D / A converter 
unit 

FP0-A04V 
FP0-A04I 

Input (16 points) WX30  
(X300-X30F) 

WX32  
(X320-X32F) 

WX34  
(X340-X34F) 

Output (16 
points) 
CH0, 2 

WY30  
(Y300-Y30F) 

WY32 
(Y320-Y32F) 

WY34  
(Y340-Y34F) 

Output (16 
points) 
CH1, 3 

WY31 
(Y310-Y31F) 

WY33 
(Y330-Y33F) 

WY35 
(Y350-Y35F) 

FP0 
I/O link 
unit 

FP0-IOL 
Input 32 points X300 - X31F X320 - X33F X340 - X35F 

Output 32 points Y300 - Y31F Y320 - Y33F Y340 - Y35F 

(Note 1): The channel datum of FP0 A / D converter unit (FP0-A80), FP0 thermocouple unit (FP0-TC4 / FP0-TC8) 
and FP0 D / A converter unit (FP0-A04V / FP0-A04I) are shifted, read and wrote according to the user program 
including conversion data switching flags. 

(Note 2): For FP0 CC-Link slave unit, please confirm it according to the appropriate manual (the starting address 
must be read). 
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3.4 Detailed I/O Information of Motion Control Part 
Contact 
allocation 

Target 
axis Name Description 

W
X1

10
 

X1100 All axes 
Link 
establishment 
annunciation 

Indicates that the network link was established, and announce the 
system started running. 

X1101 - - - 

X1102 All axes 

Cam table 
reading 
completion 
annunciation 

Reads cam tables when the cam table reading request contact (Y1102) 
turns ON. This contact turns ON after the completion of the reading of 
cam tables. 

X1103 All axes 

Cam table 
rewriting 
completion 
annunciation 

Reads cam tables when the cam table rewriting request contact 
(Y1103) turns ON. This contact turns ON after the completion of the 
rewriting of cam tables. 

X1104 All axes Tool operation 
Contact to indicate that the positioning unit is in tool operation. The 
start-up from I/O is not available during the Tool operaiton. If it 
performs, a warning will occur. 

X1105 All axes Axis group 
setting done 

Makes axis group setting changes in the unit with the axis group setting 
request contact (Y1105) turned ON after making setting changes in the 
axis group with the program. The contact turns ON after the completion 
of the setting changes. 

X1106 - - - 

X1107 All axes Recalculation 
done 

Starts the reconfiguration of positioning data (standard area) in the 
positioning memory when the recalcuclation request contact (Y1107) 
turns ON. This contact turns OFF. This contact turns ON after the 
completion of the reconfiguration. 
Note) This contact is used to confirm the completion when a positioning 
table (standard area) is rewritten using a ladder program. 

X1108  
-X110E - - - 

X110F All axes System restart 
annunciation 

This contact turns ON when the configuration of axes that is required 
for restarting the system is changed.  
When this contact is ON, the change setting will not be reflected unless 
the power supply is restarted. 

W
X1

11
 

X1110 
-X111F - - - 

W
X1

12
 

X1120 Axis 1 

Servo lock 
Turns on when the corresponding AMP is in the state of servo lock. 
As for X1126 and X1127, they are always ON when they are allocated 
to the virtual axes. 

X1121 Axis 2 
X1122 Axis 3 

X1123 Axis 4 
X1124 Axis 5 
X1125 Axis 6 
X1126 Axis 7 
X1127 Axis 8 
X1128  
-X112F - - - 
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(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 

Contact 
allocation 

Target 
axis Name Description 

W
X1

13
 

X1130 Axis 1 

BUSY Turns on when the corresponding axis is operating. 

X1131 Axis 2 
X1132 Axis 3 
X1133 Axis 4 
X1134 Axis 5 
X1135 Axis 6 

X1136 Axis 7 
(virtual) 

X1137 Axis 8 
(virtual) 

X1138  
-X113F - - - 

W
X1

14
 

X1140 Axis 1 

Operation done 

Turns on when an operation command for the corresponding axis 
is completed.  
Turns ON when the operation for all the tables completed for P-
point control and C-point control of the automatic operation. 
After this contact turns ON, the ON-state will continue until the 
next control is activated. 

X1141 Axis 2 
X1142 Axis 3 

X1143 Axis 4 
X1144 Axis 5 
X1145 Axis 6 

X1146 Axis 7 
(virtual) 

X1147 Axis 8 
(virtual) 

X1148  
-X114F - - - 

W
X1

15
 

X1150 Axis 1 

Home return 
done 

Turns on when the home return operation for the corresponding 
axis completed. 
After this contact turns ON, the ON-state will continue until the 
next control is activated. 

X1151 Axis 2 
X1152 Axis 3 
X1153 Axis 4 
X1154 Axis 5 
X1154 Axis 6 

X1156 Axis 7 
(virtual) 

X1157 Axis 8 
(virtual) 

X1158  
-X115F - - - 

W
X1

16
 

X1160  
-X116F - - - 
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(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 

 

 

Contact 
allocation 

Target 
axis Name Description 

W
X1

17
 

X1170 Axis 1 

Near home 

Monitor contact for the near home input connected to the 
corresnponding AMP. 
As for X1176 and X1177, they are always OFF when they are 
allocated to the virtual axes. 

X1171 Axis 2 
X1172 Axis 3 

X1173 Axis 4 
X1174 Axis 5 
X1175 Axis 6 

X1176 Axis 7 
(virtual) 

X1177 Axis 8 
(virtual) 

X1178  
-X117F - - - 

W
X1

18
 

X1180 Axis 1 

Each axis 
connection 
confirmation 

Turns on when the corresponding axis exists. 
As for X1186 and X1187, they are always ON when they are 
allocated to the virtual axes. 

X1181 Axis 2 
X1182 Axis 3 
X1183 Axis 4 
X1184 Axis 5 
X1185 Axis 6 

X1186 Axis 7 
X1187 Axis 8 
X1188  
-X118F - - - 

W
X1

19
 

X1190 Axis 1 

Auxiliary contact Turns on when the corresponding positioning table of the 
corresponding axis is executed. 

X1191 Axis 2 
X1192 Axis 3 
X1193 Axis 4 
X1194 Axis 5 

X1194 Axis 6 

X1196 Axis 7 
(virtual) 

X1197 Axis 8 
(virtual) 

X1198  
-X119F - - - 
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Contact 
allocation 

Target 
axis Name Description 

W
X1

20
 

X1200 
Axis 1 

Limit + 

Monitor contact of the limit + and \endash  connected to the 
corresponding AMP. 
During the positioning operation, JOG operation or pulsar 
operation, performs the deceleration stop when the limit input that 
is an extension of the operating direction turned on. 
The deceleration stop time during the limit input can be changed 
in the positioning memory. 
It will be the contact for the automatic inversion when performing 
the home return. 
As for X120C to X120F, they are always ON when they are 
allocated to the virtual axes. 

X1201 Limit - 
X1202 

Axis 2 
Limit + 

X1203 Limit - 
X1204 

Axis 3 
Limit + 

X1205 Limit - 
X1206 

Axis 4 
Limit + 

X1207 Limit - 
X1208 

Axis 5 
Limit + 

X1209 Limit - 
X120A 

Axis 6 
Limit + 

X120B Limit - 
X120C Axis 7 

(virtual) 
Limit + 

X120D Limit - 
X120E Aixs 8 

(virtual) 
Limit + 

X120F Limit - 

W
X1

21
 

X1210  
-X121F - - - 

W
X1

22
 

X1220  
-X122F - - - 

W
X1

23
 

X1230 Axis 1 

Error 
annunciation 

Turns on when an error occurs on the corresponding axis. 
The contacts of all axes turn on if all axes have errors. 
The details of the error can be confirmed in the error annunciation 
area of the positioning memory. 

X1231 Axis 2 
X1232 Axis 3 
X1233 Axis 4 
X1234 Axis 5 
X1235 Axis 6 

X1236 Axis 7 
(virtual) 

X1237 Axis 8 
(virtual) 

X1238  
-X123F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 

Contact 
allocation 

Target 
axis Name Description 

W
X1

24
 

X1240 Axis 1 

Warning 
annunciation 

Turns on when a warning occurs on the corresponding axis. 
The contacts of all axes turn on if all axes have warning. 
The details of the warning can be confirmed in the warning 
annunciation area of the positioning memory. 

X1241 Axis 2 
X1242 Axis 3 
X1243 Axis 4 
X1244 Axis 5 
X1245 Axis 6 

X1246 Axis 7 
(virtual) 

X1247 Axis 8 
(virtual) 

X1248  
-X124F - - - 

W
X1

25
 

X1250 
Axis 1 

RTEX general-
purpose input 1 

Monitor contact for the RTEX general-purpose input connected 
to the corresnponding AMP. 
The input status of this contact does not affect on the operations 
of the motor and FP-XH M8N Control Unit. 

X1251 RTEX general-
purpose input 2 

X1252 
Axis 2 

RTEX general-
purpose input 1 

X1253 RTEX general-
purpose input 2 

X1254 
Axis 3 

RTEX general-
purpose input 1 

X1255 RTEX general-
purpose input 2 

X1256 
Axis 4 

RTEX general-
purpose input 1 

X1257 RTEX general-
purpose input 2 

X1258 
Axis 5 

RTEX general-
purpose input 1 

X1259 RTEX general-
purpose input 2 

X125A 
Axis 6 

RTEX general-
purpose input 1 

X125B RTEX general-
purpose input 2 

X125C 
Axis 7 

RTEX general-
purpose input 1 

X125D RTEX general-
purpose input 2 

X125E 
Axis 8 

RTEX general-
purpose input 1 

X125F RTEX general-
purpose input 2 

W
X1

26
 

X1260  
-X126F - - - 
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Contact 
allocation 

Target 
axis Name Description 

W
X1

27
 

X1270 Axis 1 

Synchronous 
setting done 

Changes synchronous settings in the unit with the synchronous 
setting request contact (Y1270 to Y1277) turned ON after 
changing the settings of synchronous control with the program. 
The contact turns ON upon completion of the setting changes. 
This contanct turns OFF with the synchronous setting request 
contact (Y1270 to Y1277) turned OFF. 

X1271 Axis 2 
X1272 Axis 3 
X1273 Axis 4 
X1274 Axis 5 
X1275 Axis 6 

X1276 Axis 7 
(virtual) 

X1277 Axis 8 
(virtual) 

X1278 
-X127F - - - 

W
X1

28
 

X1280 Axis 1 

Synchronous 
cancel active 
announciation 

Turns ON when the synchronous operation of the positioning unit 
is canceled with the synchronous setting cancel request contact 
(Y1280 to Y1287) turned ON. 
The synchronous operation axes cannot be executed if this 
contact is ON for the axes. 

X1281 Axis 2 
X1282 Axis 3 
X1283 Axis 4 
X1284 Axis 5 
X1285 Axis 6 

X1286 Axis 7 
(virtual) 

X1287 Axis 8 
(virtual) 

X1288 
-X128F - - - 

W
X1

29
 

X1290  
-X129F - - - 

W
X1

30
 

X1300  
-X130F - - - 

W
X1

31
 

X1310 Axis 1 

Slave axis gear 
ratio change 
annunciation 

Makes gear ratio changes with the slave axis gear ratio change 
request contact (Y1310 to Y1317). 
The contact for the corresponding axis tirms ON after the gear 
ratio is changed. 

X1311 Axis 2 
X1312 Axis 3 
X1313 Axis 4 
X1314 Axis 5 
X1315 Axis 6 

X1316 Axis 7 
(virtual) 

X1317 Axis 8 
(virtual) 

X1318 
-X131F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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Contact 
allocation 

Target 
axis Name Description 

W
X1

32
 

X1320  
-X132F - - - 

W
X1

33
 

X1330 Axis 1 

Slave axis clutch 
operation 
annunciation 

The clutch will start operating when the slave axis clutch ON re-
request contact (Y1330 to Y1337) or clutch OFF request contact 
(Y1340 to Y1347) turns ON. 
The contact for the corresponding axis  turns ON after the 
completion of the operation of the clutch. 

X1331 Axis 2 
X1332 Axis 3 
X1333 Axis 4 
X1334 Axis 5 
X1335 Axis 6 

X1336 Axis 7 
(virtual) 

X1337 Axis 8 
(virtual) 

X1338 
-X133F - - - 

W
X1

34
 

X1340  
-X134F - - - 

W
X1

35
 

X1350  
-X135F - - - 

W
X1

36
 

X1360  
-X136F - - - 

W
X1

37
 

X1370  
-X137F - - - 

W
X1

38
 

X1380 Axis 1 

Positioning speed 
change request 
reception 
annunciation 

Starts the speed change operation when the positioning speed 
change request contact (Y1380 to Y1387) turns ON. The contact 
for the corresponding axis turns ON when he request is 
accepted. 

X1381 Axis 2 

X1382 Axis 3 
X1383 Axis 4 
X1384 Axis 5 
X1385 Axis 6 

X1386 Axis 7 
(virtual) 

X1387 Axis 8 
(virtual) 

X1388 
-X138F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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Contact 
allocation 

Target 
axis Name Description 

W
X1

39
 

X1390 Axis 1 

Positioning 
movement 
amount change 
request reception 
annunciation 

Starts the movement amount change operation when the 
positioning movement amount change request contact (Y1390 to 
Y139F) turns ON. The contact for the corresponding axis turns 
ON when he request is accepted. 

X1391 Axis 2 
X1392 Axis 3 
X1393 Axis 4 
X1394 Axis 5 

X1395 Axis 6 

X1396 Axis 7 
(virtual) 

X1397 Axis 8 
(virtual) 

X1398 
-X139F - - - 

W
X1

40
 

X1400  
-X140F - - - 

W
X1

41
 

X1410  
-X141F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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Contact 
allocation 

Target 
axis Name Description 

W
Y1

10
 

Y1100 All axes System stop Contact for requesting the system stop. When it turns on, all axes will 
stop at the deceleration time 0. 

Y1101 - - - 

Y1102 All axes Cam table 
reading request 

Turn ON this signal for reading cam tables. The cam table of a 
specified cam pattern number will be read when this signal turns ON. 
After the completion of the reading of cam tables, the cam table 
reading done contact (X1102) turns ON. 

Y1103 All axes Cam table 
rewriting request 

Turn ON this signal for reading cam tables. The cam table of a 
specified cam pattern number will be rewritten when this signal turns 
ON. 
After the completion of the rewriting cam tables, the cam table 
rewriting done contact (X1103) turns ON. 

Y1104 - - - 

Y1105 All axes Axis group setting 
change request This contact will turn ON after the axis group settings are changed. 

Y1106 - - - 

Y1107 All axes Recalculation 
request 

Turn on this signal when each positioning data (standard area) in the 
positioning memory was changed. The positioning data after the 
table number starting the recalculation specified in the positioning 
memory can be restructured and will be executable by turning on this 
signal. When restructuring of the positioning data completes, the 
recalculation done contact (X1107) turns on. 
Note) It is used only when the positioning data has been rewritten by 
laddar programs. 

Y1108 
-Y110F - - - 

W
Y1

11
 

Y111E 
-Y111F - - - 
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Contact 
allocation 

Target 
axis Name Description 

W
Y1

12
 

Y1120 Axis 1 

Servo ON 
request 

Requests the servo lock for the corresponding AMP. 
The servo lock is executed by the ON edge of this contact. 
The servo cannot be free automatically even in the program 
mode. 
To make the servo free, turn on the servo OFF request contacts 
(Y1130-Y1137). 
(The operation is the edge type.) 

Y1121 Axis 2 

Y1122 Axis 3 

Y1123 Axis 4 

Y1124 Axis 5 

Y1125 Axis 6 

Y1126 Axis 7 

Y1127 Axis 8 

Y1128 
-Y112F - - - 

W
Y1

13
 

Y1130 Axis 1 

Servo OFF 
request 

Requests the servo free for the corresponding AMP. 
The servo free is executed by the ON edge of this contact. 
(The operation is the edge type.) 

Y1131 Axis 2 

Y1132 Axis 3 
Y1133 Axis 4 
Y1134 Axis 5 
Y1135 Axis 6 
Y1136 Axis 7 
Y1137 Axis 8 
Y1138 
-Y113F - - - 

W
Y1

14
 

Y1140 Axis 1 

Positioning start 

Requests the positioning control of the corresponding axis. 
The starting table is specified in the area for specifying the 
position control starting table number in the positioning memory. 
(The operation is the edge type.) 
If this contact turns ON while the positioning unit is in tool 
operation, a warning will be output. 

Y1141 Axis 2 

Y1142 Axis 3 

Y1143 Axis 4 

Y1144 Axis 5 

Y1145 Axis 6 

Y1146 Axis 7 
(virtual) 

Y1147 Axis 8 
(virtual) 

Y1148 
-Y114F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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Contact 
allocation 
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W
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15
 

Y1150 Axis 1 

Home return start 

Requests the home return of the corresponding axis. 
(The operation is the edge type.) 
If this contact turns ON while the positioning unit is in tool 
operation, a warning will be output. 

Y1151 Axis 2 
Y1152 Axis 3 
Y1153 Axis 4 
Y1154 Axis 5 

Y1155 Axis 6 

Y1156 Axis 7 
(virtual) 

Y1157 Axis 8 
(virtual) 

Y1158 
-Y115F - - - 

W
Y1

16
 

Y1160 
Axis 1 

Forward JOG 

Requests the JOG operation of the corresponding axis. 
(The operation is the level type.) 
If this contact turns ON while the positioning unit is in tool 
operation, a warning will be output. 

Y1161 Reverse JOG 

Y1162 
Axis 2  

Forward JOG 
Y1163 Reverse JOG 
Y1164 

Axis 3 
Forward JOG 

Y1165 Reverse JOG 
Y1166 

Axis 4 
Forward JOG 

Y1167 Reverse JOG 

Y1168 
Axis 5 

Forward JOG 
Y1169 Reverse JOG 
Y116A 

Axis 6 
Forward JOG 

Y116B Reverse JOG 
Y116C Axis 7 

(virtual) 
Forward JOG 

Y116D Reverse JOG 

Y116E Axis 8 
(virtual) 

Forward JOG 
Y116F Reverse JOG 

W
Y1

17
 

Y1170 
-Y117F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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W
Y1
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Y1180 Axis 1 

Emergency stop 
Requests the emergency stop for the corresponding axes. 
(The operation is the level type.) 
Note) The deviation counter cannot be cleared. 

Y1181 Axis 2 
Y1182 Axis 3 
Y1183 Axis 4 
Y1184 Axis 5 

Y1185 Axis 6 

Y1186 Axis 7 
(virtual) 

Y1187 Axis 8 
(virtual) 

Y1188 
-Y118F - - - 

W
Y1

19
 

Y1190 Axis 1 

Deceleration stop 
Requests the deceleration stop for the corresponding axes. 
(The operation is the level type.) 
Note) The deviation counter cannot be cleared. 

Y1191 Axis 2 

Y1192 Axis 3 
Y1193 Axis 4 
Y1194 Axis 5 
Y1195 Axis 6 

Y1196 Axis 7 
(virtual) 

Y1197 Axis 8 
(virtual) 

Y1198 
-Y119F - - - 

W
Y1

20
 

Y1200 Axis 1 

Pulsar input 
enabled 

Requests the permission for the pulsar operation of the 
corresponding axis. 
(The operation is the level type.) 

Y1201 Axis 2 
Y1202 Axis 3 
Y1203 Axis 4 
Y1204 Axis 5 

Y1205 Axis 6 

Y1206 Axis 7 
(virtual) 

Y1207 Axis 8 
(virtual) 

Y1208 
-Y120F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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W
Y1
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Y1210 Axis 1 

J-point speed 
change 

By turning ON this signal while the positioning unit is in J-point 
operation, the speed changes to the target speed in the specified 
acceleration/deceleration time and pattern. 
(The operation is the edge type.) 

Y1211 Axis 2 
Y1212 Axis 3 
Y1213 Axis 4 

Y1214 Axis 5 

Y1215 Axis 6 

Y1216 Axis 7 
(virtual) 

Y1217 Axis 8 
(virtual) 

Y1218 
-Y121F - - - 

W
Y1

22
 

Y1220 Axis 1 

J-point 
positioning start 

The positioning unit will go to the next table processing when this 
signal turns ON during the JOG (J-point) positioning of the 
corresponding axis. 
(The operation is the edge type.) 

Y1221 Axis 2 
Y1222 Axis 3 

Y1223 Axis 4 
Y1224 Axis 5 
Y1225 Axis 6 

Y1226 Axis 7 
(virtual) 

Y1227 Axis 8 
(virtual) 

Y1228 
-Y122F - - - 

W
Y1

23
 

Y1230 Axis 1 

Error clear 
request 

Requests the error clear of the corresponding axis. 
The processing to recover from errors is performed and the error 
logs are cleared by turning on this signal. 
Note) Unrecoverable errors cannot be recovered even if this 
signal turned on. 

Y1231 Axis 2 
Y1232 Axis 3 
Y1233 Axis 4 
Y1234 Axis 5 
Y1235 Axis 6 

Y1236 Axis 7 
(virtual) 

Y1237 Axis 8 
(virtual) 

Y1238 
-Y123F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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axis Name Description 

W
Y1
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Y1240 Axis 1 

Warning clear 
request 

Requests the warning clear of the corresponding axis. 
The warning logs are cleared by turning on this signal. 

Y1241 Axis 2 
Y1242 Axis 3 
Y1243 Axis 4 
Y1244 Axis 5 
Y1245 Axis 6 

Y1246 Axis 7 
(virtual) 

Y1247 Axis 8 
(virtual) 

Y1248 
-Y124F - - - 

W
Y1

25
 

Y1250 
Axis 1 

RTEX general-
purpose output 1 

Contact for the RTEX general-purpose output connected to the 
corresponding AMP. 
The input status of this contact does not affect on the operation 
of the motor and unit. 

Y1251 RTEX general-
purpose output 2 

Y1252 
Axis 2 

RTEX general-
purpose output 1 

Y1253 RTEX general-
purpose output 2 

Y1254 
Axis 3 

RTEX general-
purpose output 1 

Y1255 RTEX general-
purpose output 2 

Y1256 
Axis 4 

RTEX general-
purpose output 1 

Y1257 RTEX general-
purpose output 2 

Y1258 
Axis 5 

RTEX general-
purpose output 1 

Y1259 RTEX general-
purpose output 2 

Y125A 
Axis 6 

RTEX general-
purpose output 1 

Y125B RTEX general-
purpose output 2 

Y125C 
Axis 7 

RTEX general-
purpose output 1 

Y125D RTEX general-
purpose output 2 

Y125E 
Axis 8 

RTEX general-
purpose output 1 

Y125F RTEX general-
purpose output 2 

W
Y1

26
 

Y1260 
-Y126F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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Y1270 Axis 1 

Synchronous 
setting request 

This contact will turn ON after the synchronous operation 
settings are changed. 
Turn ON this contact for reflecting the setting changes in the 
synchronous control common area of the positioning memory. 
This flag is an edge trigger. 

Y1271 Axis 2 
Y1272 Axis 3 
Y1273 Axis 4 
Y1274 Axis 5 
Y1275 Axis 6 

Y1276 Axis 7 
(virtual) 

Y1277 Axis 8 
(virtual) 

Y1278 
-Y127F - - - 

W
Y1

28
 

Y1280 Axis 1 

Synchronous 
cancel request 

Turns ON the contact for the axis to cancel the synchronous 
operation. 
The unit will not perform the synchronous operation of the axis 
for which this contact is ON. Turn ON this contact for canceling 
the synchronous state temporarily during synchronous control. 
To make the synchronous state, turn OFF this contact. 

Y1281 Axis 2 
Y1282 Axis 3 
Y1283 Axis 4 
Y1284 Axis 5 
Y1285 Axis 6 

Y1286 Axis 7 
(virtual) 

Y1287 Axis 8 
(virtual) 

Y1288 
-Y128F - - - 

W
Y1

29
 

Y1290 
-Y129F - - - 

W
Y1

30
 

Y1300 
-Y130F - - - 

W
Y1

31
 

Y1310 Axis 1 

Slave axis gear 
ratio change 
request 

A gear ratio change is made with the contact for the 
corresponding axis turned ON while the positioning unit is in 
synchronous operation. 
(The operation is the edge type.) 

Y1311 Axis 2 
Y1312 Axis 3 
Y1313 Axis 4 
Y1314 Axis 5 
Y1315 Axis 6 

Y1316 Axis 7 
(virtual) 

Y1317 Axis 8 
(virtual) 

Y1318 
-Y131F - - - 

W
Y1

32
 

Y1320 
-Y132F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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Y1330 Axis 1 

Slave axis clutch 
ON request 

Starts the clutch ON operation when the contact for the 
corresponding axis during the synchronous operation turns on. 
No axes start unless the clutch is used. 
(Set the operation to level type, rising edge, or falling edge.) 

Y1331 Axis 2 
Y1332 Axis 3 
Y1333 Axis 4 
Y1334 Axis 5 

Y1335 Axis 6 

Y1336 Axis 7 
(virtual) 

Y1337 Axis 8 
(virtual) 

Y1338 
-Y133F - - - 

W
Y1

34
 

Y1340 Axis 1 

Slave axis clutch 
OFF request 

Starts the clutch OFF operation when the contact for the 
corresponding axis during the synchronous operation turns on. 
No axes start unless the clutch is used. 
(Set the operation to rising edge, or falling edge.) 
These signals will be disabled while the slave axis clutch ON 
request signal is set to level type. 

Y1341 Axis 2 
Y1342 Axis 3 
Y1343 Axis 4 
Y1344 Axis 5 
Y1345 Axis 6 

Y1346 Axis 7 
(virtual) 

Y1347 Axis 8 
(virtual) 

Y1348 
-Y134F - - - 

W
Y1

35
 

Y1350 
-Y135F - - - 

W
Y1

36
 

Y1360 
-Y136F - - - 

W
Y1

37
 

Y1370 
-Y137F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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W
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Y1380 Axis 1 

Positioning speed 
change request 

Changes the target speed by turning on the contact for the 
corresponding axis during the positioning operation. 
(The operation is the edge type.) 

Y1381 Axis 2 
Y1382 Axis 3 
Y1383 Axis 4 
Y1384 Axis 5 

Y1385 Axis 6 

Y1386 Axis 7 
(virtual) 

Y1387 Axis 8 
(virtual) 

Y1388 
-Y138F - - - 

W
Y1

39
 

Y1390 Axis 1 

Positioning 
movement 
amount change 
request 

Changes the target movement amount by turning on the contact 
for the corresponding axis during the positioning operation. 
(The operation is the edge type.) 

Y1391 Axis 2 
Y1392 Axis 3 
Y1393 Axis 4 
Y1394 Axis 5 
Y1395 Axis 6 

Y1396 Axis 7 
(virtual) 

Y1397 Axis 8 
(virtual) 

Y1398 
-Y139F - - - 

W
Y1

40
 

Y1400 
-Y140F - - - 

W
Y1

41
 

Y1410 
-Y141F - - - 

(Note 1): When using the virtual axes, the I/O numbers allocated vary according to the number of virtual axes. 
When selecting virtual 1st 
axis 

The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
1st axis". 

When selecting virtual 1st 
and 2nd axes 

The I/O number of "Axis 7 (virtual)" in the above table is allocated to "virtual 
1st axis". 
The I/O number of "Axis 8 (virtual)" in the above table is allocated to "virtual 
2nd axis". 
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4.1 Installation 

4.1.1 Installation Environment and Space 

 Installation environment 
Use the unit within the range of the general specifications when installing. 

• Surrounding air temperature: 0 to +55 °C 

• Surrounding air humidity: 10-95%RH (non-condensing at 25 °C) 

• Pollution degree: 2 

• Operating altitude: 2000 m above the sea level or lower  

• Overvoltage category: II or less 

• Site of installation: within control cabinets with the protection level of over IP54 (metal 
materials with enough toughness) 

It can be used in the above environments. 

Do not use it in the following environments. 

• Direct sunlight 

• Sudden temperature changes causing condensation 

• Inflammable or corrosive gas. 

• Excessive airborne dust, metal particles or saline matter. 

• Benzine, paint thinner, alcohol or other organic solvents or strong alkaline solutions such as 
ammonia or caustic soda. 

• Direct vibration, shock or direct drop of water. 

• Influence from power transmission lines, high voltage equipment, power cables, power 
equipment, radio transmitters, or any other equipment that would generate high switching 
surges. (Min.100mm or less） 

 Static electricity 
• Before touching the unit, always touch a grounded piece of metal in order to discharge static 

electricity. 

• Do not directly touch the connector pins. 
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 Heat dissipation considerations 
• In order to facilitate heat dissipation, set the LED display section on the left side. 

 

• Vertical, horizontal or upside down installation are prohibited because they will result in 
insufficient heat dissipation, leading to abnormal internal heat. 

• Do not install directly above the heater, transformer, large capacity resistance and other 
equipment with large heat radiation. 

 Installation space 
• Leave at least 50mm of space between the wiring ducts of the unit and other devices to 

allow heat radiation and unit replacement. 

• To avoid being affected by the radiation, the surface of each unit and the power line or 
electromagnetic switches should be separated by 100 mm or more when installing. Make 
sure it separated with other devices by a certain distance, especially when it is installed on 
the back side of the control cabinet. 

• Please ensure space for the cable connecting to the programming tool. 
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4.2 Backup Battery Installation 

4.2.1 Backup Battery Installation 

• Please install the backup battery according to the following steps. 

 Installation steps 

PROCEDURE  
1. Open the operating unit cover and battery cover. 

2. Insert the backup battery into the battery holder. 

3. Connect the battery connector. 

4. Close the operating unit cover and battery cover. 

 

• When removing the backup battery, push the push rod portion. 

 

KEY POINTS
 

• Backup battery is used for clock/calendar function and the expansion of the 
backup area of the operation memory. 

• As for the role of the backup battery, its battery life and setup of memory 
area, please refer to 21.1 Memory Backup. 
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4.3 Add-on cassette Installation 

4.3.1 Precautions for Installing Add-on cassettes 

• Use the supplied screws to fix the add-on cassette on the control unit. 

• The screw tightening torque is 0.3 - 0.5 N ⋅ m, please fasten it securely. 

 Recommended screws 
Type Input Number 

Self-tapping screw Material: SW coil (+) P fasten 2.6-16  
Zinc plated, trivalent chromate (black) 2/1 cassette 

 
• Make sure to turn off the power to install. Installing with the control unit is 

powered ON will cause failure. 

• Do not touch the back of the add-on cassette and connector. Otherwise, IC 
may be damaged due to static electricity. 

4.3.2 Communications Cassette Installation 

The communication cassette can be installed on the control unit or function cassette. 

 Mounted on the control unit 
• Connect the connector on the back of the communication cassette and the connector of the 

control unit cassette installation part, fix the communication cassette with screws at the 
bottom left and upper right. 

• If the flange is retained, there shouldn't be any problem. AFPX-COM5 does not have flange. 

     

Secured at 2 positions

Ribs
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 Mounted on the function cassette 
• Connect the connector on the back of the function cassette and the connector of the control 

unit cassette installation part, fix the function cassette with screws at the bottom left and 
upper right. 

Communication cassete

Function cassette

   

Function card Communication card

Remove the
outer cover Fixed at 2 positions

Deep groove processing

 

4.3.3 Function Cassette Installation 

The communication cassette can be installed on the control unit. 

 Mounted on the control unit 
• Connect the connector on the back of the function cassette and the connector of the control 

unit cassette installation part, fix the function cassette with screws at the bottom left and 
upper right. 

      

Secured at 2 positions
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4.4 Connecting FP-X Expansion Unit 

4.4.1 Setup of Terminal Setting Switches 

• Set all terminal setting DIP switches of the expansion unit to ON.  
Set all terminal setting DIP switches of the expansion unit to OFF. 
 

ON

1 2 3 4

FP-X
Expansion unit
terminal
Setup DIP switch

 

4.4.2 Confirmation of FP-X Expansion Cables 

• FP-X expansion units and FP-X expansion FP0 adapters are connected to the control unit 
via a dedicated expansion cable. 

• FP-X expansion units and FP-X expansion FP0 adapters come with an 8 cm type expansion 
cable (AFPX-EC08). 

• When setting the unit on the upper and lower part, a long expansion cable must be used, 
please order 30 cm type (AFPX-EC30) or 80 cm type (AFPX-EC80) separately. 

 
• Please limit the total length of the expansion cable to less than 160 cm 

when using. 

• Please try to keep the expansion cable (AFPX-EC30, EC80) away from 
interfering devices and wires. 
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4.4.3 Connecting FP-X expansion unit 

Please connect FP-X expansion unit in accordance with the following procedure. 

 Installation steps 

PROCEDURE  
1. Remove the control unit, the expansion unit expansion cover. 
2. Install an expansion connector cable on the control unit expansion 

connector portion and expansion I/O unit expansion connector portion (left). 

 
3. Units should be close together to ensure that the expansion cable is 

housed between the units. 

 
4. Install expansion cover. 
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4.5 Connecting FP0 Expansion Unit 

4.5.1 Connecting FP0 Expansion Unit 

• FP0 expansion units (expansion unit, high function unit) shall expand on the right side of FP-
X expansion FP0 adapters. 

• When the unit is expanded, use the FP0 right connector for expansion and the expansion 
hook on the side of the unit. 

 Installation steps 

PROCEDURE  
1. Please use a screwdriver to move the expansion hook. 
2. Install after the lug bosses on the expanded unit side are aligned. 

Please make the connector tightly fitted to eliminate the gap between the units. 

 
3. Please lift the expansion hook according to step 1 to fix the unit. 
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4.5.2 Connecting FP-X Expansion FP0 Adapter 

Please connect FP-X expansion unit in accordance with the following procedure. 

 Installation steps 

PROCEDURE  
1. Remove the control unit, the expansion unit expansion cover. 
2.  Install an expansion connector cable on the control unit expansion 

connector portion and FP-X expansion FP0 adapter expansion connector 
portion (left). 

 
3. Units should be close together to ensure that the expansion cable is 

housed between the units. 

 
4. Install expansion cover. 

KEY POINTS
 

• The expansion FP0 adapter has no terminal setting switch, but the terminal 
is set inside it. Set the terminal setting switch of other expansion units to 
OFF. 
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4.6 Installation 

4.6.1 Installation and Removal for DIN Rail 

 Installation steps 

PROCEDURE  
1. Pull out all DIN rail mounting stems on the back of the unit from underside. 
2. Embed the upper part of the unit installing part into the DIN rail. 
3. Embed the lower part of the unit installing part into the DIN rail while 

pushing the unit installing part into the DIN rail. 
4. Push up the DIN rail mounting stem on the back of the unit and lock until 

you hear a "click" sound. 

 

 Removal steps 

PROCEDURE  
1. Pull out all DIN rail mounting stems on the back of the unit from underside. 
2. Pull the lower side of the unit toward you. 
3. Remove it from the DIN rail while lifting the unit. 
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4.6.2 Mounting with Screws 

Please use M4 screws for mounting. 

REFERENCE  
For installation dimensions, refer to "26.9.2 Installation Dimensions". 
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5.1 Terminal Arrangement 

5.1.1 Power Supply and General-purpose I/O Parts 

NC+ - COMCOMCOMCOMCOM COM COMCOM
GND X0 X3 X4X1 X2 X5 X6 X7

NC NC NC +++++ + ++

NC NC Y0 Y3 Y4Y1 Y2 Y5 Y6 Y7

NC

1 2 3

4 5  
 

No. Name Description 

① AC power supply terminal 
(input)  

② Unused No connection is allowed. 

③ Input terminal All COM terminals of the input side are connected internally.  

④ Unused No connection is allowed. 

⑤ Output terminal All (+) terminals of the input side are connected internally. 
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5.2 Wiring of Power Supply 

5.2.1 General Precautions 

 Power supply selection 
• Please use a power supply with less interference whenever possible. 
• Although overlap in the power line interference has sufficient interference tolerance, but we 

still recommend using the insulated transformer / insulated power supply for further 
interference attenuation. 

 Isolation of power supply systems 
Please separate wires for the unit, input and output device, and power equipment. 

Insulation converter

PLC

Input / output
device

Power
equipment

Circuit breaker

Insulated DC power supply  

 Power sequence 
• Take the power sequence into consideration and cut off the PLC power supply before the 

power supply for input and output is shut off. 
• If the input and output power is shut off before cutting off the PLC power supply, the control 

unit may sometimes detect the change of the input value and cause an unexpected 
sequence of actions. 

5.2.2 Grounding 

• To obtain adequate anti-interference performance, please make sure the power supply is 
grounded. 

• Grounding location shall be as close as possible to the PLC to shorten the length of the 
grounding wire. 

• When used in common with other devices, it can sometimes lead to an opposite effect, so 
dedicated grounding must be used. 

PLC PLC

CORRECT INCORRECT

Interter and
other equipment

Grounding at the grounding
resistance of 100Ω or lower

Interter and
other equipment
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5.2.3 Power Supply of Control Unit / Expansion Unit 

 Power wiring (FP-XH M8N16PD control unit) 
Unit Wiring Diagram 

DC 
power 
source 
type 

Power supply terminal (supply voltage at 24V DC)

Circuit breaker

Ground terminal

Insulated DC power supply

Grounding at the
grounding resistance of
100 Ω or lower

Twist wires of at least 2 mm2

(AWG14) into a harness

Separated from power
equipment and input /
output devices.

 

 Supply voltage 
Please confirm that the voltage of the power supply to be connected is within the allowed 
range. 

Model Rated input 
voltage 

Allowable voltage 
range 

Rated 
frequency 

Allowable 
frequency 

range 
DC Power 
Supply Type 24 VDC 21.6 – 26.4 VDC ― ― 

 Power supply cables 
• To reduce the voltage drop, use a wire that is at least 2 mm2 (AWG14). 

• To reduce the influence of interference, the power cable shall be stranded (strand 
processing). 

 Applicable wires 
Applicable wires Tightening torque 

AWG22-14 (0.3 mm2-2.0 mm2) 0.5 - 0.6 N m 

 Applicable crimp terminals 
M3 terminal screws are used for the terminals. Please use the following crimp terminals to 
connect terminals. 

Fork type terminal Ring type terminal 

3.2mm or more

6mm
or less

 3.2mm or more

6mm
or less

 

 Applicable crimp terminals 
Shape Model Applicable wires 

Round 2-MS3 
1.04-2.63 mm2 

Fork type 2-N3A 
(Note) Use a wire that is at least 2 mm2. 
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• If the voltage or frequency of the power supply exceeds the allowable range, 

or a wire outside the specified range is used, the power unit of the PLC may 
fail. 
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5.2.4 Power Supply of FP-X Expansion FP0 Adapter / FP0 Expansion Unit 

 Power wiring (FP-X expansion FP0 adapter / FP0 expansion unit) 
Unit Wiring Diagram 

FP-X 
FP0 expansion 
adapter 
FP0 expansion unit 
FP0 high function unit 

Power cable
（AFP0581）

Green: functional
earth wire

Blue ：0V

Brown：24 V DC

Power cable

 

 About power supply selection 
• To prevent against the abnormal voltage from the power line, use a insulated power with 

built-in protection circuit (reinforced insulation or double insulation wire). 

• The built-in regulator of the unit uses a non-insulated type. 

• In order to simultaneously start the power supply, the power of the expansion FP0 adapter 
shall be supplied by a service power supply for FP-XH control unit input. 

 Supply voltage 
• Please confirm that the voltage of the power supply to be connected is within the allowed 

range. 

Rated input 
voltage 

Allowable 
voltage range 

24 VDC 20.4 - 28.8 VDC 

 Power supply cables 
• Use the supplied power cable (model: AFP0581) to connect the power supply.  

Brown: 24 VDC Blue: 0 V Green: functional earth wire 

• To reduce the influence of interference, the power cable shall be stranded (strand 
processing). 
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 Power sequence 
• In order to effectively and easily achieve the expansion FP0 adapter power sequence, the 

power of the expansion FP0 adapter shall be supplied by a service power supply for FP-XH 
M8N control unit input. 

• Power on the FP0 expansion unit before turning on the FP-XH M8N system power. 

• Note the power sequence, the power of the FP-XH M8N system and the FP0 expansion unit 
shall be turned off before the input and output power is switched off. If the input and output 
power is shut off first, the control unit may sometimes detect the change of the input value 
and cause an unexpected sequence of actions. 

Operation Power sequence 
ON FP0 power → FP-XH M8N power, expansion FP0 adapter → input and output power 
OFF FP-XH M8N power, expansion FP0 adapter → FP0 power → input and output power 

 Grounding of the FP-X expansion FP0 adapter and FP0 expansion unit 
• The functional grounding wire (green) of the included cable shall be grounded. Depending 

on the different service environments, sometimes there will be problems if grounded. 

• The power line of the FP-X expansion FP0 adapter connects to the functional grounding 
through a varistor. The varistor may be shorted when there is an abnormal potential between 
the power line and the ground. 

Extended FP0 adapter power circuit

Functional grounding

0 V

24 V DC

Varistor（82 V）
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5.3 Wiring of Input and Output 

5.3.1 Precautions Regarding Input and Output Wirings 

 Wiring location 
The input wire, output wire and power line shall be separated from each other, try to keep 
their distance when wiring. Do not put them in the same conduit or tie them up. The input 
wire, output wire, power line and high-voltage line shall be separated by at least 100 mm. 

 Wire selection 
When wiring the input line and output line, select the wire diameter according to the current 
capacity. 

 Power supply 
Switch off the PLC power supply before wiring. The control units, expansion units and all 
cassettes shall be connected with the power supply switched off. If you make the connection 
with the power supply switched on, a failure or malfunction may occur. 
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5.3.2 Input Wiring 

 Connection with photoelectric sensors and proximity sensors 
Relay Output Type 

Input powerSensor power supply

Sensor
Relays

＋

PLC
Input terminal
COM terminal

Internal
circuit

 

NPN Open Collector Output Type 

Input terminal

COM terminal

Sensor

＋

Sensor output
Vcc＋

0 V

PLC

Input power

Internal
circuit

 

Voltage Output Type 

Input terminal

COM terminal

Input power

Sensor

＋

Sensor output
Vcc

0 V

＋

PLC

Internal
circuit

 

Two-Wire Output Type 

Sensor output Input terminal

COM terminal

Input power

Sensor

＋

PLC

Internal
circuit
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 Precautions when using a reed switch with LED 
If the LED is connected in series to the input contacts (such as a reed switch with LED, etc.), 
apply a voltage greater than the ON voltage to the input terminal of the PLC. Please pay 
special attention when several switches are connected in series. 

Reed switch with LED
Input terminal

COM terminal
＋

ON voltage
or more

PLC

Input power

LED
contact

 

 Precautions when using a two-wire sensor 
When using a two-wire photoelectric sensor or proximity sensor, if cutting off the input current 
flowing to PLC is not possible due to the leakage current, connect the bleeder resistor as 
shown in the left chart. 

Input terminal

COM terminal
＋

Bleeder resistor R PLC
Two-wire

sensor

Internal
circuit

 

 Precautions when using a limit switch with LED 
When using a limit switch with LED, if cutting off the input current flowing to PLC is not 
possible due to the leakage current, connect the bleeder resistor as shown in the left chart. 

Input terminal

COM terminal

Input power
＋

Bleeder resistor R
r

PLC
Limit
switch
with LED

Internal
circuit
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5.3.3 Output Wiring 

 Protection circuit of the inductive load 
For inductive load, please install a protection circuit parallel with the load. When the DC 
inductive load is switched on/off, the protection circuit has a great positive influence on the 
service life, particularly for the relay output type.  Therefore, make sure the diode is connected 
at both ends of the load. 

For AC load 

Output
terminal Load

Surge suppressor

COM
terminal

R C

Example of surge suppressor Resistance at 50Ω
Capacity 0.47 μF

PLC

Output
terminal Load

Non-linear resistor

COM
terminal

PLC

 

For DC load 

Output
terminal Load

Diode

COM
terminal

Diode Higher than 3 times the rated load voltage
Greater than the load current

Reverse voltage
Average rectified current

PLC

 

 Precautions on using capacitive loads 
When connecting a load with a large impact current, please set up the protection circuit as the 
following figure to minimize its impact. 

Output
terminal Load

Resistor

COM
terminal

PLC

 

Output
terminal Load

Inductance

COM
terminal

PLC

 

 



Wiring of Power Supply and General-purpose I/O Parts 

5-12 

5.4 Wiring of Terminal Block 

5.4.1 Suitable Wires 

 Suitable wires 

Applicable wires Tightening 
torque 

AWG22-14 (0.3 mm2-2.0 mm2) 0.5 - 0.6 N ⋅ m 

 Supplied terminal block 
• M3 terminal screws are used for the terminals. Please use the following crimp terminals to 

connect terminals. 

• When using round terminals, remove the terminal block cover before operating. 
Fork type terminal Ring type terminal 

3.2mm or more

6mm
or less

 3.2mm or more

6mm
or less

 

 

5.4.2 Terminal Block Cover 

• When using round terminals, remove the terminal block cover before operating. 

 

 
• To prevent electric shock, make sure to install the terminal block outer 

cover as is after wiring. 
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5.4.3 Installation and Removal of Terminal Block 

The terminal block is screw-fixed and can be installed and removed. 

 Removal of the terminal block 
Loosen the 2 mounting screws to remove the terminal block. The screws are fixed on the 
terminal block, they cannot be removed. 

 

 Installation of the terminal block 
• Tighten the screws when the terminal block is lifted up. After tightening the screws, the 

terminal box is fixed. 

• Please set tightening torque to 0.25 - 0.35N ⋅ m. 
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5.5 Safety Measures 

5.5.1 Safety Measures 

 Precautions regarding system design 
In certain applications, malfunction may occur for the following reasons: 

• Power on timing differences between the PLC system and input/output or mechanical power 
apparatus. 

• Response time lag when a momentary power drop occurs. 

• Abnormality in the PLC unit, external power supply, or other devices. 

In order to prevent a malfunction resulting in system shutdown choose the adequate safety 
measures listed in the following: 

 Interlock circuit 
When a motor clockwise/counter-clockwise operation is controlled, provide an interlock circuit 
externally. 

 Emergency stop circuit 
Provide an emergency stop circuit to the PLC externally to turn off the power supply of the 
output device. 

 Start up sequence 
The PLC should be operated after all of the outside devices are energized. To keep this 
sequence, the following measures are recommended: 

• Turn on the PLC with the mode selector set to the PROG. mode, and then switch to the RUN 
mode. 

• Program the PLC so as to disregard the inputs and outputs until the outside devices are 
energized. 

Note) In case of stopping the operation of the PLC also, have the input/output devices turned 
off after the PLC has stopped operating. 

 Grounding 
When installing the PLC next to devices that generate high voltages from switching, such as 
inverters, do not ground them together. Use an exclusive ground for each device which should 
be grounded at a grounding resistance of 100Ω or less. 

 Electric shock prevention  
The terminal block cover must be used for preventing electric shock. 
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5.5.2 Momentary Power Failures 

 Operation of momentary power failures 
• - If the duration of the power failure is less than 10 ms, the FP-XH M8N control unit continues 

to operate. If the power is off for 10 ms or longer, operation changes depending on the 
combination of units, the power supply voltage, and other factors. (In some cases, operation 
may be the same as that for a power supply reset.) 

• - Although the duration of the power failure for the expansion FP0 adapter is 10 ms, judge 
the permissible time for the system after confirming the permissible duration of the power 
failure for the DC power supply that supplies power to the expansion FP0 adapter. (Supply 
the power to it from the service power supply for the input of the FP-XH M8N control unit.) 

• - When using the expansion unit with a built-in power supply (E30, expansion FP0 adapter), 
depending on the duration of the momentary power failure, either one unit may be without 
electricity momentarily and the I/O verify error may occur. In that case, turn off the power 
supply and then turn on again. 

5.5.3 Watchdog Timer 

• The watchdog timer detects abnormal program or hardware. 

• When using the FP-XH M8N control unit, it is set to 640 ms. 

• The ERR.LED at the front of the controller unit lights up after the watchdog timer is operated. 
At this time, the output of all output units turned to OFF and brought to a standstill. 
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 Wiring of Motion I/O Parts 
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6.1 Terminal Layout Diagram 
The motion I/O part has two interfaces. 

1

2

 
No. Name Description 

① Network (RTEX) connector 
RJ45 connector x 2 
Perform the loop connection via the servo amplifier and RTEX 
network. 

② Pulse input connector Input of four channels are available. Encoders and pulsars can be 
connected. 
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6.2 Settings on Servo Amplifier 

6.2.1 Checking Rotary Switches 

• When using the FP-XH M8N Control Unit in combination with the servo amplifier A6N/A5N, 
the node address of the RTEXT network is set with the rotary switches on the front side of 
the servo amplifier. 

• The numbers (01-08) set with the switches correspond to the axis numbers (1-8) controlled 
by the FP-XH M8N Control Unit. 

 

 Switch setting 

Setting 
value 

Front panel 
Function Tens place of 

the left switch 
One place of  
the right switch 

0-31 0-3 0-9 Set numbers in decimal. Range: 01-08 

KEY POINTS
 

• The node address of the RTEX network is determined by the setting of the 
rotary switches regardless of the connection order. 

• In the following cases, errors occur. 
Error code State 
2020 The same unit number exists in the same network. 
2030 A unit number is set to 0. 

2030 A unit number larger than the maximum axis number of the unit used was 
specified. 

2010 An amplifier exceeding the usable maximum number of axes is connected  

• For the setting state of the rotary switches, the values when the power turns 
on are valid.  For changing the setting, restart the power supply. 
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6.2.2 Connection of Limit Input and Near Home Input 

For the system which uses the over limit switches and near home switch, connect them to the 
I/O connector of Servo Amplifier A6N/A5N. 

Near home
switch

Over limit
switch

Over limit
switch

 

 I/O connector (X4): Allocation of functions at the factory setting 
X4 connector Function at the factory setting 

Application on the FP-XH M8N 
Control Unit side Name Pin 

no. Signal name Code Logic 

SI1 5 General-purpose 
monitor input 5 SI-MON5 A contact  

SI2 7 CW over-travel inhibit 
input POT B contact It is used as limit +. 

SI3 8 CCW over-travel 
inhibit input NOT B contact It is used as limit -. 

SI4 9 General-purpose 
monitor input 1 SI-MON1 A contact  

SI5 10 Near home input HOME A contact It is used as a near home input. 

SI6 11 External lutch input 2 EXT2 A contact  

SI7 12 External lutch input 3 EXT3 A contact  

SI8 13 General-purpose 
monitor input 4 SI-MON4 A contact  

(Note 1): The above table shows the allocation before shipment. It varies according to the setting of PANATERM. 

KEY POINTS
 

• When using the FP-XH M8N Control Unit in combination with the servo 
amplifier A6N/A5N, the over-travel inhibit inputs (POT, NOT) are used as 
limit inputs. For using them as limit inputs, it is necessary to set the limit 
switch to "Valid" in the "Axis parameter setting" menu  of Configurator PM7. 
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6.2.3 Combination of Parameters and Home Return Methods 

When using either "DOG method 2" or "Limit method 2" for the home return method, change 
the parameters on the AMP side to the pattern B described as below.  If the operation is 
executed with the pattern A setting (factory default setting), the latch input allocation error 
protection (error code 0821H:3-38) will occur. 

 Home return method and AMP parameter setting (A: Available, Blank: Not available) 
FP-XH M8N 

Home return 
method 

Reference home position 
A6N/A5N parameters 

Pattern A Pattern B 

DOG method 1 Home (Z phase) A A 

DOG method 2 Near home (DOG)  A 

DOG method 3 Home (Z phase) A A 

Limit method 1 Home (Z phase) A A 
Limit method 2 Limit - (NOT) / Limit + (POT)  A 

Z phase method Home (Z phase) A A 
Stop-on-contact 
method 1 

Mechanical stop mechanism such as a 
stopper A A 

Stop-on-contact 
method 2 Home (Z phase) A A 

Data set method - A A 

 Pattern A (Factory default setting) 

Parameter 
no. 

X4 connector 
Parameter 

value (HEX) Pin assign setting Revised 
items Terminal 

name 
Terminal 

no. 
Pr 4.00 SI1 5 00323232H SI-MON5 A contact  
Pr 4.01 SI2 7 00818181H POT B contact A 
Pr 4.02 SI3 8 00828282H NOT B contact A 
Pr 4.03 SI4 9 002E2E2EH SI-MON1 A contact  
Pr 4.04 SI5 10 00222222H HOME A contact  
Pr 4.05 SI6 11 00212121H EXT2 A contact A 
Pr 4.06 SI7 12 002B2B2BH EXT3 A contact A 
Pr 4.07 SI8 13 00313131H SI-MON4 A contact  

 Pattern B (After change)） 

Parameter 
no. 

X4 connector 
Parameter 

value (HEX) Pin assign setting Revised 
items Terminal 

name 
Terminal 

no. 
Pr 4.00 SI1 5 00323232H SI-MON5 A contact  
Pr 4.01 SI2 7 00000000H Invalid  A 
Pr 4.02 SI3 8 00000000H Invalid  A 
Pr 4.03 SI4 9 002E2E2EH SI-MON1 A contact  
Pr 4.04 SI5 10 00222222H HOME A contact  
Pr 4.05 SI6 11 00010101H POT A contact A 
Pr 4.06 SI7 12 00020202H NOT A contact A 
Pr 4.07 SI8 13 00313131H SI-MON4 A contact  
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6.2.4 Connection of General-purpose Monitor Input 

• When using the FP-XH M8N Control Unit in combination with the servo amplifier 
A6N/A5N,up to two general-purpose monitor inputs can be used. The general-purpose 
monitor input is connected to the servo amplifier I/O connector (X4). 

• The general-purpose monitor inputs (SI-MON1 and SI-MON2) connected to the servo 
amplifier can be read in the input area WX125 of the FP-XH M8N Control Unit. 

• For using the general-purpose monitor input, it is necessary to allocate the input signal 
function to them by the parameter of the servo amplifier. By defualt, the general-purpose 
monitor input (SI-MON1) is allocated to SI4 (pin no. 9) of the I/O connector. Refer to “p.6-4”. 

6.2.5 Connection of RTEX Operation Output  

• When using the FP-XH M8N Control Unit in combination with the servo amplifier 
A6N/A5N,up to two RTEX operation outputs can be used. The RTEX operation output is 
connected to the servo amplifier I/O connector (X4). 

• The RTEX opration outputs (EX-OUT1 and EX-OUT2) connected to the servo amplifier can 
be controlled in the output area WY125 of the FP-XH M8N Control Unit. 

• For controling the genera-purpose output connected to the servo amplifier, it is necessary to 
allocate the output signal function by the parameter of the servo amplifier. By default, the 
RTEX operation output 1 (EX-OUT1) is allocated to SO2 (pin no. 25/no.26) of the I/O 
connector. 

 I/O connector (X4): Allocation of functions at the factory setting 
X4 connector Function at the factory setting 

Name Pin 
no. Signal name Code 

SO1 
1 
2 

External brake 
release signal BRK-OFF 

SO2 
25 
26 

RTEX operation 
output 1 EX-OUT1 

SO3 
3 
4 

Alarm output ALM 

(Note 1): The above table shows the allocation before shipment. It varies according to the setting of PANATERM. 
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6.3 Connection of Network 

6.3.1 Wiring Method 

FP-XH
M8N

X2A X2A X2A
A6N
A5N

RX RXRX

X2B X2B X2B
TX TXTX

 

• The cable connected to "TX" of the FP-XH M8N Control Unit is connected to the connector 
"X2A connector (RX)" of the servo amplifier. Connect X2B (TX) and then X2A (RX) to the 
amplifier in this order. 

• Perform the loop connection so that the cable returns to "RX" of the FP-XH M8N Control Unit 
from "X2B (TX)" of the terminal AMP. 

• The distance between each node should be within 100 m and the total length should be 
within 200 m. 

6.3.2 Precautions on Wiring 

• Always use shielded twisted pair (STP) cables that are compatible with category 5e or higher. 

• Turn off the power supply of the system before wiring cables. 

• To prevent the cable from coming off, securely connect the connector of the cable to the 
network connector (RJ45 connector) of the unit. 

• A hub for Ethernet cannot be used. 

REFERENCE  
• For the details of the cable specifications and precautions, refe rto the 

documetn "RTEX Cable" available on the web page.  
https://industry.panasonic.com/global/en/products/fasys/plc/  
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6.4 Pulse Input Connection 

6.4.1 Linear Driver Type 

Connection Control unit side

Pulse input    A (+)

Pulse input    A (–)

Pulse input    B (+)

Pulse input    B (–)

Encoder and pulse
generator side

Phase A

Phase B

A1/A3/A5/A7

B1/B3/B5/B7

A2/A4/A6/A8

B2/B4/B6/B8

360
360

360
360

 

6.4.2 Transistor Open-collector Type 

Power supply

+5V DC GND

Phase A

Phase B

Encoder and pulse
generator sideConnection Control unit side

Pulse input    A (+)

Pulse input    A (–)

Pulse input    B (+)

Pulse input    B (–)

A1/A3/A5/A7

B1/B3/B5/B7

A2/A4/A6/A8

B2/B4/B6/B8

360
360

360
360

 

6.4.3 Transistor Resistor Pulling Up Type 

Power supply

+5V DC GND

Phase A

Phase B

Encoder and pulse
generator side

Connection Control unit side

Pulse input    A (+)

Pulse input    A (–)

Pulse input    B (+)

Pulse input    B (–)

A1/A3/A5/A7

B1/B3/B5/B7

A2/A4/A6/A8

B2/B4/B6/B8

360
360

360
360
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KEY POINTS
 

• Pulsar input operation and high-speed counter use the same pulse input 
terminal, so any of the above may be selected.  

• It is recommended to connect them with a twisted-pair cable. 

• When counting 2-phase input of coder, etc., to avoid wrong counting, 
please set the pulse input counting frequency multiplication to X4 or X2 via 
the control codes. 

Note: please use pulse input A and pulse input B signals within the following 
specifications.  

 When pulse input A and pulse input B are used in 2-phase 
It is 2-phase input when used as pulsar input. 

T

X1 X2 X3 X4
Pulse input A

Pulse input B

T 1μs
X1 ~ X4 0.2μs
Max. 1MHz per phase

 

 When pulse input A and pulse input B are used as direction detection input 
T

X1
Pulse input A

Pulse input B

T 1μs
X1 0.2μs
Max. 1 MHz for
pulse input A

 

 When pulse input A and pulse input B are used as individual input 
T

TX1
Pulse input A

Pulse input B

T   1μs
X1   0.4μs
Max. 1MHz per input
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6.4.4 Precautions on Wiring 

• It is recommended to use a twisted-pair cable for pulse input connection. 

• Please control the following wiring lengths within the range shown in the table. 

 Wiring Length 
Input / Output signal Wiring 

Length 
Pulse input within 30 m 

6.4.5 Specifications of Scattered Cable Connectors 

Connectors used for scattered cable connector need not to be peeled off the insulation layer.  
Connect them with special tools. 

 

 Applicable wires (stranded wire) 

Specification Nominal cross-section area Insulation layer 
O.D. Rated current 

AWG#22 0.3 mm2 

φ1.5-φ1.1 3 A 
AWG#24 0.2 mm2 

 Scattered cable connector (unit accessories) 
Manufacturer Parts composition Quantity 

The company 
Enclosures (40P) 1PC / 2 sets 
Half-open enclosures (40P) 2PC2 / 2 sets 
Contact head (AW22, 24) 5-pin 8PC2 / 2 sets 

(Note): For separate order, please specify AFP2801 (2 sets). 

 Special tools 
Manufacturer Product no. 

The company AXY52000FP 
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6.4.6 Usage of Scattered Cable Connector 

The insulation layer can be crimped to save wiring time. 

Steps 
1. Remove the contact piece from the carrier and crimp it into the tool. 

 
2. Insert the wire with the insulation layer directly into the contact piece, slightly grip the tool 

for crimping. 

 
3. Insert the wire into the terminal box after the crimping. 

 

4. Close the cover after insertion of the wire. 

       

KEY POINTS
 

• Contact pull pin can be used for correction in case of wrong wiring.  
Wrong wiring or wrong crimping of wire can be corrected with the attached 
contact pull pin. 
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7.1 Before Turning On the Power 
System configuration example 

1

32

4

5

RX

TX

RXTX

AMP

Power supply

Power supply

Power supply for I/O

Over limit
switch

Over limit
switch

 
 

 Confirmation matters before the power supply is turned on 
No. Item Confirmation Contents 

① Confirm connection of each 
device Check and ensure that each device has been designed and connected. 

② Confirm the servo amplifier Check the wiring of servo amplifier and parameter settings. 

③ Confirm the installation of 
the safety circuit 

Check the connection between the servo amplifier and over limit 
switches. Check the installation condition of the over limit switches. 

④ 
Confirm the sequence 
setting of turning on the 
power supply 

Please verify whether the steps for turning on the power supply are set 
according to the requirements of the "Steps for Turning on the Power 
Supply". 

⑤ 

Setting of configuration data Check if the parameters and positioning data are configured in the FP-
XH M8N Control Unit as designed. 

Confirmation of mode 
switch of the control unit. 

Set the control unit as PROG. mode. Setting as RUN mode may lead to 
neglectful actions. 

Confirm user programs 
Create programs to turn off the start request of each operation when 
switching the mode to RUN mode. If they are on, they may activate 
improperly. 
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7.2 Procedure for Turning On the Power 

7.2.1 Procedure for Turning On the Power  

To turn on the power supply of the unit system to be used, consider the performance and 
status of the external device connected to fully avoid the occurrence of unexpected actions. 

PROCEDURE  
1. Turn on the power supplies for input and output devices connected to the 

PLC. 
2. Turn on the power supply for the servo amplifier. 
3. Turn on the power supply of the PLC. 

7.2.2 Procedure for Turning Off the Power  

PROCEDURE  
1. Check and make sure the rotation of the motor has stopped, and then turn 

off the power supply for the PLC. 
2. Turn off the power supply for the servo amplifier. 
3. Turn off the power supply of input and output devices connected to the PLC. 
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7.3 Check with Power Turned On  

7.3.1 Check items after turning power on  

On System configuration example  
It can be generally divided into four stages for confirmation. 

21 3

4

RX

TX

RXTX

AMP

Near home
switch

Over limit
switch

Over limit
switch

 

 Confirmation matters before the power supply is turned on 
No. Item Confirmation Contents 

① Check the communication 
state 

Check if the communication between FP-XH M8N Control Unit and 
Servo Amplifier is performed properly. 

② Check the safety circuit 
based on the PLC unit 

Check the connection between the servo amplifier and over limit 
switches. Check the installation condition of the over limit switches. 
Check if the over limit switch is loaded as the limit input of FP-XH M8N 
Control Unit and activated properly by performing JOG operation. 

③ Check the near home input 

Check the connection between the servo amplifier and near home 
input. Check the installation condition of the near home input. Check if 
the near home input is loaded as the near home input of FP-XH M8N 
Control Unit and activated properly by performing JOG operation or 
home return operation. 

④ 
Confirm the rotation, 
movement direction and 
distance 

Confirm the rotation, movement direction and distance through the JOG 
operation and position control operation. 
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7.3.2 Checking the network communication state 

Step 1 
Turn on the powers of the servo amplifier and FP-XH M8N Control Unit in this order. 

Step 2 
Check if the operation status display LEDs on the FP-XH M8N Control Unit is in the following 
state. 

STATUS: On   LINK: On 

Points to check 
If the STATUS LED is blinking, the network is not established. 

If the LINK LED is off, the connection between the “RX” (receiver) and the “TX” of the AMP 
(sender) is not electrically correct. 
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7.3.3 Checking the safety circuit based on a unit 

Step 1 
Check if the input of the over limit switches connected to the servo amplifier is loaded to the 
unit by operating them forcibly. 

Check point 
Check if the limit setting is valid, input logic is correct in the parameter setting menu of 
Configurator PM7. 

Step 2 
Check if the limit stop is activated at the time of limit input by the tool operation function of 
Configurator PM7 or performing the JOG operation with a program. 

Step 3 
Using the JOG operation, check to see if the over limit switch is functioning properly. 

 Limit Input Operation 
Conditions Direction Limit Status Operation 

When JOG operation is 
executed 

Forward 
rotation 

Limit input (+): ON Not executable, Error occurs. 
Limit input (-): ON Executable 

Reverse 
rotation 

Limit input (+): ON Executable 

Limit input (-): ON Not executable, Error occurs. 

During JOG operation 

Forward 
rotation Limit input (+): ON Deceleration stop, Error occurs. 

Reverse 
rotation Limit input (-): ON Deceleration stop, Error occurs. 



7.3 Check with Power Turned On 

 
7-7 

7.3.4 Checking the operation of near home switch 

Step 1 
Confirm that it has been normally imported as the input signal on the PLC side for forced 
operation of the near origin input. 

Step 2 
Start the home return by the tool operation function of PM7 or inputting the home return 
program, and check if the operation transits to the deceleration operation by the near home 
input. 

Check point 
The logic of near home input depends on the settings of Servo Amplifier and FP-XH M8N 
Control Unit. 

Step 3 
Repeat the JOG operation and the home return operation to confirm that the mobile station 
exactly stop at the origin without offset. 

Step 4 
If the mobile station doesn't exactly stop at the origin, change the position of the near origin 
input or reduce the home return speed to make it accurately stop at the origin. 

7.3.5 Checking the rotation, movement direction and distance 

Step 1 
Check whether the rotation and movement direction is correct through the JOG operation or 
automatic acceleration and deceleration operation. 

Check point 
The rotation direction depends on the installation of ball screws and the "CW/CCW Direction 
Setting" of parameters. 

Step 2 
Perform the JOG operation or position control operation and confirm whether the movement 
distance is consistent with the design. 

Check point 
The movement distance depends on the pitch of ball screws, reduction gear ratio and the set 
movement amount of the position control data. 
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8.1 Before Turning on the Power 

8.1.1 Check Items 

After wiring, check the following items before turning on the power. 

 Check Items 
 Item Description 

1 Unit mounting 
 The name of each unit matches the device list as designed. 
 Mounting screws on the unit are securely tightened. No looseness. 

2 Wiring 
 The terminal screws are securely tightened. No looseness. 
 Wiring and signal names of the terminals are consistent. 
 Wire specifications fully fit the current size. 

3 Cable connection  Cables are securely connected. 

4 Mode setting  The mode toggle switch is set to "PROG." mode. 

5 Others  Please carefully confirm the possibility of accidents. 
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8.1.2 Steps Before Running 

For configuration after wiring, the steps before running are as follows. 

1. Power ON 
(1) Before turning on the power, please check."7 Power On/Off and" and "8.1.1 Check 
Items". 

(2) After switching on the power of the control unit, please confirm that the control unit's 
PROG. LED (green) is lit. 

 
2. Create the program 
(1) Use the tool software to create a program. 

(2) Use the "Totally Check Project" of the tool software to check for syntax errors. 

 
3. Confirm the output wiring 
Use the mandatory input / output function etc. to check the output wiring. 

 
4. Confirm the input wiring 
Check the input wiring through the input display LED or the monitoring function of the tool 
software. 

 
5. Test run 
(1) Set the mode toggle switch to "RUN" mode, confirm that the "RUN" LED is lit. 

(2) Confirm the serial actions. 

 
6. Commissioning 
(1) When there is an abnormal action, use the monitoring function of the tool software to 
confirm the program's abnormality. 

(2) Modify the program. 

 
7. Save the program 
Save the program created. 
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8.2 Offline Editing of the Program 

8.2.1 Program Elements 

Create the following items as program data according to the following steps. 

 Program composition 
Type Description 
Program Any program 

Comments Maximum 1MB 
I/O comments, description, comments between the lines 

System register Set the allocation for hold area using the operation memory, the operation mode during 
an abnormality, communications, high-speed counter when using pulse output function. 

Position control 
parameter 
Position control 
data table 
data 

Set via the Configurator PM7. Save the position control parameters and position control 
data table information to be set as partial program files. You can export or import it via the 
Configurator PM7, and save only the position control related data as other file. 

8.2.2 Settings of the System Register 

Follow these steps to set the system register. Explain it as below assuming that the FPWIN 
GR7 has been started. 

PROCEDURE  
1. In the menu bar, select "Option"→"System Register Setting". 

The "PLC Configuration" dialog box is displayed. 
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2. Select any item to set. 
3. Click the [OK] button. 

The contents have been set are saved as part of the program. 

 Type of system registers 
Type Description 
Memory allocation Set when changing program capacity. 

Hold / non-hold 
Set when changing hold area of internal relays, data registers and other operation 
memories. To ensure these settings are effect, you must install the memory backup 
battery (sold separately). 

Action on error 
Select the operating mode used when an operation error occurs. In addition, the 
abnormality warning function shall be set as active when installing memory backup 
battery. 

Time setting Set the timeout time when using the communication function and the time for 
constant scanning. 

Link W0 setting Allocate the station number and the link area when using the inter-PLC link 
function. 

Controller input setting 
(HSC) 

Allocate the input and output signal and channel when using HSC (High Speed
Counter). 

Interruption / pulse catch 
setting Specify the inputs allocated when using interrupt input or pulse catch input. When 

the input is interrupted, an effective pulse edge can be selected. 
Interrupt edge setting 
Time constant setting of 
CPU input Assign a input for time constant filter when the input is set as active. 

COM port setting 
Set the station number and communication speed, transmission format and other 
communication parameters via the COM port when using the communication 
function. 

 

KEY POINTS
 

• Set the system register when using functions and changing the hold area 
from default state. There is no need to set when the appropriate function is 
not in use. 

8.2.3 Setting of Position Control Parameters 

Position control parameters are set via the Configurator PM7. Start the Configurator PM7 from 
the "Options" menu of FPWIN GR7. 

REFERENCE  
• For setting of position control parameters, please refer to "Chapter 9 

Setting of Position Control Parameters". 

• For details on the system register, refer to "26.5 Table of System Registers". 
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8.3 Program Download and Run 

8.3.1 Before Turning on the Power 

Before turning on the power, verify the mode toggle switch of the control unit. According to the 
different states when the power is on, the behavior will change as following. 

1

 

① Mode toggle switch ② USB port 

 Difference between mode behaviors 
Type Description 

When the 
power is turned 
on in PROG. 
mode 

 When the power is turned on, show as the state of data saved in the control unit and 
computer (program, comments, system register data, data register). 
 Through the operation of the tool software, it can change to status: computer → download 
to the control unit, or control unit → upload to your computer. 
 If the program and other required data are not written in the control unit, turn on the power 
via PROG. mode. 

When the 
power is turned 
on in the RUN 
mode 

 When the power is turned on, transmit the datum saved in the control unit's internal 
memory (F-ROM) to the control unit memory, then start running. 
 When the program and other required data have been saved, turn on the power via RUN 
mode when running. 

 

 Mode switch based on the tool software 
• If it is online after the power is on, the operation mode can be switched by the tool software. 

However, when the power is turned on again after the power is turned off, run in the the 
mode selected by the mode toggle switch. 

 Connection of the computer and control unit 
• The USB port of the control unit is connected to the computer. Use USB 2.0 cable (A: mini 

B) when connecting 
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8.3.2 Program Downloading and Mode Switching 

• Programs created by the tool software can be downloaded to the control unit. 

• The downloaded program are saved to the program memory (F-ROM). It can be saved even 
in case of power outage. 

System register

Position control parameter

Comments

Program

PLC

Program memory （F-ROM）

Operational
 memory F-ROM data area

---------

RAM
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 Download steps 
Use the following steps to download the program data. Explain it as below assuming that the 
FPWIN GR7 has been started. 

PROCEDURE  
1. Select "Online" → "Switch to Online Mode" from the menu bar. 
2. Select "Online"→"Download to PLC" (Entire Project) from the menu bar. 

The confirmation dialog box is displayed. 

 
4. Click the [Yes] button. 

Perform the download. In addition, the information dialog box for confirming 
whether to switch the mode displays. 

 
5. Click [Yes] or [No] button. 

Click "Yes" to switch to RUN mode. Click "No" to switch to monitoring mode. 

KEY POINTS
 

• When you switch to RUN mode, switch it after confirming that there will be 
no danger even the PLC is in motion. 

• When you switch to RUN mode, the ERR LED lights up after an error occurs, 
and then return to PROG. mode.  Please refer to "20.2 What to Do If an Error 
Occurs". 
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 When "MEWNET device open circuit error" appears 
Follow these steps to clear the error status. 

PROCEDURE  
1. Verify that the power of the control unit is switched on. 
2. Verify that the computer and the control unit are connected via a USB cable. 
3. Select "Online" → "Communication Settings" from the menu bar. 

The "Communication Settings" dialog is displayed. 

 
4. Confirm the port number and click [OK] button. 

Make sure the computer and the control unit can communicate. 
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KEY POINTS
 

• Port No. can be confirmed through the computer's device manager. 
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8.3.3 Overall Program Check 

• Use the Overall Check Function of the tool software to check for syntax errors. 

• You can check for dual use of the coil and match instruction (MC and MCE, JP and LBL, 
SUB and RET, etc.) defects. 

PROCEDURE  
1. Select "Online" → "Switch to Online Mode" from the menu bar. 
2. Select "Debug" → "Totally Check Project" from the menu bar. 

The Totally Check Project dialog box is displayed. 

3. Click the [Execute] button. 
The check result is displayed. When there is an error, click the "Jump" button to 
jump to the appropriate location. 

 
 

8.3.4 Program Verify 

To confirm that the program being edited on the computer is the same as that on the control 
unit, check it when necessary. Explain it as below assuming that the FPWIN GR7 has been 
started. 

PROCEDURE  
1. Select "Online" → "Switch to Online Mode" from the menu bar. 
2. Select "Debug" → "Verify Project" from the menu bar. 

The Verify Project dialog box is displayed. 
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3. Select the object to be checked and click the [OK] button. 
The "Select Item to Check" dialog box is displayed. 

 
4. Select the item and click the [Execute] Button. 

The check result is displayed. Inconsistent items will be shown in peach. Then 
double-click this item to show details. 

 

 

 Check result 
Check contents Example in case of inconsistency 

System register Shows inconsistent error when the Settings of the system register are not consistent. 

Position control data 
table 

Shown as inconsistent error when the position control parameters and position control 
data table are different. 

PB1 Displays inconsistent program block numbers. 

KEY POINTS
 

• When switching from offline to online, if the program and system register 
are inconsistent, the message box showing the content is displayed. 
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8.4 Online Editing 

8.4.1 Online Editing  Summary 

In the FP-XH M8N control unit, even if the computer and the PLC are connected online, it can 
also be edited using the following conditions. 

 Online Editing 

Type 
Mode 

Emphasis 
PROG RUN 

Program A A 

 For pixel input mode, up to 512 steps can be rewritten. 
 To ensure the compatibility of the program, rewriting in RUN mode 
is conditional. 
 You can download the program and all comments even in RUN 
mode. 

Comments A A  You can modify the program and comments even in RUN mode. 

System register A N/A 
 Rewriting is only possible in PROG. mode. To rewrite in RUN 
mode, it will show a confirmation message box to switch to PROG. 
mode. 

Position control 
data A N/A 

 Rewriting is only possible in PROG. mode. To rewrite in RUN 
mode, it will show a confirmation message box to switch to PROG. 
mode. 

(Note 1): In case of online editing, although the entered comments show, you can not save them to the memory of the 
control unit. 

8.4.2 Online Editing of the Program 

WARNING
 

When changing the program during operation, make sure it is 
safe before changing. 

 Online Editing of the Program 
You can execute online editing of the program in PROG. mode or RUN mode. 

REFERENCE  
• For details and restrictions on rewriting during RUN, refer to FP-X User‘s 

Manual (No.ARCT1F409E). 
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 Block rewrite steps 
You can change the program in PROG. mode or RUN mode. The following is a description of 
the contents being edited online by FPWIN GR7. 

PROCEDURE  
1. After changing any program, press <Ctrl> button + <F1> button to perform 

PB conversion. 
The confirmation dialog box is displayed. 

 
2. Click the [Yes] button. 

The confirmation dialog box for comment change is displayed. 

 
3. Click the [Yes] button. 

At the end of the normal conversion, the information is displayed in the status bar. 

KEY POINTS
 

• The line comment is connected with the Boolean address of the program 
and managed within the PLC. When changing the program online, download 
the program to match the position of the line comment.  
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8.4.3 Online Editing of the System Register 

Changing the system register is only possible in PROG. mode. The following is a description 
of the contents being edited online by FPWIN GR7. 

PROCEDURE  
1. In the menu bar, select "Option"→"System Register Settings". 

The "PLC Configuration" dialog box is displayed. 

 
2. Change any system register and click [OK] button. 

The confirmation dialog box is displayed. 

   
3. Click the [Yes] button. 

The information indicating system register writing is completed shows in the PLC. 

KEY POINTS
 

• Please change the system register No.0 in PROG. mode. 
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8.5 Program block 

8.5.1 Program block summary 

In FPWIN GR7, programs can be divided into several program blocks (PB) for edition. 

 Restrictions for program blocks (FP-XH)  
Item Description 
Max. number of PBs up to 256 
Program step number of each 
PB No limit 

 Execution sequence of PBs 
• The PBs are executed as a program after being combined. 

• Please describe only 1 ED instruction at the end of the main program. Programs before the 
ED instruction will be executed circularly. 

• Please set the secondary programs (interruption programs, subprograms) after the ED 
instruction. "Match not established error" and "instruction position error" will be displayed in 
case of incorrect sequence. 

 

ⓐ Program block ⓑ Program after PBs are 
connected 
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8.5.2 Change Sequence of PBs 

The execution sequence of PBs can be altered freely after compiling the PBs. Explain it as 
below assuming that the 3 PBs has been compiled. 

PROCEDURE  
1. Double-click "Change execution order" from the project tree. 

 
 

The "Change PB Execution Order" dialog box is displayed. 

 
2. Select the PB for which the execution sequence is to be changed, click the 

[Up] or [Down] button. 
3. Click the [Yes] button. 

The name of the PB is displayed on the project tree according to the changed 
execution. 
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9.1 Axis Allocation for Use 

9.1.1 Settings in Configurator PM7  

Assign all channels to be used and their usage via the FPWIN GR7. The following steps are 
performed with the Configurator PM7 that has been started as a premise. 

PROCEDURE  
1. Select "Options"→"Positioning Table Settings" from the menu bar. Or 

double-click the "Positioning table" from the project tree. 
The "Configurator PM7" configuration menu is started. 

 
2. Select "Axis Settings"→"Change Axis" from the menu bar. 

The dialog box of for setting of the axis to be used appears. 

 
3. When using the virtual axes for the synchronous control, select from the 

drop-down list. 
When selecting V-Axis 1, "Axis 8" changes to "V-Axis 1". When selecting V-Axis 1 
through V-Axis 2, "Axis 7" changes to "V-Axis 1", and "Axis 8" changes to "V-Axis 
2". 

4. Select the axis to be used and click [OK]. 
The dialog box for setting interpolation operation group appears. 
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5. For performing the interpolation control, drag the icon of each axis to be 
allocated for interpolation to the interpolation group field. 
The figure below shows the cases when axis 1 and axis 2 are assigned to the 
interpolation operation group. 

 
6. Click the [OK] button. 

The confirmation message is displayed. 

 
7. Confirm the change and click [Yes]. 

Create the data table tab respectively according to the set group. 

 

KEY POINTS
 

• After setting the interpolation group, settings for the movements of the X-
axis, Y-axis or Z-axis and the interpolation operations will be added to the 
data table and displayed on the tab as group [A] and [B]. 

• Virtual axes and slave axes under synchronized control cannot be set to the 
interpolation operation groups. 
The master axis of the synchronous control can be set as the interpolation 
group. 

• When changing the setting of "use of virtual axes", restart the power supply 
after writing to the PLC. The set information will be reflected. 

• Press × to close during the edition to cancel and exit. 
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9.2 Parameter settings 

9.2.1 Parameter Settings in Configurator PM7 

The parameters common to various controls such as command unit, origin input, logic of limit 
input and stop time, and the parameters relating to home return and JOG operation are 
assigned by Configurator PM7. The following steps are performed with the Configurator PM7 
that has been started as a premise. 

PROCEDURE  
1. Select "Axis Settings"→"Parameter Settings" from the menu bar. 

The dialog box of "Parameter Settings" appears. 

 
2. Set the necessary parameters according to the purpose and press [OK]. 

After displaying the message "Updating data display", the screen returns to the 
base screen of Configurator PM7. 

3. Select "File"→"Apply Settings" from the menu bar. 
The parameters set in Configurator PM7 are applied as the project data being 
edited. 

KEY POINTS
 

• Closing the window with the X mark during editing the "Parameter settings" 
dialog cancels and stops the operation. 

• To save parameters as a file, select "File" > "Save Setting". 
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9.2.2 Parameter setting items 

Parameter Name Description Related 
Page 

Unit setting 
Specify the unit of each axis. Select from the following items. 
P:pulse,  M:um [Min 0.1],  M:um [Min 1],  I:inch [Min 0.00001],  I:inch 
[Min 0.0001],  D:degree [Min 0.1],  D:degree [Min 1] 

7.3 Check 
with Power 
Turned On 

Number of pulses per 
revolution Pulses per rotation of the motor (Default: 1) pulse 

Movement per revolution Movement per rotation of the motor (note 1) 

Pulse output rotatin 
direction 

CW+ : set to CW in the ＋direction of elapsed value 

CCW+ : set to CCW in the ＋direction of elapsed value 

Limit switch 
Set whether to enable or disable the limit switch. Select from the 
following items. 
A: Enabled, N: Disabled 

Limit switch connection 
Set the connections of the + direction limit switch and - direction limit 
switch. Select from the following items. 
S: Standard, R: Reverse connection 

Soft ware limit 
(Positioning control) Set whether to enable or disable the software limit in positioning 

control. Select from the following items. 
A: Enabled, N: Disabled 
 17.2 Software 

Limit 

Soft ware limit (Home 
return) 
Soft ware limit (JOG 
operation) 
Software limit upper limit 
value 

When starting the data in which the current position exceeds this value 
in operation, an error occurs. For performing infinite rotation, set the 
both software limits to 0. 
Setting range:  -2,147,482,624-2,147,482,624 

 Software limit upper limit 
value 

Auxiliary output mode 

Set the timing when auxiliary output contact turns ON and the output 
timing of auxiliary output code. In With mode, auxiliary output is 
reflected in operation. In Delay mode, auxiliary output is reflected 
when the table moves by the amount of the delay ratio (%) to the total 
movement amount. Select from the following items. 
N: Not use, W: With mode, D: Delay mode 

17.3 Auxiliary 
Output Auxiliary output on time 

(ms) 
Set the time period that auxiliary output contact is ON. 
Setting range: 0-255 (Default: 10) ms 

Auxiliary output delay 
ratio (%) 

Set the delay reatio (ratio of current movement amount to the total 
movement amount) for using Delay mode. Auxiliary output is reflected 
when the movement amount passes over the delay ratio after starting 
positioning operation. 
Setting range: 0-100 (Default: 0) % 

Completion width (pulse) Specify the width of the completion of command operation. 
Setting range: 0-2,147,482,624 (Default: 10) pulse 

17.11 
Operation 
Done Signal 

(Note 1): Only set when units are set to µm, inch or degree. . 

KEY POINTS
 

• In the control unit, as the direction of movement, the direction for increase of 
elapsed value is set to CW, and the direction for decrease of elapsed value is 
set to CCW. Therefore, limit input is limit ＋ in the CW direction and limit－in the 
CCW direction. 
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Parameter Name Description Related 
Page 

Monitor error - Torque 
judgment 

This is the setting to announce errors or warnings by setting 
judgement values for the torque command values of motors 
controlled by AMP of each axis. Select from the following items. 
N: Disabled, E: Enabled (Error), W: Enabled (Warning) 

17.10 
Monitor 
Error 
(Torque / 
Actual 
Speed 
Judgement) 

Monitor error - Torque 
judgment value (%) 

This judgement value is not set in AMP, and used only for monitoring 
monitor values. 
Setting range: 0.0-500.0 (Default: 500) % 

Monitor error - Judge 
the actual speed 

This is the setting to announce errors or warnings by setting 
judgement values for the actual speed of motors controlled by AMP 
of each axis. Select from the following items. 
N: Disabled, E: Enabled (Error), W: Enabled (Warning) 

Monitor error - Acutal 
speed judgemnet value 
(rpm) 

This judgement value is not set in AMP, and used only for monitoring 
monitor values. 
Setting range: 0-5000 (Default: 5000) rpm 

Home return - Return 
setting code 

Set the pattern of home return. Select from the following items. 
0: DOG method 1 (based on front-end + Z phase), 1: DOG method 2 
(based on front-end), 2: DOG method 3 (based on back-end + Z 
phase), 3: Limit method 1 (limit signal + Z phase), 4: Limit method 2 
(limit signal), 5: Z-phase method 1, 7: Stop-on-contact 2 (stop-on-
contact + Z phase), 8: Data set method 

14.1 Type of 
Home 
Return 

Home return - Stop-on-
contact torque value 
(%) 

Set the torque value for using the stop-on-contact method for home 
return. It is regarded as a criterion for judging the home return once 
the torque value of the AMP exceeded this set value by the stop-on-
contact. 
Setting range: 0-5000 (Default: 100) % 

Home return - Stop-on-
contact judgment time 
(ms) 

Set the judgement time for using the stop-on-contact method for 
home return. The position when this set time elapses after the AMP 
torque value exceeds the stop-on-contact torque is regarded as a 
decision criterion for the home return by the stop-on-contact method. 
Setting range: 0-10000 (Default: 100) ms 

Home return - Return 
direction 

Set the operation direction of home return. The limit (-) direction 
means the decreasing direction of elapsed values. The limit (+) 
direction means the increasing direction of elapsed values. Select 
from the following items. 
0: Limit (-) direction, 1: Limit (+) direction 

Home return - Return 
acceleration time (ms) 

Set the acceleration time or return time when performing the home 
return. At the beginning of the home return, accelerates for the 
specified acceleration time, decelerates for the specified deceleration 
time after the proximity input and changes to the creep speed. 
Setting range: 0-10000 (Default: 100) ms 

Home return - Return 
deceleration time (ms) 

Home return - Return 
traget speed 

Set the target speed when performing the home return. When there 
is no proximity input after starting the home return, accelerates to the 
target speed. 
Setting range: 1-2,147,482,624 

Home return - Return 
creep speed 

Set the speed to search the home position after the proximity input. 
Setting range: 1-2,147,482,624 

Home return - Home 
coordinates 

The coordinate specified for the coordinate origin is registered as the 
origin after the completion of the home return. 
Setting range: -2,147,482,624-2,147,482,624 (Default: 0) 
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Page 

JOG operation - 
Acceleration/deceleration 
method 

Set the acceleration/deceleration method when performing the JOG 
operation. Select from the following items. 
0: Linear acceleration/deceleration, 1: S-shaped 
acceleration/deceleration 

13.1 Setting 
and 
Operation of 
JOG 
Operation 

JOG operation - JOG 
acceleration time (ms) 

Set the acceleration time or deceleration time when performing the 
JOG operation. At the beginning of the JOG operation, accelerates 
for the specified acceleration time, decelerates for specified 
deceleration time when the starting contact (I/O) of the JOG 
operation turns off, and stops. 
Setting range: 0-10000 (Default: 100) ms 

JOG operation - JOG 
deceleration time (ms) 

JOG operation - JOG 
target speed 

Set the target speed for performing the JOG operation. After starting 
the JOG operation, accelerates to the target speed by a specified 
acceleration operation while the starting contact (I/O) of the JOG 
operation is on. After reaching the target speed, the operation is 
performed at the target speed. 
Setting range: 1-2,147,482,624 

Emergency stop 
deceleration time (ms) 

When the emergency stop is requested by I/O, the deceleration 
operation is complete in this deceleration time. 
Setting range: 0-10000 (Default: 100) ms 16.1 Types 

and 
Settings of 
Stop 
Function 

Limit stop deceleration 
time (ms) 

The deceleration operation is complete in this deceleration time at 
the time of limit input. 
Setting range: 0-10000 (Default: 100) ms 

Error stop deceleration 
time (ms) 

When an error occurs, the deceleration operation is complete in this 
deceleration time. 
Setting range: 0-10000 (Default: 100) ms 

J point - Operation 
setting code 

Set the acceleration/deceleration method when performing the J 
point control. Select from the following items. 
0: Linear acceleration/deceleration, 1: S-shaped 
acceleration/deceleration 

11.1.5 
Setting and 
Operation of 
J-point 
Control 

J-point - Acceleration 
time (ms) Set the acceleration time when performing the J point control. 

Setting range: 0-10000 (Default: 100) ms J-point - Deceleration 
time (ms) 

J-point - Target speed 

Set the target speed when performing the J point control. After 
starting the J point control, it reaches the target speed in the 
acceleration time. 
Setting range: 1-2,147,482,624 (Default: 1000) 

Pulsar operation setting 
code 

Select from the channels whose pulse input application is set to 
"Pulsar". Select from the following items. 
0: Pulsar input CH1, 1: Pulsar input CH2, 2: Pulsar input CH3, 3: 
Pulsar input CH4 

15.2 Setting 
and 
Operation of 
Pulsar 

Pulsar input method 
Set the pulsar input method. Select from the following items. 
0: Standard operation, 1: Speed restriction (pulse hold), 2: Speed 
restriction (time hold) 

Pulsar operation ratio 
numerator 

Set the pulsar operation ratio numerator by multiplying the input 
pulse train from the pulsar by (the pulsar operation ratio numerator) / 
(the pulsar operation ratio denominator) to obtain the number of 
AMP movement pulses. 
Setting range: 1-32767 (Default: 1) 

Pulsar operation ratio 
denominator 

Pulsar operation 
maximum speed 

Set the pulsar operation maximum speed. 
Setting range: 0-2,147,482,624 (Default: 0) 
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9.3 Synchronous Parameter / Cam Pattern Settings 

9.3.1 Synchronization parameter settings  

Parameters required for synchronous control are set via the Configurator PM7. The following 
steps are performed with the Configurator PM7 that has been started as a premise. 

PROCEDURE  
1. Select "Axis Setting"→"Synchronization Parameter Setting" from the menu 

bar. 
The dialog box of "Synchronization Parameter Settings" appears. 

 
2. Set the necessary parameters according to the purpose and press [OK]. 
3. Select "File" > "Apply Setting" from the menu bar. 

The parameters set in Configurator PM7 are applied as the project data being 
edited. 

KEY POINTS
 

• In the case of synchronous control, basic parameters related to I/O operate 
according to "9.2 Parameter settings". 

• Closing the window with the X mark during editing the "Synchronous 
parameter settings" dialog cancels and stops the operation. 

• To save parameters as a file, select "File" > "Save Setting". 
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9.3.2 Cam Pattern Settings 

Use the Configurator PM7 to allocate the electronic cam setting. The following steps are 
performed with the Configurator PM7 that has been started as a premise. 

PROCEDURE  
1. Select "Axis Setting"→"Cam pattern Setting" from the menu bar. 

The dialog box for cam pattern settings appears. 

 
2. Set the necessary parameters according to the purpose and press [OK]. 
3. Select "File"→"Apply Setting" from the menu bar. 

The parameters set in Configurator PM7 are applied as the project data being 
edited. 

REFERENCE  
For setting of synchronous control parameters, please refer to "Chapter 12 Automatic 
Operation (Synchronous Control)". 

KEY POINTS
 

• The saved parameters can be read on the Configurator PM7. 

• During synchronous control, basic input and output parameters will also 
operate according to "9.2 Parameter settings". 
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9.4 Creating Positioning Data Table 

9.4.1 Structure of the position control data table 

The Position Control Data table are assigned via the Configurator PM7. The following steps 
are performed with the Configurator PM7 that has been started as a premise. 

 Initial display of the Configurator PM7 
• The form is assigned by each axis to set data tables. 

 

 Setting items 
Parameter 
Name 

Description 

Operation pattern 

Select any one of the following operation patterns. 
E-Point: trapezoid control of 1 data table 
C-Point: continuous trapezoid control  E-point is specified at the end of C-point control. 
P-Point: continuous speed change control. E-point is specified at the end of P-point control. 
J-point: speed change) E-point is specified at the end of J-point control. 

Control method Select any one of the increment and the absolute values. 
X-axis movement 
amount 

Enter the movement of the X-axis. The movement unit system is specified via parameter 
setting. 

Acceleration/ 
deceleration 
method 

Select the acceleration/deceleration method. 

Acceleration time 
(ms) Set the acceleration time. Set the unit to ms. 

Deceleration time 
(ms) Set the deceleration time. Set the unit to ms. 

Target speed Set the target speed. Set the units to pps, µm/s, inch/s and rev/s. 

Dwell time (ms) 
Set the time from the completion of the positioning instruction in the E-point control until the 
operation done flag turns ON. The dwell time is the waiting time between data tables in the 
C-point control. In P-point control, the dwell time is ignored. 

Auxiliary output  Set the auxiliary output code. When auxiliary output is enabled in parameter settings, the 
auxiliary output code set here will be outputted.   

Comments Any comment can be inputted in the data tables. 
(Note 1): Details of parameter settings are displayed in the navigation bar. 
(Note 2): When the interpolation control is selected, items like interpolation, Y-axis and Z-axis movements, X-axis 

auxiliary point, Y-axis auxiliary point, Z-axis auxiliary point and interpolation speed will also display. 
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9.4.2 Select type of position control data setting area 

The position control data setting areas are classified into the 600-point standard area and the 
89-point extension area with the features shown in the following table. Please use this 
function according to the applications. 

 Comparison between the standard area and the extension area 
Item Standard area Extension area 
Position control data table 
number 600 Data tables 89 Data tables 

Data table No. 1-600 10001-10089 
Position control 
parameters 
 are set via the 
Configurator PM7 (note 
1) 

Optional Optional 

Position control data 
 are set via the 
Configurator PM7 (note 
2) 

Optional 
The set data will be downloaded to the 
control unit along with programs and 
other file data. The position control data 
will be calculated to make the 
operations available to start when the 
power is turned on or the control unit 
enters the RUN mode. 

Unavailable 

Position control data 
 are set by user program 
(Note 2) 

Optional 
Send the data to the area of positioning 
memory via user program to send 
request for recalculation and make the 
operations available to start. 

Optional 
Send the data to the area of positioning 
memory via user program to make the 
operations available to start. 
Recalculation request is not required. 

Characteristics 

Compared with using the extension 
area, starting by presetting the position 
control data via the Configurator PM7 is 
faster. 

Compared with using the standard 
area, starting by setting the position 
control data via user program is faster. 

Usage 
Applications where position control data 
like movement and target speed are 
preset. 

Applications where position control data 
change with the results of PLC 
operation. 

(Note 1): Position control parameters mean JOG operation and home return conditions, limit input logic, deceleration 
time upon stop, etc. 

(Note 2): Position control parameters mean movement, target speed, acceleration/deceleration time, running mode 
and other individual position control operation information. 

 Reconstruction calculation of standard area 
After altering the position control data area with user program, reconstruction calculation 
(recalculation) is required. If no recalculation is conducted after altering the position control 
data tables with program, the position control data tables with operate as before the altering. 
The recalculation should follow the steps below. 

1. Change the position control data table on the positioning memory 

2. Set the recalculation signal (Y1107) of the I/O area to ON 

3. Confirm the recalculation signal (X1107) of the I/O area and start any operation 
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9.4.3 Data table No. and position control startup 

• The data table No. of the Configurator PM7 is specified via the F386 PSET instruction in the 
user program. 

• After specifying the axis No. and data table No. with the F386 PSET instruction, when the 
corresponding position control starting point of is ON, execute control according to the 
settings in the data table. 

X1100
Start enabled 
condition

X1104

Tool 
operation

X1230

Axis 1 
error

R10

R2

Position 
control start

F386 PSET K1 Specify axis no. 
and table no.

R2

Position 
control start

R10

Start enable 
flag

X1130

Axis 1 
BUSY

Y1140

Start enable 
flag

Axis 1 
positioning 
start

Positioning start

K0
Axis no. Table no.

（ ）DF

（ ）DF

R0

Servo ON

Servo ON

R1

Servo OFF

Y1130

Axis 1 servo 
OFF request

Servo OFF

Axis 1 servo 
ON request

（ ）DF

（ ）DF

Y1120

X1180

Axis 1 
connection 
confirmation

X1120

Axis 1 
servo lock

Link 
establishment 
annunciation
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9.4.4 Running Mode and Data table 

• Multiple data tables are used when the position control method is P-point control (speed 
change control), C-point control (continuance point control) or J-point control (JOG position 
control). 

• When executing such controls, the data tables will be continuously created in the 
Configurator PM7, and select "E-point Control" for the operation pattern for the final data 
table. 

• Specify the starting data table No. of each control in the program. 

Eg.) During P-point control (speed change control) 
Create 3 position control data tables and select "E: End Point" for the final data table. In 
addition, start the initial data table No. from the user program. 

Speed
f [pps]

E point
table

P point
table

P point
table Time

t [ms]

P point control

 

 

REFERENCE  
For control details, please refer to "Chapter 11 Automatic Operation (Position 
Control)". 
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9.5 Saving and Managing Files 

9.5.1 File Type 

The set parameters and positioning table information can be saved or exported in the 
following three formats. 

File name Extension Application 
Operation of 
Configurator 
PM7 

FPWIN GR7 project 
file .fpx 

Save parameters set by the Configurator PM7 
together with programs and system registers as part 
of project data. 

Apply Settings 

Configurator PM7 
file .pm7r 

Save parameters set by Configurator PM7 as files. 
The saved data can also be reused in multiple units 
and projects. 

Save Setting 
Read Setting 

CSV file .csv Export parameters set by Configurator PM7 in csv 
format. They can be used for checking parameters. Export to CSV 

9.5.2 Saving Parameters as Part of Project File 

Parameters set by Configurator PM7 can be saved as part of project data. The following 
procedure is explained on the condition that the Configurator PM7 has already started. 

PROCEDURE  
1. Select "File" > "Apply Setting" from the menu bar. 

A confirmation message box is displayed. 

2. Press the [Yes] button. 
Parameters are saved as part of the project data being edited on the FPWIN GR7. 

3. Select "File" > "Exit" from the menu bar. 
It returns to the base screen of FPWIN GR7. 

4. Select "Project" > "Save As" from the FPWIN GR7 menu bar. 
The "Save As" dialog box is displayed. 

5. Enter a saving destination and file name, and press [Save] button. 
The parameters are saved as a FPWIN GR7 project file (extension (.fpx)). 
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9.5.3 Saving Parameters as Parameter File 

Parameters set by Configurator PM7 can be saved as a file. The following procedure is 
explained on the condition that the Configurator PM7 has already started. 

PROCEDURE  
1. Select "File" > "Save Settings" from the menu bar. 

The "Save As" dialog box is displayed. 

2. Enter the save path and file name, and press [Save]. 
Parameter information and position control data table information are saved as 
files with an extension (.pm7r). 

KEY POINTS
 

• The files saved by the above operations contain the information on all 
parameters and positioning tables set on the Configurator PM7. The 
information can be read by selecting "File" > "Read Setting" of the 
Configurator PM7 menu. 
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9.5.4 Exporting Parameters to CSV Files 

The information on set parameters and positioning tables can be exported in csv format. It is 
possible to open the csv files and check the settings of each parameter and positioning table. 

PROCEDURE  
1. Select "File" > "Export to CSV" from the menu bar. 

The "Export to CSV" dialog box is displayed. 

 
2. Enter a file name, and press the [OK] button. 

CSV files with given file names are saved for each parameter. 



 

 

10 
 Transfer to Unit and 

Commissioning 



Transfer to Unit and 
Commissioning 

10-2 

10.1 Check on Settings 

10.1.1 Data Check of Parameters 

The following procedure is explained on the condition that the Configurator PM7 has already 
started.  

PROCEDURE  
1. Select "Debug" →"Check Parameters and Data Values" from the menu bar. 

A message box will be displayed to show the check result. If there is an error in 
the settings for the positioning data tables, an error message will appear and the 
cursor will move to the corresponding error position.  
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10.1.2 Comparison of Parameter information 

It is possible to compare information on parameters being edited with information saved in the 
Configurator PM7. The following procedure is explained on the condition that the Configurator 
PM7 has already started.  

PROCEDURE  
1. Select "Debug" → "Verify"→"File" or "PLC" from the menu bar. 

After selecting the file, the "Select a file to verify" dialog box appears. After 
selecting PLC, the parameters being edited and configuration information saved 
in the PLC can be compared in Configurator PM7, and then the results are 
displayed. 

2. Select the file from the "Select a file to verify" dialog box and click the [OK] 
button. 
Compare the parameters being edited and configuration information saved in the 
PLC in Configurator PM7, and then display the results. 
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10.2 Transfer of parameters 

10.2.1 Download by FPWN GR7 

• Information on parameters that have been set is transferred as part of project information to 
the control unit along with programs and system registers. The following steps are performed 
with the Configurator PM7 that has been started as a premise. 

PROCEDURE  
1. Select "File"→"Exit" from the Configurator PM7 menu bar. 
2. "Setting data will be applied. Are you sure you want to proceed?" After a 

message appears, click [Yes (Y)]. 
The parameters set on the Configurator PM7 are applied to the project being 
edited, and the screen returns to the base screen of the FPWIN GR7. 

3. Select "Online"→"Download to PLC" (Entire Project) from the menu bar. 
A confirmation message dialog box is displayed. 

 
4. Press the [Yes] button. 

Downloading the project is executed. A message dialog box to confirm whether to 
switch the mode or not is displayed. 

5. Press the [Yes] or [No] button. 
Press [Yes] to change to the RUN mode. [Press [No] to continue the PROG. 
mode. When changing the RUN mode, the configuration information is valid in the 
unit, and the test run using I/O signals or the Configurator PM7 can be performed. 

6. Select "Options"→"Positioning Table Settings" from the menu bar. 
Configurator PM7 is started. Select [Online]→[Data Monitor], [Status Display], 
[Tool Operation] to enter the status available to execute different menus of the 
unit. 
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10.2.2 Download by Configurator PM7 

In the case of FP-XH M8N Control Unit, parameters and information data can be downloaded 
or uploaded on the Configurator PM7. The following procedure is explained on the condition 
that the Configurator PM7 has already started. 

PROCEDURE  
1. Select "File" > "Write PLC" from the menu bar of the Configurator PM7. 

A confirmation message box is displayed. 

 
2. Press the [Yes] button. 

The positioning parameters are downloaded to the control unit. A message dialog 
box to confirm whether to switch the mode or not is displayed. 

3. Press the [Yes] or [No] button. 
Press [Yes] to change to the RUN mode. Press [No] to continue the PROG. mode. 
When changing the RUN mode, the configuration information is valid in the unit, 
and the test run using I/O signals or the Configurator PM7 can be performed. 

4. Select "Options" > Positioning Table Settings" in the menu bar. 
The Configurator PM7 is activated. Select [Online] > [Data monitor] > [Status 
display] > [Tool operation] so that each menu items of the unit will be available. 

KEY POINTS
 

• When the download is performed on the Configurator PM7, the positioning 
parameters saved in the F-ROM of the control unit will also be overwritten. 
Save the projects as files as necessary. 
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10.3 Monitoring on Configurator PM7 

10.3.1 Status Monitor 

The connection state of each axis and input state of external terminals can be monitored. The 
following procedure is explained on the condition that Configurator PM7 has already started. 

PROCEDURE  
1. Select "Online" → "Status Display" from the menu bar. 

The “Status monitor” dialog box is displayed. 
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 Monitoring items 
Item Description Related page 
Model Displays the model name of the FP-XH M8N Control Unit.  

Axis [Group] Indicates the axis numbers. For interpolation axes, the group names are 
also displayed such as [A], [B], [C] and [D].  

Connection 
status 

Displays the state whether the network is established or not, and whether 
the communication between the control unit and servo amplifiers are 
perofmred properly or not. 
"Connected" (green): The communication is performed. 
"Not connected“ (gray): The communication is not performed. 

 

Brand name 

Displyas the servo amplifiers, motors' brand names, AMP model codes 
and motor model codes.  

AMP model 
code 
Motor model 
code 
Status display 

servo free 
Displays the servo-locked/free state. 
"Lock" (green): Indicates that the servo is locked. 
"Free" (gray): Indicates that the servo is free. 

 

Status 

Displays the operation state of each axis. 
"Operating“ (green): The motor is running. 
"Stopped" (gray): The motor stops. 
"------" (gray): No motor is connected. 

 

Completion 
width 

Displays the state whether the deviation counter is in the imposition range 
or not. 
"Within range" (green): It is in the imposition state. 
"Out of range" (gray): It is not in the imposition state. 

 

External input terminal monitor 
Home position 
proximity 

Displays the input state of the near home and limit inputs connected to the 
servo amplifiers. 
"Home position proximity" (green): The near home input is ON (valid). 
"Limit +" (green): The limit + input is ON (valid). 
"Limit -" (green): The limit + input is ON (valid). 
"OFF" (gray): The above inputs are OFF (invalid). 

 Limit + 

Limit - 

Firmware 
version Displays the firmware version and, hardware version of the FP-XH M8N 

Control Unit and motion control part.  
Hardware 
version 

The input logics of the near home, limit + and limit - inputs depend on the settings of servo amplifiers. 
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10.3.2 Data Monitor 

The connection state of each axis and input state of external terminals can be monitored. The 
following procedure is explained on the condition that Configurator PM7 has already started. 

PROCEDURE  
1. Select "Online" → "Data Monitor" from the menu bar. 

The “Data monitor” dialog box is displayed. 
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 Item monitoring 
Item Description Related Page 

Synchronous 
master axis 

When set as the master axis, "Main Station" will be displayed.  
When set as the slave axis, the master axis based on such axis will be 
displayed. E.g.) When axis-2 is set to be a slave following axis-1 as the 
main station, "axis-1" will be displayed in the line of axis-2".   
Axes not used for synchronized control will be displayed as [--------]. 

12.1 
Synchronous 
Control Synchronize 

output 

Displays the synchronous running function set to the slave axis.  
Gear, clutch, cam 
Gear＋Clutch, Gear＋Cam, Clutch＋Cam 
Gear＋Clutch＋Cam 
Axes not used for master axis and synchronized control will be displayed 
as [--------]. 

Synchronous 
state Displays the set status (synchronous/non-synchronous) of each axis. 

Table number 
executing No. of data tables being executed or executed by position control data 

9.4 Creating 
Positioning 
Data Table 

Auxiliary output 
code 

When auxiliary output is enabled, the output codes are outputted within 
the scope of 0-65536. 

17.3 Auxiliary 
Output 

Amp current 
value 

Displays the feedback pulse value of the servo amplifier. It returns to "0" 
on the completion of home return. 

17.4 
Coordinate 
17.5 Current 
Value Update 

Unit conversion 
current value 

Displays the feedback pulse value after the unit conversion of the servo 
amplifier. 
It returns to "0" on the completion of home return. When the home 
coordinate has been set, it will be preset to the home coordinate on the 
completion of home return. 

Torque 
command (%) Monitors the torque command value of the servo amplifier. 17.10 Monitor 

Error (Torque / 
Actual Speed 
Judgement) 

Actual speed 
(rpm) Monitors the actual speed of the servo amplifier. 

Deviation Monitors the deviation between the current position managed in the 
control unit and the AMP current position fed back from the AMP. 

17.12 Position 
Deviation 
Simple Monitor 

Axis state 

Displays the operation state of each axis. 
"Operating" (green): The motor is running. 
"Stopped" (gray): The motor stops. 
"Error" (red): An error occurs. 

 

Error code The latest error code is displayed in case of an error.  
Click [Clear errors] to remove the error. 

19.3 Table of 
Error Codes 

Warning code The latest warning code is displayed in case of a warning.  
Click [Clear warning] to clear the warning. 

19.4 Table of 
Warning Codes 

 
• Click [Clear errors] to clear the error upon recoverable error of the control 

unit. 

• Click [Clear warning] to clear the warning upon warning of the control unit. 



Transfer to Unit and 
Commissioning 

10-10 

10.4 Tool Operation 

10.4.1 Tool Operation Function 

• You can perform commissioning with the Configurator PM7 before actually starting the user 
program. 

• Be sure to save the settings and download the project to the control unit before starting the 
tool operation of the positioning unit. 

• The following procedure is explained on the condition that the Configurator PM7 has already 
started. 

PROCEDURE  
1. Select "Online" → "Tool Operation" from the menu bar. 

The “Tool Operation” dialog box is displayed. 

 

 Types of tool operation 
Item Description 
Servo ON/OFF Controls servo ON/OFF of each axis. 

Home return A home return is performed to the home of the machine coordinates according to the 
specified parameter. 

Positioning Moves from the start table number according to the set contents of the positioning table. 

JOG operation The specified axis can be moved to the specified direction at the specified speed while the 
operation command is on. 

Teaching Controls the axis manually like JOG operation, and reflects the resulting positioning address 
on the data editing screen. 

KEY POINTS
 

• The unit cannot go into the tool operation while the unit is operated with a 
user program. 

• Operation requests with I/O signals will be disabled while the positioning 
unit is in tool operation. 

• If any communication error occurs during the tool operation, the control 
unit will detect the error and stop automatically. 

• If the previous tool operation did not finish properly due to a 
communication error, etc., the tool operation mode will be cancelled 
forcibly when the next tool operation starts.  
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10.4.2 Servo ON/OFF with Tool Operation Function 

The following procedure is explained on the condition that the Configurator PM7 has already 
started. 

PROCEDURE  
1. Select "Online" → "Tool Operation" from the menu bar. 

The “Tool Operation” dialog box is displayed. 

2. Select "Servo ON/OFF" from the "Tool Operation" dialog box. 
The “Servo ON/OFF” dialog box is displayed. 

 
3. Press the [ON/OFF] button of any axis. 

The Servo ON/Servo OFF status is switched. 

 
4. Confirm the Servo ON/OFF of any axis and press the [Close] button. 

It returns to the “Tool Operation” dialog box. 

KEY POINTS
 

• If the servo ON/OFF has been controlled using ladder programs, the servo-
lock or servo-free state before the start of the tool operation is kept and the 
operation shifts to the tool operation. 

• The servo-lock or servo-free state before the completion will be kept even 
after finishing the tool operation mode. 
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10.4.3 JOG Operation with Tool Operation Function  

You can perform commissioning with the Configurator PM7 before actually starting the user 
program. The following procedure is explained on the condition that the Configurator PM7 has 
already started. 

PROCEDURE  
1. Select "Online" → "Tool Operation" from the menu bar. 

The “Tool Operation” dialog box is displayed. 

2. Select "JOG operation" from the Tool Operation dialog box. 
The “Tool operation – Jog operation” is displayed. 

 
3. Press the [+] or [-] button in the field of JOG. 

It executes JOG operation. 

4. Press [Exit] button to terminate the JOG operation. 

KEY POINTS
 

• This dialog box cannot be closed during the operation. 
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 Dialog box items 
Item Description Related Page 

Synchronous 
master axis 

When set as the master axis, "Master" will be displayed.  
When set as the slave axis, the master axis based on such axis will be 
displayed. E.g.) When the axis 2 is set to be a slave following the axis 1 
as the master, "Axis 1" will be displayed in the line of Axis 2".  
Axes not used for synchronized control will be displayed as [--------]. 

12.1 
Synchronous 
Control Synchronized 

output 

Displays the synchronous running function set to the slave axis.  
Gear, clutch, cam 
Gear＋Clutch, Gear＋Cam, Clutch＋Cam 
Gear＋Clutch＋Cam 
Axes not used for master axis and synchronized control will be displayed 
as [--------]. 

Synchronous 
state 

Displays the set status (synchronous/non-synchronous) of each axis. 
Pressing the "Change synchronization" button switches the state between 
Synchronous and Asynchronous. 

Current value 
Monitors the feedback values of various axes after unit conversion. Press 
the [Update Current Value] button to display the value input dialog box, 
which allows change of the current value. 

17.5 Current 
Value Update 

Unit Displays the unit of the position command of each axis set in parameter 
settings.  

JOG target 
speed 

Monitors and displays the target speed of JOG operation. Click the 
[Change] button to change the target speed of JOG operation. 13.1 Setting 

and Operation 
of JOG 
Operation 

JOG [+] Click the [+] button to execute JOG forward running. 

JOG [−] Click the [-] button to execute JOG backward running. 

Axis state 

Displays the operation state of each axis. 
"Operating" (green): The motor is running. 
"Stopped" (gray): The motor stops. 
"Error" (red): An error occurs. 

 

Error code 
The latest error code is displayed in case of an error.  
If a recoverable error occurs in the control, click the [Clear errors] button 
to clear the error. 

19.3 Table of 
Error Codes 

Warning code The latest warning code is displayed in case of a warning.  
Click [Clear warning] to clear the warning. 

19.4 Table of 
Warning Codes 

Speed rate 
It allows setting the target speed of JOG operation of different axes set in 
parameter settings as 100% to specify the speed multiplier operation. 
Click the [Speed Rate] button to display the value input dialog box. 
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10.4.4 Home Return by Tool Operation Function 

• When the power is turned on, the coordinates of the control unit do not coincide with those of 
the machine position. Execute a home return before starting positioning. 

• You can perform commissioning with the Configurator PM7 before actually starting the user 
program.. 

• The following procedure is explained on the condition that the Configurator PM7 has already 
started. 

PROCEDURE  
1. Select "Online" → "Tool Operation" from the menu bar. 

The “Tool Operation” dialog box is displayed. 

2. Select "Home Return" from the Tool Operation dialog box. 
The "Tool operation - Return to home position " dialog box is displayed. 

 
3. Click the [Start] button of the axis to be subject home return. 

It executes home return. 

4. Press [Exit] button to terminate the home return operation. 

KEY POINTS
 

• This dialog box cannot be closed during the operation. 
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 Dialog box items 
Item Description Related Page 

Synchronous 
master axis 

When set as the master axis, "Master" will be displayed.  
When set as the slave axis, the master axis based on such axis will be 
displayed. E.g.) When the axis 2 is set to be a slave following the axis 1 
as the master, "Axis 1" will be displayed in the line of Axis 2".  
Axes not used for synchronized control will be displayed as [--------]. 

12.1 
Synchronous 
Control Synchronized 

output 

Displays the synchronous running function set to the slave axis.  
Gear, clutch, cam 
Gear＋Clutch, Gear＋Cam, Clutch＋Cam 
Gear＋Clutch＋Cam 
Axes not used for master axis and synchronized control will be displayed 
as [--------]. 

Synchronous 
state 

Displays the set status (synchronous/non-synchronous) of each axis.  
Pressing the "Change synchronization" button switches the state between 
Synchronous and Asynchronous. 

Current value 
Displays the current value of the axes after unit conversion. Click [Home 
position coordinate] to display the value input dialog box to change the 
value after home return. 

17.4 
Coordinate 
17.5 Current 
Value Update 

Unit Displays the unit of the position command of each axis set in parameter 
settings.   

Home return 
mode 

Displays the content of the home return setting code registered in the 
positioning setting data. 

14.1 Type of 
Home Return 

Start/stop 

Executes Start/Stop operation of origin 
·Click the [Start] button to execute home return, and the button name is 
changed to [Stop].  
·Press the [Stop] button to execute deceleration stop, and the button 
name is changed to [Stop]. 

 

Axis state 

Displays the operation state of each axis. 
"Operating" (green): The motor is running. 
"Stopped" (gray): The motor stops. 
"Error" (red): An error occurs. 

 

Error code The latest error code is displayed in case of an error. If a recoverable error 
occurs in the control, click the [Clear errors] button to clear the error. 

19.3 Table of 
Error Codes 

Warning code The latest warning code is displayed in case of a warning.  
Click [Clear warning] to clear the warning. 

19.4 Table of 
Warning Codes 

Speed rate 
It allows setting the target speed of home return of different axes set in 
parameter settings as 100% to specify the speed multiplier operation. 
Click the [Speed rate] button to display the value input dialog box. 
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10.4.5 Positioning by Tool Operation Function 

Specifying a starting table number enables to check if positioning from the starting table 
operates properly. 

PROCEDURE  
1. Select "Online" → "Tool Operation" from the menu bar. 

The “Tool Operation” dialog box is displayed. 

2. Select "Positioning" from the "Tool Operation" dialog box. 
The “Tool operation – Positioning” dialog box is displayed. 

 
3. Press the [Change] button under the target start table number field. 

The starting table no. setting dialog box is displayed. 

4. Enter the starting table number. 
5. Press the [Operation] button. 

Positioning starts from the specified start table number. 

6. Press [Exit] button to terminate the positioning operation. 
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 Dialog box items 
Item Description Related Page 

Synchronous 
master axis 

When set as the master axis, "Master" will be displayed.  
When set as the slave axis, the master axis based on such axis will be 
displayed. E.g.) When the axis 2 is set to be a slave following the axis 1 as 
the master, "Axis 1" will be displayed in the line of Axis 2".  
Axes not used for synchronized control will be displayed as [--------]. 

12.1 
Synchronous 
Control Synchronized 

output 

Displays the synchronous running function set to the slave axis.  
Gear, clutch, cam 
Gear＋Clutch, Gear＋Cam, Clutch＋Cam 
Gear＋Clutch＋Cam 
Axes not used for master axis and synchronized control will be displayed 
as [--------]. 

Synchronous 
state 

Displays the set status (synchronous/non-synchronous) of each axis. 
Pressing the "Change synchronization" button switches the state between 
Synchronous and Asynchronous. 

Current value 
Monitors the feedback values of the axes after unit conversion. Click the 
[Current value update] button to display the value input dialog box, which 
allows to update the current value. 

17.5 Current 
Value Update 

Unit Displays the unit of the command of each axis set in parameter settings.  
Table number 
executing Displays the table number during the operation or when it completes. 9.4 Creating 

Positioning 
Data Table Start table 

number 
Start table No. of position control 
Click the [Change] button to change the start table no. . 

Operation/Stop 

Operates/stops operation of position control 
 Click the [Operation] button to execute position control, and the button 
name is changed to [Stop].  
 Press the [Stop] button to execute deceleration stop, and the button 
name is changed to [Operation]. 

 

Axis status 

Displays the operation state of each axis. 
"Operating" (green): The motor is running. 
"Stopped" (gray): The motor stops. 
"Error" (red): An error occurs. 

 

Error code The latest error code is displayed in case of an error. If a recoverable error 
occurs in the control, click the [Clear errors] button to clear the error 

19.3 Table of 
Error Codes 

Warning code The latest warning code is displayed in case of a warning.  
Click [Clear warning] to clear the warning. 

19.4 Table of 
Warning Codes 

Speed rate 
It allows setting the target speed of JOG operation of different axes set in 
parameter settings as 100% to specify the speed multiplier operation. 
Click the [Speed Rate] button to display the value input dialog box. 
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KEY POINTS
 

• For the positioning operation, the setting data should be downloaded to the 
control unit in advance. The operations after the starting table number vary 
depending on operation patterns. 

• The positioning operation of the interpolation group starts and stops the 
axis with the smalles number in the group. In the case of the tool operation 
function, the positioning operation starts by pressing the "Operate" button 
of any axes, however, a warning message is displayed when the "Operate" 
button other than that for the smallest axis number is pressed. 

• This dialog box cannot be closed during the operation. 

• When conditions are changed during the tool operation, the positioning 
memory will be updated temporarily and the operation will be performed, 
however, the changed conditions will not be reflected in the configuration 
data written in the control unit. Therefore, when the mode is changed to the 
RUN mode again, the unit will start based on the configuration data 
downloaded to the control unit. 
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10.4.6 Teaching by Tool Operation Function  

Activate each axis manually by the tool operation, and register the positioning addresses 
where each axis stops as the point data. 

PROCEDURE  
1. Select "Online" → "Tool Operation" from the menu bar. 

The “Tool Operation” dialog box is displayed. 

2. Select "Teaching" from the Tool Operation dialog box. 
The “Tool operation – Teaching” dialog box is displayed. 

 
3. Stop at the positioning point by the JOG operation. 
4. Press the [Teaching] button. 
5. Enter the table number where the desired positioning information is 

registered, and click the [OK] button. 
The current value is registered for the amount of movement of the table number 
specified. Also, if the axis that the teaching operation is performed is an 
interpolation axis, the current value is registered for the movement amount of the 
equivalent coordinate in the interpolation group. 

6. Press [Exit] button to terminate the teaching operation. 
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 Dialog box items 

Item Description Related 
Page 

Synchronous 
master axis 

When set as the master axis, "Master" will be displayed.  
When set as the slave axis, the master axis based on such axis will be 
displayed. E.g.) When the axis 2 is set to be a slave following the axis 1 as 
the master, "Axis 1" will be displayed in the line of Axis 2".  
Axes not used for synchronized control will be displayed as [--------]. 

12.1 
Synchronous 
Control Synchronized 

output 

Displays the synchronous running function set to the slave axis.  
Gear, clutch, cam 
Gear＋Clutch, Gear＋Cam, Clutch＋Cam 
Gear＋Clutch＋Cam 
Axes not used for master axis and synchronized control will be displayed as 
[--------]. 

Synchronous 
state 

Displays the set status (synchronous/non-synchronous) of each axis. 
Pressing the "Change synchronization" button switches the state between 
Synchronous and Asynchronous. 

Current value 
Monitors the feedback values of the axes after unit conversion. Click the 
[Current value update] button to display the value input dialog box, which 
allows to update the current value. 

17.5 Current 
Value Update 

Unit Displays the unit of the command of each axis set in parameter settings.  
JOG target 
speed 

Monitors and displays the target speed of JOG operation.  
Click the [Change] button to change the target speed of JOG operation. 13.1 Setting 

and Operation 
of JOG 
Operation 

JOG [+] Click the [+] button to execute JOG forward running. 

JOG [-] Click the [−] button to execute JOG backward running. 

Table no. Displays the table no. of teaching an press the [Teaching] button to change 
the data table No. of teaching and register the current value.   

9.4 Creating 
Positioning 
Data Table 

Axis state 

Displays the operation state of each axis. 
"Operating" (green): The motor is running. 
"Stopped" (gray): The motor stops. 
"Error" (red): An error occurs. 

 

Error code 
The latest error code is displayed in case of an error.  
If a recoverable error occurs in the control, click the [Clear errors] button to 
clear the error. 

19.3 Table of 
Error Codes 

Warning code The latest warning code is displayed in case of a warning.  
Click [Clear warning] to clear the warning. 

19.4 Table of 
Warning 
Codes 

Speed rate 
It allows setting the target speed of home return of different axes set in 
parameter settings as 100% to specify the speed multiplier operation. Click 
the [Speed Rate] button to display the value input dialog box. 

 

KEY POINTS
 

• The control method for the table number that the teaching operation was 
performed is automatically changed to “Absolute”. 

• The result of the teaching becomes effective once the tool operation quits 
and the setting data is downloaded to the control unit. 

• This dialog box cannot be closed during the operation. 
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10.5 Monitoring Current Value with Program 

10.5.1 Current Value Area 

• They are stored as 2-word 32-bit data in the axis information area of positioning memory. 

• The elapsed value area will be reset when the power supply turns off.  It will be held when 
switching the mode from RUN to PROG. 

 Counting range of the elapsed value (current value) area 
Division Range 
Independent 
axis control -2,147,482,624～2,147,482,624 

Interpolation 
axis control -8,388,608-+8,388,607 

 

10.5.2 Reading of the current value 

Perform reading according to the reading instruction for the [F384 PTBLR] position control 
parameters. 

 Instruction Format 

R0
S2 DnS1F384 PTBLR

 

Operand Settings Specify reading of the elapsed value area 

S1 Specify the axis number and 
positioning memory area 

H1 Specify the axis information area of axis 1 
H101 Specify the axis information area of axis 2 

H201 Specify the axis information area of axis 3 
H301 Specify the axis information area of axis 4 
H401 Specify the axis information area of axis 5 
H501 Specify the axis information area of axis 6 

H601 Specify the axis information area of axis 7 (or 
virtual) 

H701 Specify the axis information area of axis 8 (or 
virtual) 

S2 Saves the starting address of the 
positioning memory (offset address) 

H3C  Current value (Pulse) 
H3E Unit converted into the current value 

(pulse/µm/inch/degree) 
n Read the number of words K2 Specify the word 2 

D Save the operation memory of the read 
data Specify any memory. 
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 Sample program 
It represents the situation when axis-4 elapsed value (current value) is read into the data 
registers DT300-DT301. For details about the instructions, please refer to "Chapter 18 
Instruction Reference". 

R0
H3C DT300K2H301F384 PTBLR

 

 Current value and unit converted into the current value 
Offset Address Description 

H3C 

Unit: Pulse 
The current value based on the mechanical origin and is saved in the unit of pulse. reset to 
"0" upon home return. The value will not be updated even if the Update Current Value 
function is executed. 

H3E 

Unit: pulse/µm/inch/degree  
Saves the current value based on the electrical origin. Save the value converted to the 
selected unit system (pulse, µm, inch and degree) in the setting area of different axes. After 
home return, the values set as the coordinate origin will be saved. It will be reset to "0" 
when the value saved in the coordinate origin is "0". This area will be updated when using 
the Update Current Value function. 
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11.1 Basic Operations 

11.1.1 Position Control Method 

 Operation pattern                (A: Available) 

Name Timing charts Actions and Purposes Repe-
tition 

Interpo-
lation 

E-point 
Control 

t[ms]

f[Hz]

E

 

 Moving to the end point is called "E-
point Control". 
 Use this method for the 1-speed 
acceleration and deceleration control. 

A A 

P-point 
Control 

t[ms]

f[Hz]

P
E

 

t[ms]

f[Hz]

P E
P

 

 Controlling via the pass point is 
called "P-point Control". 
 Use this method for the 2-speed 
acceleration and deceleration control. 
 When the P-point control is started, it 
will be switched to the E-point control 
after the pulse output is performed 
based on the specified movement 
amount. 

A A 

C-point 
Control 

t[ms]

f[Hz]

C
E

 

t[ms]

f[Hz]

C E
C

 

 Controlling via the continuance point 
is called "C-point Control". 
 Use this method for two continuous 
1-speed position controls 
corresponding to the target speed, 
acceleration and deceleration time. 
 The time switching to the E-point 
control from the C-point control is 
specified as the dwell time. 

A A 
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Name Timing Charts Actions and Purposes Repe-
tition 

Interpo-
lation 

J-point 
Control 

No Speed Change 

t[ms]

f[Hz]

J E

①

 

 Controlling via the speed point (JOG 
Operation Point) is called "J-point 
Control". 
 Perform control at the set speed 
after startup. 
 Start the position control when the J-
point position control contact is in ON. 
 Change speed when the J-point 
speed change flag is set 

① Position control contact of 
Point J 

② Speed change flag of Point J 
 
 

− − Speed Change 

t[ms]

f[Hz]

J E

①

②

 
 
 Selection of the position control operation pattern 

Select the position control operation pattern with the Configurator PM7. 

• Enter the mode in 1 line of the E-point control. 

• During continuous input of data tables with P point control, C point control and J point control, 
executes combined input to make the final data table adopt E-point control. 

 

KEY POINTS
 

• When using P: passing point, C: continuance point, J: the next line of the 
speed point is not selected and E: end point, detect the self-diagnostic error. 

 Setting the J-point control 
• Only select the "Increment" with the J-point control. 

• Set the changed target speed in the dialog box of the position control parameters for the 
speed change with the J-point control.  
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11.1.2  Setting and Operation of E-point Control  

The following example is explained with the independent axis control of axis-1. Set the 
movement amount as the increment mode and the unit as pulse. 

Mobile station 10000 pulse

(- Pole) (+ Pole)

Drive shaft

 

 Settings 
Item Setting Example 
Operation pattern E: end point 

Control method I: increment 
X-axis movement amount 10,000 pulse 
Acceleration/deceleration method L: linear 
Acceleration time (ms) 100 ms 
Deceleration time (ms) 100 ms 
Target speed 10000 pps 

 

 Operation diagram 

100 100

f [pps]

10000

t [ms]

3000020000

10000 pulses

Positioning start contact Y1140

Current value

Operation done flag X1140

BUSY flag X1130

 

 Operation of each contact 
• The BUSY flag (X1130), which indicates that the motor is running, will turn ON when the 

positioning control starts, and it will turn OFF when the operation completes. 

• The operation done flag (X1140), which indicates the completion of operation, will turn ON 
when the current operation is completed, and it will be held until the next positioning control 
JOG operation, home return, or pulse operation starts. The flag will turn ON after the unit 
transmits a reference for the target position. 
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11.1.3 Setting and Operation of P-point Control 

The following example is explained with the independent axis control of axis-1. Set the 
movement amount as the increment mode and the unit as pulse. 

Mobile station 18000 pulse

Drive shaft

(- Pole) (+ Pole)  

 Settings 

Item 
Setting Example 

Table 1 Table 2 Table 3 
Operation pattern P: Passing Point P: Passing Point E: end point 
Control method I: increment I: increment I: increment 
X-axis movement amount 5,000 pulse 10,000 pulse 3,000 pulse 
Acceleration/deceleration 
method L: linear L: linear L: linear 

Acceleration time (ms) 100 ms 200 ms 30 ms 
Deceleration time (ms) 10 ms 20 ms 150 ms 
Target speed 10,000 pps 20,000 pps 5,000 pps 

 Operation diagram 

100 150

f [pps]

10000

20000

5000

200 150 t [ms]

3800020000

Table 1
5000

pulses

Table 2
10000
pulses

Table 3
3000
pulses

Positioning start contact Y1140

Current value

Operation done flag X1140

BUSY flag X1130

 

 Operation of each contact 
• The BUSY flag (X1130), which indicates that the motor is running, will turn ON when the 

positioning control starts, and it will turn OFF when the operation completes. 

• The operation done flag (X1140), which indicates the completion of operation, will turn ON 
when the current operation is completed, and it will be held until the next positioning control, 
JOGoperation, home return, or pulsar operation starts. The flag will turn ON after the unit 
transmits a reference for the target position. 
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11.1.4 Setting and Operation of C-point Control 

The following example is explained with the independent axis control of axis-1. Set the 
movement amount as the increment mode and the unit as pulse. 

Mobile station 18000 pulse

Drive shaft

(- Pole) (+ Pole)  

 Settings 
Position control data and parameters are set via the tool software. Unit set to pulse  

Item 
Setting Example 

Table 1 Table 2 Table 3 
Operation pattern C: Continuance Point  C: Continuance Point E: end point 
Control method I: increment I: increment I: increment 
X-axis movement amount 5,000 pulse 10,000 pulse 3,000 pulse 
Acceleration/deceleration 
method L: linear L: linear L: linear 

Acceleration time (ms) 100 ms 200 ms 30 ms 
Deceleration time (ms) 10 ms 20 ms 150 ms 
Target speed 10,000 pps 20,000 pps 5,000 pps 

 Operation diagram 

100

f [pps]

10000

20000

5000

20010
20

30 150 t [ms]

3800020000

Table 1
5000

pulses

Table 2
10000
pulses

Table 3
3000
pulses

Positioning start contact Y1140

Current value

Operation done flag X1140

BUSY flag X1130

 

 Operation of each contact 
• The BUSY flag (X1130), which indicates that the motor is running, will turn ON when the 

positioning control starts, and it will turn OFF when the operation completes. 

• The operation done flag (X1140), which indicates the completion of operation, will turn ON 
when the current operation is completed, and it will be held until the next positioning control 
JOG operation, home return, or pulsar operation starts. The flag will turn ON after the unit 
transmits a reference for the target position. 
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11.1.5 Setting and Operation of J-point Control 

J-point control operates at the target speed from the operation start to the position control 
start contact of J-point control is ON, and start the next position control when the J-point 
control is ON. 

 Settings 

Item 

Setting Example 

Data table 1 
J-point 

axis parameter 
settings 

Data table 2 Data table 3 

Operation pattern J: Speed Point － P: Passing Point E: end point 

Control method I: increment － I: increment I: increment 
X-axis movement 
amount 5,000 pulse － 10,000 pulse 3,000 pulse 

Acceleration/deceleration 
method L: linear － L: linear L: linear 

Acceleration time (ms) 100 ms － 200 ms 30 ms 

Deceleration time (ms) 10 ms － 20 ms 150 ms 

Target speed 10,000 pps － 20,000 pps 5,000 pps 
J-point - running setting 
code － Linear 

acceleration/deceleration － － 

J-point - acceleration 
time (ms) 

－ 10 ms － － 

J-point - deceleration 
time (ms) 

－ 10 ms － － 

J point target speed － 30,000 pps － － 

KEY POINTS
 

• Specify parameters in the position control data table at the beginning of 
operation. Specify parameters upon speed change in the axis parameters 
settings menu. 

• The J-point control can only be used for the independent axis control. It can 
not be used for the interpolation control. 

• Please adopt the increment mode for the P-point control, C-point control and 
E-point control after the J-point control. 

• Execute the speed control with the J-point control, but the constant value 
must be input at the target speed for the movement amount of the position 
control. 
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 Operation diagram 

f [pps]

t [ms]

30000

20000

10000

5000

100 10 20 150 150

Positioning start contact Y1140

Current value

Operation done flag X1140

BUSY flag X1130

J point speed change contact Y1210

J point positioning start contact Y1220

Table 1
J-point

parameter Table 2 Table 3

 

 Operation of each contact 
• The BUSY flag (X1130) is in ON at startup and then OFF at the end of operation. 

• It indicates that the action completion flag (X1140) is in ON at the end of operation, and has 
been holden to any action from the next position control, JOG operation, home return and 
pulsar operation for startup. 

• The target speed is changed when the contact (Y1210) of the J-point speed change is in ON. 
The speed change contact is valid in the pulse edge of OFF→ON. 

• Start the position control action when starting points (Y1220) of the J-point position control 
are in ON. 

 Actions with the speed change contact in ON during acceleration and deceleration 
• Change speed during action of the J-point control, rather than during acceleration 

(deceleration). 

• When the speed change signal is in ON during acceleration (deceleration), first convert to 
the constant speed status and then execute the speed change action. 

Invalid contact of
J-point speed
change
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11.1.6 Sample Program (E-point, P-point and C-point Control) 

 Sample program 

X1100
Start enabled 
condition

X1104

Tool 
operation

X1230

Axis 1 
error

R10

R2

Position 
control start

F386 PSET K1 Specify axis no. 
and table no.

R2

Position 
control start

R10

Start enable 
flag

X1130

Axis 1 
BUSY

Y1140

Start enable 
flag

Axis 1 
positioning 
start

Positioning start

K0
Axis no. Table no.

（ ）DF

（ ）DF

R0

Servo ON

Servo ON

R1

Servo OFF

Y1130

Axis 1 servo 
OFF request

Servo OFF

Axis 1 servo 
ON request

（ ）DF

（ ）DF

Y1120

X1180

Axis 1 
connection 
confirmation

X1120

Axis 1 
servo lock

Link 
establishment 
annunciation
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11.1.7 Sample Program (J-point Control) 

 Sample program 

X1100
Start enabled 
condition

X1104 X1230 R10

R2

Position 
control start

Specify axis no. 
and table no., and 
start positioning.

R3

Speed 
change start

Y1210

Axis 1 J-point 
speed change

J-point speed 
change

R4

J-point 
positioning start

Y1220

Axis 1 J-point 
positioning start

J-point positioning 
start

Positioning start
R2

Position 
control start

R10

Start enable 
flag

X1130

Axis 1 
BUSY

Y1140

Axis 1 J-point 
positioning start

F386 PSET K1K0（ ）DF

（ ）DF

（ ）DF

（ ）DF

X1180 X1120

R0

Servo ON

Servo ON

R1

Servo OFF

Y1130
Servo OFF

（ ）DF

（ ）DF

Y1120

Tool 
operation

Axis 1 
error

Start enable 
flag

Axis 1 
connection 
confirmation

Axis 1 
servo lock

Link 
establishment 
annunciation

Axis no. Table no.

Axis 1 servo 
OFF request

Axis 1 servo 
ON request
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11.1.8 Programming Precautions 

 Programming Precautions  
The last table should be set to E: End point.  

• If any value such as a movement amount, acceleration time, deceleration time or target 
speed is out of the specified range, a set value error will occur when the positioning control 
starts.  

• The start contact and flag number varies depending on the number of axes  

 

 Operation at limit input 
Conditions Direction Limit Status Operation 

At each control 
start 

Forward 
rotation 

Limit input (+): ON Not executable, Error occurs. 
Limit input (-): ON Not executable, Error occurs. 

Reverse 
rotation 

Limit input (+): ON Not executable, Error occurs. 
Limit input (-): ON Not executable, Error occurs. 

During each type 
of control 

Forward 
rotation Limit input (+): ON Deceleration stop, Error occurs. 

Reverse 
rotation Limit input (-): ON Deceleration stop, Error occurs. 
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11.2 Interpolation Control 

11.2.1 Interpolation Control Types 

 Operation types 
• Interpolation control includes 2-axis linear interpolation control, 2-axis circular interpolation 

control, 3-axis linear interpolation control, and 3-axis spiral interpolation control. The 
following methods are available to specify the operation of each interpolation control. Select 
an appropriate method according to the application. The axes in the relation of interpolation 
are called X-axis and Y-axis for the 2-axis interpolation, and are called X-axis, Y-axis, and Z-
axis for the 3-axis interpolation. X-, Y-, and Z-axes are automatically assigned in ascending 
order of axis signal levels.  

• In each type of interpolation control, the E-point control that uses one table, P-point control 
and C-point control that uses multiple tables can be combined arbitrarily as positioning data.  

• For example, using P-point control enables continuous interpolation control from 2-axis 
linear control to 2-axis circular interpolation control. The acceleration time and deceleration 
time can be specified individually. For P-point control and C-point control, an E point should 
be set as the last table.  

 

Type Action designation mode Necessary data 
2 axis linear 
interpolation 
control 

Resultant speed assignment Resultant speed of the X-axis and Y-axis. 

Long-axis Speed Assignment Speed of the long-axis (axis with longer 
moving distance) 

2 axis arc 
interpolation 
control 

Center point assignment/CW direction X-axis and Y-axis coordinates of center 
point 

Center point assignment/CCW direction X-axis and Y-axis coordinates of center 
point 

Passing point assignment X-axis and Y-axis coordinates of passing 
point on the arc 

3 axis linear 
interpolation 
control 

Resultant speed assignment Resultant speed of the X-axis, Y-axis and Z-axis. 

Long-axis Speed Assignment Speed of the long-axis (axis with longer 
moving distance) 

3 axis spiral 
interpolation 
control 

Center point assignment/CW direction/X-axis feeding Y-axis and Z-axis coordinates of center 
point 

Center point assignment/CCW direction/ 
X-axis feeding 

Y-axis and Z-axis coordinates of center 
point 

Center point assignment/CW direction/Y-axis feeding X-axis and Z-axis coordinates of center 
point 

Center point assignment/CCW direction/ 
Y-axis feeding 

X-axis and Z-axis coordinates of center 
point 

Center point assignment/CW direction/Z-axis feeding X-axis and Y-axis coordinates of center 
point 

Center point assignment/CCW direction/ 
Z-axis feeding 

X-axis and Y-axis coordinates of center 
point 

Passing point assignment/X-axis feeding Y-axis and Z-axis coordinates of passing 
point on the arc 

Passing point assignment/Y-axis feeding X-axis and Z-axis coordinates of passing 
point on the arc 

Passing point assignment/Z-axis feeding X-axis and Y-axis coordinates of passing 
point on the arc 
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(Note): When the X-axis and Y-axis is the moving axes, each axis in the above diagram is replaced. 
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11.2.2 Setting and Operation of 2-axis Linear Interpolation 

The following example is explained with the execution of the E-point control. Set the X-axis as 
axis-1, Y-axis as axis-2, movement amount as the increment mode and unit as pulse. 

Y-axis

X-axis

10,000 pulses

5,000 pulses

 

 Settings 
Item Setting Example 
Operation pattern E: end point 

Interpolation operation 0： Linear (resultant speed) 

Control method I: increment 
X-axis movement amount 10,000 pulse 
X-axis auxiliary point 0 

Y-axis movement amount 5,000 pulse 
Y-axis auxiliary point 0 
Acceleration/deceleration method L: linear 
Acceleration time (ms) 100 ms 
Deceleration time (ms) 100 ms 
Interpolation speed 10,000 pps 
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 Operation diagram 

100 100

f [pps]

10000

t [ms]

3000020000

1500010000

Composite speed

Positioning start contact of axis 1 Y1140

Current value of axis 1

Current value of axis 2

Operation done flag of axis 1 X1140

Operation done flag of axis 2 X1141

BUSY flag of axis 1 X1130

BUSY flag of axis 2 X1131

 

 Operation of each contact 
• The 1st axis and 2nd axis BUSY flags (X1130 and X1131) indicating the state that a motor is 

runnign will turn ON when the positioning control starts, and they will turn OFF when the 
operation completes. 

• The 1st axis and 2nd axis operation done flags (X1140 and X1141) indicating the state that 
an operation completed will turn ON when the JOG operation is completed, and they will be 
held until the next positioning control, JOG operation, home return, or pulsar operation starts. 

 

 Programming precautions 
• To start the interpolation control, trun ON the positioning start contact of the axis with the 

smalles number in the same group. 

• The values of the X-axis auxiliary point and Y-axis auxiliary point are invalid for the linear 
interpolation. 

• In the case of specifying long axis speed, the composite speed will be faster than the long 
axis speed. 

• If any value such as a movement amount, acceleration time, deceleration time or target 
speed is out of the specified range, a set value error will occur when the positioning control 
starts. 

• The starting point and flag number vary with the axis number. 
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11.2.3 Setting and Operation of 2-axis Circular Interpolation 

The following example is explained with the execution of the E-point control. Set the X-axis as 
axis-1, Y-axis as axis-2, movement amount as the increment mode and unit as pulse. 

Y-axis

Center (X-axis: 0, Y-axis: 10000)

X-axis

10,000 pulses

20,000 pulses

 
 

 Settings 
Position control data and parameters are set via the tool software. Unit set to pulse 

Item Setting Example 
Operation pattern E: end point 
Interpolation operation S: arc (center point/CW direction) 
Control method I: increment 
X-axis movement amount 0 pulse 

X-axis auxiliary point 0 pulse 
Y-axis movement amount 20,000 pulse 
Y-axis auxiliary point 10,000 pulse 
Acceleration/deceleration method L: linear 
Acceleration time (ms) 100 ms 
Deceleration time (ms) 100 ms 

Interpolation speed 10,000 pps 
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 Operation diagram 

100 100

f [pps]

10000

t [ms]

2000020000

3000010000

Composite speed

Positioning start contact of axis 1 Y1140

Current value of axis 1

Current value of axis 2

Operation done flag of axis 1 X1140

Operation done flag of axis 2 X1141

BUSY flag of axis 1 X1130

BUSY flag of axis 2 X1131

 

 Operation of each contact 
• The 1st axis and 2nd axis BUSY flags (X1130 and X1131) indicating the state that a motor is 

runnign will turn ON when the positioning control starts, and they will turn OFF when the 
operation completes. 

• The 1st axis and 2nd axis operation done flags (X1140 and X1141) indicating the state that 
an operation completed will turn ON when the JOG operation is completed, and they will be 
held until the next positioning control, JOG operation, home return, or pulsar operation starts. 

 Programming precautions 
• To start the interpolation control, turn ON the positioning start contact of the axis with the 

smallest number in the same group. 
• In the case of the center point specification, the X-axis auxiliary point is the center point of X-

axis, and the Y-axis auxiliary point is the center point of Y-axis. In the case of the pass point, 
each pass point is set as the pass point of X-axis and Y-axis. 

• When the control method is increment, both the center point and pass point will be increment 
coordinates from the start point. 

• When the start point and the operation done point is the same, it performs one circular 
operation when using the center point method. However, when using the pass point method, 
an error will occur. 

• In the case of the pass point method, when the start point, pass point, and operation done 
point exist in the same straight line, an arc will not be comprised and an error will occur. 

• In the case of specifying long axis speed, the composite speed will be faster than the long 
axis speed. 

• If any value such as a movement amount, acceleration time, deceleration time or target 
speed is out of the specified range, a set value error will occur when the positioning control 
starts. 

• The starting point and flag number vary with the axis number. 
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11.2.4 Setting and Operation of 3-axis Linear Interpolation 

The following example is explained with the execution of the E-point control. Set the X-axis as 
axis-1, Y-axis as axis-2, Z-axis as axis-3, movement as the increment mode and unit as pulse. 

Y-axis

Z-axis

X-axis

20,000 pulses

5,000 pulses

10,000 pulses

 

 

 Settings 
Item Setting Example 
Operation pattern E: end point 

Interpolation operation 0： Linear (resultant speed) 

Control method I: increment 
X-axis movement amount 10,000 pulse 

X-axis auxiliary point 0 
Y-axis movement amount 5,000 pulse 
Y-axis auxiliary point 0 
Z-axis movement amount 20,000 pulse 
Z-axis auxiliary point 0 
Acceleration/deceleration method L: linear 

Acceleration time (ms) 100 ms 
Deceleration time (ms) 100 ms 
Interpolation speed 10,000 pps 
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 Operation diagram 

100 100

f [pps]

10000

t [ms]

3000020000

200000

1500010000

Composite speed

Positioning start contact of axis 1 Y1140

Current value of axis 1

Current value of axis 2

Current value of axis 3

Operation done flag of axis 1 X1140

Operation done flag of axis 2 X1141

Operation done flag of axis 3 X1142

BUSY flag of axis 1 X1130

BUSY flag of axis 2 X1131

BUSY flag of axis 3 X1132

 

 Operation of each contact 
• The 1st axis, 2nd axis, and 3rd axis BUSY flags (X1130, X1131 and X1132) indicating the 

state that a motor is running will turn ON when the positioning control starts, and they will 
turn OFF when the operation completes. 

• The 1st axis, 2nd axis, and 3rd axis operation done flags (X1140, X1141 and X1142) 
indicating the state that an operation completed will turn ON when the JOG operation is 
completed, and they will be held until the next positioning control, JOG operation, home 
return, or pulser operation starts. 

 Programming precautions 
• To start the interpolation control, turn ON the positioning start contact of the axis with the 

smallest number in the same group. 

• The values of the X-axis auxiliary point and Y-axis auxiliary point are invalid for the linear 
interpolation. 

• In the case of specifying long axis speed, the composite speed will be faster than the long 
axis speed. 

• If any value such as a movement amount, acceleration time, deceleration time or target 
speed is out of the specified range, a set value error will occur when the positioning control 
starts. 

• The start contact and flag number varies depending on the number of axes and the 
installation position of the unit. 

• The starting point and flag number vary with the axis number. 
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11.2.5 Setting and Operation of 3-axis Spiral Interpolation 

The following example is explained with the execution of the E-point control. Set the X-axis as 
axis-1, Y-axis as axis-2, Z-axis as axis-3, movement as the increment mode and unit as pulse. 

Y-axis

Z-axis

X-axis

10,000 pulses

5,000 pulses20,000 pulses

Center (X-axis: 0, Y-axis: 10000)

 

 

 Settings 
Item Setting Example 
Operation pattern E: end point 

Interpolation operation 
E: spiral 
(center point/CCW direction/Z-axis feeding) 

Control method I: increment 
X-axis movement amount 0 pulse 
X-axis auxiliary point 0 pulse 
Y-axis movement amount 20,000 pulse 
Y-axis auxiliary point 10,000 pulse 
Z-axis movement amount 5,000 pulse 

Z-axis auxiliary point 0 
Acceleration/deceleration method L: linear 
Acceleration time (ms) 100 ms 
Deceleration time (ms) 100 ms 
Interpolation speed 10,000 pps 
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 Operation diagram 

100 100

f [pps]

10000

t [ms]

2000020000

50000

3000010000

Composite speed

Positioning start contact of axis 1 Y1140

Current value of axis 1

Current value of axis 2

Current value of axis 3

Operation done flag of axis 1 X1140

Operation done flag of axis 2 X1141

Operation done flag of axis 3 X1142

BUSY flag of axis 1 X1130

BUSY flag of axis 2 X1131

BUSY flag of axis 3 X1132

 

 Operation of each contact 
• The 1st axis, 2nd axis, and 3rd axis BUSY flags (X1130, X1131, and X1132) indicating the 

state that a motor is running will turn ON when the positioning control starts, and they will 
turn OFF when the operation completes. 

• The 1st axis, 2nd axis, and 3rd axis operation done flags (X1140, X1141, and X1142) 
indicating the state that an operation completed will turn ON when the JOG operation is 
completed, and they will be held until the next positioning control, JOG operation, home 
return, or pulser operation starts. 

 Programming precautions 
• For X-Y plane, in the case of the center point specification, the X-axis auxiliary point is the 

center point of X-axis, and the Y-axis auxiliary point is the center point of Y-axis. In the case 
of the pass point, each pass point is set as the pass point of X-axis and Y-axis. These 
settings are the same for Y-Z plane and X-Z plane. 

• When the control method is increment, both the center point and pass point will be increment 
coordinates from the start point. 

• When the start point and the operation done point is the same, it performs one circular 
operation when using the center point method. However, when using the pass point method, 
an error will occur. 

• In the case of the pass point method, when the start point, pass point, and operation done 
point exist in the same straight line, an arc will not be comprised and an error will occur. 

• In the case of specifying long axis speed, the composite speed will be faster than the long 
axis speed. 

• If any value such as a movement amount, acceleration time, deceleration time or target 
speed is out of the specified range, a set value error will occur when the positioning control 
starts. 

• The starting point and flag number vary with the axis number. 



11.2 Interpolation Control 

 
11-23 

11.2.6 Sample Program (Interpolation Control) 

3-axis interpolation control as the example. 

 Sample program 

X1100

Start enabled 
condition

X1104 X1230 R10

R2 Specify axis no. 
and table no., and 
start positioning.

R2 R10

Axis 1 
start 

enable 
flag

X1130

Axis 1 
BUSY

Y1140

Axis 1 start 
enable flag

Axis 1 
positioning 

start

Positioning start

X1231 R11

Axis 2 start 
enable flag

X1232 R12

Axis 3 start 
enable flag

X1131

Axis 2 
BUSY

X1132

Axis 3 
BUSY

R11 R12

F 386 PSET K1K0
Axis no. Table no.

（ ）DF

（ ）DF

R1

Servo OFF

Servo OFF

Y1130

Axis 1 Servo 
OFF request

Y1131

Axis 2 Servo 
ON request

Y1132

Axis 3 Servo 
ON request

（ ）DF

X1180 X1120

X1181 X1121

X1182 X1122

R0

Servo ON

Servo ON

Y1120

Axis 1 Servo 
ON request

Y1121

Axis 2 Servo 
ON request

Y1122

Axis 3 Servo 
ON request

（ ）DF

Tool 
ope-
ration

Link 
establish

-ment
annunciation

Axis 1 
error

Axis 1 
connection 
confirmation

Axis 1 
servo lock

Axis 2 
error

Axis 2
connection 
confirmation

Axis 2 
servo lock

Axis 3 
error

Axis 3 
connection 
confirmation

Axis 3 
servo lock

Position 
control start

Position 
control start

Axis 2 
start 

enable 
flag

Axis 3 
start 

enable 
flag
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11.3 Positioning Repeat Function 
Positioning repeat function means to specify the times of repetition for continuous position 
control at specified times. 

The times of repetition is set in the position control repetitions area of each axis. The 
repetitions can be specified within 2~254, or be set to 255 to indicate infinite repetitions. 

 Overview of Positioning repeat function 
The following figure shows repetition of the position control for 3 times. 

 

 

When the dwell is set to 0 with the E-point control of the end position control, the control unit 
processes E-point control as P-point control and repeats the position control for 3 times 
without stopping the operation before ending the operation. 

 

 

When the pause is set to a value other than 0 with the E-point control of the end position 
control, the control unit processes E-point control as C-point control and pause according to 
the set dwell time of pause before executing position control again. 

The operation is ended after repetitions of position control for 3 times. 

P P P C P P P C P P P E

Dwell timeDwell time  
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 Position control repetitions settings area (memory area no.0: common area) 
In this area, it is allowed to set the times of repetitions from the position control start by axis.   
The control unit will start repeating the position control that is started for the set times before 
ending the operation.  The times of repetition will change to the initial value at the end of the 
operation. 

Positioning 
memory 
offset address 

Name Description Initial 
value 

Setting 
Range Unit 

H108 Positioning repeat 
count of axis 1 

Saves the times of repetition from 
the no. of the position control start 
data table to the E-point. If set to 
255, the operation will be repeated 
infinitely before the operation is 
stopped. 

0 0-255 Times 

H109 Positioning repeat 
count of axis 2 

H10A Positioning repeat 
count of axis 3 

H10B Positioning repeat 
count of axis 4 

H10C Positioning repeat 
count of axis 5 

H10D Positioning repeat 
count of axis 6 

H10E 
Positioning repeat 
count of axis 7 (or 
virtual) 

H10F 
Positioning repeat 
count of axis 8 (or 
virtual) 
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 Stop processing in the repetitive operation of position control 
During repetitions of position control, if deceleration stop is executed, the following operations 
will occur. 

 

• When E-point control is repeated（Dwell time：0 ms） 

When the control unit detects the deceleration stop, it will stop after performing the repetitive 
position control N+2 times. 

E E E E

N-1 N N+1 N+2

Deceleration stop request

Repetition times

Deceleration stop
 request signal

Busy

Operation completion

Stop completion

 

• When continuously executing multiple position control data tables 
When the control unit detects the deceleration stop, it will stop after performing the repetitive 
position control N+1 times. 

N-1 N N+1

P P P E

Deceleration stop request

Repetition times

Deceleration stop
 request signal

Busy

Operation completion

Stop completion
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11.3.1 Setting and Operation of Repeat Operation 

The following example is explained with the independent axis control. Set the movement 
amount as the increment mode and the unit as pulse. 

Table

(-) side (+) side

Ball screw

54000 pulse
(18000 x 3)

 
 

 Settings 

Item 
Setting Example 

Table 1 Table 2 Table 3 
Operation pattern P: Passing Point P: Passing Point E: end point 
Control method I: increment I: increment I: increment 
X-axis movement amount 5,000 pulse 10,000 pulse 3,000 pulse 
Acceleration/deceleration 
method L: linear L: linear L: linear 

Acceleration time (ms) 100 ms 200 ms 30 ms 
Deceleration time (ms) 10 ms 20 ms 150 ms 

Target speed 10,000 pps 20,000 pps 5,000 pps 
Dwell time 0 ms 0 ms 0 ms 
Repetitions of position 
control 3 (setting area for writing to the positioning memory) 
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 Operation diagram 
f [pps]

10000

6000

20000

t [ms]100 150200

Positioning start contact Y1140

Operation done flag X1140

BUSY flag X1130

 

 Operation of each contact 
• The BUSY flag (X1130), which indicates that the motor is running, will turn ON when the 

positioning control starts, and it will turn OFF when the operation completes. 

• The operation done flag (X1140), which indicates the completion of operation, will turn ON 
when the current operation is completed, and it will be held until the next positioning control, 
JOG operation, home return, or pulser operation starts. 

 Sample program 

X1100
Start enabled 
condition

X1104 X1230 R10

R2
Specify axis no. 
and table no.

R2 R10 X1130 Y1140
Positioning start

（ ）DF

（ ）DF

Specify repeat 
count

F386 PSET K1K0

F0 MV DT100K3
Repeat 
count

Specify repeat 
count setting areaDT100 H108K1

1 word Axis 1 repeat 
count setting 
area

H0F385 PTBLW
Common 
area

R0
Servo ON

R1 Y1130
Servo OFF

（ ）DF

（ ）DF

Y1120

X1180 X1120

Tool 
operation

Axis 1 
error

Position 
control start

Start enable 
flag

Axis no. Table no.

Servo ON

Servo OFF
Axis 1 servo 
OFF request

Axis 1 servo 
ON request

Axis 1 
connection 
confirmation

Axis 1 
servo lock

Link 
establishment 
annunciation

Position 
control start

Start enable 
flag

Axis 1 
BUSY

Axis 1 
positioning 
start  
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12.1 Synchronous Control 

12.1.1 Outline of Synchronous Control 

The positioning unit in synchronous control operates a master axis so that slave axes will 
operate in synchronization with the master axis. The use of synchronous control provides the 
following merits.  

1. Ease of setting  
A number of related axes can be operated with ease by designing the operation of the axes 
based on the master axis.  

2. Ensuring operational safety  
If an axis comes to a stop for some reason while the positioning unit is in synchronous control, 
all the relevant axes under synchronous control will come to a stop. Therefore, you can easily 
increase the safety of the positioning unit.  

 

 Outline of synchronous control 
The synchronous control provides the following functions. These functions are executed in 
order, and the slave axes operate according to the operation result of each function.  

Function Outline 

Electronic gear  The number of pulses multiplied by the preset electronic gear ratio is output according to the 
operation of the master axis. 

Electronic 
clutch  

The operation of the slave axes can be separated from the operation of the master axis by 
disengaging the clutch. 

Electronic cam 

A function to output pulses according to the preset cam pattern.  
Calculates the operation phase of the master axis and outputs cam pulses according to the 
phase.  
The cam pattern is set with a setting tool. 
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 Execution Order of Synchronous Control and Setting Procedure 
The following section provides information on the outline of functions achieved by 
synchronous control and setting procedures for the functions. 
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12.2 Settings for Master and Slave Axes 

12.2.1 Selection for Master and Slave Axes 

The master axis serves as a reference for synchronization control. Start and stop requests for 
various operations are made to the master axis under synchronous control. It is possible to 
select one of the following master axes. 

 Types of master axes 
Types of 

master axes Outline 

Existing axis 

Axis that can be physically controlled by the control unit (1~8 axis). 
It is used when you hope that the master axis is also used as a control object. 
When an actual axis is used as the master axis, it is allowed to use axes other than the master 
axis (7 axes) as the slave axes. 

Virtual axis A virtual axis exists in the control unit. 
The virtual axis does not perform the motor control 

Pulse input 

The action to make the pulse input value of the input unit as the master axis. 
It is used when connecting external devices on the bases of synchronous control such as 
external encoder. 
When pulse input is used as the master axis, the slave axis operates according to the pulse 
input. Therefore, special attention must be paid when stating or stopping operations via the 
control unit. 

 Types and restrictions of master axis 

 
Type 

Existing axis Virtual axis Pulse input 

Home return Yes Available to data setting 
only. No 

JOG operation Yes Yes No 

Positioning 

Single axis Yes Yes No 

Interpolation Yes 
No 
Available to single axis 
only. 

No 

Stop 
functions 

System/Emergency/ 
Deceleration stop Yes Yes No 

Limit stop Yes 

Questionable 
Stops only with software 
limit because of no limit 
signal input. 

No 

Error stop Yes Yes No 

Others  

Necessary to make 
settings to use the virtual 
axis on the Configuration 
screen. 

Synchronizes with 
external pulse input, 
and no master axis 
control is possible. 
To stop synchronous 
control, stop the slave 
axes. 
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KEY POINTS
 

• While the positioning unit is in synchronous control, slave axes set to use 
the master axis will operate only in synchronization with the master axis, 
i.e., the slave axes cannot operate independently.  

• The virtual axis is assigned to a single axis only. In the case of using the 
virtual axis, check the box for the virtual axis in the dialog box to set the 
operating axes on the Configurator PM7. 

• The home return of the virtual axis is possible only by data setting. 

• If pulse input is set for the master axis, the master axis will synchronize 
with pulse input from an external device, such as an encoder. Therefore, the 
master axis cannot be stopped arbitrarily. 

12.2.2 Selection of Slave Axes and Settings 

 Selection of Slave Axes 
The 1st to 8th axes are available as slave axes. The virtual axis can be used only as the 
master axis. 

When “Synchronous master axis” is selected in the synchronous parameter dialog box of the 
Configurator PM7, the corresponding axis will operate as a salve axis for the specified master 
axis. 

Up to eight slave axes can be set for a single master axis. 

Axes set as slave axes operate in synchronization with the master axis as long as 
synchronous control is enabled. No slave axes can perform positioning and other control 
independently from the master axis while synchronous control is enabled. 

 Settings for Slave Axes 
The slave axes operate in synchronization with the master axis. Set the following items, 
however, for each individual salve axis. 

• Unit setting 

• Number of pulses per rotation 

• Movement amount per rotation 
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12.3 Start and Cancel of Synchronous Control 

12.3.1 Start and Cancel of Synchronous Control 

 Start and cancel operations 
• It is possible to cancel the synchronous control temporarily with a sync cancel request signal 

turned ON. 

• It is possible to operate any slave axes individually while the synchronous state is canceled. 

• The synchronous control can be started again with the sync cancel request signal turned 
OFF. 

• The synchronous control can be cancelled while a master axis is activated. 

 

 I/O signal assignment 
Signal  
name Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 

(virtual) 
Axis 8 

(virtual) Operation 

Synchronous 
cancel request Y1280 Y1281 Y1282 Y1283 Y1284 Y1285 Y1286 Y1287 

On: Cancel 
synchronous 
control 
Off: Execute 
synchronous 
control 

Synchronous 
cancel active 
announciation 

X1280 X1281 X1282 X1283 X1284 X1285 X1286 X1287 

On: 
Synchronous 
control being 
canceled 
Off: Under 
synchronous 
control 

 



12.3 Start and Cancel of Synchronous Control 

 
12-7 

 Operations while synchronous control is performed/canceled 

Operation request axis 
Operation while synchronous control  
is performed 

Operation while 
synchronous control 
is canceled 

Master axis set Slave axis set Master/Slave axis set 

Home return 

No 
The master axis performs 
a home return. 
The slave axes do not 
perform a home return 
but operate in 
synchronization with 
output from the master 
axis. 
For performing home 
return, cancel the 
synchronous control and 
operate. 

No 
The slave axes do 
not operate in 
response to 
operation requests. 

Yes 
The master axis or slave 
axes will perform a home 
return only if the master 
axis or the slave axes are 
so requested. 

JOG operation Yes 
The slave axes operate 
in synchronization with 
the operation request of 
the master axis. 

Yes 
The master axis or slave 
axes will go into JOG 
operation only if the 
master axis or the slave 
axes are so requested. 

Positioning 

Single axis 

Interpolation 

Yes 
Interpolation will be 
executed upon request if 
the master axis is the 
start axis of interpolation. 
The slave axes operate 
in synchronization with 
the master axis. 

Yes 
Interpolation will be 
executed upon request if 
the requested axis is the 
start axis of interpolation. 

Stop 
functions 

System stop All the axes come to a stop regardless of the synchronization settings. 
Emergency 
stop Yes 

The master axis comes 
to a stop upon request. 
The slave axes come to 
a stop in synchronization 
with the master axis. 

Yes 
Only axes 
requested come to a 
stop. 
The master axis and 
other salve axes set 
on the same master 
axis continue 
operating. 

Yes 
Only axes requested 
come to a stop. 
(All the axes in 
interpolation operation 
come to a stop.) 

Deceleration 
stop 

Limit stop 
The master axis and all the slave axes come to a 
stop. 

Only axes resulting in a 
limit error come to a stop. 

Error stop Only axes resulting in an 
error come to a stop. 

(Note 1): When an error occurs in the master axis and slave axes, all axes will stop at the stop time of tha master axis. 
(Note 2): When a limit stop or error stop occurs in slave axes, the master axis will stop. Consequently all slave axes 

will stop at the stop time of the master axis. 
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12.3.2 Precautions When Canceling or Starting Synchronous Control 

 Precautions when canceling synchronous control 
• The synchronous control can be canceled during  the master operation, however, slave axes 

will stop immediately. 

• It is recommended to cancel the synchronous control after stopping slave axes using the 
clutch function. 

• When the synchronous control is canceled, relays related to the synchronous control 
(synchronous slave gear ratio change state annunciation, synchronous slave clutch 
connection state notification) will turn off. 

 Conditions for starting synchronous control 
Only when the following conditions are met, the synchronous control can be started. 

• Slave axes stop. 

• No stop request for slave axes is generated. 

• No error occurs in slave axes. 

When these conditions are not met, the unit does not become the synchronous state and the 
synchronous control cancel active annunciation relay does not turn off. If the synchronous 
cancel request kept off while the conditions are not met, the synchronous control will start 
once the condition to start the synchronous control is met. 

 Phase when starting synchronous control 
It is calculated from the "current value after unit conversion" of master axis and the "cam 
control synchronous master axis cycle" of synchronous parameter. The remainder obtained by 
dividing "current value after unit conversion" by "cam control synchronous master axis cycle" 
is used as a phase. 

t

t

0

0

Master axis
Current value �
after unit conversion

Phase of slave axis

The phase does not change �
in the section that the clutch is off.

Synchronous control
canceled

Clutch ON

Cam control synchronous master cycle

Under synchronous control

Clutch
OFF

Calcuate the phase based on the
current position of master axis when
starting synchronous control.
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 Procedures of canceling and starting synchronous control 
The following shows the procedures when "Level" is selected for the clutch trigger type as an 
example. 

Section Procedure Operation by user programs and unit operation 

Synchronous 
canceled 

○1  Turn off the synchronous slave clutch ON request by a user program. 

○2  The unit turns off the synchronous slave clutch connection state annunciation. 

○3  Turn on the synchronous state cancel request by a user program. 

○4  The unit cancel the synchronous control when the synchronous cancel active 
annunciation turns on. 

Synchronous 
started 

○5  Turn off the synchronous state cancel request by a user program. 

○6  The unit turns off the synchronous cancel active annunciation. 

○7  Turn on the synchronous slave clutch ON request by a user program. 

○8  The unit starts the synchronous operation of slave axes when the synchronous 
slave clutch connection state annunciation turns on. 

ON
OFF

t

t

ON
OFF

ON
OFF

ON
OFF

ON
OFF

Master axis output speed

Slave axis BUSY

Slave axis output speed

Synchronous state cancel request

Synchronous cancel active announciation

Synchronous slave clutch ON request

Synchronous slave clutch connection state annunciation

Slip time Slip time

Under
synchronous

control

Synchronous
control

canceled

Under
synchronous

control

 
Signal  
name Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 

(virtual) 
Axis 8 

(virtual) 
Synchronous cancel 
request Y1280 Y1281 Y1282 Y1283 Y1284 Y1285 Y1286 Y1287 

Synchronous cancel 
active annunciation X1280 X1281 X1282 X1283 X1284 X1285 X1286 X1287 

Slave axis clutch ON 
request Y1330 Y1331 Y1332 Y1333 Y1334 Y1335 Y1336 Y1337 

Slave axis clutch 
operation annunciation X1330 X1331 X1332 X1333 X1334 X1335 X1336 X1337 

Slave axis BUSY X1130 X1131 X1132 X1133 X1134 X1135 X1136 X1137 

 Operation when selecting "Level" for the clutch ON trigger type 
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• If the "synchronous slave clutch ON request" is on when the synchronous control start 
processing is executed, the clutch is connected by the direct method regardless of the 
setting of "slip method". 

• However, if the "synchronous slave clutch ON request" is off when the synchronous control 
start processing is executed, the clutch is connected according to the setting of "slip method". 

When the synchronous slave clutch ON request is on when the synchronous control 
start processing is executed 

ON
OFF

t

t

ON
OFF

ON
OFF

ON
OFF

ON
OFF

Master axis output speed

Slave axis BUSY

Slave axis output speed

Synchronous state cancel request

Synchronous cancel active announciation

Synchronous slave clutch ON request

Synchronous slave clutch connection state annunciation

Slip time

Synchronous
control

canceled

Under
synchronous

control

 
 

○1  
The slave axes start the operation immediately as the clutch is connected (synchronous slave clutch 
connection state annunciation: ON) when the synchronous control starts (synchronous cancel active 
annunciation: OFF). 

 

① 
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When the synchronous slave clutch ON request is off when the synchronous control 
start processing is executed 

ON
OFF

t

t

ON
OFF

ON
OFF

ON
OFF

ON
OFF

Master axis output speed

Slave axis BUSY

Slave axis output speed

Synchronous state cancel request

Synchronous cancel active announciation

Synchronous slave clutch ON request

Synchronous slave clutch connection state annunciation

Slip time Slip time

Synchronous
control

canceled

Under
synchronous

control

 
 

○1  
The slave axes do not operate immediately as the clutch is not connected (synchronous slave clutch 
connection state annunciation: OFF) when the synchronous control starts (synchronous cancel active 
annunciation: OFF). 

○2  Slave axes start the operation by the synchronous slave clutch ON request. 

I/O Allocation 
Signal  
name Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 

(virtual) 
Axis 8 

(virtual) 
Synchronous cancel 
request Y1280 Y1281 Y1282 Y1283 Y1284 Y1285 Y1286 Y1287 

Synchronous cancel 
active annunciation X1280 X1281 X1282 X1283 X1284 X1285 X1286 X1287 

Slave axis clutch ON 
request Y1330 Y1331 Y1332 Y1333 Y1334 Y1335 Y1336 Y1337 

Slave axis clutch 
operation annunciation X1330 X1331 X1332 X1333 X1334 X1335 X1336 X1337 

Slave axis BUSY X1130 X1131 X1132 X1133 X1134 X1135 X1136 X1137 

① 

② 
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12.4 Electronic Gear Function 

12.4.1 Outline of Electronic Gear Function 

 Electronic Gear Function 
The electronic gear function operates the positioning unit at the speed of the master axis 
multiplied by a preset gear ratio. 

Speed [V] Output speed

Input speed

Gear ratio: Set to 2x

Time [T]
Speed [V]

Output speed
Input speed Gear ratio: Set to 0.5x

Time [T]

Master axis
operation

Electronic gear
output

Output speed       =       Input speed       x　
(Speed after gear change) (Information on master axis speed)

Gear ratio numerator
Gear ratio denominator

 

 Cautions for using the electronic gear function. 
The use of the electronic gear function makes it possible to set the slave axes to a desired 
speed relative to the master axis. The movement amount of the slave axes, however, is 
obtained from the following formula. Therefore, the movement amount of the master axis does 
not coincide with that of the slave axes. 

Movement amount of slave axes = Movement amount of master axis x (gear ratio 
numerator/Gear ratio denominator) 
* On the condition that the gear ratios are constant. 

Do not use the electronic gear function if the movement amount of the master axis needs to 
coincide with that of the salve axes. 

 
Keep in mind that the slave axes may come to a sudden stop if an emergency stop or 
deceleration stop is executed while making a gear ratio change. 
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12.4.2 Types and Contents of Setting Parameters 

The use of the electronic gear requires the following parameter settings. 

Parameter name Outline 

Electronic gear operation 
settings 

Set to use or not to use the electronic gear function. 
The gear ratio of the electronic gear will be set to 1:1 if the electronic gear is not 
used, and the operation of the master axis will be input as it is into the electronic 
clutch. 

Gear ratio numerator Determines the gear ratio of the electronic gear. 
Electronic gear ratio is determined by the following formula. 
Output speed of electronic gear = Operating speed of master axis x (Gear ratio 
numerator/Gear ratio denominator) 

Gear ratio denominator 

Gear ratio change time The time required to change the current gear ratio to a new gear ratio if the new 
gear ratio is set for the electronic gear in operation. 
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12.4.3 Gear Ratio Changes while in Operation 

 Precautions for gear ratio changes while the positioning unit is in operation 
• If the gear ratio is changed with a new gear ratio while the electronic gear is in operation, the 

new gear ratio will be effective with an elapse of a preset gear change time. 

• If the gear ratio change time is 1, the gear ratio will be changed at an 
acceleration/deceleration time of 0. 

• Acceleration or deceleration during the gear ratio change results in linear acceleration or 
deceleration. S-shaped acceleration or deceleration cannot be used. 

Speed [V] Gear ratio change time
(1 ms)

Gear ratio change time
(100 ms)

Gear ratio change request signal

Gear ratio numerator/Gear ratio denominator 200 ／ 100

1 100

50 ／ 100100 ／ 100

Gear ratio change time

Input speed
Output speed

Time [T]

 

 Programming 
Follow the procedure below and write a user program in the case of changing the gear ratio 
while the positioning unit is in operation. 

1. Change the gear ratio. 

• Change the gear ratio numerator and denominator of the electronic gear in the setting area 
for the electronic gear. 

• The gear ratio at the time of starting the positioning unit is set for this area. It is 
recommended to save the initial gear ratio before change so that the initial gear ratio can be 
reused with ease. 

2. Set the gear ratio change request contact to ON  
• Turn ON an I/O signal (electronic gear ratio change request) for the target axis allocated to 

the unit. 

• This signal enabled is of edge type. Starts the gear ratio change triggered by the gear ratio 
change request signal turned ON. 

 I/O Allocation 
Signal  
name Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 

(virtual) 
Axis 8 

(virtual) 
Slave axis gear ratio 
change request Y1310 Y1311 Y1312 Y1313 Y1314 Y1315 Y1316 Y1317 

Slave axis gear ratio 
change state annunciation X1310 X1311 X1312 X1313 X1314 X1315 X1316 X1317 

After the change, please set the gear ratio change request signal to OFF. 
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REFERENCE  
For details about the gear ration setting area, please refer to "Chapter 26.4 Positioning 
Memory". 
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12.5 Electronic Clutch Function 

12.5.1 Electronic Clutch Function 

The electronic clutch function is used to engage or disengage the clutch for output from the 
electronic gear. When the electronic clutch is disengaged, the master axis will be separated 
from the slave axes and the slave axes not in synchronization with the master axis will come 
to a stop. When the electronic clutch is engaged, the master axis and slave axes will operate 
in synchronization. 

Synchronized Stop

Electronic gear
output

Electronic clutch
output

Speed [V]

Output speed

ON

OFF
Clutch

Input speed

Time [T]

 

 

 
Keep in mind that the slave axes may come to a sudden stop if the clutch is 
disengaged while making a gear ratio change. 
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12.5.2 Types and Contents of Setting Parameters 

The use of the electronic clutch requires the following parameter settings. 

Parameter name Outline 

Electronic clutch used/unused 

Set to use or not to use the electronic clutch function. 
The electronic clutch is by default disengaged. 
Be sure to engage the electronic clutch in response to the operation. 
The electronic clutch will be always engaged when the electronic clutch is 
not in use, in which case, output data from the electronic gear will be input 
as it is into the electronic cam. At that time, the master axis will always 
operate in synchronization with the slave axes. 

Clutch 
ON  

Trigger type Set an I/O clutch ON request as a trigger to be detected. 

Edge selection Select the method of trigger signal detection from “Level,” “Rising edge,” or 
“Falling edge.” 

Method Select “Direct” or “Slip” for the engagement of the clutch. 
Slip time If “Slip” is selected, set the slip time. 

Clutch 
OFF  

Trigger type Set an I/O clutch OFF request or "I/O+Phase after clutch" as a trigger to be 
detected. 

Edge selection Select the method of trigger signal detection from “Level,” “Rising edge,” or 
“Falling edge.” 

Method Select “Direct” or “Slip” for the engagement of the clutch. 
Slip time If “Slip” is selected, set the slip time. 

 

KEY POINTS
 

• For the details of the mode to stop at any phase after the clutch OFF (I/O + 
phase after clutch), refer to "12.5.5 Phase Specification Clutch Off Function". 
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12.5.3 Trigger Types for Electronic Clutch 

The following methods are available for the engagement or disengagement of the electronic 
clutch. 

 Clutch request signal (Y1330-Y1337, Y1340-Y1347) 
An I/O signal (clutch request signal) allocated to the unit is in control of the electronic clutch. 

 I/O Allocation 
Signal  
name Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 

(virtual) 
Axis 8 

(virtual) Operation 

Slave axis 
clutch ON 
request 

Y1330 Y1331 Y1332 Y1333 Y1334 Y1335 Y1336 Y1337  

Slave axis 
clutch OFF 
request 

Y1340 Y1341 Y1342 Y1343 Y1344 Y1345 Y1346 Y1347  

Slave axis 
clutch operation 
annunciation 

X1330 X1331 X1332 X1333 X1334 X1335 X1336 X1337 
ON: Engaged, 
OFF: 
Disengaged 

 

ON
OFF

Master axis operation

Slave axis operation

Clutch request signal
 

(Note): The above shows an example of the direct method selected for the engagement of the clutch. 
 

 Edge selection 
Edge selection Operation 

Level 
The clutch operation is switched by turning on or off the slave axis clutch ON request 
(Y1330-Y1337). The slave axis clutch OFF request signal is not used. When the edge 
selection is level, the slave clutch OFF request (Y1340-Y1347) is invalid. 

Leading edge 
The clutch turns ON by the leading edge of the slave clutch ON request (Y1330-Y1337). 
Also, the clutch turns OFF by the leading edge of the slave clutch OFF request (Y1340-
Y1347). 

Trailing edge 
The clutch turns ON by the trailing edge of the slave clutch ON request (Y1330-Y1337)). 
Also, the clutch turns OFF by the trailing edge of the slave clutch OFF request (Y1340-
Y1347). 
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12.5.4 Engagement Methods of Electronic Clutch 

The electronic clutch function engages the clutch to start operating the slave axes and 
disengages the clutch to stop operating the slave axes, the acceleration or deceleration of the 
slave axes can be set as shown below. 

 Direct method 
This method detects the engagement or disengagement of the clutch to adjust the operating 
speed of the master axis to coincide with that of the slave axes. In the direct method, the 
speed of the slave axes with the clutch engaged or disengaged coincides with the operating 
speed of the master axis with the acceleration and deceleration time set to 0. 

Main station axis operation

Slave station axis operation

Clutch request signal ON
OFF  

 Slip method 
This method detects the engagement or disengagement of the clutch and set the slip time to 
acceleration time and deceleration time so that the operating speed of the slave axes to follow 
the operation speed of the master axis. Linear acceleration and deceleration will apply. 

Slip time Slip time

Main station axis operation

Slave station axis operation

Clutch request signal ON
OFF  
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12.5.5 Phase Specification Clutch Off Function 

The "phase specification clutch OFF function" is a function for turning off an electronic clutch 
at an arbitrarily specified phase. For stopping or starting at the same phase repeatedly, the 
control without variance can be performed. 

 Phase specification clutch OFF function 
When performing the OFF request by the I/O signal, the clutch off operation will be executed 
regardless of phase. 

OFF

ON

100%(0%)

0%

50%

t

t

Current value

Phase after clutch control

I/O X clutch connection
state annunciation Disconnected

Connected

Slave axis
(e.g. Rotary cutter)

Clutch request is OFF.
Clutch is OFF.

I/O Y clutch ON request

Master axis
Current value
after unit conversion

Phase

 

Using the "phase specification clutch off function" turns a clutch off when the phase reaches 
the set phase after the clutch off request by the I/O signal. 

OFF

ON

100%(0%)

0%

50%

t

t

It does not turn OFF until the
phase after clutch control

 reaches the set value.

Clutch OFF setting phase

Current value

Phase after clutch control

I/O X clutch connection
state annunciation Disconnected

Connected

Slave axis
(e.g. Rotary cutter)

I/O Y clutch ON request

Master axis
Current value
after unit conversion

Phase

 
(Note 1): The above figure shows the case that the both clutch on request and off request are set to "Level". Also, 

either "Rising edge" or "Falling edge" can be selected. 
(Note 2):The above figure shows the case that the clutch off setting ratio is set to "0%". It can be set to 0 to 99%. 
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 Precautions for operation chracteristics 
• When setting "Slip" for the clutch off method, the deceleration stop is performed after a 

specified slip time from the time that the phase reaches the clutch off setting ratio. To stop 
the motors at the phase of a set ratio, set the clutch off method to "Direct". 

OFF

ON

t

t

Clutch OFF
setting phasePhase after

clutch control
Slip time

Stop (disconnect) the clutch
shifted by the slip for the set phase.

Current value

I/O X clutch connection
state annunciation Disconnected

Connected

I/O Y clutch ON request

Master axis
Current value
after unit conversion

Phase

 
• When the clutch off trigger signal is detected at a phase larger than the set clutch off setting 

ratio (0 to 99%), the clutch will be off at the next time the signal reaches the set phase. 

OFF

ON

t

t

I/O clutch OFF detection cycle Next cycle

When the clutch OFF signal was detected,
the phase already exceeds the set phase.

Clutch OFF

Cam control
synchronous
master cycle

Clutch OFF
setting phase

Phase after
clutch control

Current value

I/O X clutch connection
state annunciation Disconnected

Connected

I/O Y clutch ON request

Master axis
Current value
after unit conversion

Phase
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12.6 Electronic Cam Function 

12.6.1 Outline of Electronic Cam Function 

 Electronic cam function 
The electronic cam function uses a preset cam pattern, determines the movement amount of 
the slave axes according to the operation of the master axis (phase information) and cam 
pattern, and outputs the movement amount. The cam pattern uses one rotation of the master 
axis as an operation reference, based on which the displacement of the slave axes in each 
phase (rotation angle) is defined on the Configurator screen. 

Electronic clutch
output

Slave axis output

Input axis
phase

Output axis
displacement

Input value
Current value [L]

Time [T]

Time [T]

Time [T]

Cam pattern

 

 Cam pattern 
The cam pattern uses one rotation of the master axis as an operation reference, based on 
which the displacement of the slave axes in each phase (rotation angle) is defined. The cam 
pattern is defined with the phase (rotation angle) of the master axis based on one rotation as 
a reference on the X-axis and the displacement on the Y-axis in percent. The cam pattern is 
set with the desired settings for the positioning unit selected from the Configurator PM7 
Configuration screen. 
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 Cam pattern specifications 
Setting items Description 

Resolution 1024, 2048, 4096, 8192, 16384, 32768 

No. of cam patterns 
Resolutions of 1024, 2048, 4096, and 8192: 16 
Resolution of 16384: 8 
Resolution of 32768: 4 

Section setting 100%/cycle, 20 sections max. 
Displacement setting 100% setting 

Cam curve 

Selected from the following ones 
Uniform velocity/Constant acceleration/Simple harmonic motion/Cycloid/Modified 
trapezoid/Modified sine/Trapecloid 
One-dwell cycloidal m=1/One-dwell cycloidal m=2/3/One-dwell modified trapezoid 
m=2/3/One-dwell modified trapezoidal (Ferguson)/One-dwell modified sine/One-dwell 
trapecloid/No-dwell modified trapezoid/NC2 curve/Asymmetric cycloid/Asymmetric 
modified trapezoid 

Adjustment function 
Function to adjust the displacement of desired point data. 
1,000 points max. (in units of cam data) 

Shift function 
Phase shift in created cam data 
0% to 100% 

Indication 
Displacement/Speed/Acceleration/Jerk 
A check box allows desired display. 

REFERENCE  
The phases (values) of slave axes are stored in the positioning memory (each axis 
information area: H20-H21). The values can be read by using F384 (PTBR) 
instruction. For details of the positioning memory, refer to "26.4.3 Each Axis 
Information Area (Memory Area No. 1)". 
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12.6.2 Types and Contents of Setting Parameters 

The use of the electronic cam requires the following parameter settings. 

Parameter name Outline 

Electronic cam 
use/non-use 

Select the use or non-use of the electronic cam function. 
When the electronic cam is not used, the electronic cam function will not work, and 
output from the electronic clutch will be output as pulses. 

Cam pattern 

The cam pattern is the most fundamental setting for using the electronic cam function. 
The cam pattern is set in the cam pattern settings window in the FPWIN GR7 
Configuration screen. 
The positioning unit converts cam patterns into point data based on the preset cam 
curves and resolutions. 

Cam control master 
axis period 

Set the number of pulses corresponding to the total phase of the cam pattern used 
(one-rotation data on the master axis). 

Cam pattern number to 
use Specify the cam pattern number to be used from cam patterns created. 

Cam stroke  Set the number of pulses corresponding to the total displacement (100%) of the cam 
pattern to use. 

Advance angle 
correction operation 
setting 

Select the use or non-use of the advance angle correction function. 

 Reference value 
The unit follows the unit system of the master axis. 
Setting range: -2,147,482,624 to 2,147,482,624 (The decimal point position is based 
on unit systems.) 

 Reference speed 
The unit follows the unit system of the master axis. 
Setting range: 1 to 2,147,482,624 (The decimal point position is based on unit 
systems.) 

 Parameter change 
time Setting range: 1 to 10000 ms 
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12.6.3 Cam Pattern Setting Method 

 Starting Cam Pattern Setting Screen 
Open the Configuration screen on the FPWIN GR7 and select “Positioning settings” so that 
the setting tool will start. 

Select “Axis settings” - “Cam pattern settings” from the toolbar of the setting tool for click the 

following icon:  The Cam Pattern Settings screen is displayed. 

A blank screen will be displayed for a new file and settings for cam pattern 1 will be displayed 
if data already exists. 

 

 Resolution setting 
Click the [Resolution] button from the cam pattern menu. After the resolution settings menu is 
displayed, select the resolution and click the [OK] button. 
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KEY POINTS
 

• The resolution is valid for all cam patterns. It is not allowed to set the 
resolution of each cam pattern separately. 

• Number of cam patterns available for setting depends on the resolution.  
When changing the resolution, if the set number of cam patterns exceeds 
the number of cam patterns available for setting after the resolution is 
changed, the resolution will not be changed. Please delete the cam patterns 
and change the resolution again.  

 

 Creating/copying cam patterns 
Click the [Add] button in the "Cam" field to start the cam no. selection menu. 

Select the cam no. and click the [OK] button. 

 

Cam patterns can also be copied. Click [Copy] to select the target and source cam pattern no. 

 

To change the cam no., click the [Change] button and select the changed cam no.  

 

Note) A cam pattern no. that has been set cannot be set. 
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 Cam pattern settings 
Click the [Insert] button in the "Section" field. Set the starting phase and click the [OK] button. 

In the initial status, the cam pattern is only set as a section of the 0~100 phase. 

It is allowed to divide the above section into multiple sections by setting the starting phase. 

 

Selected sections are on white background and unselected sections are on gray background. 

 
 

 
• The starting phase may fail to reach the designated phase due to resolution. 
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 Editing of the cam table 
Edit the cam table data that was created. 

Set the following items for each section set: 

• Starting phase (%) 

• Displacement (%) 

• Cam curve 

The cam curve changes according to the settings. 

 

KEY POINTS
 

• The termination phase cannot be set. The termination phase will be 
changed automatically if the staring phase is changed. 

• Do not make a radical displacement change of set cam curves. There is a 
possibility that the motor cannot keep up with the output in the case of 
rapid displacement. 

• Similarly, make settings that a phase of 0% and that of 100% are the same in 
displacement. 
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 Cam table checks 
Check the cam table (cam curve) that has been set. The slave axes in synchronous control 
operate to follow the cam curve cam. Therefore, there will be a possibility that the motor 
cannot follow the output if the change in the cam curve is steep. In addition, it is important to 
know information on the acceleration as well as the displacement of the cam as factors 
affecting the change of the cam curve. The Cam Table Settings screen can display 
information on the following items besides the displacement. 

Display item Outline 
Displacement An item set on the cam table. 
Speed The operating speed of the cam table for the amount of displacement that has been set is 

displayed. 
The relative value is displayed. 

Acceleration The acceleration in each phase is displayed. 
Pay attention to points of significant acceleration changes, which involve radical speed 
changes. 

Jerk Jerk, which is obtained from acceleration differentiated by time, represents the rate of change 
of acceleration. 

 

Each display item is set by checking the following boxes in the Cam Table Settings screen. 
Refer to each display item and make setting changes in the cam table. 
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 Cam table adjustments 
The Cam Table settings screen is provided with a function to make the fine-tuning of set cam 
curve data. In order to mitigate radical changes, this adjustment function makes it possible to 
fine-tune cam data that has been set. To make adjustments, select the target section number 
and press the [Adjust] button. The adjustment screen is displayed. The Adjustment screen 
displays the tables corresponding to the numbers of the designated sections out of all the 
sections (0% to 100%) divided by the resolution. 

 

Select the data on the target phases (control points) and change the corresponding 
displacement data. The adjustments will be reflected by selecting [OK] and the set adjustment 
data will be cleared by selecting [Adjustment clear]. The numbers of the adjusted sections 
where the cam curve adjustments have been made are displayed in red, which tells that the 
adjustments have been completed. 
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 Cam table shift 
The created cam pattern is defined with a phase of 0% to 100%, but the actual operation may 
differ in phase from the reference of the cam pattern. The cam table shift is a function to set 
the percentage of the created cam pattern for the phase at a current coordinate position of 
zero. 

Shift image of electronic cam 

0 100 0-100 0

0 100 0-100 0
８１９/１０２４

0 100 0-100 0

Cam pattern
example
• Cycle: 1000
• Resolution:

1024

Current
coordinate position
after the clutch.

• In the case of setting coordinate 0 to 0% phase (0/1024).

Current
coordinate
system after
the clutch.

Current
coordinate
system after
the clutch.

• In the case of setting coordinate 0 to 80% phase (819/1024).

To what value
the phase of
coordinate 0 is
set?

 

Select the shift from ”Interval” and set the shift amount. 

 

The created cam pattern moved by 10% with the display updated. 

Before change 

 

After change 

 

 Storage of cam tables 
Created cam tables can be automatically saved by pressing the [OK] button on the cam table 
setting screen. Saved cam tables are managed by FPWIN GR7, and set by downloading to 
control units. 
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12.6.4 Rewriting Cam Patterns by Programs 

The editing function by the programs of cam patterns is a function to execute the change of 
cam patterns by user programs. 

 Procedure of editing cam patterns 
The edit of cam patterns is executed by two operations, which are "Reading cam tables" and 
"Rewriting cam tables". These operations are performed using a "Cam pattern editing area" in 
the positioning memory. 

(1) Procedure of changing a cam patter that has been set 

○1  Read a cam table in the cam pattern editing area. 

○2  Change the parameter of the cam table read in the cam pattern editing area. 

○3  Execute rewriting the cam table. 

（2） Procedure of creating a new cam pattern 

○1  Write parameters of created cam pattern data in the cam pattern editing area. 

○2  Execute rewriting the cam pattern data. 

No.n

No.3
No.2

No.1

Rewriting cam tables

●Cam pattern editing area
Cam pattern edit no.
Number of set sections

Start phase for sections 1 to n
Displacement
Cam curve no.

User program

Changing parameters

Shift amount

Reading cam tables

Internal cam pattern data

 

 Execution conditions of editing cam patterns 
The execution conditions for editing cam patterns are as follows. 

• The synchronous control is not performed on all axes. 

• All axes are not activated. 

• Parameters are set correctly. 

Also, when request for reading and rewriting are executed simultaneously, reading takes 
priority. In this case, the execution of the request for rewriting results in an abnormal end 
(response code: FF21H). 
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 Procedure of reading cam pattern data 
Step Operation by user programs and unit operation 
① Set a cam pattern number to be read out to the cam pattern editing area. 

② Turn on the came table reading request (Y1102) from a ladder program. 

③ On the completion of reading, turn on the cam pattern reading completion annunciation (X1102) after 
storing a response code in "Cam table reading result". 

④ Once the cam table reading request (Y1102) turns off, the unit turns off the cam pattern reading 
completion annunciation flag (X1102). 

ON
OFF

ON
OFF

Cam table edit no.

Cam table reading request
(Y1102)

Cam table reading completion
annunciation (X1102)

0000h (Nomal completion)

Read cam pattern no.

The cam table data of the specified number
is stored in the cam pattern editing area.

●Cam pattern editing area
No. of sections
Section n   Start phase

Displacement
Cam curve no.

Cam table reading result

 

 Related positioning parameter 

Area Offset 
address Name Default Description 

Cam pattern 
editing area 
（No.3） 

58H Cam pattern 
reading result H0 

・Stores the result of reading processing 
(response code).  
[Range] (Hexadecimal) 
0000H: Normal end 
Other than 0000H: Abnormal end 
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 Procedure of rewriting cam pattern data 
Step Operation by user programs and unit operation 

① 

Store necessary setting parameters in the cam pattern editing area. 
 Rewriting cam pattern number 
 No. of sections: following parameters in sections 1 to n (n is a specified number of sections.) 
 Start phase 
 Displacement 
 Cam curve number 

② Turn on the came table rewriting request (Y1103) from a ladder program. 

③ On the completion of rewriting, turn on the cam pattern rewriting completion annunciation (X1103) after 
storing a response code in "Cam table rewriting result". 

④ Once the cam table rewriting request (Y1103) turns off, the unit turns off the cam pattern rewriting 
completion annunciation flag (X1103). 

ON
OFF

ON
OFF

Cam table rewriting result

Cam table rewriting request
(Y1103)

Cam table rewriting done
annunciation (X1103)

0000h (Nomal completion)

Store necessary setting parameters
in the cam pattern editing area. ●Cam pattern editing area

Cam pattern edit no.

Sections 1 to n  Start phase
Displacement
Cam curve no.

Cam table
parameters

Request ON after storing the parameters

No. of sections

 

 Related positioning parameter 

Area Offset 
address Name Default Description 

Cam pattern 
editing area 
（No.3） 

59H 
Cam pattern 
rewriting 
result 

H0 

・Stores the result of rewriting processing 
(response code).  
[Range] (Hexadecimal) 
0000H: Normal end 
Other than 0000H: Abnormal end 
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 Sample program 
• The following program shows the case that the phase, displacement and the type of curve is 

changed in the section 3 of the cam table number 2. The first axis is set to the master axis, 
and the 2nd to 8th axes are set to slave axes. 

• Execute the synchronous cancel operation is executed for all the slave axes (axes 2 to 8). 
Confirm if all slave axes (axes 2 to 8) are not in the synchronous control and all axes are not 
activated. 

• Read the cam table, and change and rewrite the parameters. 

R0 X1100 Y1281

Y1282

Y1283

Y1284

X1281 R1

X1131 X1132 X1133 R2

X1282 X1283 X1284

X1134 X1135

R3
（ ）DF

R1 R2 X1102

Y1102

1

F0 MV DT100K2

DT100 H0K1H3F385 PTBLW

1

Y1102

ⓐ

ⓑ

ⓒ

②

④

⑤

④

③

① Y1285

Y1286

Y1287

X1285 X1286 X1287

X1136 X1137 X1130
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F20 + DT102K5000

HC DT101K3H3F384 PTBLR
X1102

（ ）DF

F20 + DT101K500

F0 MV DT103K11

DT101 HCK3H3F385 PTBLW

R4
（ ）DF

R1 R2 X1103

Y1103

ⓓ

ⓔ⑦

⑤

⑥

⑥

Y1103

 
Code Content specified by program Description 

ⓐ Synchronous control cancel for all axes Cancels the synchronous control for all slave axes. 

ⓑ Confirmation of execution permission 
condition 

Confirms that all slave axes are not in the synchronous control 
and all axes are stopped. 

ⓒ Cam table reading start Specifies a cam pattern number, and performs a reading 
request (Y1102). 

ⓓ Parameter change in cam table editing area 

Edits the cam table data in the section 3 after the completion 
of reading the cam table. In this example, start phase + 5%, 
displacement + 50%, and cam curve are set to constant 
acceleration. 

ⓔ Cam table rewriting start Performs the rewriting to a specified cam pattern data. 

 

Code Content specified by 
program 

Value specified in program 

Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 
(virtual) 

Axis 8 
(virtual) 

① Synchronous cancel 
request Y1280 Y1281 Y1282 Y1283 Y1284 Y1285 Y1286 Y1287 

② Synchronous cancel 
active annunciation X1280 X1281 X1282 X1283 X1284 X1285 X1286 X1287 

③ BUSY X1130 X1131 X1132 X1133 X1134 X1135 X1136 X1137 

④ Cam table reading 
request Y1102 

⑤ Cam table reading 
completion X1102 

⑥ Cam table rewriting 
request Y1103 

⑦ Cam table rewriting 
completion X1103 
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 Precautions for rewriting cam patterns by program 
• Even if cam pattern data is rewritten by this function, the cam pattern data of positioning 

parameters will not be updated. 

• It will be rewritten again to a cam pattern set on Configurator PM7 when the power turns on 
or configuration data is written and the PROG mode changes to RUN mode. As necessary, 
execute the rewriting of the cam pattern again by a program. 

• It is possible to confirm whether the cam pattern has been rewritten to the data of positioning 
parameters by a "cam pattern update flag". 

• When performing a reading request specifying an unregistered cam pattern number, all the 
read data will be "0". 

• When performing a rewriting request while no cam is registered (a resolution is 
undetermined), rewriting will be performed considering the resolution as 1024. 

• Cam adjustment data set on Configurator PM7 cannot be used. Also, when executing the 
rewriting, the adjustment data before the rewriting will be initialized. 

REFERENCE  
• For the details of "cam pattern update flag", refer to "26.4.5 Cam Pattern 

Editing Area (Memory Area No. 3)". 
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 Precautions when using phase shift amount  
○1  Specify the values when the phase shift amount is 0(%) for the parameter values of cam 
pattern (starting phase, displacement and cam curve). 

○2  The starting phase of the section number 1 is 0(%). When any values other than 0(%), an 
error will occur. For starting phases after the section number 2, specify arbitrary starting 
phases. When reading and writing settings, the closest phase will be automatically calculated 
within the unit from the resolution. 

○3  After setting the cam pattern when the phase shift amount is 0(%), set a phase shift 
amount. When reading and writing settings, the closest phase amount will be automatically 
calculated within the unit from the resolution. 

For rewriting the cam pattern set on the tool software Configurator PM7 to a user program, 
perform the following procedure. 

○5  Record the phase shift amount specified on Configurator PM7. 

○6  The phase shift amount has been added to the starting phase displayed on Configurator 
PM7. Set the phase shift amount to 0(%) to confirm the parameter values of cam pattern 
(starting phase, displacement, cam curve). 

○7  Use the parameter values acquired in ○6 on user programs. As for the starting phase, use 
values to two decimal places. 

○8  Set the phase shift amount recorded in ○5. As well as the starting phase, use values to two 
decimal places. 

 



12.6 Electronic Cam Function 

 
12-39 

12.6.5 Advance Angle Correction Function 

"Advance angle correction function" is a function to correct the delay in the response of a 
machine system connected to an electronic cam output or the delay in a PLC arithmetic 
processing time. This function is available for the unit of Ver.1.5 or later. 

 Specification of advance angle correction amount 
• Advance angle correction amounts are specified for each slave axis using a tool software or 

user program. 

• By setting "advance angle correction reference speed" and "advance angle correction 
reference amount", a correction amount is automatically calcuated using an active "master 
axis input speed". The advance angle correction amount is calculated by the following 
formula. 

Advance angle 
correction amount Master axis input speed

Advance angle correction 
reference amount 

Advance angle correction 
reference speed

Master axis input speed: Speed information after clutch control

= ×

 

 Internal processing of advance angle correction 
The phase of the master axis which will be a reference of slave axis correction is obtained as 
operation data for according to the set values of advance angle amount. A correction amount 
for each slave axis is calculated based on this value as a reference. 

t

t

Input axis phase

Output axis displacement Not corrected

Advance angle
correction amount

Advance the output of slave axes.

Corrected

Not corrected

Corrected

 
To the next page 
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 Setting with tool software 
Set in the synchronous control setting dialog box. 

 
Parameter name Overview 
Advance angle 
correction operation 
setting 

Select the use or non-use of the advance angle correction function. 

 Reference amount 
The unit follows the unit system of the master axis. 
Setting range: -2,147,482,624 to 2,147,482,624 (The decimal point position is based 
on unit systems.) 

 Reference speed 
The unit follows the unit system of the master axis. 
Setting range: 1 to 2,147,482,624 (The decimal point position is based on unit 
systems.) 

 Parameter change 
time Setting range: 1 to 10000 ms 

 Setting with user programs 
The following examples shows the case that the advance angle correction reference value of 
1st axis is changed to 50 and the advance angle correction reference speed to 3000. 

R1
（ ）DF

R0
（ ）DF F1 DMV DT100K50

DT100 H56K2H4F385 PTBLW

F0 MV DT102K3000

DT102 H58K2H4F385 PTBLW

①

③

②

①  

Code Content specified by 
program 

Value specified by program 

Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 
(virtual) 

Axis 8 
(virtual) 

① Axis no. and synchronous 
control setting area H4  H104 H204 H304 H404  H504 H604 H704 

② 
Advance angle correction 
reference amount setting 
area 

H56 

③ Advance angle correction 
reference speed setting area H58 
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 Changing the advance angle correction amount during operation 
• The advance angle correction amount can be changed during operation. 

• After the detection of the change in "advance angle correction reference speed" or "advance 
angle correction reference amount" by the unit, the advance angle correction amount will be 
reflected after the elapse of a specified "advance angle correction change time". 

1 100

100/100 200/100 50/100

t

Advance angle correction
parameter change time

(1ms)

Advance angle correction reference amount/�
Advance angle correction reference speed

Advance angle correction
parameter change time

Advance angle correction amount
Advance angle correction

parameter change time
(100ms)

④

①

②

③

 

 
• "Advance angle correction reference speed" and "Advance angle correction 

reference amount" are signed 32-bit data. If they are changed by 16-bit (1-
word) unit, they may be changed to uninteded values. Always perform the 
rewriting by 32-bit (2-word) unit. 

• When changing an "advance angle correction reference speed" or "advance 
angle correction reference amount" during operation, the timing that the 
unit acquires the changed "advance angle correction reference speed" or 
"advance angle correction reference amount" may deviates. Change either 
parameter of "advance angle correction reference speed" or "advance angle 
correction reference amount" to prevent the "advance angle correction 
amount" from being rapidly changed. 
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 Precautions for settings 
• Overshoot or undershoot may occur according to settings when sufficient 

acceleration/deceleration time is not set for the start or stop of master axis while the advance 
angle correction function is used, or when an input speed is rapidly accelerated or 
decelerated by the direct connection or disconnection of a clutch while the master axis is 
operated. 

• When using the advance angle correction function, set a sufficient acceleration/deceleration 
time on the master axis. When using the clutch function in combination, make the setting to 
prevent the occurrence of a rapid acceleration or deceleration using the slip function. 

t

t

t

t

Input axis phase

Output axis displacement

Master speed Master speed

Output axis displacement

Input axis phase

 

• Depending on the setting of "advance angle correction reference speed" or "advance angle 
correction reference amount", a calculated advance angle correction amount may exceed 
the "cam control synchronous master axis cycle". When the advance angle correction 
amount exceeds the "cam control synchronous master axis cycle", the "synchronous cam 
master axis cycle" will be the upper limit as below. Set the parameter of advance angle 
correction which meets an input speed. 
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13.1 Setting and Operation of JOG Operation 
The following example is explained with the JOG operation of axis-1. Settings are made in 
pulses. 

Table
Forward JOGReverse JOG

Ball screw

(-) side (+) side  

 Settings 
Parameters required for the JOG operation of the positioning unit is set in the positioning 
setting menu of the programming tool. 

Items Setting example 
Acceleration/deceleration pattern 0: Linear acceleration/deceleration 
Acceleration time (ms) 100 ms 

Deceleration time (ms) 100 ms 
Target speed 10000 pps 

 

 Operation diagram 

100 100

f [pps]

10000

100 100 t [ms]

Forward Reverse

Operation done flag X1140

Forward JOG contact Y1160

Reverse JOG contact Y1161

BUSY flag X1130

 

 Operation of each contact 
• The BUSY flag (X1130), which indicates that the motor is running, will turn ON when the 

positioning control starts, and it will turn OFF when the operation completes. 

• The operation done flag (X1140), which indicates the completion of operation, will turn ON 
when the current operation is completed, and it will be held until the next positioning control, 
JOG operation, home return, or pulser operation starts. 
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 Sample program 

X1100 X1104 X1230 R10

R2
（ ）DF /

Forward 
JOG

R11

Forward 
OFF edge

R3
（ ）DF /

Reverse 
JOG

R12

Reverse 
OFF edge

R2 R10 X1130 R11 Y1160

Start 
enable 
flag

Axis 1 
BUSY

Forward 
OFF edge

Axis 1 
forward 
JOGY1160

Axis 1 
forward JOG

R3 R10 X1130 R12 Y1161

Axis 1 
reverse 
JOGY1161

Axis 1 reverse 
JOG

Start enabled 
condition

Axis 1 forward 
JOG start

Axis 1 reverse 
JOG start

（ ）DF

（ ）DF

R0

Servo ON

Servo ON

R1

Servo OFF

Y1130

Axis 1 Servo 
OFF request

Servo OFF

Axis 1 Servo 
ON request

（ ）DF

（ ）DF

Y1120

X1180 X1120

Tool 
operation

Axis 1 
error

Position 
control start

Start enable 
flag

Axis 1 
connection 
confirmation

Axis 1 
servo lock

Link 
establishment 
annunciation

Forward 
JOG

Reverse 
JOG

Start 
enable 
flag

Axis 1 
BUSY

Reverse 
OFF edge

 

 Programming precautions 
The starting point and flag number vary with the axis number. 

 Operation at limit input 
Condition Direction Limit status Operation 

When JOG 
operation is 
executed 

Forward 
rotation 

Limit input (+): ON Not executable, Erro roccurs 
Limit input (-): ON Executable 

Reverse 
rotation 

Limit input (+): ON Executable 

Limit input (-): ON Not executable, Erro roccurs 
During JOG 
operation 

Forward 
rotation 

Limit input (+): ON Deceleration stop, Error occurs 

Reverse 
rotation 

Limit input (-): ON Deceleration stop, Error occurs 
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13.2 Speed Change During Operation 
The target speed can be changed while the positioning unit is in JOG operation. 

 Settings 
Parameters required for the JOG operation of the positioning unit is set in the positioning 
setting menu of the programming tool. 

Items Setting example 
Acceleration/deceleration pattern 0: Linear acceleration/deceleration 
Acceleration time 1 (ms) 100 ms 
Deceleration time 1 (ms) 50 ms 

Target speed 1 10000 pps 
Acceleration time 2 (ms) 200 ms The set values of acceleration time, deceleration time, and 

target speed after the speed change are 
 written to the unit memory by the program. 

Deceleration time 2 (ms) 150 ms 
Target speed 2 20000 pps 

 Operation diagram 

100

f [pps]

10000

20000

200 150 t [ms]

Writing the target speed 2

Operation done flag X1140

JOG forward contact Y1160

BUSY flag X1130

 

 Operation of each contact 
• The BUSY flag (X1130), which indicates that the motor is running, will turn ON when the Jog 

operation starts, and it will turn OFF when the operation completes. 

• The target speed can be changed freely while the positioning unit is in JOG operation. Use a 
program to change the target speed. 

• The operation done flag (X1140), which indicates the completion of operation, will turn ON 
when the current operation is completed, and it will be held until the next positioning control, 
JOG operation, home return, or pulser operation starts. 
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 Sample program 

X1100 X1104 X1230 R10

R2
（ ）DF /

R11

R2 R10 X1130 R11 Y1160

Axis 1 
forward 
JOGY1160

Axis 1 
forward JOG

R4

Speed 
change

F0 MV K200 DT100

F0 MV K150 DT101

F1 DMV K20000 DT102

Start enabled 
condition

Rewrite 
acceleration time, 
deceleration time, 
target speed

Axis 1 forward 
JOG start

（ ）DF

（ ）DF

DT100 K4 H2AAxis 1, 
each axis 
setting 
area

F385 PTBLW H2
4 words JOG accelera-

tion time 
setting area

JOG acceleration 
time 2

JOG target speed 2
Specify JOG 
acceleration time 
setting area

R0
Servo ON

R1 Y1130
Servo OFF

（ ）DF

（ ）DF

Y1120

X1180 X1120

Servo ON

Servo OFF

Tool 
operation

Axis 1 
error

Axis 1 
connection 
confirmation

Axis 1 
servo lock

Link 
establishment 
annunciation

Forward 
JOG

Start 
enable 
flag

Axis 1 
BUSY

Forward 
OFF edge

Forward 
JOG

Forward 
OFF edge

Axis 1 Servo 
OFF request

Axis 1 Servo 
ON request

Start enable 
flag

JOG deceleration 
time 2

 

 Programming precautions 
• To change the JOG operation speed, use a user program and rewrite the unit memory (H2A-

H2D). The following contents are set with user programs at each addresses of the 
positioning memory; (H2A: JOG acceleration time, H2B: JOG deceleration time, H2C-H2D: 
target speed) 

• The starting point and flag number vary with the axis number. 
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14.1 Type of Home Return 
The home return is a function to move the current position to the reference origin and set the 
coordinates as 0. 

There the following home return modes for your selection. 

 DOG method 1 (Edge detection of near home switch + First rising edge of home 
position as reference) 

The first rising edge of home position (Z phase) is detected after detecting the rising edge of 
the near home switch (DOG). It becomes the start point. 

The starting point is
between the near home
switch and limit (+) input.
(including limit (+) input)

①

The starting point is
between the near home
switch and limit (-) input.

③

The starting point is on the
near home switch.

Limit (-) input

Z phase

Target speed

Home return creep speed

Home return creep speed

Home return creep speed

Target speed

Target speed

Target speed

Target speed Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Limit (+) input

Limit stop
deceleration time

Near home switch

Home return direction

②

The starting point is on the
limit (-) input.

④

 
Note) When the home sensor is ON at startup, the operation is similar to ○2 . 
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 DOG method 2 (Edge detection of near home switch) 
The rising edge of the near home switch (DOG) is detected. It becomes the start point. 

Target speed

Target speed

Target speed

Target speed

Target speed

Limit stop
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return creep speed

Home return creep speed

Home return creep speed

Home return creep speed

Limit (-) input Limit (+) inputNear home switch

Home return direction

The starting point is
between the near home
switch and limit (+) input.
(including limit (+) input)

The starting point is
between the near home
switch and limit (-) input.

The starting point is on the
near home switch.

The starting point is on the
limit (-) input.

①

③

②

④

 

 DOG method 3 (Edge detection of near home switch + Falling edge of home position 
as reference) 

The falling edge of the near home switch (DOG) is detected. The first rising edge (Z phase) of 
the home switch in the home return direction becomes the start point. 

Limit (-) input Limit (+) inputNear home switch

Home return direction

The starting point is
between the near home
switch and limit (+) input.

The starting point is
between the near home
switch and limit (-) input.

The starting point is on the
near home switch.

The starting point is on the
limit (-) input.

①

③

②

④

Z phase

Home return creep speed

Home return creep speed

Home return creep speed

Home return creep speed

Target speed

Target speed

Target speed

Limit stop
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

 
Note) When the home sensor is ON at startup, the operation is similar to ○3 . 
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 Limit method 1 (Edge detection of limit switch + First rising edge of home position 
as reference) 

Reverses after detecting the rising edge of the limit switch on the opposite side of the home 
return direction. The first rising edge of the home switch is detected. It becomes the start point. 

Limit (-) input Limit (+) input

Home return direction

Z phase

The starting point is any
points other than the limit
(+) input.

The starting point is on the
limit (+) input.

①

②

Home return creep speed

Home return creep speed

Target speed Home return
deceleration time

 

 Limit method 2 (Edge detection of limit switch) 
Detects the rising edge of the limit switch in the home return direction and stops. That point 
becomes the start point. 

Limit (-) input Limit (+) input

Home return direction

Target speed
The starting point is any
points other than the limit
(-) input.

The starting point is on the
limit (-) input.

①

②

Home return creep speed

Home return creep speed

Target speed

Home return
deceleration time

 

 Z phase method (Edge detection of home switch) 
Moves from the current position in the home return direction, and detects the first rising edge 
of the home switch and stops. That point becomes the start point. 

Home return directionHome switch

Home return creep speed

 
Note) When the home sensor is ON at startup, the unit does not detect the home sensor and operates to the home 

return direction. 
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 Stop-on-contact method 1 
The position reached after a constant time has passed at the torque value higher than a 
specified value using an automatic stop mechanism such as a stopper is regarded as a home 
position. 

Home return creep sped

Home return direction

Stopper, etc
 

 Stop-on-contact method 2 
Performs the reverse operation after the stop by a stopper and stops at the position where the 
first home position (Z phase) is detected although the operation is similar to the stop-on-
contact method. This position is set as a home position. 

Home return direction

Z phase

Stopper, etc

Home return creep speed

Home return creep speed  

 Data setting mode 
Set the current value as a home position.  

Home position (= Current value)
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14.2 Setting and Operaion of Home Return 
The following example is explained with the home return of axis-1. Settings are made in 
pulses. 

Table

Ball screw

Home return

Near home switch(-) side

Home position

(+) side

 

 Settings 
Parameters required for setting home return are set in the position control menu of the 
programming tool. 

Item Setting Example 
Reset setting code 0: DOG mode 1 
Reset direction 0: Reset (－) direction 

Acceleration time (ms) 100 ms 
Deceleration time (ms) 100 ms 
Target speed 10,000 pps 

Reset creep speed 1000 pps 
ON time of the deviation counter 
removal signal 1000 pps 

 Operation diagram 
Target speed

Detect

Home return creep speed

Home return start contact Y1150

Near home input

Z phase

Home return done flag X1150

BUSY flag X1130
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 Operation of each contact 
• The BUSY flag (X1130) indicating the state that a motor is running will turn ON when the 

home return of the positioning unit starts, and it will turn OFF when the operation completes. 

• The home return done flag (X1150) indicating the state of operation completion will turn ON 
when the home return operation is completed, and it will be held until the next positioning 
control, JOG operation, home return, or pulser operation starts. The timing of that the flag 
turns ON is at the time that the home return operation is completed. 

 Sample program 

X1100 X1104 X1230 R10

R2

Start enable 
flag

Home return

Y1150

Axis 1 home 
position 
start

R10 X1130

Start enable 
flag

Axis 1 
BUSY

Start enabled 
condition

Home position 
start

（ ）DF

R0
Servo ON

R1 Y1130

Axis 1 Servo 
OFF request

Servo OFF

Axis 1 Servo 
ON request

（ ）DF

（ ）DF

Y1120

X1180 X1120

Servo ON

Servo OFF

Tool 
operation

Axis 1 
error

Axis 1 
connection 
confirmation

Axis 1 
servo lock

Link 
establishment 
annunciation

 

 Programming precautions 
• The starting point and flag number vary with the axis number. 

 Limit Input Operation 
Condition Direction Limit status Operation 

When Home return 
operation is 
executed 

Forward rotation Limit input (+): ON Executable 
Limit input (-): ON Executable 

Reverse rotation Limit input (+): ON Executable 
Limit input (-): ON Executable 

During Home 
return operation 

Forward rotation Limit input (+): ON Automatic reverse operation 
Reverse rotation Limit input (-): ON Automatic reverse operation 



Manual Operation 
(Home Return) 
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15.1 Pulse Input 

15.1.1 Pulse input application 

Pulse inputs can be used for the following applications. The application is selected in the 
"Pulse input" setting dialog box of Configurator PM7. 

 

 Specifications 
Item Description 

Number of channels Max. 4 channels (Used in combination with the pulsar input and high-speed counter.) 
Counting range Counting range:  -2,147,483,648 to 2,147,483,647 pulses 

Input mode Phase difference input, Direction detection input, Individual input (Multiplication function 
available for each.) 

 Pulse input application 
Input object Description 

Pulsar 
 Set when using the manual pulsar. 
 The pulsar of a specific axis can be specified with the pulsar operation setting code. 

High-speed counter 
 Set when used for the general-purpose counter input. 
 Various input methods (2-phase input, direction detection input, individual input). 
 The unit stores the number of input pulses in the monitor area. 

 Combination restrictions based on application 

Pulse input mode 
Pulse input application 

Pulsar High-speed 
counter 

Input mode 

2-phase input Available Available 
Direction 
detection input Not available Available 

Individual input Not available Available 

Multiplication 

1 X Not available Available 

2 X Not available Available 

4 X Available Available (Note) 
(Note): Only settable for 2-phase input. 
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15.1.2 Selection of Pulse Input Applications 

The applications and methods of pulse input circuits are selected in the "Pulse input setting" 
dialog box of Configurator PM7.  

 

 Setting item 
Item Default Settable range 
Pulse input application 0: Pulsar 0: Pulsar, 2: High-speed counter 
Pulse input rotation 
direction 0: Forward 0: Forward, 1: Reverse 

Pulse input method 0: 2-phase input 0: 2-phase input, 1: Direction detection input (Pulse/Sign), 2: 
Individual input (CW/CCW) 

Pulse input 
multiplication 2: Multiply by 4 0: Multiply by 1, 1: Multiply by 2, 2: Multiply by 4 

Input time constant 0: No input time 
constant 

0: No input time constant, 1: 0.1us, 2: 0.5us, 3: 1.0us, 4: 2.0us, 5: 
10.0us 
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15.1.3 Input mode of pulse input 

• You can select from the following 3 modes depending on the input device to be connected. 

• The counting operation changes according to the settings of multiplier as shown in the 
following page. 

 Input mode 
Mode Connection Counting 

2-phase 
(phase 
difference) 

单元

Input A

Input C

Input BRelative value encoder

Pulse input of phase A

Pulse input of phase B

Pulse input of phase
Z (reset input)

Unit

Input A

Input C

Input BIncremental
encoder

Pulse input of
phase A

Pulse input of
phase B

Pulse input of phase
Z (reset input)

 

 The 2-phase input connects the 
input A signal and input B signal of 
each counter to the input A signal 
and input B signal of corresponding 
encoder.  
 The counting direction depends on 
the phase difference between Phase 
A and Phase B. If Phase A leads over 
Phase B (electronic angle at 90°), 
add the counted value; and if Phase 
A lags behind Phase B (electronic 
angle at 90°), subtract the counted 
value. 

Direction 
detection 

Input A

Input A

Incremental
encoder or pulse
generator Pulse input

Counting direction

Sensor
or
switch

Unit

 

 During direction detection input, 
counting signal is connected with 
input A signal. The counting direction 
is controlled by the level of the 
direction signal of input B signal. 
 If input B signal is turned OFF, the 
counter will perform addition 
operation when input A signal is on 
the rising edge or falling edge,  and 
perform subtraction operation when 
input B is on the rising edge or falling 
edge. 

Individual 

Unit

Input A

Input B

Incremental
encoder or pulse
generator Addition pulse input

Subtraction pulse input

Incremental
encoder or pulse
generator

 

 For individual input, the counter will 
perform addition operation when 
input A signal is on the rising edge or 
falling edge and subtraction operation 
when input B is on the rising edge or 
falling edge. 
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 Counting operation of 2-phase input (phase difference input) 

Multiple 
Time chart 

 Addition Subtraction 

1 X 

0 1 2 3 2 1 0

ON
Input A

OFF

ON
Input B

OFF

 

2 X 

2 1 05 5 4 360 1 2 3 4

ON
Input A

OFF

ON
Input B

OFF

 

4 X 

1 2 3 4 5 6 7 11 100 12 5 49 88 9 10 11 1 03 27 6

Input B
OFF
ON

ON
Input A

OFF

 

 Counting operation for individual input 

Multiple 
Time chart 

 Addition Subtraction 

1 X 

0 1 2 3 2 1 0

Input A

Input B

ON
OFF
ON
OFF

 

2 X 

0 1 2 3 4 5 6 5 04 3 2 1

Input A
OFF

ON
Input B

OFF

ON

 

 Counting operation for direction detection input 

Multiple 
Time chart 

 Addition Subtraction 

1 X 

2 1 0

ON
Input A

OFF

0 1 2 3

ON
Input B

OFF

 

2 X 

0 1 2 3 4 5 6 5 4 3 2 1 0

ON
Input B

OFF

ON
Input A

OFF
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15.1.4 Monitoring of Pulse Input Values 

• Pulse input values are saved in the positioning memory (Area no.0/Address H3C0-H3C7). 
Pulse input values can be read and monitored via user program.  

• Save pulse input values corresponding to the purposes of pulse input (pulsar, and high-
speed counter). (Unit: pulse) 

• Accumulated save pulse input values and clear the pulse input values after the pulse input 
purposes are changed or the pulse input values are cleared. 

 Sample program 
An example for monitoring the pulse input value of Axis-1 is given below. 

R0
H3C0 DT200K2
②

H0F384 PTBLR
①

 

Symbols Specified content of program Specified value of program 
CH1 CH2 CH3 CH4 

① Common area H0 

② Pulse input value area H3C0 H3C2 H3C4 H3C6 

15.1.5 Pulse Input Value Change Function 

When the pulse input purpose is set to "high-speed counter", it is allowed to change the pulse 
input values saved in the positioning memory according to the user program. 

 Pulse counting control area (positioning memory area no. 0) 
Offset 
Address 
(Hex) 

Name Description 

H3A9 Request flag for 
pulse count change 

 When the bit corresponding to each axis turns from 0 to 1, change 
the pulse input value to the preset pulse count change value. 
 This symbol is a pulse edge trigger. Please remember to turn 0 to 1 
before the change. 
 After the change, the unit controller will automatically clear the 
corresponding bit. 

bit Name Initial 
value Description 

0 CH1 pulse count change 0 
0: Pulse input value not 

changed 
0→1: Pulse input value 

changed 

1 CH2 pulse count change 0 

2 CH3 pulse count change 0 
3 CH4 pulse count change 0 

15-4 － － － 
 

H3B0- H3B1 Pulse input change 
value of CH1 Sets the pulse input value to be changed for CH1 

H3B2- H3B3 Pulse input change 
value of CH2 Sets the pulse input value to be changed for CH2 

H3B4- H3B5 Pulse input change 
value of CH3 Sets the pulse input value to be changed for CH3 

H3B6- H3B7 Pulse input change 
value of CH4 Sets the pulse input value to be changed for CH4 
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 Sample program 
• An example for presetting the pulse input value of CH1 to any value K0 is given below. Read 

the pulse input value from the 1st line of the program for monitoring.  

• Preset the pulse input value in corresponding positioning memory and set the change value 
request flag of corresponding channel. After the input value is changed, the change request 
flat area (positioning memory area no.0/address H3A9) will be cleared. 

R2
（ ）DF

R1
（ ）DF

ⓑ

F1 DMV DT100K0

DT100 H3B0K2H0F385 PTBLW

ⓒ

F0 MV DT102H1

DT102 H3A9K1H0F385 PTBLW

R9010
ⓐH3C0 DT0K2H0F384 PTBLR

①

⑦

⑥

⑤④

④

③

②

 
 

Symbols Specified content of program 
Specified value of program 

CH1 CH2 CH3 CH4 
① Common area H0 

② Area in which pulse input values are 
stored H3C0  H3C2 H3C4 H3C6 

③ Change value Any value 

④ Common area H0 

⑤ Pulse count value change value area H3B0 H3B2 H3B4 H3B6 

⑥ Set value for the pulse count value 
change request flag area H1 H2 H4 H8 

⑦ Pulse count value change request 
flag area H3A9 

ⓐ Reading of pulse input value 

ⓑ Write the preset values saved in the pulse input value area into the positioning memory 

ⓒ Write the values to the positioning memory according to the request for pulse input 
change 
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15.2 Setting and Operation of Pulsar 

15.2.1 Overview 

This function is used to connect axes by manual operation via the pulsars connected to the 
pulse input connectors of FP-XH M8N Control Unit. 

• Pulsars for a maximum of 4 channels can be connected. 

• The pulsar operation for a maximum of 8 axes can be performed. For each axis, a pulsar 
connected as an internal signal can be selected. Multiple channels can be activated 
simultaneously with one pulsar. 

 Pulsar input method 
Operation 

mode Operation 

Standard 
operation 

The operation to obtain the number of pulses of the pulsar in the unit of 1ms. 
The input content of the pulsar is directly reflected to the actual operation. 

Speed 
restriction 
(pulse hold) 

The input speed of the pulsar will be held at the preset max. speed if is to exceed the max. 
speed. 
Hold the number of pulses inputted by the pulsar. Because pulses that cannot be outputted will 
also be maintained, the pulses will still be outputted even if there's no input of the pulsar. 
The speed unit is "(the set unit X 1000)/s". 

Speed 
restriction 
(time hold) 

The input speed of the pulsar will be held at the preset max. speed if is to exceed the max. 
speed. 
Pulses that are cannot be outputted will be discarded, and the pulse output is interlocked with 
the operations of the pulsar. 
The speed unit is "(the set unit X 1000)/s". 

Pulsar input
(kHz)

Standard
operation

Speed restriction
(pulse hold)

Speed restriction
(time hold)

Pulse output (kHz)

Max. speed (kHz)

Min. speed (kHz)
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15.2.2 Settings for Pulsar Operation 

For using the pulsar operation, set the parameters in the two dialog boxes "Pulse input" and 
"Parameter settings" of Configurator PM7. 

 Pulse input setting 
Select "Pulsar" from the items of pulse input application. 

 
 

Item Setting example Settable range 
Pulse input application 0: Pulsar 0: Pulsar 
Pulse input rotation 
direction 0: Forward 0: Forward, 1: Reverse 

Pulse input method 0: 2-phase input When using the pulsar, only "0: 2-phase input" can be set. 
Pulse input multiplication 2: Multiply by 4 When using the pulsar, only "2: Multiply by 4" can be set. 

 Parameter settings menu 
• For the item of the "pulsar operation code" of the axis on which the pulsar operation is 

performed, select the channel number of the connected pulse input. 

• The movement amount per an 1-pulse signal from the pulsar can be changed by setting the 
ratio numerator and ratio denominator for the input signal of the pulsar. 

 

 
 

Item Setting example Settable range 

Operation setting code 0: Pulse input CH1 0: Pulsar input CH1, 1: Pulsar input CH2, 2: Pulsar input 
CH3, 3: Pulsar input CH4 

Pulsar operation ratio 
numerator 2 1-32,767 

Pulsar operation ratio 
denominator 1 1-32,767 

Pulsar input method 2: Speed restriction (time 
hold) 

0:Standard operation , 1: Speed restriction (pulse hold), 2: 
Speed restriction (time hold) 

Pulsar operation maximum 
speed 500 pulse: 0 -2,147,482,624 pps 
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15.2.3 Operation of Pulsar 

The following example is explained with the pulsar operation of axis-1. Settings are made in 
pulses. 

Table

Manual pulser

(-) side (+) side

Ball screw

 

 Operation diagram 

 

 Operation of each contact 
• The BUSY flag (X1130) indicating the state that a motor is running will turn ON when the 

pulser operation permit contact turns ON and will turn OFF when the contact turns OFF. 

• The operation done flag (X1140) indicating the state of operation completion will turn ON 
when the pulser operation permit contact is turned OFF and the flag will be maintained until 
the next positioning control, JOG operation, home return, or pulser operation starts. 
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 Sample program 

X1100 X1104 X1230 R10

R2

Start enable 
flag

（ ）DF /
Pulsar 

operation

R11

Pulsar OFF 
edge

R2 R10 X1130 R11 Y1200

Start 
enable 

flag

Axis 1 
BUSY

Pulsar OFF 
edge

Axis 1 
pulsar 

enabled

Pulsar 
operation
Y1200

Axis 1 pulsar 
enabled

Start enabled 
condition

Axis 1 pulsar 
enabled（ ）DF

R0
Servo ON

R1 Y1130

Axis 1 Servo 
OFF request

Servo OFF

Axis 1 Servo 
ON request

（ ）DF

（ ）DF

Y1120

X1180 X1120

Servo ON

Servo OFF

Tool 
operation

Axis 1 
error

Axis 1 
connection 
confirmation

Axis 1 
servo lock

Link 
establishment 
annunciation

 
 

 Programming precautions 
• The starting point and flag number vary with the axis number. 

 Limit Input Operation 
Condition Direction Limit status Operation 

When Pulsar 
operation is 
executed 

Forward rotation Limit input (+): ON Not executable, Error occurs. 

Limit input (-): ON Executable 
Reverse rotation Limit input (+): ON Executable 

Limit input (-): ON Not executable, Error occurs. 
During Pulsar 
operation 

Forward rotation Limit input (+): ON Deceleration stop, Error occurs. 
Reverse rotation Limit input (-): ON Deceleration stop, Error occurs. 
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15.3 Pulse Input / High-speed Counter Function 

15.3.1 Overview 

The control unit can use the pulse inputs as external counters by setting the pulse input 
application to "High-speed counter". 

REFERENCE  
• For the details of monitoring count values, refer to "15.1.4 Monitoring of 

Pulse Input Values". 

• For the details of the methods to preset count values, refer to "15.1.5 Pulse 
Input Value Change Function". 

15.3.2 Settings When Using High-speed Counter 

For using the pulse input function as the high-speed counter, make the setting in the "pulse 
input" dialog box of Configurator PM7. 

 Pulse input setting 
Select "High-speed counter" from the items of pulse input application. 

 
Item Setting example Settable range 

Pulse input application 2: High-speed 
counter 2: High-speed counter 

Pulse input rotation 
direction 0: Forward 0: Forward, 1: Reverse 

Pulse input method 0: 2-phase input 0: 2-phase input, 1: Direction detection input (Pulse/Sign), 2: 
Individual input (CW/CCW) 

Pulse input 
multiplication 2: Multiply by 4 0: Multiply by 1, 1: Multiply by 2, 2: Multiply by 4 

Input time constant 0: No input time 
constant 

0: No input time constant, 1: 0.1us, 2: 0.5us, 3: 1.0us, 4: 2.0us, 5: 
10.0us 
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KEY POINTS
 

• For using the pulse input as the master axis of synchronous control, select 
an arbitrary pulse input channel from the "Select synchronous master axis" 
of the "Synchronous parameter settings" dialog box. 

 

15.3.3 Count Disable/Enable Control 

 Control of pulse inputs 
• When selecting "High-speed counter" for the pulse input application, the count of the pulse 

input value can be stopped arbitrarily. While the count of the pulse input value stoaps, the 
current pulse input value is held. 

• The setting to disable/enable the count of pulse inputs is made by writing to the following 
area with user programs. 

 Program example 
The following shows the example which disables the pulse input of the first axis when the 
execution condition R0 is ON. 

R0
F0 MV DT100H1

①

DT100 H3A8K1
③

H0F385 PTBLW
②  

Code Description 
Value specified in program 

CH1 CH2 CH3 CH4 

① Value corresponding to the axis that 
the count is disabled 

H1 
（bit0） 

H2 
（bit1） 

H4 
（bit2） 

H8 
（bit3） 

② Common area H0 

③ Pulse count enable flag area H3A8 
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16.1 Types and Settings of Stop Function 

16.1.1 Type of Stop Operations 

• The following seven stop operations are available. 

• The system stop, emergency stop, deceleration stop, and pause will be effective when 
allocated output signals turn ON by user programs. 

• The limit stop, software limit stop, and error stop will be effective when corresponding 
conditions are established. 

 Type of operation stop 
Name Time chart Occurrence Conditions and Operation 

System 
stop 

 

E

 

 When the system stop contact (Y1100) is set 
to ON, stop the operation of all axes 
immediately. 
 Stop at 1 ms deceleration time. 
 Perform the same action when the Operation 
pattern of the control unit is switched to PROG. 
from RUN. 

Emergency 
stop 

E

Emergency-stop deceleration time

 

 When the system stop contacts (Y1180-
Y1187) are set to ON, stop the started operation 
and the pulse output of the corresponding axis. 
 Set the deceleration time of emergency stop 
in the settings of the parameters in the 
Configurator PM7. 

Limit 
stop 

E

Limit-stop deceleration time

 

 When the limit＋input and limit-input (Y1200-
Y120F) are set to ON, stop the operation of the 
corresponding axis. 
 Set the deceleration time of limit stop to be set 
in the settings of the parameters for 
deceleration. 

Software 
limit 
stop 

E

Error stop deceleration time

 

 When the software limit function is enabled, if 
the software limit range is exceeded, the 
operation that is already started will be stopped 
along with the operation of corresponding axis.  
 Performs a deceleration stop in the "error stop 
deceleration time" specified in the parameter 
settings menu of Configurator PM7 

Error 
stop 

 In case of self-diagnosis error (error code 44: 
position control operation error), the operation of 
corresponding axes (all axes or various axes) 
are stopped.  (Note 1) 
 Performs a deceleration stop in the "error stop 
deceleration time" specified in the parameter 
settings menu of Configurator PM7. 

(Note 1): Upon self-diagnosis error other than the position control operation error, the mode will change to PROG. 
and the system will be stopped.  However, the mode when a self-diagnostic error occurs varies according to the 
settings of system registers. 
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Name Real-time Charts Occurrence Conditions and Operation 

Deceleration 
stop  
(Note 1) E

Deceleration time

 

 When the deceleration stop (Y1190-Y1197) is 
set to ON, stop the started operation and the 
operation of the corresponding axis. 
 Set the deceleration time to be set in the 
starting position control operation for 
deceleration. 

Pause 
(Note 1) 

Deceleration time

Stop canceled  

 When the deceleration stop (Y1190-Y1197) is 
set to ON, stop the started operation and the 
operation of the corresponding axis. 
 Set the deceleration time to be set in the 
starting position control operation for 
deceleration. 
 When the deceleration stop signal if OFF, the 
stop control is executed again after cancellation 
of the deceleration stop.  

(Note 1): The deceleration stop and pause function set the system operation setting area of the positioning memory 
and switch the operations with the user program. 

 I/O signal assignment 

Signal name 
I/O number 

Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis Axis 7 
(virtual) 

Axis 8 
(virtual) 

System stop Y1100 
Emergency stop (The 
operation is the level type.) Y1180 Y1181 Y1182 Y1183 Y1184 Y1185 Y1186 Y1187 

Deceleration stop (The 
operation is the level type.) Y1190 Y1191 Y1192 Y1193 Y1194 Y1195 Y1196 Y1197 

(Note 1): During interpolation control, please turn the contact corresponding to the min. axis number in the 
interpolation group. 

16.1.2 Stop Tme Settings 

Each stop time is specified for each axis on Configurator PM7. 

 Stop time settings 

 
 

Item Description 
Emergency stop 
deceleration time 

Set the deceleration time at the time of emergency stop. 0 to 10000ms  (Default: 100 
ms) 

Limit stop 
deceleration time 

Set the deceleration time at the time of limit stop and software limit stop. 0 to 10000ms  
(Default: 100 ms) 

Error stop 
deceleration time Set the deceleration time at the time of error stop. 0 to 10000ms  (Default: 100 ms) 
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16.2 Operation During Stop 

 Operation during stop 
• The system stp, emergency stop, deceleration stop and pause is performed by turning on 

each request contact in the I/O area. 

• The stopped state is held while each contact is on until each request signal turns off. Any 
operation cannot be performed in the stopped state. It is also the same in the cases of limit 
stop, software limit stop and error stop. 

 Priority of stop operations 
• When stop control requests are made simultaneously, the stop operations will be executed 

according to the following priority. 

(1) System stop > (2) Error stop / Software limit stop / Limit stop > (3) Emergency stop > (4) 
Pause > (5) Deceleration stop 
- The priorities of the error stop, software limit stop and limit stop are the same. 
- In case of the same priorities, the axes will stop at the stop time previously occurred.  

 Dwell time setting 
• The dwell time setting is invalid in the stop operations regardless of patterns. 

• However, the dwell time setting is invalid in the positioning operation after a pause. 

 Flag processing 
• In the case of system stop, the busy signal turns off and the operation done signal turns on. 

• In the cases of emergency stop, limit stop, software limit stop, error stop and deceleration 
stop, the busy signal turns off and the operation done signal turns on after the completion of 
deceleration. 

 Current value coordinate 
• Even in a stop operation, the current value coordinate area is always updated. 

• After the emergency stop, limit stop, software limit stop, error stop, deceleration stop or 
pause, deceleration is performed with each specified deceleration time, and the value when 
the operation stops is stored. 

• In the case of system stop, the value whe the operation stops is stored. 
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16.3 Pause Function 

16.3.1 Pause Function 

• The pause function temporarily stops operation. Toggle between the pause function and the 
deceleration stop function for use. 

• The pause function performs a deceleration stop in the deceleration time of operation when 
the deceleration stop request contact turns ON. After that, the stopped state is kept while the 
deceleration stop request contact (Y1190 to Y1197) is on, and the control stopped is 
restarted by turning off the deceleration stop request contact. 

KEY POINTS
 

• No deceleration stop can be executed while the pause function is in use. 
Use the emergency stop function in the case of executing a stop while the 
pause function is in use. 

• The pause function is enabled only when the positioning unit is in 
automatic operation (positioning control). During a manual operation (JOG 
operation/home return/pulsar operation), it is the same operation as a 
deceleration stop. 

• Like other stop functions, the pause function will maintain the stop state 
while the deceleration stop (pause) request signal is ON. The pause will be 
canceled if an emergency stop or system stop is executed while the 
positioning unit is not operating, and the positioning unit will go into the 
emergency stop or system stop state. 

16.3.2 Pause Settings 

• Deceleration stop and pause set the system operation setting area of the positioning 
memory (positioning memory area no.0/Address H389) and switch the operations with the 
user program. 

 System operation setting area (positioning memory area no.3) 
Offset 
Address 
(Hex) 

Name Initial 
value Description 

Common 
area 
H389 

Deceleration 
stop operation 0 

Operate when the deceleration stop request signal is Active (OFF⇒
ON). 
0: Deceleration stop 
During repetition, the operation stops to the E-point of the object of 
repetition. 
1: Pause 
 Perform deceleration stop, and resume position control when the 
"deceleration stop request signal" is canceled (ON⇒OFF).  
 All operations are the same to that of deceleration stop for cases 
other than position control operation. 
 During repetition, the operation stops till the E-point of the object of 
repetition, and resumes when the "deceleration stop request signal" is 
canceled (ON⇒OFF).  
 If system stop or emergency stop is executed during pause, the 
pause will be canceled and the operation will not be resumed even if 
the "deceleration stop request signal" is canceled (ON⇒OFF).  



Stop Function 

16-6 

 Sample program 
• Operation when the deceleration stop contact of axis-1 is turned ON. 

• Set parameters corresponding to the operation in the system operation area (positioning 
memory area no.0/Address H389). 

R2
（ ）DF

R1
（ ）DF

ⓐ

F0 MV DT100H1

DT100 H389K1H0F385 PTBLW

ⓑ

F0 MV DT101H0

DT101 H389K1H0F385 PTBLW
③

①

③②

②

①

R0
ⓒ

Y1190

④  

Cod
e Description 

Value specified in program 

Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 
(virtual) 

Axis 8 
(virtual) 

① Parameter values for switching 
operations H0: Deceleration stop operation, H1: Pause operation 

② Common area H0 

③ System stop H389 

④ Deceleration stop (The 
operation is the level type.) Y1190 Y1191 Y1192 Y1193 Y1194 Y1195 Y1196 Y1197 

ⓐ Switch the operation to pause when the deceleration stop contact turns ON 

ⓑ Switch the operation to deceleration stop when the deceleration stop contact turns ON 

ⓒ Perform deceleration stop or pause 
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17.1 Dwell Time 
The time taken until the next operation after the completion of an executed positioning table in 
the automatic operation is called dwell time. 

 Operation pattern and dwell time 
Operation 
pattern Dwell time and operation 

E-point 
control 

BUSY flag

Action Completion

Dwell time

 

The dwell time is the time 
taken from the completion of 
the position reference until the 
operation done flag turns ON. 

P-point 
control 

BUSY flag

Action Completion

Dwell time

 

While the positioning unit is in 
P-point control, the positioning 
table will operate 
consecutively, and the dwell 
time will be invalid. For the last 
table (E point), like E-point 
control, dwell time is a period 
required from the completion of 
the position reference until the 
operation done flag turns ON. 

C-point 
control 

BUSY flag

Action Completion

Dwell timeDwell timeDwell time

 

The dwell time is the waiting 
time for executing the next 
table from the completion of 
the positioning table 
(deceleration stop). For the last 
table (E point), like E-point 
control, dwell time is a period 
required from the completion of 
the position reference until the 
operation done flag turns ON. 

 Setting of the dwell time 
• The dwell time is designated in the position control data tables via the Configurator PM7 

• It is allowed to set each data table of position control data within the range of 0-32767 (ms). 
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17.2 Software Limit 

 Software limit functions 
The system is designed to mechanically set the limit (+) and limit (-) to restrict the moving 
range of a motor. 

Separately from the mechanical limits (+) and (-), the software limit is a function to add the 
limits for the absolute coordinate managed within the positioning unit. As the software limit is a 
function for the protection of the motor, servo amplifier and motor driver, it is recommended to 
set them to the values within the range of the mechanical limits (+) and (-) as below. 

Table

(-) side (+) side

Limit (+)

Ball screw

Limit (-)

Lower  limit value of
software limit

Upper  limit value
of software limit

 

If the operating range of the motor exceeds the setting range of the software limit (upper and 
lower limit values), an error will occur, and the deceleration stop will be executed. It is 
necessary to clear the error and move the motor into the range of the software limit using an 
operation such as JOG operation after the stop. 

Table

(-) side (+) side

Lower limit value of
software limit

The table can move within the setting
range of the software limit.

 

 Software limit settings 
• Software limit can be enabled/disabled in the Parameter Settings dialog box of Configurator 

PM7 by axis. 

• Software limit can be enabled/disabled separately for position control, home return and JOG 
operation. For example, you can enable software limit during home return and JOG 
operation 
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17.3 Auxiliary Output 

17.3.1 Auxiliary Output Function 

• Auxiliary output is the function to notify the outside of which data is being executed during 
automatic operation (E-point control, C-point control, P-point control and J-point control). 

• Auxiliary output contacts and auxiliary output codes vary depending on data tables in 
execution.  

• Values of auxiliary output codes can be held to the next position control data table for 
execution. In addition, upon completion of auto operation, the auxiliary output codes just 
outputted will be held.  

P E

1H 2H

1H 2H

Busy flag

Operation done flag

Auxiliary output data

Auxiliary output data

Auxiliary contact flag

Auxiliary contact flag

Auxiliary contact flag

Delay mode

With mode

Delay rate
(%)

Delay rate
(%)

Auxiliary output
ON time

(ms)

Auxiliary output
ON time

(ms)

Auxiliary output
ON time

(ms)

Auxiliary output
ON time

(ms)

 

• Auxiliary output modes include the With mode and the Delay mode. Auxiliary output mode, 
auxiliary output ON time and delay ratio can be set via the Configurator PM7. 

• Auxiliary output contacts can be monitored by input contacts (X1190-X1197) assigned to 
various axes. 

• Auxiliary output codes can be set for various position control data tables via the Configurator 
PM7 Auxiliary output codes can read positioning memory (information area of each axis) for 
monitoring. 
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17.3.2 Auxiliary Output Settings 

Auxiliary output is designated with the Configurator PM7 by axis. The Auxiliary output function 
is valid when the auxiliary output mode is selected from the "Parameter Settings" dialog box. 

 Settings of auxiliary output mode/auxiliary output contact operation  

 
 

Item Description 

Auxiliary output mode 

N: Unused Selected when auxiliary output contacts and auxiliary output codes 
are not used. 

W: With mode As the auto operation started, the auxiliary contact flag assigned to 
corresponding axis in the I/O area is turned ON. 

D: Delay mode 

According to the position control movement ratio (%) of auto 
operation, the auxiliary contact flag assigned to corresponding axis 
in the I/O area is turned ON. However, when the auto operation is 
set to J-point control, the operation is the same to that in the With 
mode. 

Auxiliary output ON 
time Sets the auxiliary output contact ON time. 0-255 ms (Initial value at 10 ms） 

Auxiliary output Delay 
ratio 

sets the ratio of the delay to the auxiliary output contact is turned ON when the auxiliary 
output mode is set to Delay mode. Setting range 0-100% (initial value: 0%) 

 Settings of auxiliary output codes 
Each data table of position control data can be assigned an output code (1 byte). 

 

KEY POINTS
 

• If only auxiliary output code is used, please select any auxiliary output 
mode from the With mode and the Delay mode. 

• No matter in which auxiliary output mode (With mode or Delay mode), the 
auxiliary output codes will be saved at the beginning of position control. 
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17.3.3 Monitoring of Auxiliary Output 

Auxiliary output contacts in operation can be monitored by input contacts. In addition, auxiliary 
output codes can read positioning memory area for monitoring. 

 Assignment of auxiliary output contacts 
Item Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 

(virtual) 
Axis 8 

(virtual) 
Auxiliary output 
contact X1190 X1191 X1192 X1193 X1194 X1195 X1196 X1197 

 Auxiliary output code.monitoring 
• Auxiliary output codes indicating the current status are saved at address H39 of the 

information area of each axis in the positioning memory. Please read them with the user 
program. 

• Auxiliary output codes can also be monitored with the data monitoring of the Configurator 
PM7 

 Sample program 
An example of reading auxiliary output codes of axis-1 and axis-2 to DT0-DT1 is given below.  

R9010
H39 DT0K1H1F384 PTBLR

① ②

H39 DT1K1H101F384 PTBLR
① ②  

Code Content specified by 
program 

Value specified by program 

Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 
(virtual) 

Axis 8 
(virtual) 

① Axis no. and each information 
area H1  H101 H201 H301 H401 H501 H601 H701 

② Area in which auxiliary output 
codes are stored H39 

17.3.4 Operation upon Movement Change during Operation 

 Precautions for movement change during position control operation 
When the Delay ratio is set to 1-99％, the operation of the auxiliary contacts during movement 
change in position control operation is shown as follows. 

• When executing movement change request before the auxiliary contact is turned ON, please 
turn the auxiliary contact on according to the ratio before the movement change. 

• The data table is turned ON upon completion of data table execution when the movement 
when the auxiliary contact is turned on is smaller than the target value after change.  
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17.4 Coordinate Origin 
The coordinate origin function is used to set the coordinates of the origin to any value after 
home return. 

• The coordinates of the origin after home return can be set in the positioning memory via the 
Parameter Setting dialog box of Configurator PM7 or the user program.  

• The set coordinates will be turned into the coordinate origin when executing home return of 
the target axis. 

 Settings of coordinate origin 
The coordinate origin for each axis can be set in the Parameter Settings dialog box of 
Configurator PM7. 

 
 

 Sample program 
An example of reading the current value of axis-1 after unit system conversion and setting it 
the coordinate origin is given below.  

R0
（ ）DF

DT100 H4AK2
④

H2F385 PTBLW
③

H3E DT100K2H1F384 PTBLR
① ②

 

Code Description 
Value specified in program 

Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 
(virtual) 

Axis 8 
(virtual) 

① Axis no. and each 
information area H1 H101 H201 H301 H401 H501 H601 H701 

② Memory area for unit 
conversion current value H3E 

③ Axis no. and each axis 
setting area H2 H102 H202 H302 H402 H502 H602 H702 

④ Coordinate origin setting 
area H4A 
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KEY POINTS
 

• The coordinate origin will be set to be equal to the integral value after unit 
system conversion.  
E.g.) when the unit is µm (0.1 µm), 1,000.0 µm is set as "10000". 
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17.5 Current Value Update 
The current value update function is used to set the "current value after conversion of unit 
system" saved in the positioning memory to any value. 

• Set the value as the current value via the user program in the current value update 
coordinates area (positioning memory area no.0/Address HC8-HD7) of the positioning 
memory. 

• When the bit of the target axis of the current value update question flag area (positioning 
memory area no.0/Address HC0) is set to ON, the "current value after conversion of unit 
system" of the information area of each axis (positioning memory area no.1/Address H3E-
H3F) will be changed to the designated current value.  

 Sample program 
An example of presetting any value K100000 in the positioning memory area to update the 
current value after conversion of unit system of axis-1 is given below. In the first line of the 
program, read the current value after conversion of unit system of axis-1 to the data registers 
DT0-DT1 for monitoring. 

R2
（ ）DF

R1
（ ）DF

ⓑ

F1 DMV DT100K100000

DT100 HC8K2H0F385 PTBLW

ⓒ

F0 MV DT102H1

DT102 HC0K1H0F385 PTBLW

R9010
ⓐH3E DT0K2H1F384 PTBLR

①

⑦

⑥

⑤④

④

③

②

 

 Code 
Content specified by 
program 

Value specified by program 

Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 
(virtual) 

Axis 8 
(virtual) 

① Axis no. and each 
information area H1  H101 H201 H301 H401 H501 H601 H701 

② Memory area for unit 
conversion current values H3E 

③ Update value Arbitrary value 

④ Common area H0 

⑤ Current value update 
coordinate area HC8 HCA HCC HCE HD0 HD2 HD4 HD6 

⑥ Set value of current value 
update request flag area H1 H2 H4 H8 H10 H20 H40 H80 

⑦ Current value update 
request flag area HC0 
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 Current value update area (positioning memory: common area) 
Memory 
address 
(Hex) 

Name Description 

HC0 Current value update 
request flag   

Change the current value coordinates after conversion of unit system 
managed by the unit controller (offset addresses H3E-H3F of the axes) 
into the values set in the current value updated coordinates areas 
(HC8-HD7) only when the bit corresponding to the axes turns from 0 to 
1. 
Upon completion of the change, the unit controller will automatically 
clear the corresponding bit of the current value update request flag 
area (HC0).

bit Name Initial 
value Description 

0 Current value update 
request of axis 1 0 0: unchanged 

1: Coordinate origin of 
corresponding content 
changed 
(Auto clearing by the unit 
controller after execution) 

－ 

1 Current value update 
request of axis 2 0 

2 Current value update 
request of axis 3 0 

3 Current value update 
request of axis 4 0 

4 Current value update 
request of axis 5 

0 

5 Current value update 
request of axis 6 

0 

6 Current value update 
request of (virtual) 
axis 7 

0 

7 
Current value update 
request of (virtual) 
axis 8 

0 

15-8 － － － 
 

HC8-HC9 Current value update 
coordinate of axis 1 

Saves the preset coordinates as the current value. 

HCA-HCB Current value update 
coordinate of axis 2 

HCC-HCD Current value update 
coordinate of axis 3 

HCE-HCF Current value update 
coordinate of axis 4 

HD0- HD1 Current value update 
coordinate of axis 5 

HD2- HD3 Current value update 
coordinate of axis 6 

HD4- HD5 
Current value update 
coordinate of (virtual) 
axis 7 

HD6-HD7 
Current value update 
coordinate of (virtual) 
axis 8 

(Note): The current value update request flag is designated via the H constant. For update request of axis-1 and axis-
2, write H3. 

KEY POINTS
 

• The current value changed via current value update is the current value 
after conversion of unit system. 
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17.6 Target Speed Change Function 

17.6.1 Overview 

The target speed change function is used to change the target speed to any speed according 
to the position control data tables in operation. The operation amount in the data table will not 
be changed even if the speed is changed. 

 
 Use Conditions 

The use conditions of the target speed change function are as follows. 
A: Available, N/A: Not available 

Po
si

tio
n 

co
nt

ro
l 

Control 
method 

Separate axis control A ・In the case of the synchronous control, the speed can be 
changed only for the master axis. 
(Slave axes operate according to the master axis.) 

Interpolation control N/A 
Synchronous control A 

Operation 
pattern 

E-point A ・The speed can be changed more than once in one table. 

・The speed cannot be changed during the deceleration in 
accordance with the stop operation. 

・The speed cannot be changed during the deceleration in the 
C point control. 
・The speed cannot be changed during the dwell time in the C 
point control. 
・For the J point control, use "J point speed change contact" 
to change the speed. 

P-point A 
C-point A 
J-point N/A 

Repetition control A 

JOG operation N/A ・For the JOG operation, change "JOG operation target 
speed" directly to change the speed. 

Home return N/A  

 Speed change mode 

Speed direct 
specification 

This is a method in which a desired speed is specified directly and the change is requested by 
I/O. 
The valid range of the function can be selected from two patterns, which are "Active table only" 
and "Active table to completion of operation". 

Ratio 
specification 
(Override) 

This is a function to change a set speed using a specified ratio (%). 
The change request by I/O is not necessary, and the change is reflected when the set value 
(ratio) is changed. 
The function is valid for all the positioning operations after the set timing. 
The ratio specification also becomes valid when the speed is changed by the speed direct 
specification.  



Auxiliary Function 

17-12 

17.6.2 Setting Procedures and Operations (Speed Direct Specification Method) 

 Setting procedures and operations of speed direct specification method 
The target speed change function in the speed direct specification method is activated by the 
following procedure during a positioning operation. 

1. Set "Change mode selection" and "Change speed" in the positioning memory. 

2. Turn on the "Speed change request" contact during a positioning operation. 

* "Speed change done annunciation" turns ON when the speed change is actually started. 

* Once the "Speed change request" contact turns OFF, the "Speed change done 
annunciation" also turns OFF. 

f

t

100000

200000

Active table only

200000pps

Change mode selection

Change speed

Speed change request

Positioning speed change 
done annunciation

 
(Note 1) The acceleration time to the change speed and the deceleration time from the change speed follows the 

setting values of the active table. 
(Note 2) The movement amount does not change when the speed change is performed. 

 Setting parameters of speed direct specification method 
The following parameters are used in the target speed change function of the speed direction 
specification method. 
Positioning operation change setting area (positioning memory area no. 5) 

Offset 
address 
(Hex) 

Name Default Description 

H1 

Positioning speed 
change 
Change mode 
selection 

H0 

Area for setting the range of the positioning speed change. 
0000H: Active table only 
0001H: Active table to E point table (until the completion of the 
operation) 
In the case of other values, the unit operates as the setting of 
0000H (Active table only). 

H2-H3 
Positioning speed 
change 
Change speed 

K100 

Area for setting a change speed for changing the positioning 
speed. 
Set using unit system conversion values. 
1-2,147,482,624 (designated unit system) 



17.6 Target Speed Change Function 

 
17-13 

 Example of operation (1) Speed direct specification, Active table only 
Parameter Setting value 
Change mode selection 0000H (Active table only) 

Change speed 150,000 (pps) 

f

t

f

t

100,000pps

150,000pps

A

1 2 3 1 2 3

B C

 
A Speed change request contact turns ON. 

B Only the speed of the table 1 is changed to 150,000 pps. 

C The speeds of the table 2 and 3 do not change. 

  

 Example of operation (2) Speed direct specification, Active table to E point table 
(until the completion of the operation) 

Parameter Setting value 
Change mode selection 0001H (Active table to E point table) 

Change speed 150,000 (pps) 

f

t

f

t

100,000pps

150,000pps

A

1 2 3 1 2 3

B

 
A Speed change request contact turns ON. 

B The speeds of all consecutive tables are changed to 150,000 pps. 
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 Example of operation (For repetitive operations) 
When the speed change (speed direct specification, active table only) is performed during the 
positioning repeat operation, only the speed of the active table in an active repeat period is 
changed. 

f

t

100,000pps

1 2 3 1 2 3 1 2 3

Repeat: 1st time Repeat: 2nd time Repeat: 3rd time

A B

150,000pps

f

t

100,000pps

1 2 3 1 2 3 1 2 3

Repeat: 1st time Repeat: 2nd time Repeat: 3rd time

 

 

A Only the speed of the table 1 in the first repeat period is changed to 
150,000 pps. 

B The speeds of the table 1 in the second and third repeat periods are 
not changed. 
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17.6.3 Setting Procedures and Operations (Ratio Specification Method) 

 Setting procedures and operations of ratio specification method (Override) 
When setting the ratio specification, the command speed is immediately reflected in the 
specified ratio once the "Ratio specification" in the shared memory is changed. 

f

t

50,000pps

100,000pps

200,000pps

Ratio specification 100(%) 200(%) 50(%) 100(%)
 

(Note 1) The acceleration time to the change speed and the deceleration time from the change speed follows the 
setting values of the active table. 

(Note 2) The movement amount does not change when the speed change is performed. 
 

 Setting parameters of ratio specification method 
The following parameters are used in the target speed change function of the ratio 
specification method. 

Positioning operation change setting area (Positioning memory area No. 5) 
Offset 
address 
(Hex) 

Name Default Description 

H0 

Positioning speed 
change 
Ratio 
specification 
(Override) 

K100 

Area for setting the change ratio (override) to the command 
speed for the positioning speed change. The speed change 
request by I/O is not necessary, and the change becomes valid 
when the set value (ratio) is set. 
1 to 300 (%) 
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 Example of Operation 
When changing the ratio from 100% to 150% 

Parameter Setting value 
Ratio specification 100 (%) to 150 (%) 

f

t

100,000pps

f

t

150,000pps
↑ 

100,000pps

A

B

150,000pps

200,000pps

300,000pps
↑

200,000pps

225,000pps
↑ 

150,000pps

 
A The ratio specification is changed from 100 to 150 (%). 

B All consecutive tables follow the set ratio. 
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17.7 Movement Amount Change Function  

17.7.1 Overview 

• The movement amount change function is used to change the movement amount on an 
active positioning table to an arbitrary amount. 

• Even when the movement amount is changed, the target speed is the same. 

f

t

When increasing the movement amount
f

t

f

t

F(+)

t

When decreasing the movement amount

F(-)
 

 Use Conditions 
Conditions to use the movement change function are as follows 

Po
si

tio
n 

co
nt

ro
l 

Control 
method 

Separate axis control A ・In the case of the synchronous control, the movement 
amount can be changed only for the master axis. 
(Slave axes operate according to the master axis.) 

Interpolation control N/A 

Synchronous Control A 

Operation 
pattern 

E-point A ・The movement amount can be changed more than once in 
one table. 
・The movement amount cannot be changed during the 
deceleration in accordance with the stop operation. 
・The movement amount cannot be changed during the 
deceleration in the C point control. 

・The movement amount cannot be changed during the 
dwell time in the C point control. 

P-point A 

C-point A 

J-point N/A 

Repetition control A 

JOG operation N/A  
Home return N/A  

A: Availabel, N/A: Not available 
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17.7.2 Setting Procedures and Operations 

 Setting procedures and operations of movement amount change function 
The movement amount change function is activated by the following procedure during a 
positioning operation. 

1. Set "Change movement amount" in the positioning memory. 

2. Turn on the "Movement amount change request" contact during a positioning operation. 

* "Movement amount change done annunciation" turns ON when the movement amount 
change is actually started. 

* Once the "Speed change request" contact turns OFF, the "Speed change done 
annunciation" also turns OFF. 

f

t

150,000plsChange movement amount

Movement amount change request

Positioning movement amount 
change done annunciation

Positioning movement amount 
(Before change)

100,000pls

 

 Setting parameters 
The following parameters are used in the movement amount change function. 
Positioning operation change setting area (Positioning memory area No.3) 

Offset 
address 
(Hex) 

Name Initial 
value Description 

HA-HB 

Positioning 
movement amount 
change 
Change movement 
amount 

H0 
Area for setting a change movement amount for changing 
the positioning movement amount. 
-2,147,482,624 to 2,147,482,624  (Specified unit system) 
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 Example of operation (1) When reducing the movement amount (Change movement 
amount > Current value) 

Parameter Setting value 

Control method Incremental 

Positioning movement 
amount (Before 
change) 

10,000 (pls) 

Positioning movement 
amount (After change) 7,000 (pls) 

10,000pls

f

t

f

t

7,000pls

A

 
A Movement amount change request contact ON 

 

 Example of operation (2) When reducing the movement amount (Change movement 
amount < Current value) 

Parameter Setting value 

Control method Incremental 

Positioning movement 
amount (Before 
change) 

10,000 (pls) 

Positioning movement 
amount (After change) 1,000 (pls) 

10,000pls

F(+)

t

f

t

1,000pls

A

F(-)  
A Movement amount change request contact ON 
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 Example of operation (3) When a continuous table operation is performed 
(Incremental) 

Parameter Setting value 

Control method Incremental 

First table positioning movement 
amount (Before change) 5,000 (pls)  

First table positioning movement 
amount (After change) 8,000 (pls) 

5,000plsf

t

8,000plsf

t

1 2 1 2

A

B

 
A Movement amount change request contact ON 

B Because of the increment setting, the stop position of the 
table 2 also changes. 

 

 Example of operation (4) When a continuous table operation is performed 
(Absolute) 

Parameter Setting value 
Control method Absolute 
First table positioning movement 
amount (Before change) 5,000 (pls)  

First table positioning movement 
amount (After change) 8,000 (pls) 

f

t

f

t

1 2 1 2

A

8,000pls5,000pls
B

 
A Movement amount change request contact ON 

B Because of the absolute setting, the stop position of the table 
2 does not change. 
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 Example of operation (For repetitive operations) 
When the movement amount change is performed during the positioning repeat operation, 
only the movement amount of the active table in an active repeat period is changed. 

f

t

1 2 3 1 2 3 1 2 3

Repeat: 1st time Repeat: 2nd time Repeat: 3rd time

f

t

A B

1 2 3 1 2 3 1 2 3

Repeat: 1st time Repeat: 2nd time Repeat: 3rd time  

A Only the movement amount of the table 1 in the first repeat period is 
changed to 8,000 pls. 

B The movement amounts of the table 1 in the second and third repeat 
periods are not changed. 

 

 Auxiliary output when changing movement amounts 
Even if the movement amount is changed when the auxiliary output is set in the delay mode, 
the auxiliary contact turns ON at the position of the delay ratio to the movement amount 
before the change. If the delay ratio is set to100%, however, the auxiliary contact turns ON on 
the completion of the operation. 
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17.8 Direct Input / Output 

17.8.1 Direct Input / Output Function 

• The direct input / output function means to update external inputs/outputs during operation. 

• In general, the inputs / outputs are updated as a whole during refreshing. 

• When direct input instruction is used, read and update external inputs during operation.  

• When direct input instruction is used, turn ON/OFF external inputs during operation.  

• It is valid for controls with requirement for high-speed response. 

 Types of instructions 

Direct input 
instruction 

DST Direct start 

DST/ Direct start NON 

DAN Direct AND 

DAN/ Direct AND NON 

DOR Direct OR 

DOR/ Direct OR NON 

Direct output 
instruction 

DOT Direct output 

DSET Direct set 

DRST Direct reset 

DKP Direct hold 

 



17.8 Direct Input / Output 

 
17-23 

 Programming method based on FPWIN GR7 
[Direct] selection via the options in the function bar. 

 

 

• The function bar is used as direct instruction. 

 

• Select the direct input/output instruction to be used. Select DKP instruction via [Instruction 
Input]. 

• Press [Esc] or [Shift] + [f11], the function key bar returns to the common input/output 
instruction keys. 
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17.8.2 Direct Input 

• Direct Input instructions include DST·DST/·DAN·DAN/·DOR·DOR/ instructions. 

• Relay type available for designation includes only X contact. 

 Range that can be specified 
Model Device Range 
FP-XH M8N control unit X0-X7·X1100-X141F (Note) 

(Note): When designating X1100-X141F, the input area of the motion control part is read and reflected. 

 Latter diagram flag 
X0

D
R0

X1
D

R1

R10 R2

R12 R4

X4

R13 R5

X5

DST

DOR

DOR/

X2
D

D

D

R11 R3X3
D

DST/

DAN

DAN/

 

REFERENCE  
Please refer to the Instruction Word Reference to instructions for details about the 
instructions. 
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17.8.3 Direct Output  

• Direct output instructions include DOT,·DSET,·DRST·and DKP. 

• Relay type available for designation includes only Y contact. 

 Range that can be specified 
Model Device Range 
FP-XH M8N control unit Y0-Y7・Y1100-Y141F (Note) 

(Note): When designating Y1100-Y141F, the input area of the motion control part is read and reflected. 

 Latter diagram flag 

R0 Y0

R1

D

Y1

R2 Y2

R4

DOT

D

R3

D

DSET

DRST

DKP

SET＜ ＞

RST＜ ＞

DKP

Y3
 

REFERENCE  
Please refer to the reference to instructions for details about the instructions. 
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17.9 Torque Limit 
The torque limit is a function to change the maximum output torque of the AMP realtime 

• The torque limit function is executed by setting and writing the "Torque limit enable flag" of 
the positioning memory to "Torque limit value" using a user program. The setting to enable 
or disable the torque limit and the torque limit values can be set for each axis. 

• This function can be executed during the position control, synchronous control and JOG 
operation. It cannot be executed during the home return operation. 

• The torque limit function cannot be executed when the AMP parameter R/W or AMP 
monitoring is executed. 

 Torque limit setting area (Positioning memory area no. 0) 
Offset 
address 
(Hex) 

Name Default Description 

H0D8 Torque limit enable flag H0 

Sets whehter to enable or disable the execution of the torque 
limit for each axis. 
Executes the torque limit when the bit corresponding to each axis 
turns on. 

bit Name Defaul
t 

Description 

0 Torque limit of axis 1 0 0: Torque limit disabled 
(default) 
1: Torque limit enabled 

1 Torque limit of axis 2 0 

2 Torque limit of axis 3 0 

3 Torque limit of axis 4 0 

4 Torque limit of axis 5 0 

5 Torque limit of axis 6 0 

6 Torque limit of axis 7 0 

7 Torque limit of axis 8 0 

15～8 － － － 
 

H0D9 
-H0DF Reserved for system - - 

H0E0 Torque limit value of axis 
1 3000 

Set the torque limit values. 
The unit is (0.1%). 
If 2000 is written in this area, it operates with “2000 x 0.1 = 200 
(%)” as the maximum torque. 

H0E1 Torque limit value of axis 
2 3000 

H0E2 Torque limit value of axis 
3 3000 

H0E3 Torque limit value of axis 
4 3000 

H0E4 Torque limit value of axis 
5 3000 

H0E5 Torque limit value of axis 
6 3000 

H0E6 Torque limit value of axis 
7 3000 

H0E7 Torque limit value of axis 
8 3000 
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 Program example 
The following sample program shows an example of executing the realtime torque limit during 
the JOG operation of 1st axis. Set and write the "Torque limit enable flag" of the positioning 
memory to "Torque limit value" using the user program. 

R4
（ ）DF

Torque limit 
enabled

F0 MV DT100K1

DT100 HD8K1H0F385 PTBLW

Realtime torque 
limit

F0 MV DT101K100

DT101 HE0K1H0F385 PTBLW
⑤

④

③②

②

①Torque 
change 
flag

X1100 X1104 X1230 R10

R2

Start enable 
flag

（ ）DF/
Forward JOG

R11

Forward 
OFF edge

Start enabled 
condition

R3
（ ）DF/

Reverse JOG

R12

Reverse 
OFF edge

R2 R10 X1130 R11 Y1160

Start 
enable 
flag

Axis 1 
BUSY

Forward 
OFF edge

Axis 1 
forward 

JOG

Forward JOG

Y1160

Axis 1 
forward JOG

Axis 1 
forward 
JOG start

（ ）DF

R3 R10 X1130 R12 Y1161

Axis 1 
reverse 

JOG

Reverse JOG

Y1161

Axis 1 
reverse JOG

Axis 1 
reverse 
JOG start

（ ）DF

R0
Servo ON

R1 Y1130

Axis 1 Servo 
OFF request

Servo OFF

Axis 1 Servo 
ON request

（ ）DF

（ ）DF

Y1120

X1180 X1120

Servo ON

Servo OFF

Tool 
operation

Axis 1 
error

Axis 1 
connection 
confirmation

Axis 1 
servo lock

Link 
establishment 
annunciation

Start 
enable 
flag

Axis 1 
BUSY

Reverse 
OFF edge

 



Auxiliary Function 

17-28 

 

Code Description 
Value specified by program 
Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 Axis 8 

① Torque limit enable flag area 
setting value H1  H2 H4 H8 H10 H20 H40 H80 

② Common area H0 

③ Torque limit enable flag area HD8 

④ Torque limit value Arbitrary value 

⑤ Torque limit value area HE0 HE1 HE2 HE3 HE4 HE5 HE6 HE7 
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17.10 Monitor Error (Torque / Actual Speed Judgement) 
This is a function to monitor the actual speed/torque of servo amplifier and generate an error 
or warning on the Control Unit side when it exceeds a set judgemen value. 

• The monitor error is set in the "Parameter settings" dialog box of Configurator PM7. 
Judgement values can be set for torque and actual speed separately by respective axes. 

• when an error occurs, the operation will stop in the "error stop deceleration time, and cannot 
be executed until the error is cleared. When a warning occurs, only the occurrence of 
warning will be informed, and the operation will continue. 

Actual speed judgment value
or Torque judgment value

Error stop
deceleration time

Error annunciation flag  
(Note): The above figure shows an operation diagram when error is set. 

 Parameter Settings in Configurator PM7 

 
Parameter name Default Description 

Monitor error - Torque 
judgment N: Disabled 

Select the operation of the control unit when the torque value of 
the amplifier exceeds the judgement value. 
N: Disabled, E: Enabled (Error), W: Enabled (Warning) 

Monitor error - Torque 
judgment value (%) 500.0 Set the torque judgement value. 

Range: 0-500.0 (%) 

Monitor error - Actual 
speed judgement N: Disabled 

Select the operation of the control unit when the actual speed of 
the amplifier exceeds the judgement value. 
N: Disabled, E: Enabled (Error), W: Enabled (Warning) 

Monitor error - Actual 
speed judgement value 
(rpm) 

5000 Set the actual speed judgement value. 
Range: 0-10000 rpm 

REFERENCE  
• For details of the errors and warnings, refer to“19 Error/Warning 

Annunciation Function“. 
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17.11 Operation Done Signal 

17.11.1 Operation Done Flag and Imposition Flag 

There are two kinds of flags which announces the completion of operation, which are the 
"operation done flag" controlled by the FP-XH M8N Control Unit and "imposition flag" 
controlled by the servo amplifier. 

 Operation done flag 
• The operation done flag is a signal to confirm the "completion of an operation" on the FP-XH 

M8N Control Unit side. 

• The operation done flag turns off when each operation starts, and turns off when the 
operation is complete. The completion of the operation differs according to operations. 

Operation mode Timing regarded as the completion of operation 
Positioning operation The operation command for a specified movememnt amount is complete. 
JOG operation The JOG request signal turns off and the the deceleration stop is complete. 
Home return The home return operation is complete (stops at the home position). 

• When an arbitrary stop operation such as the deceleration stop, emergency stop or error 
stop is executed during an operation, the operation done flag turns on when the stop 
operation is complete. 

• The range of the "completion width" regarded as the completion of operation is specified in 
the FP-XH M8N Control Unit by Configurator PM7 or a user program. The completion width 
can be set by respective axes. 

• The set completion width is transferred to the servo amplifier and set in the parameter 
"positioning complete (in-position) range" (Pr.4.31) of the servo amplifier. 

 Imposition flag 
• The imposition (INP) is a signal to confirm the "completion of positioning operation" on the 

servo amplifier side. 

• Tthe conditions and output setting of "imposition" state are set in the servo amplifier using 
PANATERM. 

• It can be monitored on the FP-XH M8N Control Unit via the positioning memory. 
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17.12 Position Deviation Simple Monitor 
"Position deviation simple monitor" is a function to monitor the difference between the current 
position controlled within the FP-XH M8N Control Unit and the AMP current position fed back 
from the AMP. 

• The deviation can be read from the each axis information area in the positioning memory 
using a user program. 

• It can also be monitored by the "data monitor function" of Configurator PM7. 

 Monitoring by the FP-XH M8N Control Unit 
The position deviation of the first axis is read and written to DT0 to DT1 and monitored. 

R100
H34 DT0K2H1F384 PTBLR

① ②
 

Code Content specified by 
program 

Value specified by program 
Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 Axis 8 

① Axis no. and each axis 
information area H1  H101 H201 H301 H401 H501 H601 H701 

② Deviation H34 

 

KEY POINTS
 

• As the deviation read by the "position deviation simple monitor" function is 
calculated in the FP-XH M8N Control Unit, the diffence between this value 
and the deviation counter value in the AMP may occur.  

• -The display of the position deviation monitor is updated by 10 ms. 
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17.13 AMP Parameter R/W Function 

17.13.1 Overview 

The FP-XH M8N Control Unit can execute the following operations for the amplifiers 
connected to the network. Any of these operations can be controlled with user programs 
through the AMP parameter control area (memory area no. 6 address H0-H27) in the 
positioning memory of the FP-XH M8N Control Unit. 

 Type of operation (●: Executable, Blank: Inexecutable) 

Operation Description 
State of target axis 
Axis is 
stopping 

Axis is 
active 

Reading AMP 
parameters 

Reads parameters from the AMP and stores them 
in the positioning memory (AMP parameter control 
area) of the FP-XH M8N Control Unit. 

● ● (Note 1) 

Writing AMP parameters 
Writes the values stored in the positioning memory 
(AMP parameter control area) of the FP-XH M8N 
Control Unit to the AMP. 

●  

Saving AMP parameters 
(EEPROM write) 

Writes the parameters set in the AMP to the 
EEPROM built in the AMP. ●  

Resetting AMP (Restart) Resets the AMP. ● (Note 2)  
(Note 1): Reading parameters cannot be executed during home return. 
(Note 2): Resetting the AMP should be executed when all axes are stopping. 
 

 
• Turn all axes connected to the network into the servo off state when 

executing the AMP reset function.When the AMP is reset, all the connected 
axes will result in error and be in the servo off state because the network is 
disconnected. 

• When the network disconnection error occurs, this function cannto be 
executed becuase communication is not available. 
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17.13.2 Reading Parameters from AMP 

Reading parameters from the AMP is performed by the following procedure using user 
programs. 

Step Description 
① Confirm that the target axes exist in the network (For 1 axis: X1180 = ON). 

② 
Set the following items in the AMP parameter control area (memory area no.6, address H0/H3/H24). 
(AMP ID no., parameter classification, parameter no.) 
Set the control flag in the AMP parameter control area (memory area no. 6, address H1) to "H2 (Read 
request)". The FP-XH M8N Control Unit requests the reading of the parameters to the AMP. 

③ On the processing is compelte, "H0 (No request)" is stored for the control flag in the AMP parameter 
control area (memory area no. 6, address H1). 

④ Confirm if the status of the AMP parameter control area (memory area no. 6, address H2) is H2 (normal 
end). If any error occurs, H4 to H6 area stored. 

⑤ Read the parameter values from the AMP parameter control area (memory area no. 6, address H26-H27) 
and written to an arbitrary area. 

 Program example 
The following sample program shows the case when the AMP parameter Pr.1.01 of the first 
axis is read. 

R600

AMP control 
start

R500

AMP read 
flag

AMP control 
start

（ ）DF
R600X1180

Axis 1 
connection 
confirmation

AMP ID no. 
setting

F0 MV DT1001H1

DT1001 H0K1
AMP ID no.

H6F385 PTBLW
AMP 
parameter 
area

AMP parameter 
classification

F0 MV DT1005H1

DT1005 H3K1
Parameter 
classification

H6F385 PTBLW

Parameter no. 
setting

F0 MV DT1006H1

DT1006 H24K1
Parameter no.

H6F385 PTBLW

Parameter read 
request

F0 MV DT1010H2

DT1010 H1K1

Control flag

H6F385 PTBLW
AMP 
parameter area

＜ ＞SET
Control 
start

R610

AMP 
parameter 
area

AMP 
parameter 
area

 
  To the next page 
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1

1DT1020 H2=

H26 DT1100K2H6F384 PTBLR
AMP parameter 
area

R610

Normal end
Parameter value 
acquisition

DT1010 H0=

R620

Status 
acquisition

Request 
completion check

H2 DT1020K1H6F384 PTBLR
AMP 
parameter area

＜ ＞SET

Status 
acquisition

R620

＜ ＞RST
Control start

R610

＜ ＞RST
R620

Parameter 
area

Status
1

1

1DT1020 H2<>

H2 DT1110K1H6F384 PTBLR
AMP parameter 
area Abnormal end

Status acquisition

R620

＜ ＞RST
R610

＜ ＞RST
R620

Status
1

R610

Control start
H1 DT1010K1H6F384 PTBLR

Control flag

Control start

Status 
acquisition

Status 
acquisition

Control start
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17.13.3 Writing Parameters to AMP 

Writing parameters to the AMP is performed by the following procedure using user programs. 

Step Description 
① Confirm that all axes are not activated. 

② 

Set the following items in the AMP parameter control area (memory area no.6, address H0/H3/H24/H26-
H27).  
(AMP ID no., parameter classification, parameter no., parameter data (2-word)) 
Set the control flag in the AMP parameter control area (memory area no. 6, address H1) to "H4 (Write 
request)". The FP-XH M8N Control Unit requests the writing of the parameters to the AMP. 

③ On the processing is compelte, "H0 (No request)" is stored for the control flag in the AMP parameter 
control area (memory area no. 6, address H1). 

④ Confirm if the status of the AMP parameter control area (memory area no. 6, address H2) is H2 (normal 
end). If any error occurs, H4 to H6 area stored. 

 Program example 
The following sample program shows the case when the AMP parameter Pr.1.01 of the first 
axis is written. 

R600

AMP control 
start

R500

AMP read 
flag

AMP control 
start

（ ）DF
R600X1180

Axis 1 
connection 
confirmation

X1130

Axis 1 
BUSY

AMP ID no. setting

F0 MV DT1001H1

DT1001 H0K1
AMP ID no.

H6F385 PTBLW
AMP parameter 
area

AMP parameter 
classification

F0 MV DT1005H1

DT1005 H3K1
Parameter 
classification

H6F385 PTBLW
AMP 
parameter area

Parameter no. 
setting

F0 MV DT1006H1

DT1006 H24K1
Parameter no.

H6F385 PTBLW
AMP 
parameter area

Parameter write 
request

F0 MV DT1010H4

DT1010 H1K1

Control flag

H6F385 PTBLW
AMP 
parameter area

＜ ＞SET
Control 
start

R610

Parameter value 
setting

F1 DMV DT1007H1

DT1007 H26K2
Parameter 
data

H6F385 PTBLW
AMP 
parameter area
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1

1DT1020 H2=

R610

Control start

Normal end

DT1010 H0=

R620

Status 
acquisition

Request 
completion check

H2 DT1020K1H6F384 PTBLR
AMP 
parameter area

＜ ＞SET
Status 
acquisition

R620

＜ ＞RST
Control start

R610

＜ ＞RST
Status 
acquisition

R620

Status
1

1

1DT1020 H2<>

H2 DT1110K1H6F384 PTBLR
AMP parameter 
area Abnormal end

Status acquisition

R620

Status 
acquisition

＜ ＞RST
Control start

R610

＜ ＞RST
Status 
acquisition

R620

Status
1

R610

Control start
H1 DT1010K1H6F384 PTBLR

Control flag
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17.13.4 Saving AMP Parameters (Writing to EEPROM) 

Writing AMP parameters to the EEPROM is performed by the following procedure using user 
programs. 

Step Description 
① Confirm that all axes are not activated. 

② Set the control flag in the AMP parameter control area (memory area no. 6, address H1) to "H5 (EEPROM 
request)". The FP-XH M8N Control Unit requests the writing of the AMP parameters to the EEPROM. 

③ On the processing is compelte, "H0 (No request)" is stored for the control flag in the AMP parameter 
control area (memory area no. 6, address H1). 

④ Confirm if the status of the AMP parameter control area (memory area no. 6, address H2) is H2 (normal 
end). If any error occurs, H4 or H6 area stored. 

 Program example 
The following sample program shows the case when the AMP parameters of the first axis are 
saved. 

R600

AMP control 
start

R610

Control start

R500

AMP read 
flag

AMP control 
start

（ ）DF
R600X1180

Axis 1 
connection 
confirmation

X1130

Axis 1 
BUSY

H1 DT1010K1H6F384 PTBLR

Control flag

AMP ID no. 
setting

F0 MV DT1001H1

DT1001 H0K1
AMP ID No.

H6F385 PTBLW
AMP parameter 
area

EEPROM write 
request

F0 MV DT1010H5

DT1010 H1K1
Control flag

H6F385 PTBLW
AMP 
parameter area

＜ ＞SET
Control 
start

R610

1
R610

Control start

DT1010 H0=
Request 
completion check

H2 DT1020K1H6F384 PTBLR
AMP 
parameter area

＜ ＞SET
Status 
acquisition

R620

Status
1

 
  To the next page 

 



Auxiliary Function 

17-38 

1DT1020 H2=

Normal end

R620

Status 
acquisition

＜ ＞RST
Control start

R610

＜ ＞RST

Status 
acquisition

R620

1

1DT1020 H2<>

H2 DT1110K1H6F384 PTBLR
AMP parameter 
area Abnormal end

Status acquisition

R620

＜ ＞RST
R610

＜ ＞RST
R620

Status
1

Status 
acquisition

Control start
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17.13.5 Resetting AMP (Restart) 

Resetting the AMP is performed by the following procedure using user programs. 

Step Description 
① Confirm that all axes are not activated. 

② Set the control flag in the AMP parameter control area (memory area no. 6, address H1) to "H6 (AMP 
reset request)". The FP-XH M8N Control Unit requests the resetting AMP. 

③ On the processing is compelte, "H0 (No request)" is stored for the control flag in the AMP parameter 
control area (memory area no. 6, address H1). 

④ Confirm if the status of the AMP parameter control area (memory area no. 6, address H2) is H2 (normal 
end). If any error occurs, H4 or H6 area stored. 

 Program example 
The following sample program shows the case when the AMP of the first axis (ID) is reset. 

R600

AMP control 
start

R610

Control start

R500

AMP read 
flag

AMP control 
start

（ ）DF
R600X1180

Axis 1 
connection 
confirmation

X1130

Axis 1 
BUSY

H1 DT1010K1H6F384 PTBLR

Control flag

AMP ID no. setting

F0 MV DT1001H1

DT1001 H0K1
AMP ID No.

H6F385 PTBLW
AMP parameter 
area

AMP reset request

F0 MV DT1010H6

DT1010 H1K1

Control flag

H6F385 PTBLW
AMP 
parameter area

＜ ＞SET
Control 
start

R610

1
R610

Control start

DT1010 H0=
Request 
completion check

H2 DT1020K1H6F384 PTBLR
AMP 
parameter area

＜ ＞SET
Status 
acquisition

R620

Status
1

 
  To the next page 
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1DT1020 H2=

Normal end

R620

Status 
acquisition

＜ ＞RST
Control start

R610

＜ ＞RST
Status 
acquisition

R620

1

1DT1020 H2<>

H2 DT1110K1H6F384 PTBLR
AMP parameter 
area Abnormal end

Status acquisition

R620

Status 
acquisition

＜ ＞RST
Control start

R610

＜ ＞RST
Status 
acquisition

R620

Status
1

 

 
• When the AMP is reset, all the connected axes will result in error and be in 

the servo off state because the network is disconnected. 
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17.14 AMP Monitoring Function 

17.14.1 Overview 

This function enables the FP-XH M8N Control Unit to monitor the status information of servo 
amplifier using RTEX monitor commands. 

• This information can be read by controlling the AMP monitor & control area (common area 
no. 0, address H390-H395) in the positioning memory of the FP-XH M8N Control Unit using 
user programs. 

• The AMP monitor function can be executed only when the axes to be monitored stop. The 
monitoring request made while the axes are activated is invalid. However, if the request for 
monitoring is enabled when the axes stop, the monitoring starts. 

• When the network disconnection error occurs, this function cannto be executed becuase 
communication is not available. 

17.14.2 Monitoring Items 

The type codes and names that can be read by the FP-XH M8N Control Unit are as follows. 

Type Code 
(HEX) Name Type Code 

(HEX) Name 

01 Position deviation 31 Inertia ratio 
02 Encoder resolution 32 Automatic motor recognition 

04 Internal command position (after 
filtering) 33 Cause of no revolution 

05 Actual speed 34 Warning flags 

06 Torque 41 Mechanical angle (Single turn data) 

07 Actual position 42 Electrical angle 

08 Internal command position 
(beforer filtering) 43 Multi-turn data 

09 Latch position 1 61 Power on cumulative time 
0A Latch position 2 62 Servo driver temperature 

0C Command velocity (after 
filtering) 63 Encoder temperature 

11 Regenerative load ratio 64 No. of inrush resistance relay 
operations 

12 Overload ratio 65 No. of dynamic brake operations 
21 Logical input signal 66 Fan operating time 
22 Logical output signal 67 Fan life expectancy 

23 Logical input signal (expansion 
portion) 68 Capacitor life expectancy 

24 Logical output signal (expansion 
portion) 69 Voltage across PN 

25 Physical input signal 71 RTEX cumulative communication 
errors 

26 Physical output signal 81 Encoder cumulative communication 
errors 
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(Note): Refer to the latest instruction manual and technical materials of the servo amplifier.  
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17.14.3 Monitoring Procedure 

Monitoring the status information is performed by executing the following items using user 
programs. 

1. AMP monitor & control area 
Set the axis number (AMP ID No.) to be read to AMP ID number. 
Set the control flag for the type code to be monitored. 

2. The RTEX sets H1 (Being processed) for the status, and stores the monitor value in the 
monitor data. 

3. Check if the status of the AMP monitor & control area is H2 (Normal end). 

4. Read the monitor data. 

 Program example 
When monitoring the encoder temperature (type code 63) of the first axis 

R600

AMP 
monitor start

R610

Control start

R500

AMP monitor 
flag

AMP 
monitor start

（ ）DF
R600X1180

Axis 1 
connection 
confirmation

X1130

Axis 1 
BUSY

H391 DT1010K1H0F384 PTBLR
Control flag

AMP ID no. setting

F0 MV DT1001H1

DT1001 H390K1
AMP ID no.

H0F385 PTBLW
Common area

Monitoring request

F0 MV DT1010H63

DT1010 H391K1
Control flag

H0F385 PTBLW
Common area

＜ ＞SET
Control 
start

R610

Common 
area

1
R610

Control start

DT1010 H0=
Request 
completion check

H392 DT1020K1H0F384 PTBLR ＜ ＞SET
Status 
acquisition

R620

Status
1

Common 
area

 
  To the next page 
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1DT1020 H2=
R620

Status 
acquisition

1DT1020 H2<>

H392 DT1110K1H0F384 PTBLR

Abnormal end
Status acquisition

R620

＜ ＞RST
R610

＜ ＞RST
R620

Status
1

H394 DT1100K2H0F384 PTBLR
Common 
area

Normal end
Monitor value 
acquisition

＜ ＞RST
Control start

R610

＜ ＞RST
Status 
acquisition

R620

Monitor data
1

Status 
acquisition

Common 
area

Control start

Status 
acquisition
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18.1 Motion Control Instructions 

18.1.1 [F384 PTBLR] Positioning parameter read instruction 

Read the position control parameter saved in the unit positioning memory to the area of 
memory for operation. 

 Instruction format 

R0
S2 DnS1F384 PTBLR

 

 Operand 
Operand Settings 

S1 

Specify the axis number and positioning memory area 

 (upper bit 8bit) axis number: H0 (Axis 1), H1 (Axis 2), H2 (Axis 3), H3 (Axis 4), H4 (Axis 5), H5 
(Axis 6), H6 ((virtual) Axis 7), H7 ((virtual) Axis 8) 

 (lower bit 8bit) area 
number: 

H0 (common area), H01 (axis information area), H02 (axis 
setting area), H04 (synchronous control setting area), H05 
(position control operation change setting area) and H06 (AMP 
parameter area) 

S2 Initial address of the positioning memory in which data to be read will be saved (offset address)  
or memory for computation in which initial address will be saved 

n Read the number of words 
D Save the operation memory of the read data 

(Note 1): The setting of axis number is invalid when reading common area. Please specify H0 is S1. 
(Note 2): Designate the operand S1 via the hex combination. For the axis information area of axis number 3, it is 

designated to H201. 

 Memory area type that can be specified (A: Available, -: Not available) 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S1 A A A A A A A A A A A A 
S2 A A A A A A A A A A A A 
n A A A A A A A A A A A A 
D － A A A A A A A A － － A 

 Operation description 
• Read the data saved in positioning memory with [n] word starting with [S2], and save it to the 

memory area for computation starting with [D]. 

• Use [S1] to designate axis number and area number of positioning memory. 

 Precautions for programming 
• When the number of operations exceeds the specified range, operating error will occur. 
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18.1.2 [F385 PTBLW] Positioning parameter write instruction 

This is used when writing in position control parameter and data of position control data table 
through the user program. 

 Instruction format 

R0
S2 DnS1F385 PTBLW

 

 Operand 
Operand Settings 

S1 

Specify the axis number and positioning memory area 

 (upper bit 8bit) axis 
number: 

H0 (Axis 1), H1 (Axis 2), H2 (Axis 3), H3 (Axis 4), H4 (Axis 5), H5 
(Axis 6), H6 ((virtual) Axis 7), H7 ((virtual) Axis 8) 

 (lower bit 8bit) area 
number: 

H0 (common area), H01 (axis information area), H02 (axis setting 
area), H04 (synchronous control setting area), H05 (position control 
operation change setting area) and H06 (AMP parameter area) 

S2 Save the memory area for operational  to which data is written 
n Number of words written 

D Initial address of the positioning memory to which data is saved (offset address)  
or memory for computation in which initial address will be saved 

(Note 1): The setting of axis number is invalid when being written to common area. Please specify H0 is S1. 
(Note 2): Designate the operand S1 via the hex combination. For the axis setting area of axis number 3, it is 

designated to H202. 

 Memory area type that can be specified (A: Available, -: Not available) 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S1 A A A A A A A A A A A A 
S2 A A A A A A A A A − − A 
n A A A A A A A A A A A A 
D A A A A A A A A A A A A 

 Operation description 
• Read the data saved in the area with [n] word starting with [S2], and save it to the positioning 

memory starting with [D]. 

• Use [S1] to designate axis number and area number of positioning memory. 

 Precautions for programming 
• When the number of operations exceeds the specified range, operating error will occur. 

REFERENCE  
For details about the positioning memory, see "26.4 Positioning Memory". 
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18.1.3 [F386 PSET] Positioning start data table setting  

Written before the program starting the position control to set the position control data table to 
be started. 

 Instruction format 

R0
S2S1F386 PSET

 

 Operand 
Operand Settings 

S1 Numbers of axes to start position control data tables: H0 (Axis 1), H1 (Axis 2), H2 (Axis 3), H3 (Axis 
4), H4 (Axis 5), H5 (Axis 6), H6 ((virtual) Axis 7), H7 ((virtual) Axis 8) 

S2 Numbers of data tables to start position control data tables: 1-600 (standard area), 10001-10089 
(extended area) 

 Memory area type that can be specified (A: Available, -: Not available) 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S1 A A A A A A A A A A A A 
S2 A A A A A A A A A A A A 

 Operation description 
• Sets position control data table to start. 

• When the startup contact of corresponding axis is ON, start position control operation 
according to the data set in the positioning memory (position control data table area) in 
advance. 

 Precautions for programming 
• When the number of operations exceeds the specified range, operating error will occur. 

• When the conditions for system stop, emergency stop, position limit stop and deceleration 
stop are fulfilled, processing should be stopped with priority. 

• When the value set or the positioning memory (axis setting area) is abnormal, self-diagnose 
error (position control operation error) will occur. 

• When the axis to be started is in operation, the operation will stop without starting position 
control. 
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18.1.4 [F387 PSTRD] Axis status acquisition 

Reads status information indicating position control operations to any device. 

 Instruction format 

R0
DSF387 PSTRD

 

 Operand 
Operand Settings 

S Numbers of axes to read status: H0 (Axis 1), H1 (Axis 2), H2 (Axis 3), H3 (Axis 4), H4 (Axis 5), H5 
(Axis 6), H6 ((virtual) Axis 7), H7 ((virtual) Axis 8) 

D Saves the address of device completing information reading 

 Memory area type that can be specified (A: Available, -: Not available) 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S A A A A A A A A A A A A 
D − A A A A A A A A − − A 

 Operation description 
• Reads status of the axis designated by [S] to any device. 

 Type of axis status information 
Status information Description 

Tool operation It will be turned ON during tools running with Configurator PM7, irrelevant to the 
designated axis 

Error annunciation ON when the designated axis is in error 

Warning annunciation ON when the designated axis is in warning 
BUSY ON when the designated axis is operating 
Operation done ON when the operation of the designated axis is completed 
Home return done ON when the designated axis is subject to home return 

 Allocation of axis status information stored in [D] 

bit Status 
information Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 

(virtual) 
Axis 8 

(virtual) 
0 Tool operation X1104 X1104 X1104 X1104 X1104 X1104 X1104 X1104 
1 Error annunciation X1230 X1231 X1232 X1233 X1234 X1235 X1236 X1237 

2 Warning 
annunciation X1240 X1241 X1242 X1243 X1244 X1245 X1246 X1247 

3 BUSY X1130 X1131 X1132 X1133 X1134 X1135 X1136 X1137 

4 Operation done X1140 X1141 X1142 X1143 X1144 X1145 X1146 X1147 
5 Home return done X1150 X1151 X1152 X1153 X1154 X1155 X1156 X1157 
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 Example of storage 
When the status of the axis 1 is as follows, the stored value is H0008. 

bit Status 
information Axis 1 Value 

→ 

 

0 Tool operation X1104 0  

1 Error 
annunciation X1230 0 Stored 

value 

2 Warning 
annunciation X1240 0 H0008 

3 BUSY X1130 1  
4 Operation done X1140 0  

5 Home return 
done X1150 0  

 Precautions for programming 
• When the number of operations exceeds the specified range, operating error will occur. 
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18.1.5 [F388 PERRD] Positioning error /warning acquisition 

Reads codes saved in error annunciation buffer 1/warning buffer 1 to any device. 

 Instruction format 

R0
DSF388 PERRD

 

 Operand 
Operand Settings 

S Numbers of axes to read error/warning codes: H0 (Axis 1), H1 (Axis 2), H2 (Axis 3), H3 (Axis 4), H4 
(Axis 5), H5 (Axis 6), H6 ((virtual) Axis 7), H7 ((virtual) Axis 8) 

D Saves the address of device completing information reading 

 Memory area type that can be specified (A: Available, -: Not available) 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S A A A A A A A A A A A A 
D − A A A A A A A A − − A 

 Operation description 
• Reads codes saved in error annunciation buffer /warning buffer of the designated axis to any 

device. 

• [D] saves error codes and [D+1] saves warning codes. 

 Precautions for programming 
• When the number of operations exceeds the specified range, operating error will occur. 

REFERENCE  
• Please refer to "19.1 Errors and Warnings" for overview about errors and 

warnings. 

• Please refer to "19.3 Table of Error Codes" for error codes. 

• Please refer to "19.4 Table of Warning Codes" for warning codes. 
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18.1.6 [F389 UCLR] Positioning error / warning clearing 

Clears codes saved in error annunciation buffer/warning buffer. 

 Instruction format 

R0
F389 UCLR

 

 Operation description 
• Clears position control error annunciations & area and warning annunciations & area 

contents. 
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18.2 Direct Input Instruction 

18.2.1 [DST·DST/] Direct start / Direct start NOT 

DST, DST/: reads external inputs for logical operation. Due to the input refreshing of contact 
units, it is valid for controls with requirement for high-speed response. 

 Instruction format 
X0

D
R0

X1
D

R1

DST

DST/
 

 Type of relays that can be specified (unit: bit) (A: Availalbe, -: Not available)) 

 X Y R T C L P E Index 
modifier 

DST Normal ON input contact for the start of 
logical operation A － － － － － － － A 

DST/ Normal OFF input contact for the start of 
logical operation A － － － － － － － A 

 Operation description 
• 「DST」Instruction, read specified external input, reflect it to the input contact, and then take 

this contact as normally open (NO) contact (a contact) and perform logic operation. 

• 「DST/」Instruction, read specified external input, reflect it to the input contact, and then take 
this contact as normally closed (NC) contact (b contact) and perform logic operation. 

<Example> During the above procedure 

• When external input X0 flag is ON, R0 flag will be ON. 

• When external input X1 flag is OFF, R1 flag will be ON. 

 Range that can be specified 
Model Device Range 
FP-XH M8N control unit X0-X7·X1100-X141F (Note) 

(Note): When designating X1100-X141F, the input area of the motion control part is read and reflected. 

 Precautions for programs 
• When the contact is out of the specified possible range, operation error may occur. 

• When setting the time through main unit input time constant setting function of system 
register, the time constant will be invalid. 
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 Comparison of ST instruction and DST instruction 
• DST instruction is more suitable for requirement for high-speed response than ST instruction. 

＜For ST instruction＞

●Ladder diagram

X0 R0

●Time chart

n-1 scanning n scanning n+1 scanning

External input

X0

R0

* CPU input time constant setting: None

Execute ST X0  
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＜For DST instruction＞

●Ladder diagram

X0 R0

●Time chart

n-1 scanning n scanning n+1 scanning

External input

X0

R0

Execute DST X0

D

* CPU input time constant setting: None
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18.2.2 ［DAN·DAN/］ Direct AND /·Direct AND NOT 

DAN: read external input and connect normally open (NO) contacts (a contact) in series. As 
input refreshing is performed by taking contact as a unit, it is valid for controls with 
requirement for high-speed response. 

DAN: read external input and connect normally closed (NC) contacts (b contact) in series. As 
input refreshing is performed by taking contact as a unit, it is valid for controls with 
requirement for high-speed response. 

 Instruction format 
X0

D
R10

X0
D

R11

DAN

DAN/

R0

R1

 

 Type of relays that can be specified (unit: bit) (A: Availalbe, -: Not available)) 

 X Y R T C L P E Index 
modifier 

DAN Normally open (NO) contacts connected in a 
line A － － － － － － － A 

DAN/ Normally closed (NC) contacts connected in 
series A － － － － － － － A 

 Operation description 
• Read specified external input and reflect it to output contact, and then perform logic multiply 

operation with the current result calculated with contacts connected in series. 

<Example> During the above procedure 

• When R0 flag is ON and external input X0 flag is ON, R10 flag will be ON. 

• When R1 flag is ON and external input X0 flag is OFF, R11 flag will be ON. 

 Range that can be specified 
Model Device Range 
FP-XH M8N control unit X0-X7·X1100-X141F  (Note) 

(Note): When designating X1100-X141F, the input area of the motion control part is read and reflected. 

 Precautions for programs 
• When the contact is out of the specified possible range, operation error may occur. 

• When setting the time through main unit input time constant setting function of system 
register, the time constant will be invalid. 
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 Comparison of AN instruction and DAN instruction 
• DAN instruction is more suitable for requirement for high-speed response than AN 

instruction. 

＜For AN instruction＞

●Ladder diagram

R0 X0 R10

●Time chart

n-1 scanning n scanning n+1 scanning

R0

External input

X0

R10

*CPU input time constant setting: None

Execute AN X0  
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＜For DAN instruction＞

●Ladder diagram

R0 X0 R10

●Time chart

n-1 scanning n scanning n+1 scanning

R0

External input

X0

R10

* CPU input time constant setting: None

D

Execute DAN X0  
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18.2.3 ［DOR·DOR/］ Direct OR / Direct OR NOT 

DOR: read external input and connect normally open (NO) contacts (a contact) in parallel. As 
input refreshing is performed by taking contact as a unit, it is valid for controls with 
requirement for high-speed response. 

DOR/: read external input and connect normally closed (NC) contacts (b contact) in parallel. 
As input refreshing is performed by taking contact as a unit, it is valid for controls with 
requirement for high-speed response. 

 Instruction format 
R0 R10

X0

R1 R11

X0

DOR

DOR/

D

D
 

 Type of relays that can be specified (unit: bit) (A: Availalbe, -: Not available)) 

 X Y R T C L P E Index 
modifier 

DOR Normally open (NO) contacts connected in 
parallel A － － － － － － － A 

DOR/ Normally closed (NC) contacts connected in 
parallel A － － － － － － － A 

 Operation description 
• Read specified external input and reflect it to output contact, and then perform logic add 

operation with the current result calculated with contacts connected in parallel. 

<Example> During the above procedure 

• When R0 flag is ON or external input X0 flag is ON, R10 flag will be ON. 

• When R1 flag is ON or and external input X0 flag is OFF, R11 flag will be ON. 

 Range that can be specified 
Model Device Range 
FP-XH M8N control unit X0-X7·X1100-X141F (Note) 

(Note): When designating X1100-X141F, the input area of the motion control part is read and reflected. 

 Precautions for programs 
• When the contact is out of the specified possible range, operation error may occur. 

• When setting the time through main unit input time constant setting function of system 
register, the time constant will be invalid. 
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 Comparison of OR instruction and DOR instruction 
• DOR instruction is more suitable for requirement for high-speed response than OR 

instruction. 

＜For OR instruction＞

●Ladder diagram

R0 R10

X0

●Time chart

n-1 scanning n scanning n+1 scanning

R0

External input

X0

R10

* CPU input time constant setting: None

Execute OR X0  
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＜For DOR instruction＞

●Ladder diagram

R0 R10

X0

●Time chart

n-1 scanning n scanning n+1 scanning

R0

External input

X0

R10

* CPU input time constant setting: None

Execute DOR X0

D
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18.3 Direct Output Instruction 

18.3.1 ［DOT］ Direct output 

DOT: operate external output (ON/OFF). As input refreshing is performed by taking contact as 
a unit, it is valid for controls with requirement for high-speed response. 

 Instruction format 

R0
D

Y0
DOT

 

 Type of relays that can be specified (unit: bit) (A: Availalbe, -: Not available)) 

 X Y R T C L P E Index 
modifier 

DOT Coil outputting logic operation result － A － － － － － － A 

 Operation description 
• 「DOT」 Instruction, reflect operation result to specified output contact, external input flag will 

be On/OFF. 

<Example> During the above procedure 

• When R0 flag is ON, external output Y0 flag will be ON. 

• When R0 flag is OFF, external output Y0 flag will be OFF. 

 Range that can be specified 
Model Device Range 
FP-XH M8N control unit Y0-Y7·Y1100-Y141F (Note) 

(Note): When designating Y1100-Y141F, the input area of the motion control part is read and reflected. 

 Precautions for programs 
• When the contact is out of the specified possible range, operation error may occur. 

• A syntax error may occur if the same output coil is specified (dual output). 
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 Comparison of OT instruction and DOT instruction 
• DOT instruction is more suitable for requirement for high-speed response than OT 

instruction. 

 

Y0

n scanning n+1 scanning
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＜For DOT instruction＞

●Ladder diagram

R0 Y0

●Time chart

n-1 scanning n scanning n+1 scanning

R0

Y0

External input

D

Execute DOT Y0  
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18.3.2 ［DSET·DRST］ Direct set / Direct reset 

DSET: When execution condition is satisfied, external output flag will be ON. And the ON 
state will be held. As input refreshing is performed by taking contact as a unit, it is valid for 
controls with requirement for high-speed response. 

DRST: When execution condition is satisfied, external output flag will be OFF. And the OFF 
state will be held. As input refreshing is performed by taking contact as a unit, it is valid for 
controls with requirement for high-speed response. 

 Instruction format 
R0 Y0

R1 Y0

D

D

DSET

DRST

SET＜ ＞

RST＜ ＞

 

 Type of relays that can be specified (unit: bit) (A: Availalbe, -: Not available)) 

 X Y R T C L P E Index 
modifier 

DSET Output coil － A － － － － － － A 
DRST Output coil － A － － － － － － A 

 Operation description 
• 「DSET」 Instruction, when execution condition is ON, the specified output contact flag will be 

ON and external output flag will be ON. Hold the ON state, regardless of the change of state 
of execution condition. 

• 「DRST」 Instruction, when execution condition is ON, the specified output contact flag will be 
OFF and external output flag will be OFF. Hold the OFF state, regardless of the change of 
state of execution condition. 

• 「DSET」「DRST」 Instruction can designate output on the same coil for many times. (No 
syntax error may occur even if total check is performed) 

<Example> During the above procedure 

• When R0 flag is ON, external output Y0 flag will be ON and the ON state will be held. 

• When R1 flag is ON, external output Y0 flag will be OFF and the OFF state will be held. 

 Range that can be specified 
Model Device Range 
FP-XH M8N control unit Y0-Y7·Y1100-Y141F (Note) 

(Note): When designating Y1100-Y141F, the input area of the motion control part is read and reflected. 

 Precautions for programs 
• When the contact is out of the specified possible range, operation error may occur. 

• The state of output end of DSET instruction will be held even if 「MC」 instruction is being 
executed. 

• The output end of DSET instruction will be reset when switching from 「RUN mode」 to 
「PROG mode」 or when the power is OFF, etc. 
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 Comparison of SET instruction and DSET instruction 
• DSET instruction is more suitable for requirement for high-speed response than SET 

instruction. 

＜For SET instruction＞

●Ladder diagram

R0 Y0
<SET>

●Time chart

n-1 scanning n scanning n+1 scanning

R0

Y0

External input

Execute SET Y0  
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＜For DSET instruction＞

●Ladder diagram

R0 Y0
<SET>

●Time chart

n-1 scanning n scanning n+1 scanning

R0

Y0

External input

Execute DSET Y0

D
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 Comparison of RST instruction and DRST instruction 
• DRST instruction is more suitable for requirement for high-speed response than RST 

instruction. 

＜For RST instruction＞

●Ladder diagram

R0 Y0
<RST>

●Time chart

n-1 scanning n scanning n+1 scanning

R0

Y0

External input

Execute RST Y0  



18.3 Direct Output Instruction 

 
18-25 

＜For DOT instruction＞

●Ladder diagram

R0 Y0
<RST>

●Time chart

n-1 scanning n scanning n+1 scanning

R0

Y0

External input

Execute DRST Y0

D
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18.3.3 ［DKP］ Direct hold 

DKP: By outputting with set/reset input, external input flag will be On/OFF and its state will be 
held. 

 Instruction Format 

R1

R0

DKP
DKP

Y0
 

 Type of relays that can be specified (unit: bit) (A: Availalbe, -: Not available)) 

 X Y R T C L P E Index 
modifier 

DKP Output coil － A － － － － － － － 

 Operation description 
• When set input is ON, the specified coil output will be ON and external output flag will be ON. 

And its state will be held. 

• When reset input is ON, the specified coil output will be OFF and external output flag will be 
OFF. And the holding state will be canceled. 

• When the flag is held in the middle, this state will be held until the reset input flag is changed, 
regardless of ON/OFF state of set input. 

• When set input and reset input is ON simultaneously, the reset input will be performed 
preferentially. 

<Example> During the above procedure 

• When R0 flag is ON, external output Y0 flag will be ON and the ON state will be held. 

• When R1 flag is ON, external output Y0 flag will be OFF and the OFF state will be held. 

 Range that can be specified 
Model Device Range 
FP-XH M8N control unit Y0-Y7·Y1100-Y141F (Note) 

(Note): When designating Y1100-Y141F, the input area of the motion control part is read and reflected. 

 Precautions for programs 
• When the contact is out of the specified possible range, operation error may occur. 

• Syntax error may occur if the same output coil is specified (dual output). 

• The state of output end will be held even if 「MC」 instruction is being executed. 

• The output end will be reset when switching from 「RUN mode」 to 「PROG mode」 or when 
the power is OFF, etc. 
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 Comparison of KP instruction and DKP instruction 
• DKP instruction is more suitable for requirement for high-speed response than KP instruction. 

＜For KP instruction＞

●Ladder diagram

R0
KP

R1
Y0

●Time chart

n-1 scanning n scanning n+1 scanning

R0

R1

Y0

External input

Execute KP Y0  
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＜For DKP instruction＞

 Ladder diagram

R0
DKP

R1
Y0

 Time chart

n-1 scanning n scanning n+1 scanning

R0

R1

Y0

External input

Execute DKP Y0  
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19.1 Errors and Warnings 

19.1.1 Errors and Warnings 

 Function of Error/Warning 
• Notify that error occurs in the setting and operation of motion control part. 

• The difference between error and warning is as follows. 

Error 
When an error occurs, the running motor will stop. 
The motor stopped due to occurrence of error will not resume its operation before the error 
is cleared. 

WARNING 
Warning may occur when non-anomalous disorder of operation occurs. 
Operation can be executed after the warning, and the running motor will keep running. 

 Relationship with self-diagnosis error. 
• when error or warning occurs, it will be detected as a self-diagnosis error (error code: 

position control operation error). 

• Operation mode of control unit is set by using the system register No. 24 when position 
control operation error occurred. The default setting sets the operation to "continue", so the 
operation of motion control part is the one described in the table above. If "stop" is selected 
by system register No. 24, the motor will stop in case of error or warning. 

19.1.2 Check and Clearing with Configurator PM7 

It is possible to check and clear data on an axis-by-axis basis by selecting [Online] → [Data 
monitor] on the Configurator PM7 programming tool. 
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19.1.3 Check and Clearing with User Program 

 Confirmation of Error/Warning message 
• The message is read via the special instruction PERED (Error/Warning obtained). When 

executing F388 PERRD instruction, in addition to error code and warning code, the code 
saved in buffer 1 will be read. 

R100
F388 PERRD DT100H0（ ）DF

Axis 1Axis 1 error/warning read

 

Error and warning codes are saved as follows. 
DT100 Error code 
DT101 Warning code 

 Clear of all axes is performed via UCLR instruction 
• Error and warning occurred in the all axes of control unit can be cleared by executing the 

special instruction UCLR (Error/Warning cleared). 

F389 UCLR
R100

Unit clearing
request

）DF（

 

 Clear for each axis via the I/O signal 
• When the Error/Warning clear request flag assigned to I/O area is ON, the Error/Warning of 

each axis can be cleared individually. The following is the program for clearing the error. 

R100

Clear error
request

Axis 1 error
clearing flag

X1230

Axis 1 error
notification flag

Y1230

DF
Y1230

Axis 1 error
clearing flag

（ ）

 

 Allocation of I/O signals 

Signal name Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 
(virtual) 

Axis 8 
(virtual) 

Error annunciation X1230 X1231 X1232 X1233 X1234 X1235 X1236 X1237 

Warning annunciation X1240 X1241 X1242 X1243 X1244 X1245 X1246 X1247 

Error clear request Y1230 Y1231 Y1232 Y1233 Y1234 Y1235 Y1236 Y1237 

Warning clear request Y1240 Y1241 Y1242 Y1243 Y1244 Y1245 Y1246 Y1247 
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19.1.4 Error/Warning Log 

Log area for saving Error/Warning code when Error/Warning occurs is reserved in the unit. 

Error log Up to 7 error codes can be saved in each axis 

Warning log Up to 7 warning codes can be saved in each axis 

 
• In case of Error/Warning, the Error/Warning code will be saved in the log area of the axis 

where the error occurs. 

• Only the newest Error/Warning code of each axis can be confirmed in the position control 
setting menu of programming tool. 

• Please read the Error/Warning log of each axis from the Error/Warning log area saved in the 
positioning memory (common area). 

Error log Warning log area 

H128～H137

H138～H147

H148～H157

H158～H167

H168～H177

Error log area of axis 4

Error log area of axis 5

Error log area of axis 3

Error log area of axis 2

Error log area of axis 1 H128

H129

H12A～H12B

H12C～H12D

H12E～H12F

H130～H131

H132～H133

H134～H135

H136～H137

－

No. of occurrences of
errors
Error code annunciation
buffer 1
Error code annunciation
buffer 2
Error code annunciation
buffer 3
Error code annunciation
buffer 4
Error code annunciation
buffer 5
Error code annunciation
buffer 6
Error code annunciation
buffer 7

No. of occurrences of
warnings
Warning code annunciation
buffer 1
Warning code annunciation
buffer 2
Warning code annunciation
buffer 3
Warning code annunciation
buffer 4
Warning code annunciation
buffer 5
Warning code annunciation
buffer 6
Warning code annunciation
buffer 7

H1C0～H1CF

H1D0～H1DF

H1E0～H1EF

H1F0～H1FF

H230～H23F

Warning log area of axis 1

Warning log area of axis 2

Warning log area of axis 3

Warning log area of axis 4

H1C0

H1C1

H1C2-～H1C3

H1C4～H1C5

H1C6～H1C7

H1C8～H1C9

H1CA～H1CB

H1CC～H1CD

H1CE～H1CF

－

H178～H187

H188～H197

H198～H1A7

Error log area of
(virtual) axis 7
Error log area of
(virtual) axis 8

Warning log area of
(virtual) axis 7
Warning log area of
(virtual) axis 8

Error log area of axis 6

H220～H22F

H200～H20F

H210～H21F

Warning log area of axis 5

Warning log area of axis 6

 

 

Error/warning count Save Error/Warning occurrence number. 

Error/Warning annunciation 
buffer 

Save Error/Warning code. 
The code saved in buffer 1 is always the newest one and the codes are 
saved in buffer 1⇒ buffer 2......in the occurrence order of Error/Warning 
respectively. 
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 Sample program 
• Read Error count of axis-1 to DT100, and the example for reading Error code saved in Error 

code annunciation buffers 1 - 7 to 14 characters of DT101 - DT114 is as follows. 

• Similarly, read Warning count of axis-1 to DT200, and the example for reading Warning code 
saved in Warning code annunciation buffers 1 - 7 to 14 characters of DT201 - DT214 is as 
follows. 

• Read 2 characters for each Error code and Warning code. 

R0
（ ）DF H129 DT100K1

②
H0F384 PTBLR
①

H12A DT101K14
③

H0F384 PTBLR
①

R1
（ ）DF H1C1 DT200K1

④
H0F384 PTBLR
①

H1C2 DT201K14
⑤

H0F384 PTBLR
①  

 Code  Content specified 
by program 

 Value specified by program 

Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 Axis 7 
(virtual) 

Axis 8 
(virtual) 

① Common area H0 

② No. of occurrences of errors H129 H139 H149 H159 H169 H179 H189 H199 

③ Starting address of error 
code annunciation buffer H12A H13A H14A H15A H16A H17A H18A H19A 

④ No. of occurrences of 
warnings H1C1 H1D1 H1E1 H1F1 H201 H211 H221 H231 

⑤ Starting address of warning 
annunciation buffer H1C2 H1D2 H1E2 H1F2 H202 H212 H222 H232 
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19.2 Change of Error Recovery Processing 

19.2.1 Outline 

Recovery methods after error occurred varies from state to state when the error occurs. 

State when the 
error occurs 

Description 

Recoverable 
state 

(Yes) 

• The moving axis stops after the error occurs. 

• The control unit can recover the error at any time after the error occurs. 

Unrecoverable 
state 

(No) 

• Error when severe abnormalities appeared in the system of control unit. 

• Reconnect the power in case of unrecoverable error. 
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19.3 Table of Error Codes 

19.3.1 AMP Errors (0001H 0- ) 

• Alarms/errors occurred on the AMP side are output on the FP-XH M8N Control Unit side as 
error codes. 

• The AMP errors differ depending on the types of AMP. For details of the processing for AMP 
errors, refer to the manual of servo amplifiers.  

• When an AMP error occurs, the servomotor automatically becomes free. Execute the servo 
on request again after clearing the error. 

 How to read AMP error codes 
• An AMP error is divided into a main code and sub code. 

• The error codes stored in the error annunciation area of the FP-XH M8N Control Unit are 
hexadecimal 4-digit codes. 

• For confirming error codes on the AMP, convert the hexadecimal codes to decimal codes. 

Example) When the encoder communication error protection occurred; 

Error code of this unit: 01 15 H 
    ↓ 
  Main code: 15 H, Sub code: 01 H 
    ↓ 
  Converts hexadecimal codes to decimal codes 

  Error code of the AMP 
  Main code: 21, Sub code: 1 

 

 



Error/Warning Annunciation Function 

19-8 

 AMP error code table [For A6N] 
FP-XH M8N 
error code 

A6N error no. 
Description 

Main Sub 
000BH 11 0 Control power supply undervoltage protection 
000CH 12 0 Over-voltage protection 
000DH 13 0 Main power supply undervoltage protection (between P to 

N) 

010DH 13 1 Main powr supply undervoltage protection (AC interception 
detection) 

000EH 14 0 Over-current protection 
010EH 14 1 IPM error protection 
000FH 15 0 Over-heat protection 
010FH 15 1 Encoder overheat error protection 
0010H 16 0 Over-load protection 
0110H 16 1 Torque saturation error protection 

0012H 18 0 Over-regeneration load protection 
0112H 18 1 Over-regeneration Tr error protection 
0015H 21 0 Encoder communication disconnect error protection 
0115H 21 1 Encoder communication error protection 
0017H 23 0 Encoder communication data error protection 
0018H 24 0 Position deviation excess protection 

0118H 24 1 Speed deviation excess protection 
0019H 25 0 Hybrid deviation excess error protection 
001AH 26 0 Over-speed protection 
011AH 26 1 2nd over-speed protection 
011BH 27 1 Absolute clear protection 
041BH 27 4 Command error protection 1 

051BH 27 5 Command generation error protection 
061BH 27 6 Operation command contention protection 
071BH 27 7 Position information initialization error protection 
001CH 28 0 Limit of pulsareplay error protection 
011DH 29 1 Counter overflow protection 1 
021DH 29 2 Counter overflow protection 2 

001FH 31 0 Safety function error protection 1 
021FH 31 2 Safety function error protection 2 
0021H 33 0 I/F overlaps allocation error 1 protection 
0121H 33 1 I/F overlaps allocation error 2 protection 
0221H 33 2 I/F input function number error 1 protection 
0321H 33 3 I/F input function number error 2 protection 

0421H 33 4 I/F output function number error 1 protection 
0521H 33 5 I/F output function number error 2 protection 

(Note): Refer to the latest instruction manual and technical materials of the servo amplifier. 
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FP-XH M8N 
error code 

A6N error no. 
Description 

Main Sub 
0821H 33 8 Latch input allocation error protection 

0022H 34 0 Software limit protection 
0024H 36 0 EEPROM parameter error protection 
0124H 36 1 EEPROM parameter error protection 
0025H 37 0 EEPROM check code error protection 
0125H 37 1 EEPROM check code error protection 
0225H 37 2 EEPROM check code error protection 

0026H 38 0 Over-travel inhibit input protection 1 
0126H 38 1 Over-travel inhibit input protection 2 
0226H 38 2 Over-travel inhibit input protection 3 
0028H 40 0 Absolute system down error protection 
0029H 41 0 Absolute counter over error protection 
002BH 43 0 Encoder initialization error protection 

002CH 44 0 Single turn counter error protection 
002DH 45 0 Multi-turn counter error protection 
0030H 48 0 Encoder Z-phase error protection 
0031H 49 0 Encoder CS signal error protection 
0032H 50 0 External scale connection error protection 
0132H 50 1 External scale communication data error protection 

0033H 51 0 External scale ST error protection 0 
0133H 51 1 External scale ST error protection 1 
0233H 51 2 External scale ST error protection 2 
0333H 51 3 External scale ST error protection 3 
0433H 51 4 External scale ST error protection 4 
0533H 51 5 External scale ST error protection 5 

0037H 55 0 Phase A connection error protection 
0137H 55 1 Phase B connection error protection 
0237H 55 2 Phase Z connection error protection 
0052H 82 0 RTEX node addressing error protection 
0053H 83 0 RTEX communication error protection 1 
0153H 83 1 RTEX communication error protection 2 

0054H 84 0 RTEX time out error protection 
0354H 84 3 RTEX sync and initialization error protection 
0554H 84 5 RTEX communication cycle error protection 
0056H 86 0 RTEX cyclic data error protection 1 
0156H 86 1 RTEX cyclic data error protection 2 

(Note): Refer to the latest instruction manual and technical materials of the servo amplifier.  
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FP-XH M8N 
error code 

A6N error no. 
Description 

Main Sub 
0256H 86 2 RTEX update counter error protection 
0057H 87 0 Compulsory alarm input protection 

025AH 90 2 Multi-axis synchronization establishment error protection 
015BH 91 1 RTEX command error protection 
005CH 92 0 Encoder data recovery error protection 
015CH 92 1 External scale data recovery error protection 
035CH 92 3 Multi-turn data upper-limit value disagreement error 

protection 
005DH 93 0 Parameter setting error protection 1 
025DH 93 2 Parameter setting error protection 2 
035DH 93 3 External scale connection error protection 

055DH 93 5 Parameter setting error protection 4 
085DH 93 8 Parameter setting error protection 6 
025EH 94 2 Home position return error protection 
035EH 94 3 Home position return error protection 2 
005FH 95 0 Motor automatic recognition error protection 
015FH 95 1 Motor automatic recognition error protection 

025FH 95 2 Motor automatic recognition error protection 
035FH 95 3 Motor automatic recognition error protection 
045FH 95 4 Motor automatic recognition error protection 
0260H 96 2 Control unit error protection 1 
0360H 96 3 Control unit error protection 2 
0460H 96 4 Control unit error protection 3 
0560H 96 5 Control unit error protection 4 
0660H 96 6 Control unit error protection 5 
0760H 96 7 Control unit error protection 6 
0162H 98 1 RTEX hardware error protection 1 
0262H 98 2 RTEX hardware error protection 2 
0362H 98 3 RTEX hardware error protection 3 
- Other 

numbers 
 Other error protections 

(Note): Refer to the latest instruction manual and technical materials of the servo amplifier.  
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 AMP error code table [For A5N] 
FP-XH M8N 
error code 

A5N error no. 
Description 

Main Sub 
000BH 11 0 Control power supply undervoltage protection 
000CH 12 0 Over-voltage protection 
000DH 13 0 Main power supply undervoltage protection (between P to 

N) 

010DH 13 1 Main power supply undervoltage protection (AC interception 
detection) 

000EH 14 0 Over-current protection 
010EH 14 1 IPM error protection 
000FH 15 0 Over-heat protection 
0010H 16 0 Over-load protection 
0110H 16 1 Torque saturation error protection 
0012H 18 0 Over-regeneration load protection 

0112H 18 1 Over-regeneration Tr error protection 
0015H 21 0 Encoder Communication disconnect error protection 
0115H 21 1 Encoder Communication error protection 
0017H 23 0 Encoder communication data error protection 
0018H 24 0 Position deviation excess protection 
0118H 24 1 Speed deviation excess protection 

0019H 25 0 Hybrid deviation excess error protection 
001AH 26 0 Over-speed protection 
011AH 26 1 2nd over-speed protection 
011BH 27 1 Absolute clear protection 
041BH 27 4 Command error protection 1 
051BH 27 5 Command generation error protection 

061BH 27 6 Operation command contention protection 
071BH 27 7 Position information initialization error protection 
001CH 28 0 Limit of pulse replay error protection 
011DH 29 1 Deviation counter overflow protection 1 
021DH 29 2 Deviation counter overflow protection 2 
001EH 30 0 Safety detection [Only special product supports this 

feature.] 
0021H 33 0 I/F input duplicated allocation error 1 protection 
0121H 33 1 I/F input duplicated allocation error 2 protection 

0221H 33 2 I/F input function number error 1 protection 
0321H 33 3 I/F input function number error 2 protection 
0421H 33 4 I/F output function number error 1 protection 
0521H 33 5 I/F output function number error 2 protection 
0821H 33 8 Latch input allocation error protection 
0022H 34 0 Software limit protection 

(Note): Refer to the latest instruction manual and technical materials of the servo amplifier. 
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FP-XH M8N 
error code 

A5N error no. 
Description 

Main Sub 
0024H 36 0 EEPROM parameter error protection 

0124H 36 1 EEPROM parameter error protection 
0224H 36 2 EEPROM parameter error protection 
0025H 37 0 EEPROM check code error protection 
0125H 37 1 EEPROM check code error protection 
0225H 37 2 EEPROM check code error protection 
0026H 38 0 Over-travel inhibit input protection 1 

0126H 38 1 Over-travel inhibit input protection 2 
0226H 38 2 Over-travel inhibit input protection 3 
0028H 40 0 Absolute system down error protection 
0029H 41 0 Absolute counter over error protection 
002AH 42 0 Absolute over-speed error protection 
002BH 43 0 Incremental encoder initialization error protection 

002CH 44 0 

・For Absolute 
Absolute single turn counter error protection 
・For Incremental 
Incremental single turn counter error protection 

002DH 45 0 

・For Absolute 
Absolute multi-turn counter error protection 

・For Incremental 
Incremental multi-turn counter error protection 

002FH 47 0 Absolute status error protection 
0030H 48 0 Incremental encoder Z-phase error protection 
0031H 49 0 Incremental encoder CS signal error protection 
0032H 50 0 External scale connection error protection 
0132H 50 1 External scale communication error protection 
0033H 51 0 External scale status 0 error protection 

0133H 51 1 External scale status 1 error protection 
0233H 51 2 External scale status 2 error protection 
0333H 51 3 External scale status 3 error protection 
0433H 51 4 External scale status 4 error protection 
0533H 51 5 External scale status 5 error protection 
0037H 55 0 A-phase connection error protection 

0137H 55 1 B-phase connection error protection 
0237H 55 2 Z-phase connection error protection 
0052H 82 0 RTEX node addressing error protection 
0053H 83 0 RTEX communication error protection 1 
0153H 83 1 RTEX communication error protection 2 
0054H 84 0 RTEX time out error protection 

0354H 84 3 RTEX sync and initialization error protection 
0554H 84 5 RTEX communication cycle error protection 

(Note): Refer to the latest instruction manual and technical materials of the servo amplifier. 
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FP-XH M8N 
error code 

A5N error no. 
Description 

Main Sub 
0056H 86 0 RTEX cyclic data error protection 1 

0156H 86 1 RTEX cyclic data error protection 2 
0256H 86 2 RTEX update counter error protection 
0057H 87 0 Compulsory alarm input protection 
025AH 90 2 Multi-axis synchronization establishment error protection 
015BH 91 1 RTEX command error protection 
005CH 92 0 Encoder data recovery error protection 
015CH 92 1 External scale data recovery error protection 
005DH 93 0 Parameter setting error protection 1 
025DH 93 2 Parameter setting error protection 2 
035DH 93 3 External scale connection error protection 
055DH 93 5 Parameter setting error protection 4 
025EH 94 2 Home position return error protection 

005FH 95 0 Motor automatic recognition error protection 
015FH 95 1 Motor automatic recognition error protection 
025FH 95 2 Motor automatic recognition error protection 
035FH 95 3 Motor automatic recognition error protection 
045FH 95 4 Motor automatic recognition error protection 
0162H 98 1 RTEX hardware error protection 1 
0262H 98 2 RTEX hardware error protection 2 
0362H 98 3 RTEX hardware error protection 3 
- Other 

numbers 
 Other error protections 

(Note): Refer to the latest instruction manual and technical materials of the servo amplifier.  
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19.3.2 System Errors (1000H - ) 

The followings are errors occurred due to internal abnormalities of the unit. The system error 
is defined as the error that has a fatal effect on the system. Except for some items, 
reconnecting the power is necessary for the recovery of system error. 

Code Name Description Object Recovery Measures 

1000H System 
crash System crash All axes × 

Reconnect the power. 
If this error continues, please 
contact our company. 

1001H Hardware 
error 

Error occurred during the 
hardware test with the power 
ON 

All axes × 

1002H Unit error Some errors occurred during 
internal processing All axes × 

1003H 
System 
processing 
error 

System processing error 
caused by some reasons All axes ○ 

Check the settings. 
If this error continues while there 
are no abnormal settings, please 
contact our company. 

1015H System start 
error 

Reading positioning setting 
data failed at the time of the 
system startup. 

All axes × 

Turn off the power supply and turn 
it on again. 

If an error occurs repeatedly, 
consult your Panasonic 
representative. 

1020H 
Tools 
running 
Abnormal 
completion 

Error occurs in the 
communication with the 
computer when performing 
tools running via the position 
control setting menu of 
programming tool. 

All axes ○ 
Confirm the cable connection 
between computer and PLC. 
Restart the computer. 

1030H Control unit 
error ALARM occurs in control unit All axes × 

Confirm the state of the control unit. 
Reconnect the power. 

1031H 
Control unit 
Abnormal 
operation 
mode 

Switch the control unit to PROG 
mode and the operation stops All axes ○ 

Confirm the state of the control unit. 
Set the control unit as RUN mode. 
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19.3.3 AMP Communication Errors (2000H - ) 

These are the errors occurred in the communication between FP-XH M8N Control Unit and 
AMP. 

Code Name Description Object Recovery Measures 

2000H 
AMP 
communication 
error 

A communication error occurred after 
the network communication has been 
established. 

All axes × 

・Check the power supply of the AMP is 
on. 

・Check the communication pathway. 
Carefully check the connector failure 
and breaking of the communication 
cable. 
Also, check if any excessive noise is 
caused in the usage environment. 

・If the error occurred repeatedly, 
please contact us. 

2001H AMP data 
acquisition error 

Failed in the data acquisition of each 
AMP. 

Each 
axis ○ ・Check the status of the AMP that the 

error occurred. 

・Check the communication pathway. 
Carefully check the connector failure 
and breaking of the communication 
cable. 
Also, check if any excessive noise is 
caused in the usage environment. 

・If the error occurred repeatedly, 
please contact us. 

2002H AMP parameter 
error 

The communication parameters of 
each AMP are incorrect. 

Each 
axis ○ 

2003H 
Network 
communication 
timeout 

Time-out occurred in communication 
between the FP-XH M8N Control Unit 
and AMP, and communication was 
cut off. 

Each 
axis ○ 

Check the state of the AMP. 
(As information on the AMP cannot be 
obtained when communication is cut 
off, an error on the AMP may not be 
obtained.) 
Check the communication cable. 

2004H AMP parameter 
control error 

A communication error occurred 
during an AMP parameter operation 
(read, write, save or reset). 

Each 
axis ○ 

・Check the state of the AMP. 

・Check that the control mode of the 
AMP is correctly set.(The speed control 
mode and torque control mode cannot 
be used.) 

2010H 
Excessive no. of 
AMP 
cocnnections 

The number of the AMPs connected 
to the network exceeded the limit 
(maximum No. of axes) of the unit. 

All axes × 

・Afer checking the connection and 
settings of the AMP, turn off the power 
supply and turn it on again. 

・If the error occurred repeatedly, 
please contact us. 

・When using the virtual axes, set the 
unit numbers of AMPs as follows; 

when using one virtual axis: 1-7 

when using two virtual axes: 1-6 

2020H AMP node 
duplication 

The AMPs with the same unit number 
exist in the network. All axes × 

2021H Virtual axis 
duplication error 

The AMP with the following unit 
number is connected although virtual 
axes are used. 

When using one virtual axis: Unit no. 
8 
When using two virtual axes: Unit 
nos. 7 and 8 

All axes × 

2030H 
AMP node 
number setting 
error 

The AMP with a node number other 
than the numbers below exists. 
1-8 

All axes × 

2040H AMP reset failure An error occurred in the AMP reset 
operation and the system stopped. All axes × Turn off the power supply to the system 

and turn it on again. 

2050H AMP connection 
error 

A4N and A6N/A5N are both used for 
the connected AMP. All axes × 

Check the configuration of connected 
AMPs so that A4N and A6N/A5N are 
not mixed. 
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19.3.4 Axis Operation Errors (3000H - ) 

The followings are errors occurred when executing various of operations 
Code Name Description Object Recovery Measures 
3000H Not servo ready The axis that servo is not 

locked was started. 
Each 
axis ○ Confirm the servo is locked 

while each axis is operating 

3001H Servo off detection 
in operation 

The servo became off 
during the operation being 
processed. 

Each 
axis ○ 

- Turn off the servo on input 
when the busy signal for the 
target axis is not on. 
- Check the state of the AMP. 

3005H Main power supply 
OFF error 

The servo on was 
requested when the main 
power supply of the AMP 
was off. 

Each 
axis ○ 

- Turn the servo on after the 
main power supply has been 
turned on. 
- Check the voltage of the main 
power supply. 

3010H Limit + signal 
detection 

The input on the positive 
side of the limit has turned 
ON. 

Each 
axis ○ Move the motor into the range 

of the limit by an appropriate 
mode, such as JOG operation. 
Check the limit signal is correct. 3011H Limit – signal 

detection 
The input on the negative 
side of the limit has turned 
ON. 

Each 
axis ○ 

3012H Limit signal error 
Both inputs on the positive 
and negative sides of the 
limit have turned ON. 

Each 
axis ○ Check the status of the limit 

signal. 

3020H 
Software limit 
(positive side) 
detection 

The movement amount of 
the motor has exceeded 
the upper limit of the 
software limit. 

Each 
axis ○ Move the motor into the range 

of the software limit by an 
appropriate mode, such as JOG 
operation. 
Check the set values of the 
software limit. 3021H 

Software limit  
(negative side) 
detection 

The movement amount of 
the motor has exceeded 
the lower limit of the 
software limit. 

Each 
axis ○ 

3025H Command speed 
operation error 1 

The internal operation 
of command speed 
failed due to overflow. 

Each 
axis ○ Lower the set speed. 

Check the settings of the 
pulse number per rotation 
and movement amount per 
rotation. 

3026H Command speed 
operation error 2 

Each 
axis ○ 

3027H Command speed 
operation error 3 

Each 
axis ○ 

3030H Axis operation error 
An error has occurred in 
the operation processing of 
each axis due to some 
reason. 

Each 
axis ○ 

Check the set values and 
parameters for the positioning 
unit. 
If an error occurs repeatedly 
with the correct set values, 
consult your Panasonic 
representative. 

3031H Operation abnormal 
end 

An error has occurred in 
the operation processing of 
each axis due to some 
reason. 

Each 
axis 
All axes 

○ 
If an error occurs repeatedly, 
consult your Panasonic 
representative. 

3032H Axis group 
operation error 

Axis group settings are 
changed while the 
positioning unit is in 
operation or a stop request 
is being made. 
Axis group settings are 
outside the range. 

Each 
axis ○ 

Changing the axis group should 
be performed when the axes are 
not in operation. 
Do not make a stop request, 
either. 
Check the axis group settings. 

3033H Interpolation 
operation error 

The operation has stopped 
due to an error in another 
interpolation axis during 
interpolation. 

Each 
axis ○ 

Check the set values for 
positioning data on interpolation. 
If an error occurs repeatedly 
with the correct set values, 
consult your Panasonic 
representative. 
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Code Name Description Object Recovery Measures 

3034H 

Axis group not 
settable 
(In pulser 
operation） 

The axis group settings are 
changed while the 
positioning unit is in pulser 
operation. 

Each 
axis ○ 

Changing the axis group should 
be performed when the pulser 
operation enabled signal is 
OFF. 

3035H 
Positioning 
movement amount 
error 

The positioning movement 
amount has exceeded the 
upper or lower limit. 

Each 
axis ○ Check the set value. 

3040H 
Synchronous 
operation group 
error 

The synchronous group is 
changed while the 
positioning unit is in 
synchronous operation or a 
stop request is being 
made. 
The settings of axis groups 
are outside the range. 
An error has occurred 
during a home return while 
the positioning unit is in 
synchronous operation. 

Each 
axis ○ 

Changing the synchronous 
group should be performed 
when the busy signal for the 
axes to be synchronized is OFF. 
It should be performed when 
various stop request signals 
(system stop, emergency stop, 
deceleration stop) are OFF. 

3042H 
Synchronous 
operation home 
return error 

The home return 
processing is executed 
in synchronous 
operation. 

Each 
axis ○ 

When performing the home 
return processing, cancel 
the synchronous control. 

3043H Synchronous 
operation error 

The operation has stopped 
as an error occurred on 
another axis while the 
positioning unit is in 
synchronous operation. 

Each 
axis ○ 

Check the unit setting of the 
stopped axis. 
If an error occurs repeatedly 
with the correct set values, 
consult your Panasonic 
representative. 

3044H 

Synchronous 
operation not 
settable 
(In pulser 
operation） 

The setting of the 
synchronous operation was 
changed while the 
positioning unit is in pulser 
operation. 

Each 
axis ○ 

Changing the setting of the 
synchronous operation should 
be performed when the pulser 
operation enabled signal is 
OFF. 

3045H 
Synchronous axis 
difference check 
error 

The difference between the 
movement amounts of the 
target axes under 
synchronous control 
exceeded the specified 
difference. 

Each 
axis ○ 

Check the operation of the 
target axes for the synchronous 
operation. 

3050H Torque judgment 
error 

The torque value exceeds 
the setting upper and lower 
limit values. 
This error occurs when 
setting  
- torque judgment to 
“Available”  
- annunciation method to 
“Error” 

Each 
axis ○ 

・Design the system within the 
range that the torque of the 
motor does nto exceed the 
judgment value. 

・Check the torque judgment 
value. 

3051H 
Actual speed 
judgment value 
error 

The actual speed exceeds 
the setting upper and lower 
limit values. 
This error occurs when 
setting  
- actual speed judgment to 
“Available”  
- annunciation method to 
“Error” 

Each 
axis ○ 

・Design the system within the 
range that the actual speed of 
the motor does nto exceed the 
judgment value. 

・Check the actual speed 
jdgement value. 

3060H Home return not 
executable error 

The home return could not 
be executed as AMP 
parameter settings and 
signal input were not 
correct. 
This error occurs when 
using A6N/A5N as AMP. 

Each 
axis ○ Check the parameters of AMP 

and signal inputs. 
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19.3.5 Set Value Errors (4000H - ) 

The following errors occur to various set values made in the positioning setting menu of the 
programming tool and ladder programs. 

Code Name Description Object Recovery Measures 

4000H Axis group 
setting error 

The axis group setting is 
abnormal. 

When using the virtual axes, the 
virtual axes are not registered in 
the independent axis area of the 
axis group. 

Each 
axis ○ 

Check settings of the axis group 
and individual axis as follows. 
- The same axis no. is registered 
in multiple groups. 

-  More than 4 axes are set in the 
same group. 

-  The axis group comprises only 
1 axis. 

- The virtual axes are not 
registered in the independent 
axis area of the axis group. 

4001H Virtual axis 
setting error 

The virtual axis usage setting 
(number of virtual axes) is 
incorrect. 

All axes ○ Check the setting. 

4002H Unit setting 
error 

The unit system for the axis 
setting is out of the range. 

Each 
axis ○ 

Check if the unit is one of the 
followings. 
pulse, µm, inch, degree 

4004H 
Pulse number 
error per 
rotation 

The pulse number is out of the 
range. 

Each 
axis ○ 

Check the set value. 
If the set value is out of the 
range, reduce it by the following 
formula. 
(Pulse number per rotation) / 
(Movement amount per rotation) 

4005H 
Movement 
amount error 
per rotation 

The movement amount is out of 
the range. 

Each 
axis ○ 

4010H Software limit 
setting error 

The upper or lower limit value of 
software limit is out of the range. 

Each 
axis ○ 

Check the set value. 
If an error occurs repeatedly with 
the correct set values, consult 
your Panasonic representative. 

4020H 
Limit stop 
deceleration 
time error 

The limit stop deceleration time 
is out of the range. 

Each 
axis ○ 

4021H 
Error stop 
deceleration 
time error 

The error stop deceleration time 
is out of the range. 

Each 
axis ○ 

4022H 
Emergency 
stop 
deceleration 
time error 

The emergency stop 
deceleration time is out of the 
range. 

Each 
axis ○ 

4028H 
Auxiliary 
output setting 
error 

The settings of auxiliary output 
are not correct. 
A mode other than With mode or 
Delay mode for the auxiliary 
output mode has been set. 
The auxiliary output delay ratio 
while the positioning unit is in 
Delay mode is not 0 to 100 (%). 

Each 
axis ○ 
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Code Name Description Object Recovery Measures 

4030H Synchronous group setting 
error 

The same axis has been set 
for the synchronous groups 
1 and 2. 

Either master axis or slave 
axis has not been set. 

Multiple axes have been set 
for the master or slave axis. 

The same axis has been set 
for the master and slave 
axes. 

The slave axis has been set 
to the interpolation group. 

Each 
axis ○ 

Check the set value. 

If an error occurs 
repeatedly with the 
correct set values, 
consult your 
Panasonic 
representative. 

4031H Synchronous operation 
mode setting error 

Operation settings for the 
synchronous operation 
differential check function 
are incorrect. 

Each 
axis ○ 

4041H Completion width error The completion width is out 
of the range. 

Each 
axis ○ 

Check the set value. 

If the error occurs 
repeatedly with the 
correct set values, 
please contact us. 

4042H Pulsar setting error 

The pulsar input mode is 
incorrect. 

The pulsar operation 
method is incorrect. 

The maximum speed for the 
pulsar operation is incorrect. 

Each 
axis ○ 

Check the set value. 

If the error occurs 
repeatedly with the 
correct set values, 
please contact us. 

4043H Pulsar disabled error 

The pulse input application 
of the axis which the uplsar 
input is enabled is not set to 
pulsar. 

Each 
axis ○ 

Check the pulse input 
application. 

When using the pulsar, 
set the input 
application to "Pulsar". 

4044H Speed factor error The setting of the speed 
factor is out of the range. 

Each 
axis ○ 

Check the set value. 

If an error occurs 
repeatedly with the 
correct set values, 
consult your 
Panasonic 
representative. 

4080H 
JOG positioning 
acceleration/deceleration 
method error 

The acceleration/ 
deceleration method of the 
JOG positioning is out of the 
range. 

Each 
axis ○ 

4081H JOG positioning 
acceleration time error 

The acceleration time of the 
JOG positioning is out of the 
range. 

Each 
axis ○ 

4082H JOG positioning 
deceleration time error 

The deceleration time of the 
JOG positioning is out of the 
range. 

Each 
axis ○ 
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Code Name Description Object Recovery Measures 

4083H 
JOG 
positioning 
target speed 
error 

The target speed of the JOG 
positioning is out of the range. 

Each 
axis ○ 

Check the set value. 
If an error occurs repeatedly with 
the correct set values, consult your 
Panasonic representative. 

4102H 
Home return 
target speed 
error 

The target speed of the home 
return is out of the range. 

Each 
axis ○ 

4105H 
Home return 
acceleration 
time error 

The acceleration time of the 
home return is out of the range. 

Each 
axis ○ 

4106H 
Home return 
deceleration 
time error 

The deceleration time of the 
home return is out of the range. 

Each 
axis ○ 

4107H 
Home return 
setting code 
error 

The home return setting code is 
incorrect. 

Each 
axis ○ 

4110H 
Home return 
creep speed 
error 

The creep speed of the home 
return is out of the range. 

Each 
axis ○ 

4111H 
Home return 
returning 
direction error 

The moving direction of the 
home return is incorrect 

Each 
axis ○ 

4112H Home return 
limit error 

The limit switch is disabled. 
(It occurs when the home return 
method is set to the limit 
method 1 or 2.) 

Each 
axis ○ 

4115H 

Home return 
stop-on-
cotnact 
torque value 
error 

The home return stop-on-
contact torque value is out of 
the range. 

(It occurs when the home return 
method is set to the stop-on-
contact method 1 or 2.) 

Each 
axis ○ 

4116H 

Home return 
Stop-on-
contact 
judgment 
time error 

The home return stop-on-
contact judgment time is out of 
the range. 

(It occurs when the home return 
method is set to the stop-on-
contact method 1 or 2.) 

Each 
axis ○ 

4120H Coordinate 
origin error 

The coordinate origin is out of 
the range. 

Each 
axis ○ 

4201H 

JOG 
operation 
target speed 
error 

The target speed of the JOG 
operation is out of the range. 

Each 
axis ○ 
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4203H 
JOG operation 
acceleration/deceleration 
method error 

The 
acceleration/deceleration 
method of the JOG 
operation is incorrect. 

Each 
axis ○ 

Check the set value. 
If an error occurs 
repeatedly with the 
correct set values, 
consult your Panasonic 
representative. 

4204H JOG operation acceleration 
time error 

The acceleration time of the 
JOG operation is out of the 
range. 

Each 
axis ○ 

4205H JOG operation deceleration 
time error 

The deceleration time of the 
JOG operation is out of the 
range. 

Each 
axis ○ 

4250H Current value update error 
The set value of the current 
value update is out of the 
range. 

Each 
axis ○ 

4251H Realtime torque limit value 
error 

The specified realtime 
torque value is out of the 
range. 

Each 
axis ○ 

4301H Absolute/incremental setting 
error 

A value other than the 
absolute/increment is set for 
the control method. 

Each 
axis ○ 

4302H Dwell time error The set value of the dwell 
time is out of the range. 

Each 
axis ○ 

4303H Positioning starting table 
No. error 

The specified table number 
is 0, or it exceeds the 
maximum table number. 

Each 
axis ○ 

4304H Table setting error 
The last table of the 
positioning setting tables is 
not the E point. 

Each 
axis ○ 

4400H Positioning movement 
amount setting error 

The movement amount of 
the positioning operation is 
out of the range. 

Each 
axis ○ 

4401H 
Positioning 
acceleration/deceleration 
method error 

The acceleration/ 
deceleration method of the 
positioning operation is 
incorrect. 

Each 
axis ○ 

4402H Positioning acceleration 
time error 

The acceleration time of the 
positioning operation is out 
of the range. 

Each 
axis ○ 

4404H Positioning target speed 
error 

The target speed of the 
positioning operation is out 
of the range. 

Each 
axis ○ 

Check the set value. 
If an error occurs 
repeatedly with the 
correct set values, 
consult your Panasonic 
representative. 

4500H Interpolation type error 
The setting of the 
interpolation type is 
incorrect. 

Each 
axis ○ 

4504H Circular interpolation not 
executable 

The parameter of the 
circular interpolation (such 
as center point or pass 
point) is incorrect. 

Each 
axis ○ 

4505H Spiral interpolation not 
executable 

The error occurred while the 
positioning unit is in spiral 
interpolation operation as 
the set value is incorrect. 

Each 
axis ○ 

4510H Positioning speed change 
speed error 

The position control speed 
change is out of the range. 

Each 
axis ○ 

4520H Positioning movement 
amount change error 

The positioning speed 
movement  amount change 
is out of the range. 

Each 
axis ○ 

4600H Pulse input setting error The pulse input settings are 
incorrect. 

Each 
axis ○ 

4605H Pulse count value change 
setting error 

The set pulse count change 
value is out of the range. 

Each 
axis ○ 
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19.3.6 Setting value errors of synchronous parameters (5000H - ) 

 Synchronous parameters: Common errors (5000H -) 
Code Name Description Object Recovery Measures 

5000H Synchronous master 
setting value error 

The setting for the 
synchronous master axis is 
incorrect. 

→ Setting error (Value is 
incorrect.) 

→ Own axis setting 

Each 
axis ○ 

Check the set value. 

If the error occurs 
repeatedly with the correct 
set values, consult your 
Panasonic representative. 

5001H 
Synchronous master 
pulse input application 
error 

The pulse input other than 
"High-speed counter" 
application was selected 
when setting the synchronous 
master axis to pulse input. 

Each 
axis ○ 

5002H Synchronous setting 
disable error 

The synchronous setting 
rquest was made in the 
following axis setting . 

- Its own axis (slave axis) is 
set as the master of another 
axis. 

- The master axis is set as 
the slave axis of another axis. 

- Its own axis (slave axis) 
belongs to the interpolation 
group. 

Each 
axis ○ 

5006H 
Synchronous slave 
single deceleration 
stop deceleration time 

The setting for the 
synchronous slave single 
deceleration stop time is 
incorrect. 

Each 
axis ○ 

 

 Synchronous parameters: Electronic gear-related errors (5100H - ) 
Code Name Description Object Recovery Measures 

5100H 
Electronic gear - Gear 
ratio numerator setting 
error 

The setting for the gear ratio 
numerator of the electronic 
gear is incorrect. 

Each 
axis ○ 

Check the set value. 

If the error occurs 
repeatedly with the correct 
set values, consult your 
Panasonic representative. 

5101H 
Electronic gear - Gear 
ratio denominator 
setting error 

The setting for the gear ratio 
denominator of the electronic 
gear is incorrect. 

Each 
axis ○ 

5102H 
Electronic gear - Gear 
ratio change time 
setting error 

The setting for the gear ratio 
change time of the electronic 
gear is incorrect. 

Each 
axis ○ 
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 Synchronous parameters: Electronic clutch-related errors (5200H - ) 
Code Name Description Object Recovery Measures 

5200H 
Clutch - Clutch ON 
trigger type setting 
error 

The setting for the clutch ON 
trigger type is incorrect. 

Each 
axis ○ 

Check the set value. 
If an error occurs 
repeatedly with the correct 
set values, consult your 
Panasonic representative. 

5201H 
Clutch - Clutch ON 
edge selection setting 
error 

The setting for the clutch ON 
edge selection is incorrect. 

Each 
axis ○ 

5203H 
Clutch - Clutch OFF 
trigger type setting 
error 

The setting for the clutch OFF 
trigger type is incorrect. 

Each 
axis ○ 

5204H 
Clutch - Clutch OFF 
edge selection setting 
error 

The setting for the clutch OFF 
edge selection is incorrect. 

Each 
axis ○ 

5207H Clutch - Clutch ON 
method setting error 

The setting for the clutch ON 
method is incorrect. 

Each 
axis ○ 

5208H Clutch - Clutch ON slip 
method setting error 

The setting for the clutch ON 
slip method is incorrect. 

Each 
axis ○ 

5209H Clutch - Clutch ON slip 
time setting error 

The setting for the clutch ON 
slip time is incorrect. 

Each 
axis ○ 

5210H 
Clutch - Clutch ON slip 
curve selection setting 
error 

The setting for the clutch ON 
slip curve is incorrect. 

Each 
axis ○ 

5211H Clutch - Clutch OFF 
method setting error 

The setting for the clutch ON 
method is incorrect. 

Each 
axis ○ 

5212H 
Clutch - Clutch OFF 
slip method setting 
error 

The setting for the clutch OFF 
slip method is incorrect. 

Each 
axis ○ 

5213H Clutch - Clutch OFF 
slip time setting error 

The setting for the clutch OFF 
slip time is incorrect. 

Each 
axis ○ 

5214H 
Clutch - Clutch OFF 
slip curve selection 
setting error 

The setting for the clutch OFF 
slip curve is incorrect. 

Each 
axis ○ 
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 Synchronouse parameters: Electronic cam-related errors (5300H - ) 
Code Name Description Object Recovery Measures 

5300H 

Electronic cam - Cam 
control synchronous 
master axis cycle 
setting error 

The setting for the cam 
control synchronous master 
axis cycle is incorrect. 

Each 
axis ○ 

Check the set value. 

If the error occurs 
repeatedly with the correct 
set values, consult your 
Panasonic representative. 

5301H 
Electronic cam - Used 
cam pattern no. setting 
error 

The used cam pattern 
number is out of the range. 

The used cam pattern 
number is not registered. 

Each 
axis ○ 

5302H 
Electronic cam - Cam 
stroke amount setting 
error 

The setting for the cam stroke 
amount is incorrect. 

Each 
axis ○ 

 

 Cam patterns-related errors 
Code Name Description Object Recovery Measures 

5400H Cam pattern resolution 
setting error 

The setting for the cam 
pattern resolution is out of the 
range. 

Each 
axis ○ 

Check the set value. 

If the error occurs 
repeatedly with the correct 
set values, consult your 
Panasonic representative. 

5401H Cam pattern set 
number setting error 

The cam pattern set number 
is out of the range. 

Each 
axis ○ 

5402H Cam pattern section 
function setting error 

The setting for the cam 
pattern section function is out 
of the range. 

Each 
axis ○ 

5403H 
Cam pattern control 
start position setting 
error 

The setting for the cam 
pattern control start position 
is out of the range. 

Each 
axis ○ 

5404H Cam pattern start 
phase setting error 

The start phase setting for 
each section of cam pattern 
is out of the range. 

Each 
axis ○ 

5405H 
Cam pattern 
displacement setting 
error 

The displacement for each 
section of cam pattern is out 
of the range. 

Each 
axis ○ 

5406H Cam pattern cam 
curve no. setting error 

The curve number for each 
section of cam pattern is out 
of the range. 

Each 
axis ○ 

5410H Adjustment data total 
no. setting error 

The total number of cam 
pattern adjustment data is out 
of the range. 

Each 
axis ○ 

5411H Adjustment data no. 
setting error 

The number of cam pattern 
adjustment data is out of the 
range. (cam pattern unit) 

Each 
axis ○ 

5413H 
Adjustment data 
control point setting 
error 

The control point of cam 
pattern adjustment data is out 
of the range. 

Each 
axis ○ 

5414H 
Out-of-range 
adjustment data setting 
error 

The adjustment value of cam 
pattern adjustment data is out 
of the range. 

Each 
axis ○ 
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19.4 Table of Warning Codes 

19.4.1 AMP Warnings (A000H - ) 

• Warnings occurred on the AMP side are output on the FP-XH M8N Control Unit side as 
warning codes. 

• The warning codes output from this unit are written in hexadecimal, however, the warning 
codes output from the AMP are written in hexadecimal when using A6N/A5N. 

• The AMP warnings differ depending on the types of AMP. For details of the processing for 
AMP warnings, refer to the manual of servo amplifiers.  

 How to read AMP warning codes [For A6N/A5N] 
The warning numbers of AMP are obtained by subtracting A000H from the warning codes of 
this unit. 

Example) When an overload protection occurred; 

  Warning code of this unit: A0A0 H 
    ↓ 
  Subtract A000H from the warning code: 00A0 H 
    ↓ 
  Warning number of AMP: A0 H 
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19.4.2 Unit Warning (B000H - ) 

The warning codes upon warnings of the unit are listed below. 
Code Name Description Object Recovery Measures 

B000H Tool operation 

The following request 
signals were turned ON by 
the host PLC while the 
positioning unit is in tool 
operation. 
• Positioning start 
request flag (each axis) 
• Home return 
request flag (each axis) 
• JOG 
forward/reverse rotation 
request flag (each axis) 

Each 
axis ○ 

No requests from the PLC can be 
executed while the positioning unit is 
in tool operation. 
The following requests, however, 
can be executed from the PLC while 
the positioning unit is in tool 
operation. 
• Deceleration stop request flag 
(each axis) 
• Emergency stop request flag (each 
axis) 
• System stop request flag (all axes) 
• Pulser operation enabled flag 
(each axis) 

B004H 
Realtime 
torque limit 
protection 

The realtime torque limit 
was not executed as the 
AMP parameter operation or 
AMP monitor operation was 
being executed.  

Each 
axis ○ 

Execute the realtime torque limit 
when the AMP parameter operation 
and AMP monitor are not used. 

B010H Duplicate start 
The same axis was 
requested to start even 
though the axis operation 
has not completed. 

Each 
axis ○ 

No requests to any axes in operation 
can be executed. 
The following requests, however, 
can be executed while the 
positioning unit is in operation. 
• Deceleration stop request flag 
(each axis) 

• Emergency stop request flag (each 
axis) 

• System stop request flag (all axes) 

B030H 
J-point 
simultaneous 
start warning 

The J-point speed change 
contact and J-point 
positioning start contact turn 
ON simultaneously during 
the JOG positioning (J-
point) operation. 
The J-point contact are 
turned ON while the system 
is accelerating or 
decelerating the speed 

Each 
axis ○ 

When the both contacts turn ON 
simultaneously, the J-point 
positioning start contact will have a 
priority, and the J-point speed 
change contact will be ignored. 
Make settings so that the J-point 
speed change contact will be turned 
ON while the positioning unit is in 
operation at constant speed. 

B031H 

J-point speed 
change 
request 
warning 

The J-point speed change 
contact turned ON when J-
point operation is not active. 

Each 
axis ○ 

Check the timing that the J-point 
speed change request contact turns 
ON. 

B032H 

J-point 
positioning 
start request 
warning 

The J-point positioning start 
contact turned ON when J-
point operation is not active. 

Each 
axis ○ Check the timing that the J-point 

positioning start contact turns ON. 

B050H 
Torque 
judgment 
value warning 

The monitored torque value 
exceeded the specified 
upper/lower limit value. 

This warning occurs when 
setting  

- torque judgment to 
“Available”,  

- annunciation method to 
“Warning” 

Each 
axis ○ 

Design the system within the range 
that the torque of the motor does nto 
exceed the judgment value. 
Check the torque judgment value. 
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Code Name Description Object Recovery Measures 

B051H 
Actual speed 
judgment value 
warning 

The monitored actual speed 
exceeded the specified 
upper/lower limit value. 

This warning occurs when 
setting  

- actual speed judgment to 
“Available”,  

- annunciation method to 
“Warning” 

Each 
axis ○ 

Design the system within the 
range that the actual speed of 
the motor does nto exceed the 
judgment value. 
Check the actual speed 
judgment value. 

B055H Pulse input setting 
warning 

The pulse input setting is 
out of the range. All axes ○ 

Check the set value. 

Check the combination of the 
input mode, input multiplying, 
input purpose. 

B056H 
Pulse count 
change value 
setting warning 

The specified pulse count 
changed value is out of the 
range. 

All axes ○ Check the set value. 

B060H 
Positioning speed 
change disabled 
warning (except 
positioning) 

The speed change request 
contact turns ON before the 
position control operates 

Each 
axis ○ 

Please check the time for speed 
change request ON. 

B062H 
Positioning speed 
change disabled 
warning (during J-
point operation) 

The speed change request 
contact turns ON during J-
point operation. 

Each 
axis ○ 

B063H 

Positioning speed 
change disabled 
warning 
(Synchronous 
slave axis) 

The speed change request 
contact of the slave axis of 
synchronization turns ON. 

Each 
axis ○ 

B064H 

Positioning speed 
change disabled 
warning 
(positioning output 
done) 

The speed change request 
contact turns ON upon 
completion of position 
control output. 

Each 
axis ○ 

B065H 

Positioning speed 
change disabled 
warning (during 
positioning stop 
operation) 

Speed change request 
contact turns ON during 
various stops of position 
control. 

Each 
axis ○ 

B066H 
Positioning speed 
change disabled 
warning (during 
dwell operation) 

Speed change request 
contact turns ON during 
dwell time of position 
control. 

Each 
axis ○ 
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Code Name Description Object Recovery Measures 

B070H 

Positioning 
movement 
amount change 
disabled 
warning (except 
positioning) 

The speed change request 
contact turns ON before the 
position control operates 

Each 
axis ○ 

Please check the time for 
movement change request ON. 

B071H 

Positioning 
movement 
amount change 
disabled 
warning (during 
interpolation 
operaiton) 

Movement change request 
contact ON during 
interpolation. 

Each 
axis ○ 

B072H 

Positioning 
movement 
amount change 
disabled 
warning (during 
J-point 
operation) 

Movement change request 
contact turns ON during J-
point operation. 

Each 
axis ○ 

B073H 

Positioning 
movement 
amount change 
disabled 
warning 
(Synchronous 
slave axis) 

The movement change 
request contact of the slave 
axis of synchronization turns 
ON. 

Each 
axis ○ 

B074H 

Positioning 
movement 
amount change 
disabled 
warning 
(positioning 
output done) 

The movement change 
request contact turns ON 
upon completion of position 
control output. 

Each 
axis ○ 

B075H 

Positioning 
movement 
amount change 
disabled 
warning (during 
positioning stop 
opration) 

Movement change request 
contact turns ON during 
various stops of position 
control. 

Each 
axis ○ 

B076H 

Positioning 
movement 
amount change 
disabled 
warning (during 
dwell operation) 

Movement change request 
contact turns ON during dwell 
time of position control. 

Each 
axis ○ 

B100H 

Synchronous 
setting change 
disabled 
warning 

Request for synchronization 
settings are made for axis in 
operation 

Each 
axis ○ 

Change the synchronous settings 
when the Busy signal of 
synchronous target axis is turned 
OFF. 
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Code Name Description Object Recovery Measures 

B110H 
Cam pattern table 
reading error 
warning 

The operation for the cam 
pattern table reading request 
ended abnormally as an 
incorrect value was set or the 
execution condition was not 
satisfied. 

All axes ○ 

・Confirm the setting values of the 
parameters required for reading cam 
patterns. 

・Confirm if any axes are in 
synchronous operation. If any, cancel 
the synchronous operation and read 
the cam pattern tables. 

* The details about the cause of the 
occurrence of this warning are stored 
in the "cam pattern reading result" 
area of the positioning memory. 

B1111H 
Cam pattern table 
rewriting error 
warning 

The operation for the cam 
pattern table rewriting request 
ended abnormally as an 
incorrect value was set or the 
execution condition was not 
satisfied. 

All axes ○ 

・Confirm the setting values of the 
parameters required for rewriting cam 
patterns. 

・Confirm if any axes are in 
synchronous operation. If any, cancel 
the synchronous operation and 
rewrite the cam pattern tables. 

* The details about the cause of the 
occurrence of this warning are stored 
in the "cam pattern rewriting result" 
area of the positioning memory. 

B304H 
Recalculation 
exception 
warning 

Error occurs during 
recalculation 

Each 
axis ○ 

Please check the parameters of 
the axes and the settings of the 
interpolation group. 
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 Troubleshooting 
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20.1 Self-diagnosis Function 

20.1.1 Status display LED of the Control Unit 

 

• When an error occurs in the embedded control unit, judge the current situation and stop the 
running self-diagnosis function as needed. 

• When an error occurs, the status display LED of the control unit is as shown in below table. 

 Self-diagnosis related LED display 

 
LED display 

Description Run 
RUN PROG. ERR. 

Normal 

○ × × In normal operation Run 

× ○ × 
Prog mode 
In prog mode, even if forcible output is 
performed, LED does not blink. 

Stop 

△ △ × In RUN mode, during forcible input/output, 
RUN and PROG. LEDs will blink one by one. Run 

Excepti
on 

○ × △ Self-diagnosis error (in operation) Run 
× ○ △ Self-diagnosis error (being stopped) Stop 
－ ○ ○ System monitoring timer stops working Stop 

○: ON, △: Blink, ×：off, －: on or off 
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20.1.2 Status Display LED of the FP-X Expansion FP0 Adapter 

 

• When an error occurs in the FP0 adapter with embedded FP-X expansion, judge the current 
situation and stop the running self-diagnosis function as needed. 

• When an error occurs, the status display LED of the control unit is as shown in below table. 

 Self-diagnosis related LED display 

 
LED display 

Description 
POWER I / F ERR. 

Normal ○ ○ × In normal operation 

Abnor
mal 

○ △ × FP0 / FP0R expansion unit is not connected. 

○ ○ △ 

When the power of the control unit is turned on, the 
connected FP0 expansion unit detached.  
The data access between the expansion FP0 adapter and 
the FP0 / FP0R expansion unit failed due to interference. 

○ × × The expansion FP0 adapter power is turned on after the 
control unit. 

○: ON, △: Blink, ×：off, －: on or off 

20.1.3 Operation mode in case of exception 

• When an error occurs, the system usually stops running. Depending on various type of 
exception, you can set the system register to choose between keep running or stop. 

 FPWIN GR7 system register setting dialog box 
If an error occurs when FPWIN GR7 is used to set PLC, select "Option (O)"→"PLC System 
Registrar Setting" in the menu bar, and click "Action on Error" tab. The following screen shows. 
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20.2 What to Do If an Error Occurs 

20.2.1 ERR LED Blinking 

 Situation 
A syntax error or self-diagnosis error occurs. 

 Handling method 

PROCEDURE  
1. Use the programming tool to confirm the error code. 

When a PLC error occurs during programming and commissioning, the Show 
Status dialog box will be displayed automatically. Please confirm the contents of 
self-diagnosis errors. 

  
2. Confirm the error code and modify the error reason. 
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 Error code and handling method 
Error code Situation Handling method 

1-9 A syntax error occurs. 
 Switch PLC to PROG mode and clear error status. 
 Use FPWIN GR7 for overall check and identify the address of 
syntax error and modify the program. 

above 20 A self-diagnosis error 
occurs. 

 Adjust settings and programs according to the error code list. 
 Use the programming tool in PROG mode and resolve the error 
status. 

KEY POINTS
 

• When an error with a code above 43 occurs, press the [Clear Error] button 
in the status display dialog box to clear the error status. In PROG mode, 
connecting to power supply again also can clear an error. However, 
contents of the computation memory except data for keeping will be cleared. 

• When a computation error (code 45) occurs, the address in which an error 
occurred is saved to special data register DT90017 and DT90018. Before 
resolving the error status, click the [Computation Error] button in the dialog 
box and view the address in which an error occurs. 

REFERENCE  
• For how to handle the position control error (error code 44), see "Chapter 19 

Error/Warning Annunciation Function". 
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20.2.2 When Not Switched to RUN Mode 

 Situation 
When a syntax error occurs or running stops, a self-diagnostic error occurs. 

 Solution 
Confirm the situation according to the following steps. 

PROCEDURE  
1. Confirm whether the ERR LED is lit or not. 
2. Use the tool software to perform "Totally Check Project" to confirm the 

syntax error. 

20.2.3 When ERR.LED Lights Up 

 Situation 
The system monitoring timer is in operation, the controller stops running. 

 Solution 

PROCEDURE  
1. Switch to PROG. mode and turn on the power supply again. 

If the ERR. LED lights again, it may be due to abnormal unit. If off, it may be 
caused by interference and other temporary reasons. 

2. Switch to RUN mode. 
If the ERR. LED lights up after switching to RUN mode, it means that the program 
has timed out. Rerun the program. 

3. Check the surrounding environment to confirm if there is interference. 
If the program itself is OK, it may be due to the surrounding environment. Check 
wirings (includes grounding wire). 

KEY POINTS
 

• When rechecking the program, confirm the following items. 
Example 1) Confirm whether the program is an infinite loop according to the 
instructions controlling JP instruction, LOOP instruction and other program 
processes. 

Example 2) The interrupt instruction is continuously executed? 
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20.2.4 If All LEDs are Not Lit 

 Situation 
It may be due to insufficient power supply. 

 Solution 
Confirm the situation according to the following steps. 

PROCEDURE  
1.  Recheck the terminal and wiring for looseness after turning off the power. 
2. Check that the voltage is applied within the allowable range. 
3. Check whether the voltage fluctuation is too large. 
4. When sharing power with other devices, disconnect the power from the 

other devices. 
If the unit LED lights up during this operation, it may be due to insufficient power 
supply capacity. Redesign the power supply. 

20.2.5 When Protection Error Message Shows 

 Situation 
It may be due to the master memory cassette used or a password is set. 

 Handling method (when using the master memory cassette) 
In the case of using the master memory cassette, the program cannot be edited. Turn off the 
power supply and remove the master memory cassette. 

 Handling method (when using the password function) 

PROCEDURE  
1. Select "Tools" → "Set PLC Password" in FPWIN GR7. 

The "Set PLC Password" dialog box is displayed. 

2. Select "Access" and click the [Set] button. 
Remove the protection status. 

KEY POINTS
 

• Pressing [Force Cancel] button will delete all programs saved to the PLC. 
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20.2.6 When the Output is Not Normal 

 Situation 
It may be due to the program, I/O assignment and other software problems combined with the 
wiring, power supply and other hardware problems. 

 Handling method (check of the output side) 
Follow the check order of the output and input side to confirm the situation. 

PROCEDURE  
1. Verify if the output display LEDs of the input and output units are lit. 

If lit, perform the next step; if not lit, perform step 4. 

2.  Recheck the terminal for loose and the wiring status of the load. 
If the unit LED lights up during this operation, it may be due to insufficient power 
supply capacity. Redesign the power supply. 

3. Verify if the voltage across the load is normal. 
If the voltage is normal, it may be due to an abnormal load. If the voltage is not 
applied, it may be due to an abnormality in the unit's output. 

4. Use the tool software to monitor the output status. 
If the monitor state is ON, it may be due to a dual output is used. 

5. Use the forcible input / output function of the tool software to force the 
corresponding outputs turn to ON / OFF. 
When the unit output LED is lit, make further checks on the input side. If not lit, it 
may be due to abnormal unit output part. 

 Handling method (check of the input side) 
Confirm the situation according to the following steps. 

PROCEDURE  
1. Verify if the input display LED of the unit is lit. 

If not lit, perform the next step; if lit, perform step 3. 

2. Recheck the terminal for loose and the wiring status of the input device. 
If the unit LED lights up during this operation, it may be due to insufficient power 
supply capacity. Redesign the power supply. 

3. Verify if the voltage across the input terminal is normal. 
If the voltage is normal, it may be due to an abnormal unit input. If the voltage is 
not applied, it may be due to an abnormal power or input device. 
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4. Use the tool software to monitor the input status. 
If the monitor state is OFF, it may be due to an abnormal unit input.  
If the monitor state is ON, recheck the program. When the input device is two-wire 
sensor, it may be caused by a leakage current. 

KEY POINTS
 

• When rechecking the program, note the following items. 

1. Check if the output has been rewritten, for example, a dual output is used. 

2. Check if the program process has changed via control instructions such as MCR 
and JMP instruction. 

3. Check if the allocation of the I/O mapping is consistent with the installation state. 

20.2.7 When Expansion Units are Not Operated 

 Situation 
The setting of the expansion unit may be incorrect. 

PROCEDURE  
1. Verify if the expansion unit terminal is set correctly. 

Verify if the terminal setting of several units is made. 

2. Verify if the expansion FP0 adapter is attached to the end. 
When the FP-X expansion FP0 adapter is attached to the end, the other 
expansion unit does not need to be set in the terminal. 

3. Verify if a momentary outage or other short time power on/off are occurred. 
Sometimes, it is unable to identify the expansion unit due to momentary outage 
and other short time power on/off. Reconnect the power. 



Troubleshooting 

20-10 

20.2.8 In Case of Communication Error (RS-232C) 

 Object 

Product no. Communication Interface 

Communication Port No. Assigned 
Main 
Unit 

Cassette 
mounting part 1 

Cassette 
mounting part 2 

COM0 COM1 COM2 COM3 COM4 
Control unit 
standard 
configuration 

RS-232C (3-wire) × 1 channel ●     

AFPX-COM1 RS-232C (5-wire) × 1 channel  ●  ●  

AFPX-COM2 RS-232C (3-wire) × 2 channel  ● ● ● ● 
AFPX-COM4 RS-232C (3-wire) × 1 channel   ●  ● 

AFPX-COM5 RS-232C (3-wire) × 1 channel   ●  ● 

 Situation 
Connections and settings may be incorrect. 

PROCEDURE  
1. Confirm the setting of the system register. 

Verify if the setting corresponding to the communication port number assigned is 
correct. When selecting the inter-PLC link, verify if the connection area is 
repeated. 

2. Verify if the CS signal is ON.  
When using 3-wire type, set the connection RS signal and CS signal to ON. When 
using 5-wire type, verify the RS signals of the communication cassette LED and 
the matched devices. 

3. Verify the connection with the matched devices.  
Confirm that the SD terminal of the matched device is connected to the RD 
terminal at the PLC side, and the RD terminal of the matched device is connected 
to the SD terminal at the PLC side. Also, make sure the SG terminals from both 
devices are connected. 
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20.2.9 In Case of Communication Error (RS-422) 

 Object 

Product no. Communication Interface 

Communication Port No. Assigned 
Main 
Unit 

Cassette 
mounting part 1 

Cassette 
mounting part 2 

COM0 COM1 COM2 COM3 COM4 
AFPX-COM3 RS-485 / RS-422 × 1 channel  ●  ●  

 

 Situation 
Connections and settings may be incorrect. 

 

PROCEDURE  
1. Confirm the setting of the system register. 

Verify if the setting corresponding to the communication port number assigned is 
correct. When selecting the inter-PLC link, verify if the connection area is 
repeated. 

2. Verify if the terminal station is connected properly. 
3. Verify if the transmission cable is securely connected to the data send 

terminal and data receive terminal. 
4.  Verify if the transmission cable is within the specifications. 
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20.2.10 In Case of Communication Error (RS-484) 

 Object 

Product no. Communication Interface 

Communication Port No. Assigned 
Main 
Unit 

Cassette 
mounting part 1 

Cassette 
mounting part 2 

COM0 COM1 COM2 COM3 COM4 
AFPX-COM3 RS-485 / RS-422 × 1 channel  ●  ●  

AFPX-COM4 RS-485 × 1 channel  ●  ●  

AFPX-COM6 RS-485 × 2 channel  ● ● ● ● 
 

 Situation 
Connections and settings may be incorrect. 

PROCEDURE  
1. Confirm the setting of the system register. 

Verify if the setting corresponding to the communication port number assigned is 
correct. When selecting the inter-PLC link, verify if the connection area is 
repeated. 

2. Verify if the terminal station is connected properly. 
Do not set the unit outside both sides of the network as the terminal exchange. 

3. Verify if the transmission cable is securely connected to the transmission 
terminals of the devices by (+) and (+), ( - ) and ( - ). 

4. Verify if the transmission cable is within the specifications. 
Do not use more than one type of cable. 
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20.2.11 In Case of Communication Error (Ethernet) 

 Object 

Product no. Communication Interface 

Communication Port No. Assigned 
Main 
Unit 

Cassette 
mounting part 1 

Cassette 
mounting part 2 

COM0 COM1 COM2 COM3 COM4 
AFPX-COM5 Ethernet × 1 channel  ●  ●  

 Situation 
Connections and settings may be incorrect. 

 Verification steps (when the ERR.LED is not lit) 
Connections and settings may be incorrect. 

PROCEDURE  
1. Confirm the setting of the system register. 

Verify if the setting corresponding to the communication port number assigned is 
correct. 

2. Verify if the LAN cable is securely connected to the cassette or computer. 
3. When using the HUB during connection, verify if the power of the HUB has 

been connected.  
4. Verify if the LINK / ACT LED is lit. 

If not lit, it indicates that the LAN cable is not connected properly. 

5. Verify the IP address and the IP address of the other end of the connection. 
6. Verify if the transmission mode and speed of the COM1 port of the control 

unit are consistent with the communication environment setting of the FP-X 
communication cassette (AFPX-COM5). 

 Verification steps (when the ERR.LED is lit) 
Connections and settings may be incorrect. 

PROCEDURE  
1. Verify the status via the Configurator WD. 

There is an IP address conflict on the network if the status is displayed "IP 
Conflict Error". Do not set conflicted IP address. 

It is unable to get IP from the DHCP server if the status is displayed "DHCP Error". 
Verify if there is an exception in the network system. 
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20.3 What to Do If an Error Occurs 

20.3.1 Cannot Communicate with AMP 

・

Is the STATUS LED
of the FP-XH M8N

flashing?

Is the LINK LED of
the FP-XH M8N

lighted?

Are the LINK LEDs of all
connected AMPs lighted?

Did the error occur on
all connected AMPs?

Yes
Is the ERR LED of the
FP-XH M8N lighted?

Yes

Yes

No

No

No

No

No

Yes

Yes

Check the settings of the AMP that
the error occurred.
Turn on the power supply of the
system again.
If the similar error repeatedly occurs,
please contact us.

Turn on the power supply of
the system again.
If the similar error repeatedly
occurs, please contact us.

Turn on the
power supply of
the system
again.
If the similar
error repeatedly
occurs, please
contact us.

Check if the network cable
is normal.

Check if the length of the
network cable is the
regulation size.

Check the error code of FP-XH
M8N, and take appropriate
measures for the error content.

Check if an excessive noise
is applied on the system.

The connection with the
next node is incorrect.
The connection with the
next node is incorrect.
Check if the connection of
the network cable is correct.
Check if the network cable is
normal.
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20.3.2 Motor does Not Rotate and Operate 

 Solution 1: 
Please confirm if the servo ON request is ON and the servo for AMP is locked. When 
attempting to activate an axis that is not in the servo-locked state, the not servo ready error 
(3000H) occurs. 

R0 Y1120

 

 Solution 2: 
Review the program. 

Point to check 
Check to make sure the I/O numbers are appropriate. 

Check non-rewriting of the start flag in the program. 

Check the input valid logic of the over limit switch. In this case, the ERR.LED is on.) 
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21.1 Memory Backup 

21.1.1 Program Memory Backup 

The contents downloaded to the control unit can be saved even in case of power outage. 

 Program Memory Backup 
Type Remarks 
Program  

Comments Maximum 200KB I/O comments, description, comments between the lines 
System register  
Positioning data Contains positioning parameters and positioning table data set by the Configurator PM7. 

21.1.2 Operation Memory Backup 

• The operation memory includes outage hold and non-hold area. 

• In the FP-XH M8N Control unit, backup fixed area in case of a power outage or mode 
switching (RUN → PROG.). 

 Non-hold and hold area 
Type Description 

Non-hold area In case of a power outage or mode switching (RUN → PROG.), the data content is reset 
to 0. 

Hold area In case of a power outage or mode switching (RUN → PROG.), maintain the previous 
operational data. 

 Automatic backup in case of an outage 
Type Hold Area 
Counter 16 points C1008 - C1023 
Counter elapsed 
value area 16 words EV1008 - EV1023 (note 1) 

Internal relay 128 
points R5040-R511F 

Data register  315 
words (Note 2) 

DT11970 - DT12284 (When 40k step program capacity is 
selected) 
DT32450 - DT32764 (When 32k step program capacity is 
selected) 
DT65218 - DT65532 (When 12k step program capacity is 
selected) 

(Note 1): You can not hold counter target value area SV. 
(Note 2): The data register range varies from the system register No.0 internal relay capacity setting. 

 Backup based on user program P13 (ICWT) instruction 
Type Description 

How to use 
The user program allows you to write P13 (ICWT) instruction and transfer the data 
register to the F-ROM area. Specifies the continuous range for using the 2K words as 1 
memory block. Read from the F-ROM area to the data register by F12 (ICRD) instruction. 

No. of times of 
writing Less than 10 thousand times 
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21.1.3 Operation Memory Backup (When Battery Installed) 

• Initially, install the backup battery sold separately when the hold area is insufficient or using 
the clock/calendar function. 

• After installing the battery, all the following areas also can be backuped in case of a power 
outage or mode switching (RUN→PROG.). 

 Backup using a backup battery 
Type Hold area 

Operation 
memory 

Timer 

The tool software allows you to set the system 
register no. 6 - no.13 and specify any hold / non-hold 
area. (You can also keep the whole point) 

Timer elapsed value area 
Internal relay 
Data register 
Step ladder diagram 
Link relay 
Link register 

Special 
data register Clock/calendar 

Monitoring area DT90053: hour/min (read only) 

Setting/motoring 
area 

DT90054: min/sec, DT90055: day/hour, 
DT90056: year/month, DT90057: week 

(Note 1): If detects that the battery is running out when the power is on, the operation memory of the hold area will be 
cleared to 0. 

 Backup battery type (sold separately) 
Appearance Product Name Specification Product no. 

 

Backup battery  
for FP-XH With connector AFPXHBATT 

(Note): You can not use the old model FP-X series battery. 

 Number of installed batteries 
For FP-XH M8N only one battery can be installed. 

REFERENCE  
• For battery installation methods, refer to "4.2 Backup Battery Installation". 



Memory /Master Memory Cassette 

21-4 

21.1.4 Alarm Battery Error / Setting of the Hold area 

 Setting of alarm battery error 
• If a backup battery installed, select the "System Register No. 4 Alarm Battery Error" check 

box. 

• When the battery capacity is low, the ERR.LED of the control unit flashes and an error alarm 
occurs. 
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 Setting of the hold / non-hold area 
When changing the range of the hold area of data registers and other operation memory 
areas, set the system register no. 6 - no. 14. 

 

KEY POINTS
 

• If the "Alarm Battery Error" is not set, the ERR.LED will not blink even if a 
battery error is detected. 

• The setting of the system register no. 6 - no. 14 are only effective when the 
backup battery is installed. Use the initial valuesdirectly when the battery is 
not installed. 
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21.2 RAM / ROM Transfer Function 

21.2.1 Outline of function 

Through an operation based on the tool software, all contents of the hold area of the data 
register DT can be backed up to the F-ROM area of the control unit built-in memory. 

Control unit
Controller built-in
Storage
RAM(DT)

①

②

Control unit
Controller built-in
Storage
FROM-

 

21.2.2 Operations Using Tool Software 

Explain it as below assuming that the FPWIN GR7 has been started. 

PROCEDURE  
1. Select "Online" → "Switch to Online Mode" from the menu bar. 
2. Select "Tools" → "ROM<=>RAM Transfer" from the menu bar. 

The "ROM <=> RAM Transfer" dialog box is displayed. 

 
3. Select the transfer direction and click the [Execute] Button. 

For ROM-> RAM transfer, transfer from the F-ROM area to the data register area. 

For RAM-> ROM transfer, transfer from the data register area to the F-ROM area. 

KEY POINTS
 

• Only PROG. mode can be performed. 

• Transfer data in all areas of the data register. 
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21.3 Functions of Master Memory Cassette 

21.3.1 Outline of Functions 

The master memory cassette includes functions such as memory backup, replication and real-
time clock. Only one of the functions can be installed to the FP-XH M8N Control unit. 

 Master memory function 
Item Specification 

Clock/calendar  
(real-time clock) 

Setting items  Year (last 2 numbers in the Gregorian calendar), month, day, hour 
(24-hour) minute, second, week 

Accuracy 0 ℃: Month error in 104 seconds or less, 25 ℃: Month error in 51 
seconds or less, 55 ℃: Month error in 155 seconds or less 

Master memory 
function 

Memory 
capacity  Flash-ROM (512kB) 

Storable data 
System register, ladder diagram program, position control data and 
comment data (200kB) 
F-ROM data area, security function (password, upload prohibited) 

21.3.2 Setting of Master Memory Unit 

 Setting of the Function Toggle Switch 
Confirm the switch position before installation. 

 

Switch position Specifications 
OFF (RTC) Position of factory setting. Only runs the real-time clock function. 

ON (RTC + ROM) The real-time clock function and master memory function are activated. 
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21.4 Master Memory Function 

21.4.1 Outline of Function 

Use the master memory function when backing up and duplicating the program and data 
saved in the control unit. 

Master memory
cassette

①

②

Internal memory
in Control unit

F-ROM

 

 Control unit ← → master memory transfer 
Transfer 
direction Transfer method Transferred content 

① Operations Using the 
Tool Software 

(Data must be transmitted) 
Ladder diagram program, system register, position control data, safety 
information (password) 
(Data selected via dialog boxes) 
Safety information (upload prohibited), comment data, F-ROM data area 
(note 1) (note 2) 

② 

Operations Using the 
Tool Software 

(Data must be transmitted) 
Ladder diagram program, system register, position control data, safety 
information (password) 
(Data selected via dialog boxes) (note 3) 
comment data, F-ROM data area 

Switch to RUN mode 
Power ON in RUN 
mode 

All contents written into the master memory unit are transferred to the 
internal memory of the control unit  
(F-ROM). 

(Note 1): According to memory block no., specify the F-ROM data area in 2K words unit. 
(Note 2): Delete the items unselected during built-in memory → master memory transferring from the master memory. 
(Note 3): There is no comment data on the master memory. For the F-ROM data area, select via the menu is not 

available. 
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21.4.2 Before Turning on the Power 

When the master memory cassette function toggle switch is ON (RTC + ROM) and the master 
memory function is active, depending on the different modes when the power is ON, the 
operation changes as follows. 

 When the power is turned on in PROG. mode 
• When the power is turned on, change to the state indicating that data exists in all control 

units and master memory units (program, comments, system register data, data register and 
position register). 

• Through the operation of the tool software, built-in memory → master memory transfer or 
master memory → built-in memory transfer can be performed. 

• When you copy the data saved in the control unit to the master memory cassette, turn on the 
power in PROG. mode. When you switch to RUN mode, transfer the contents of the master 
memory cassette to the built-in memory. 

 When the power is turned on in the RUN mode 
• When the power is turned on, transfer the data saved in the master memory unit (program, 

comments, system register data, data register) to the memory of the control unit. 

• Data saved in the control unit before powering on will be overwritten. 

• When the required data (program, comments, system register data, data register) has 
already saved to the master memory, turn on the power in RUN mode. 

KEY POINTS
 

• Perform the installation of the master memory cassette and the data 
transmission from the control unit to the master memory cassette after the 
setting and program editing are completed. Depending on the different 
operating conditions, the following errors will occur. 
Error message Operating conditions 
42FromPLC: Basic step error 
NOT support error Upload prohibited status 

63FromPLC: Application error 
mode error 

When you want to perform the transfer operation of the master 
memory cassette in RUN mode. 

65FromPLC: Application error 
protection error 

When you want to edit the program with the master memory 
cassette installed. 

The master memory is not 
installed in the PLC 
connected. 

The function toggle switch in the master memory cassette can not 
switch to ON (RTC + ROM side). Or the master memory cassette 
is not installed. 

• When installing or removing the cassette with the power turned on, an I/O 
verifification error will occur. 
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21.4.3 Transferring Data to Master Memory Cassette 

Comments and data register set through the program, system register, position register and 
options can be transferred to the master memory cassette. 

 Operating steps 
Please follow these steps to transfer data to the master memory cassette from the control unit. 
Operate via FPWIN GR7. Explain it as below assuming that the FPWIN GR7 has been started. 

PROCEDURE  
1. Select "Online" → "Switch to Online Mode" from the menu bar. 
2. Select "Tools" → "Internal Memory<=>Master Memory" from the menu bar. 

The "Internal Memory <=> Master Memory" dialog box is displayed. 

 
3. Select the transfer direction and click the [Execute] Button. 

The message is displayed at the end of the transmission. 
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 Option setting 
Type Description 

Upload protection 
Create the master memory cassette set in the upload prohibited status when the 
check box is selected. The control unit in which installed the master memory cassette 
and perform transferring changes to upload prohibited status. 

Comments 
Transfer the comments saved in the control unit built-in memory (F-ROM) (I/O 
comments, descriptions, comments between the lines) when the check box is 
selected. 

F-ROM data area 
(for data register 
transfer) 

Transfer the data for data register saved in the F-ROM data area of the control unit to 
the master memory cassette when the check box is selected. 
Specify the starting block No. and the number of the transfer blocks. The unit of the 
memory block is 2 words. 
The maximum number of the memory blocks can be transferred to the master 
memory is 20 (40,960 words). 

 

 Assigning of the F-ROM data area 
Block no. DT number conversion 

range 
Block No. DT number conversion range 

0 DT0 DT2047 16 DT30768 DT32815 
1 DT2048 DT4095 17 DT32816 DT34863 
2 DT4096 DT6143 18 DT34864 DT36911 
3 DT6144 DT8191 19 DT36912 DT38959 
4 DT8192 DT10239 20 DT38960 DT41007 
5 DT10240 DT12287 21 DT41008 DT43055 
6 DT12288 DT14335 22 DT43056 DT45103 
7 DT14336 DT16383 23 DT45104 DT47151 
8 DT16384 DT18431 24 DT47152 DT49199 
9 DT18432 DT20479 25 DT49200 DT51247 
10 DT20480 DT22527 26 DT51248 DT53295 
11 DT22528 DT24575 27 DT53296 DT55343 
12 DT24576 DT26623 28 DT55344 DT57391 
13 DT26624 DT28671 29 DT57392 DT59439 
14 DT28672 DT30719 30 DT59440 DT61487 
15 DT30720 DT30767 31 DT61488 DT65535 

KEY POINTS
 

• Temporarily delete all data in the master memory cassette when the 
transmission begins. Comments and F-ROM data values that are not 
selected as the transmission range will not be saved in the master memory 
cassette. 

• Transfer data from the control unit built-in RAM to the F-ROM area through 
the "RAM → Transfer Function" of the tool software or P13 (ICWT) 
instruction. 

• Writing by P13 (ICWT) instruction and reading by F12 (ICRD) instruction can 
perform up to 32 blocks (up to 65536 words). 
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21.4.4 Transferring Data from Master Memory Cassette to Control Unit 

The data saved in the master memory cassette can be transferred to the control unit by the 
following methods. 

 Operating steps 
Use FPWIN GR7 and follow these steps to transfer data to the master memory cassette from 
the control unit. Explain it as below assuming that the FPWIN GR7 has been started. 

PROCEDURE  
1. Select "Online" → "Switch to Online Mode" from the menu bar. 
2. Select "Tools" → "Internal Memory<=>Master Memory" from the menu bar. 

The "Internal Memory <=> Master Memory" dialog box is displayed. 

 
3. Change the transfer direction to "Master memory => Internal Memory", click 

the "Execute" button. 
The message is displayed at the end of the transmission. 

 

KEY POINTS
 

• After the transfer, and PROG is switched to RUN, the contents in the master 
memory cassette and the internal memory are checked. The transfer 
process is not performed if consistent. 
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 Option setting 
Type Description 

Comments 

Comments saved in the master memory cassette (I/O comments, descriptions, comments 
between the lines) are transferred to the control unit built-in memory (F-ROM) when the 
check box is selected. The check box is not displayed when there is no comment data 
saved in the master memory unit. 

F-ROM data area 
data register 

The data saved in the master memory cassette is transfered to the F-ROM data area of 
the control unit when the check box is selected. The check box is not displayed when 
there is no data saved in the master memory unit. 

 

21.4.5 Using Master Memory Cassette with Other Models 

The master memory unit created for the FP-XH M8N control Unit cannot be used for other 
models (such as FP-X and FP-XH). 
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21.5 Clock/Calendar 

21.5.1 Outline of Function 

• The master memory cassette has clock/calendar function. 

• The time data is stored in the special data register for reading and using the user program. 

 Functions of the master memory unit 
Item Specification 

Clock/calendar  
(real-time clock) 

Function  
Year (last 2 numbers in the Gregorian calendar), month, day, hour (24-
hour) minute, second, week 
Applicable until 2099. Applicable during leap years. 

Accuracy 0 ℃: Month error in 104 seconds or less, 25 ℃: Month error in 51 
seconds or less, 55 ℃: Month error in 155 seconds or less 

 Areas used via the clock/calendar 
Special DT 
number 

Data content 
R W 

High byte Low byte 
DT90053 Time data H00 - H23 Minute data H00 - H59 ○ × 

DT90054 Minute data H00 - H59 Second data H00 - H59 ○ ○ 

DT90055 Day data H00 - H31 Time data H00 - H23 ○ ○ 

DT90056 Year data H00 - H99 Month data H00 - H12 ○ ○ 

DT90057 － Week data H00 - H06 ○ ○ 

(Note 1): Specifies any week data within the range of H00 - H06. 

21.5.2 Clock/calendar Setting 

You can set the clock/calendar through the tool software or the user program. 

 Tool software setting 
Select the "PLC Date / Time Settings" menu. If the week data is required to set, please set 
through the user program. 

 

KEY POINTS
 

• Backup the clock/calendar data through a battery. Install the battery before 
setting. 
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 Setting based on the user program 
After the time data is written in the special data register DT90054 - DT90057, write H8000 in 
DT90058. Perform the transmission by following the order of H8000→H0000 or using the 
differential instruction. Always remember not to input H8000. 

R0
DT90054H0F0 MV

DT90055H512F0 MV

（ ）DF

DT90058H8000F0 MV

ⓐ

ⓑ

ⓒ  

ⓐ Set 0 minutes 0 
seconds ⓑ Set 5 days 12 hours ⓒ Time alignment 

21.5.3 Clock/calendar Application Examples 

 Application example (regular automatic start) 
• Use the clock/calendar (real-time clock) function to output 1 second (Y0) signal at 8:30 am 

every day. In this example, the "hour, minute data" stored in the special data register 
DT90053 are used to output signal regularly. 

• In DT90053, the "hour data" and "minute data" are respectively stored in the high 8 bytes 
and low 8 bytes in the form of BCD. When compare this "hour, minute data" and the value of 
any time (BCD), use the special internal relay R900B (= flag) to check if the time is 
consistent. 

R9010
H830DT90053F60 CMP

K10TMX 0

ⓐ

ⓒ

ⓓ

R0
（ ）DF

R0R900B

T0 Y0

Y0

ⓑ

 

ⓐ Compare the value of special data register DT90053 (hour, minute data) and H830 (8:30). 

ⓑ Output if consistent ⓒ Output pulse at a fixed time 
(1 second) ⓓ 

0.1 s timer 
setting K10, used as 1 s 
timer 
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22.1 Password Protection Function 

22.1.1 Outline of Function 

 Outline of password protection function 
This function is used to prohibit reading and writing programs and system registers by setting 
a password. There are two ways to set a password as below. 

1. Set by using the programming tool 
2. Set by instructions (SYS1 instructions), but 32-digit password cannot be set in this case. 

 Characters can be used by the password 
Password digits Characters can be used 
4-digit password 4 characters of the "0" to "9" and "A" to "F" (16 characters) can be used. 
8-digit password You can use 8 or less half-width alphanumeric characters (case sensitive) and symbols. 

32-digit password You can use 32 or less half-width alphanumeric characters (case sensitive) and 
symbols. 

 

 
• Never forget your password. You can not read the program if you forget 

your password. This is not possible even you ask for help from our 
company. 

22.1.2 Tool software setting 

 Setting based on FPWIN GR7 
1. Select [Online] → [Switch to Online Mode] from the menu bar, or press <CTRL> +  
<F2> keys simultaneously.  
The screen switches to [Online Monitor]. 

2. Select [Tools] → [PLC Security Settings] → [Set PLC Password] from the menu bar.  
The "Set PLC Password" dialog box is displayed. 
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 PLC password setting dialog box 

 

① Display the current status of the password setting. 

② Specify the type of passwords used. 

③ 
Specify password behavior. 
Access: enter the password for program access operation.  
Protect: a password is set.  
Unprotect: remove the password setting. 

④ Enter the password. 

 Confirmation of password Settings 
Item Settings 

Current 
state 

Password is not set No password is set. 
xx digits Protect 
(note) A password is set, no access. 

xx digits Available 
to access (note) 

A password is set, allow access.  
(Password input is completed, the program can be accessed.) 

Retry number 

Namely the maximum number for consecutive password input.  
Each time the password is entered incorrectly, the retry number decreased 
(up to 3 times).  
If there has been three consecutive failed password attempts, you can not 
access the program. To reenter the password, set the PLC's power to OFF / 
ON and reboot. 

(Note): XX is one of 4, 8, 32 depending on the digits of the password set. 

 
• When the access is allowed, if the PLC power supply is set to OFF / ON, it 

will return to the password protection status again. 
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 Setting to prohibit access with a password 
1. Select [Tools] → [PLC Security Settings] → [Set PLC Password] from the menu bar.  
The "Set PLC Password" dialog box is displayed. 

  
2. Set the items in the table below, click [Set] button. 

Item Settings 
Digits Please set the digits. 
Operation mode Select "Protect". 
4, 8, 32-digit password Enter any password to be set. 

  

3. In order to confirm, enter the password again, click the [OK] button.  
The following information is displayed when entering a state (protected state) that is forbidden 
to write / read. 

   

4. Click the [OK] button. 
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 Setting to allow access with a password 
1. Select [Tools] → [PLC Security Settings] → [Set PLC Password] from the menu bar.  
The "Set PLC Password" dialog box is displayed. 

 
2. Set the items in the table below, click [Set] button. 

Item Settings 
Digits Please set the digits. 
Operation mode Select "Access". 
4, 8, 32-digit password Enter a set password. 

When allowing access, the following information is displayed. 

  
3. Click the [OK] button. 

 
• When the " Access" status stays unchanged, if the PLC power supply is set 

to OFF / ON, it will become password protection status again. 
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 Password protection removal 
The following 2 methods can be used to remove password setting. 

 Description Program 
Password 
removal Specify and remove the logged password. Hold all 

Compulsory 
removal 

Remove the password by deleting all programs and 
security information. 

Delete all  
(also delete upload prohibited 
setting) 

 

1. Select [Tools] → [PLC Security Settings] → [Set PLC Password] from the menu bar.  
The "Set PLC Password" dialog box is displayed. 

   
2. Set the items in the table below, click [Set] button. 

Item Settings 
Digits Please set the digits. 
Operation mode Select "Unprotect". 

4, 8, 32-digit password Enter a set password. 

After the password removal is completed, the following message is displayed. 

  
3. Click the [OK] button. 
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• The password removal operation can only be performed in the "Allow 

Access" status. 
 

 Compulsory removal method (programs and security information all deleted) 
1. Select [Tools] → [PLC Security Settings] → [Set PLC Password] from the menu bar.  
The "Set PLC Password" dialog box is displayed. 

  
2. Click the [Force Cancel] button.  
The confirmation message is displayed. 
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3. Confirm the message and click the [Yes] button.  
The current status is displayed as "Password is not set". All programs and security information 
have been deleted. 
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22.2 Program Upload Protection Function 

22.2.1 Outline of Function 

 Outline of the program upload protection function 
• This function is to prohibit reading programs and system registers by setting to disable 

program uploading. 

• If the upload protection is set, note that the ladder programs and system registers will be 
disalbed to be uploaded after that. 

• The setting can be cancelled using the programming tool, however, all ladder programs, 
system registers and password information will be deleted when the setting is cancelled. 

• Editing the files that are controlled with a PC can be carried out online using the 
programming tool. However, the programs will be broken if the programs are not absolutely 
matched. When using this function, store ladder programs as files without fail. 

 Interaction with the password protect function 
• The password setting can be specified simultaneously for the PLC in which this function is 

set. 

• This function can be also set in a passoword-protected PLC. 

 
• All programs and security information will be deleted when the upload 

protection setting is cancelled. We cannot restore the deleted programs 
even if you ask us. 
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22.2.2 Tool Software Setting 

 Setting based on FPWIN GR7 
1. Select [Online] → [Switch to Online Mode] from the menu bar, or press <CTRL> +  
<F2> keys simultaneously.  
The screen switches to [Online Monitor]. 

2. Select [Tools] → [PLC Security Settings] → [Upload Protection] from the menu bar.  
The dialog box of "Disable Uploading" appears. 

 

3. Select "Disable uploading for the PLC" and click the "Execute" button. 

 Compulsory removal based on FPWIN GR7 
In the "Disable Uploading" dialog box, select "Forcibly cancel the uploading disabled state", 
and then press the [Execute] key. 
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22.3 Security Function Applicability List 

22.3.1 Control Unit 

The safe operating conditions of the control unit vary according to the presence or absence of 
the master memory cassette. 

 No master memory cassette 
  Security status 

  
Security 
function is 
not set 

Upload 
prohibited 

4-digit 
password 

8-digit 
password 

32-digit 
password 

Sets/ 
cancels 

Upload 
protection A  A A A 

4-digit 
password A A  N/A N/A 

8-digit 
password A A N/A  N/A 

32-digit 
password A A N/A N/A 

 

A: Available,  N/A: Not available 

 When a master memory cassette is installed 
  Security status 

  
Security 
function is 
not set 

Upload 
prohibited 

4-digit 
password 

8-digit 
password 

32-digit 
password 

Sets/ 
cancels 

Upload 
protection N/A  N/A N/A N/A 

4-digit 
password N/A N/A  N/A N/A 

8-digit 
password N/A N/A N/A  N/A 

32-digit 
password N/A N/A N/A N/A  

A: Available,  N/A: Not available 
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23.1 General-purpose Input / High-speed counter 
Function Summary 

23.1.1 High-speed counter Function Summary 

• It is the function which can perform high-speed count for input signal from sensor and 
encoder. 

• When the counted value is consistent with a target value, the special instruction (F166/F167) 
which can change any output (Y0 - Y29F) to ON or OFF by interrupt processing are provided. 
When the output changes to ON/OFF, you can use presets such as SET/RET instruction. 

• Designate used channel and input with system registers. Designate output in case of 
consistency with the operand of instruction. 

Feeding Guide Roller Motor Encoders

Inverter

Input the encoder output
to the high-speed counter

Cutter

Tap,Wire

Cutter Blade Control Signal

START STOP
Signal

 

23.1.2 Counting Range and Elapsed Value (Current Value) Area 

• The high-speed counter’s elapsed value is stored in the special data register as 2-word 32-
bit data. 

• When the power turns to OFF, the elapsed value area is reset. It is held when the RUN 
mode is switched to the PROG. mode. 

• The high-speed counter is a ring type counter. When the counted value exceeds the 
maximum value, it is restored to the minimum value. When the counted value is lower than 
the minimum value, it is restored to the maximum value. 

 Counting range of the elapsed value (current value) area 
Division Range 

＋2,147,483,647

＋2,147,483,646

＋2,147,483,645

－2,147,483,646

－2,147,483,647

－2,147,483,648

Maximum＝

Minimum＝

 

For high-speed 
counter control 

K–2,147, 483, 648-K2, 147, 483, 
647 
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23.1.3 When using the high-speed counter function 

 Control unit  

Channel number Count 
input 

Hardware 
reset 
input 

Used memory area Performance 
specification 

Control  
flag 

Elapsed 
value  
area 

Target 
value  
area 

Min. 
input 
pulse 
width 

Max. 
count 
speed 

[Single Phase] 
addition input 
subtraction 
input 

CH0 X0 X6 R9110 DT90300 
DT90301 

DT90302 
DT90303 

Mid-speed 
input  
50 µs 

10kHz 

CH1 X1 No R9111 DT90304 
DT90305 

DT90306 
DT90307 

CH2 X2 X7 R9112 DT90308 
DT90309 

DT90310 
DT90311 

CH3 X3 No R9113 DT90312 
DT90313 

DT90314 
DT90315 

CH4 X4 No R9114 DT90316 
DT90317 

DT90318 
DT90319 

CH5 X5 No R9115 DT90320 
DT90321 

DT90322 
DT90323 

CH6 X6 No R9116 DT90324 
DT90325 

DT90326 
DT90327 

CH7 X7 No R9117 DT90328 
DT90329 

DT90330 
DT90331 

[2-phase] 
Phase 
difference 
input 
Individual 
input 
Direction 
detection 

CH0 X0 
X1 X6 R9110 DT90300 

DT90301 
DT90302 
DT90303 

Mid-speed 
input  

100 µs 
10kHz 

CH2 X2 
X3 X7 R9112 DT90308 

DT90309 
DT90310 
DT90311 

CH4 X4 
X5 No R9114 DT90316 

DT90317 
DT90318 
DT90319 

CH6 X6 
X7  No R9116 DT90324 

DT90325 
DT90326 
DT90327 

(Note 1): X6 can be used for either CH6 count input or CH0 reset input. X7 can be used for CH7 count input or CH2 
reset input. 

(Note 2): Only F1 (DMV) instruction can perform the reading and writing of elapsed value area. 

 About max. count speed 
The max. count speed indicates the situation when executing each item condition (output 
mode, channel) only. It indicates the value when not performing high-speed counter 
consistent ON (F166) instruction, high-speed counter consistent OFF (F167) instruction, pulse 
output function and other interruption handling control. For the performance when these 
functions are used concurrently, please contact us. 
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23.1.4 Type of Input Mode 

 Input mode and count operation 
Mode Scope 

Addition input 
1 2 3 4 n -3 n -2 n -1 n0

ON
OFFX0

Counting

 

Subtraction input 
n-1 n-2 n-3 n-4 3 2 1 0n

ON
OFFX0

(X1 ~ X7)

Counting

 

2-phase input 

n–10 1 2 n

n–3n–1n n–2 2 1

ON
OFF

ON
OFF

ON
OFF

ON
OFF

X0
(X2 X4 X6)

X1
(X3 X5 X7)

X0
(X2 X4 X6)

X1
(X3 X5 X7)

Counting

Counting

 

Individual input 

1 2 3 2 3 4 30 3 24 1

ON
OFF

ON
OFF

X0
(X2 X4 X6)

X1
(X3 X5 X7)

Counting

 

Direction 
detection input 

3210 2 04 3 1

ON
OFF

ON
OFF

X0
(X2 X4 X6)

X1
(X3 X5 X7)

Counting
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23.1.5 Minimum Input Pulse Width 

For cycle T, below input pulse width is needed as a minimum. 

 Min. input pulse width 
For single phase input For 2-phase input 
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23.2 Settings of the System Registers 

23.2.1 Settings of System Registers 

Functions are allocated in system register setting dialog box as below. Explain it as below 
assuming that the FPWIN GR7 has been started. 

PROCEDURE  
1. In the menu bar, select "Options"→"System Register Settings". 

The "PLC Configuration" dialog box is displayed. 

2. Select "Controller input settings 1 (HSC)" or "Controller input settings 2 
(HSC)" from the left pane. 
The setting menus of system register "No.400" or "No.401" display. 

3. Change the setting of the channel which uses high-speed counter. 
Below is the situation when 2-phase input (X0, X1) is allocated in CH0. 

 
4. Click the [OK] button. 

Return to the Edit screen of the ladder diagram. You can download Settings, 
program, and notes to PLC. 
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 High-speed counter output related system register 
Type No. and Setting Items Settings 

Controller input settings 
1 (HSC) 

400 
High-speed counter 
settings 
(X0-X3) 

CH0 

Select any one of + count input input (X0), - count 
input input (X0), 2-phase input (X0, X1), individual 
input (X0, X1) and direction detection input (X0, 
X1). 

CH1 Select any one of + count input (X1) and - count 
input (X1). 

CH2 
Select any one of + count input (X2), - count input 
(X2), 2-phase input (X2, X3), individual input (X2, 
X3) and direction detection input (X2, X3). 

CH3 Select any one of + count input (X3) and - count 
input (X3). 

Controller input settings 
2 (HSC) 

401 
High-speed counter 
settings 
(X4-X7) 

CH4 
Select any one of + count input (X4), - count input 
(X4), 2-phase input (X4,X5), individual input (X4, 
X5) and direction detection input (X4, X5). 

CH5 Select any one of + count input (X5) and - count 
input (X5). 

CH6 
Select any one of + count input (X6), - count input 
(X6), 2-phase input (X6, X7), individual input (X6, 
X7), direction detection input (X6, X7). 

X6 When using external reset input, select the reset 
input of high-speed counter CH0. 

CH7 Select any one of + count input (X7) and - count 
input (X7). 

X7 When using external reset input, select the reset 
input of high-speed counter CH2. 

(Note 1): The project name and range displayed vary with the model of control units. 
(Note 2): The input not used in high-speed counter function selects "XX not act as high-speed counter for setting". 
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23.3 General-purpose Input / High-speed Counter Related 
Instruction 

23.3.1 [F0 MV] High-speed counter control instruction 

Perform controls such as software reset, count disabling, high-speed counter instruction clear. 

 Instruction format 

R0
DT90052H1F0 MV

DT90052H0F0 MV

S

（ ）DF

 

 Operand 
Operand Settings 

S The area or constant data in which high-speed counter control code is saved. 

 Memory area type that can be specified (A: Available) 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S A A A A A A A A A A A A 

 Operation description 
• Perform high-speed counter control which corresponds to the control code designated by "S". 

• This instruction is used when high-speed counter performs below operation.  
① Software reset, ② count is disabled, ③ External input makes reset input invalid, ④ When 
the control executed by high-speed counter instruction F166 - F167 is canceled, clear target 
value is interrupted. 

• Once the control code is written, it will maintain till next writing. 

• Control code written via F0 (MV) instruction is also saved to control code monitoring area 
when written in special register DT90052. Only lower 8 bits are written. 

 Precautions for programming 
• The setting which is reset input invalid will become valid only when system register is used 

to allocate reset input. 

• The external reset input setting can be used to switch the reset input (X6 or X7) allocated to 
mainframe input to valid or invalid. 
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 Control code allocation 
• Below bits are allocated according to designated channel and function. 

bit no. 15 0

Soft reset

0 0 0 0 0 0 0 0
8 7

0：Unavailable1：Execute

H00：Fixed

Counting 0：Available 1：Not execute

External reset input 0：Cancel 1：Disable

High-speed counter instruction 0：Continue 1：Allowed

Channel assignment
H0～H7： CH0～CH7

 

• Assign any input by controlling the above functions via the external input. 

 Sample program 
Below shows the situation in which input X7 is used to perform the software reset of high-
speed counter CH0. 

X7
DT90052H1F0 MV

DT90052H0F0 MV

（ ）DF
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23.3.2 [F1 DMV] Elapsed value read and write instruction 

Perform read and write of high-speed counter elapsed value. 

 Instruction format 

R0
DT90300K3000F1 DMV

DT100DT90300F1 DMV

S
（ ）DF

R1
（ ）DF

D  

 Operand 
Operand Settings 

S 
During setting: save the area or constant data of elapsed value (32 bit) which is set in high-speed 
counter. 
K−2, 147, 483, 648-K2, 147, 483, 647 

D During reading: read the area of high-speed counter elapsed value. 

 Memory area type that can be specified (A: Available) 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier K H 
S A A A A A A A A A A A A 
D - A A A A A A A A - - A 

 Operation description (elapsed value reading) 
• Save the contents of the special data register in which high-speed counter elapsed value is 

saved to the area which is designated by D. 

 Operation description (elapsed value setting ) 
• When writing to elapsed value area of high-speed counter in which 32 bit data is designated 

by S, use high-speed counter elapsed value area to perform setting inside the system. 

 Precautions for programming 
• Only F1 (DMV) instruction can be written. Transmit instruction F0 (MV) and other application 

instructions such as arithmetic cannot be written. 

• Please use lower 16 bit memory area No. to designate the memory area of "S" or "D". 
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23.3.3 [F166 HC1S] High-speed counter target value consistent ON instruction 
[F167 HC1R] High-speed counter target value consistent OFF instruction 

When the high-speed counter elapsed value is consistent with the target value of operand 
setting, set the designated output to ON or OFF. 

 Instruction format 

R0
K10000H0F166 HC1S Y2

S
（ ）DF

Dn
 

 Operand 
Operand Settings 

S The high-speed counter channel number which acts as consistent output object 
n Start number of the area in which high-speed counter’s target value data or data is saved 
D The output coil of ON or OFF in case of consistency (Y0 - Y29F) 

 Memory area type that can be specified (A: Available) 

Operand WX WY WR WL SV EV DT LD I 
Constant Index 

modifier 
 K H 

S - - - - - - - - - A A - 
n A A A A A A A A A A A A 
D - - - - - - - - - - - - 

 Operation description 
• The value designated by [S] is set to high-speed counter’s target value, when elapsed value 

is consistent to target value, control designates the output [Yn]. This will be executed by 
interruption handling. 

• [F166 HC1S] During instruction, set output OFF->ON; during [F167 HC1R] instruction, set 
the output ON->OFF. 

• When executing instruction, S value is saved to target value area. 

• When the target value setting is consistent to target value, output control is cleared to zero 
when target value is consistent. 

• When the target value is consistent, reset ON/OFF output, please use RST instruction, F0 
(MV) instruction for resetting, or F166 (HC1S) instruction, F167 (HC1R) instruction to match 
the use. 
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 Sample program 
When the elapsed value of high-speed counter CH0 is consistent with K10000, below is the 
situation for setting output Y0. 

R0
K10000H0F166 HC1S Y0（ ）DF

10000

0

R0
High-speed counter
in-control flag

Y0

Process value

F166 Control end
(Removal)

Target value

ON when the target
value is consistent  

 Precautions for programming 
• After the instruction’s execution condition turns to ON, high-speed counter In-control flag 

(R9110 - R9117) will be ON until the target value is consistent. The high-speed counter for 
the same channel cannot execute instruction (F166 - F167). 

• Before being consistent with the target value, during hardware reset, elapsed value is reset 
to 0, but the setting of the target value and target value being consistent will not reset to zero. 

• For the output Y designated when target value has consistent output, do not perform dual-
output check for OT instruction, KP instruction and other application instruction. 

• When in common program and interruption program, the same channel is described, do not 
execute them at the same time. 
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23.3.4 Interruption program startup when target value has consistent control 

After [F166 HC1S] instruction, [F167 HC1R] instruction combined with interruption program, 
when the target values are consistent, you can startup interruption program. 

 Execute method 
• Use system register to set high-speed counter. No need to set interruption input. 

• Compile interruption program as secondary program. 

• With the ICTL instruction in the main program, the corresponding interruption program is 
allowed to execute. 

• Execute [F166 HC1S] instruction and [F167 HC1R] instruction. If high-speed counter’s 
elapsed value is consistent with target value, the interruption program will startup. 

( ED     )
( INT      0  )

( IRET    )
INT0 Program

ON when the F166HC1S
instruction target value is
consistent
R9110: CH0
In-control mark
K0: CH0 designation
K10000: target value
Y2: Consistent output settings

ICTL instruction
INT0 program
allowed for execution

R0
H0ICTL H1

R1
K10000K0F166 HC1S Y2DF

R9110
）（

 

 Matching of channel number and interruption program number 
Channel 
number INT No Channel 

number INT No 

CH0 INT0 CH4 INT4 
CH1 INT1 CH5 INT5 
CH2 INT2 CH6 INT6 
CH3 INT3 CH7 INT7 

 



General-purpose Input / High-speed counter Function 

23-14 

23.4 Sample Program 

23.4.1 Running of the position control which has used inverter (1 speed) 

Use the high-speed counter to perform counting for feedback signal of the encoder. When the 
count value reaches 5000, stop the inverter. 

 Wiring example 

Y0

X0

X5

COM

COM

Encoder input

Encoders Motor

Conveyor Belt

Operation Startup

Inverter
Operation

Inverter

Run/Stop

Output terminal

Output terminal

 

 Operation diagram 

 

 I/O allocation sheet 
I/O 

Number Contents I/O 
Number Description 

X0 Encoder input R100 Position control operation 
X5 operation startup signal R101 Position control operation startup 

Y0 Frequency converter operation 
signal R102 Position control end pulse 

  R9110 High-speed counter CH0 in-control flag 
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 Sample program 

R101
DT90300K0F1 DMV

K5000K0F167 HC1R Y0

R100
（ ）DF

R101

X5
（ ）DF

R100

R100

R9110 R102

R101 Y0
< >SET

R9110
（ ）DF/

R102

R102

R100 T0

K5TMX 0

1

2

3

4

5

6

7

 

① Position control operation 

② Position control operation startup 

③ Value thorough which high-speed counter CH0 passes being reset 

④ Target value consistent OFF instruction: when high-speed counter’s elapsed value reaches 5000 pulse, 
Y0 becomes OFF. 

⑤ Setting inverter operation signal Y0 

⑥ Position control end pulse (0.5 s) 

⑦ Use 0.1 s timer, setting 0.5 s 
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23.4.2 Running of the position control which has used inverter (2 speed) 

Use the high-speed counter to perform counting for feedback signal of the encoder. When the 
count value reaches 4500, switch inverter to low speed operation. When the count value 
reaches 5000, stop the inverter. 

 Wiring example 

Y0
Y1

－

X0

X5

COM

COM

Encoder input

Encoders Motor

Conveyor Belt

Operation Startup

Inverter Operation
Inverter High Speed

Inverter
Run/Stop
High Speed/Low Speed

Input terminal

Output terminal

 

 Operation diagram 

 

 I/O allocation sheet 
I/O 

Number Contents I/O 
Number Description 

X0 Encoder input R100 Position control operation 
X5 operation startup signal R101 Reach deceleration point 

Y0 Frequency converter operation 
signal R102 Position control operation startup 

Y1 Frequency converter high speed 
signal R103 Position control end pulse 

  R900C Compare instruction＜ flag 

  R9110 High-speed counter CH0 in-control flag 
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 Sample program 

R101
DT90300K0F1 DMV

K5000K0F167 HC1R Y0

R100
（ ）DF

R101

X5
（ ）DF

R100

R100

R9110 R103

R101 Y0
< >SET

R9110
（ ）DF/

R103

R103

R100 T0

K5TMX 0

1

2

3

4

5

10

11

Y1
< >SET 6

R100
DT90300K4500F61 DCMP 7

R100 R102
8

R900C

R102
（ ）DF

Y1
9< >RST

 

① Position control operation 

② Position control operation startup 

③ Value thorough which high-speed counter CH0 passes being reset 

④ Target value consistent OFF instruction: high-speed counter CH0’s elapsed value reaches 5000 pulse, 
Y0 changes to OFF. 

⑤ Setting Y0 (inverter operation signal) 

⑥ Setting Y1 (inverter high speed signal) 

⑦ 32 bit data compare instruction: when high-speed counter CH0’s elapsed value exceeds 4500 pulse, 
R900C becomes ON. 

⑧ Reach deceleration point 

⑨ Reset Y1 (inverter high speed signal) 

⑩ Position control end pulse (0.5 s) 

⑪ 0.1 s timer: setting K5, used as 0.5 s timer 
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24.1 Analog Potentiometer 

24.1.1 Outline of Function 

 Outline of function  
• The FP-XH M8N control unit equipped with an analog potentiometer. 

• When rotating the potentiometer, the value of the special data register DT90040 changes 
between K0 - K4000. The set values inside the PLC can be changed without using a 
programming tool, therefore, it can be used to analog timers that change the set values by 
external rotary potentiometer. 

24.1.2 Analog Potentiometer Application Examples 

 Timer application examples 

The value of the special data register (DT90040) corresponding to the analog potentiometer 
V0 is transmitted to the set value area (SV0) of TMX0, and the timer time is set. 

R9010
SV0DT90040F0 MV

K10TMX 0
R0
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24.2 Input Time Constant Setting Function 

24.2.1 Outline of Function 

 Actions when setting the input time constant processing 
It is easy to set the time constant of the control unit input after changing the values of the 
system registers 430 - 431 with the programming tool. 

If this setting is carried out, it will run in accordance with the following equivalent circuit. Once 
set, you can remove the input interference and vibration. 

 

CXn Xn
S

CXn Xn
R

Timer processing Set value =
system register set value

Timer processing Set value =
system register set value

 

CXn=Xn contact input signal 
Xn=input Xn image memory 

 
• Receiving an input signal of the X contact can be performed by the common 

I/O refresh time. 

• For the input in the time constant processing, such as executing part of the 
refresh instructions, the time constant processing is invalid, and the input 
status at this time is read out for setting. 

• If use the F182 (FILTR) instruction, the time constant processing can be set 
even for the input outside the control unit (expansion unit). 

• Using the time processing in the equivalent circuit requires no time 
instruction. 

• For the setting to interrupt the high-speed counter or pulse catch, the time 
constant processing is ineffective. 

 Input time constant setting function and applicable models 
System register 

number 
Control unit 

controller I/O number Applicable models 

430 X0 - X3 ○ 
431 X4 - X7 ○ 
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25.1 Precautions for Using Backup Battery 

25.1.1 Backup Battery Replacement 

You can replace the backup battery of the FP-XH M8N control unit when the power is on. 
Please replace the backup battery according to the following steps.  

 
Do not use batteries other than FPXHBATT. Failure to do so may 
result in an electric shock. 

 Backup battery type (sold separately) 
Appearance Product Name Specification Product no. 

 

Backup battery  
for FP-XH With connector AFPXHBATT 

 Number of installed batteries 
For FP-XH M8N control unit, only one battery can be installed. 

PROCEDURE  
1. Power up the controller unit for more than five minutes. 

When replacing the battery, charge up the built-in capacitor to maintain the 
memory contents. 

2. Turn the power off. 
3. Open the cover. 
4. Remove the used batteries. 
5. Install the new battery within 2 minutes after cutting off the power supply. 
6. Close the cover. 

KEY POINTS
 

• You can replace the battery of the FP-XH M8N control unit when the power is on. 
If you perform the replacement after cutting off the power, in order to charge up 
the built-in capacitor, power up for more than 5 minutes, and complete the 
replacement in less than 2 minutes. If the charging is not sufficient, it may lead 
to unstable clock/calendar data. When storing the battery connector cables, 
avoid them to be clapped into the cassette cover. 
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25.1.2 Backup Battery Lifetime and Replacement Time 

 Backup Battery Lifetime 
Master memory 
cassette Type of Control Unit Backup Battery 

Lifetime Remarks 

If installed M8N More than 5 years Run 8 hours per day 
If not installed 

(Note): Please notice that the service life may be reduced due to use conditions. 

 Backup battery abnormality detection and battery replacement time 
• If the battery voltage drops, special internal relays (R9005, R9006) will turn to ON. Develop 

an program to send an outside abnormal warning as needed. 

• If the system register No. 4 "Alarm Battery Error" setting is effective, the ERR.LED of the 
controller unit controller will flash. 

• After the backup battery error is detected, the data can be maintained for about one week 
without power. However, please replace the battery immediately. 

 
• When special internal relays (R9005, R9006) are ON or the ERR.LED of the 

control unit is flashed, if the power outage lasts a week, the data saved in 
the memory may be turned to 0. 

• Special internal relays (R9005, R9006) are independent of the system 
register setting, if a backup battery error has been detected, it will turn to 
ON. 

• Regardless of when the backup battery error was detected, power up the 
control unit for more than 2 minutes when replacing the backup battery. 
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25.2 Inspection 
Perform routine or periodic inspection to ensure the best use conditions. 

 Check Items 
Check Items Check Contents Determination Criteria Related Page 

Power supply Verify the lighting state of the 
control unit RUN / PROG LED. Normal if "Lit" P.2-4 

Status display LED 
display 

Verify RUN mode LED display 
Verify the ERR.LED 

Lit when in RUN status 
Normal if "Unlit" P.2-4 

Installation status DIN rail installation, looseness 
Unit looseness and shaking 

Required to be installed 
securely. 

P.4-7 
P.4-11  

Connection status 
Terminal screw looseness 
near to crimp terminals 
connector looseness 

No looseness  
Fastened in parallel  
Locked.  
The connector shall be tight. 

P.4-5 -P.4-10 

Unit supply voltage Voltage between terminals 24 VDC P.2-6 
Input and output circuit 
supply voltage Supply voltage 24 VDC  P.2-7-P.2-8 

Ambient environment 

Ambient temperature, internal 
temperature 
ambient humidity, internal 
humidity 
environment 

0-＋55℃ 
10-95%RH 
There should be no dust and 
corrosive gas 

P.4-2-P.4-3 

Backup battery Control unit backup battery Periodic replacement P.4-4 
P.25-2-P.25-3 
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26.1 Control Unit Specifications 

26.1.1 General Specifications 

 General Specifications  （AFPXHM8N16PD） 
Item Specification 

Operating ambient 
temperature 0 °C to +55 °C 

Storage ambient 
temperature -40 °C to +70 °C 

Operating ambient 
humidity 10% to 95%RH (at 25 °C with no-condensing) 

Storage ambient 
humidity 10% to 95%RH (at 25 °C with no-condensing) 

Breakdown voltage 
(Detection current 5 
mA) 

Between power supply terminal and earth terminal 500V AC for 1 minute 

Between general-purpose input terminal and earth 
terminal 1500V AC for 1 minute 

Between general-purpose output terminal and earth 
terminal 500V AC for 1 minute 

Between pulse input terminald and earth terminal 500V AC for 1 minute 

Between RTEX (RJ45) connector and earth terminal 500V AC for 1 minute 

Insulation resistance 
(Test voltage: 500V DC) 

Between power supply terminal and earth terminal 

100MΩ min. 

Between general-purpose input terminal and earth 
terminal 
Between general-purpose output terminal and earth 
terminal 

Between pulse input terminal and earth terminal 

Between RTEX (RJ45) connector and earth terminal 

Vibration resistance 
5 to 8.4 Hz, 3.5 mm single amplitude 
8.4 to 150 Hz, acceleration of 9.8 m/s2 
10 sweeps each in X, Y and Z directions (1 octave/min.) 

Shock resistance 14. m/s2 min. In X, Y, and Z directions three times each 

Noise resistance 1,000 V[p-p], pulse width of 50 ns/1 µs (by noise simulator) 

Environment Free from corrosive gases and excessive dust 

Overvoltage category Category II or lower 

Pollution degree Pollution degree 2 or lower 

Weight Approx. 560g 

 Current consumption list （AFPXHM8N16PD） 
For 24 VDC 

200 mA or less 
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26.1.2 Performance Specifications 

Item Specifications 

No. of control I/O points 

General-purpose I/O part of the cotnrol unit: 16 points (DCinput: 8 points / 
Transistor output: 8 points) 
For E16 expansion I/O unit: up to 32 points 
For E30 expansion I/O unit: up to 256 points (up to 8 expansion units) 
For FP0R expansion I/O unit: up to 112 points (up to 3 expansion units) 

Program mode / Control 
method Relay symbol / cyclic operation mode 

Program memory 
Built-in Flash-ROM (requires no backup battery) 
Saved programs, system registers, position control data and position control data. 

Comments storage All comments including I/O comments, explanatory notes, interlinear comments 
can be stored. (Backup battery is not necessary: 1M bytes) 

No. of 
instructions 

Basic 
instructions Approx. 120 

High-level 
instructions Approx. 230 

Program capacity 24k / 32k / 40k step (Note 1) 

Operation processing speed  

Up to 7k steps: basic instruction 0.04 µs - / step, high-level instruction 0.22 µs - / 
step 
Above 7k steps: basic instruction 0.7 µs - / step, high-level instruction 1.73 µs - / 
step 

IO refresh  
+ base time 

Single control unit: below .0.12µs 
For expansion unit E16: 0.34 ms × No. of units 
For expansion unit E30: 0.47ms × No. of units 
For expanded FP0 adapter: 1.4ms ＋ FP0 expansion unit refresh time (note 2) 

O
peration m

em
ory 

R
elay 

External input (X) 2272 points (X0-X141F) (Note 3) 
External output (Y) 2272 points (Y0-Y141F) Not 3) 
Internal relay (R) 8192 points (R0-R511F) 
Special internal relay 
(R) 240 points 

Timer, counter 
(T / C) 

1024 points (note 4) 
(Initial setting Timer 1008 points: T0-T1007, counter 16 points: C1008-C1023） 
Timer measurable up to (1msec/10msec/100msec/1sec units) x 32767 
Counter measures 1-32767 

Link relay (L) 2048 points (L0 - L127F) 

M
em

ory 
area 

Data register (DT) 64k, 32k, 12k words (Note 1) 
Link data register 
(LD) 256 words (LD0 - LD255) 

Index register (I) 14 words (I0 - ID) 
Differential points (DF, DF /, 
DFI) Program capacity 

Master control relay points 256 points 
No. of labels (JMP+LOOP) 256 points 
No. of step ladders 1000 steps 
No. of subroutines 500 subroutines 

(Note 1): When changing the system register No.0 (sequence program capacity setting), the data register (DT) 
capacity will also change. 

(Note 2): Refresh time of FP0 expansion unit: No. of 8-point units used x 0.8 msec, No. of 16-point units:used × 1.0 
msec, No. of 32-point units used × 1.3 msec, No. of 64-point units used × 1.9 msec 

(Note 3): The number of points in the above table is the number of points of operation memory.. The actual number of 
points for input and output is determined by the combination of hardware. 

(Note 4): The number of timer points can be changed by the setting of the system register no. 5. Points can be 
increased with the auxiliary timer. 
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Item Specifications 

Interrupt program 
Interruption via external input or interruption when the target value of the high-
speed counter is consistent × 8 programs 
Periodical interrupt (0.1 ms unit, 0.5 ms unit or 10 ms unit) × 1 program 

Sampling trace Smapling by commands/Sampling at regular time intervals For one sampling: 16 
bits + +3 words, 1000 samples) 

PLC link function 
Up to 16 units, (link relay 1024 points, link register 128 words) × 2. 
(Baud rate: 115200 bps / 230400 bps) 

Constant scan Available (0 msec-350 msec) 
Security Function Passwords (4-digit, 8-digit, 32-digit), upload protection 
Self-diagnosis function Watchdog timer, program syntax check 
Rewriting during RUN Available (Download during RUN, Program rewrite during RUN (Max. 512 steps) 

High-speed 
counter 

Controller input Single-phase 8ch or 2-phase 4-ch Max. 10 kHz 
When pulse I/O 
cassette is 
installed 

Can not be installed 

Pulse output 
/ PWM 
output 

Controller 
output None 

When pulse I/O 
cassette is 
installed 

Can not be installed 

Pulse catch input 
interrupt input 8 points (Input of main unit: 8 points) 

Periodical interrupt 0.1ms-0.3s (0.1ms unit), 0.5ms-1.5s (0.5ms unit),  
10ms-30s (10ms unit) 

Potentiometer input 1ch (K0 - K4000) 
Input time constant processing Available (set via system register or instructions) 

Calendar timer  
(real-time clock) 
(note 5) 

Year (last 2 numbers in the Gregorian calendar), month, day, hour (24h), minute, 
second, week. As of 2099.  
Applicable during leap years.  
Available only when the master memory cassette AFPX-MRTC and battery are 
installed 

Flash-ROM backup 

Guaranteed writing times: up to 10 thousand times 

Automatic backup in case of power outage 
Counter 16 points, internal relay 128 points, data register 315 words 
Can be operated through the tool software or F-ROM read and write instruction 
(F12 / P13)  
Backup in data register 2K words 

Battery backup 
When optional batteries are used, all memory areas for operation can be backed 
up 
The hold / non-hold area can be set with the system register. 

Battery lifetime More than 5 years depending on the actual use condition (run 8 hours per day) 
(note 7) 

(Note5): Precision of calendar timer (realtime clock) (At 0 degree: less than 119 seconds per month, At 25 degrees: 
less than 51 seconds per month, At 55 degrees: less than 148 seconds per month) 

(Note 6): It will be cleared upon connection of the power if no battery installed or the battery is empty. 
(Note 7): The battery life is the value with the power supply not connected. The actual service life may be reduced 

due to use conditions. 



26.1 Control Unit Specifications 

 
26-5 

26.1.3 Performance Specifications of Motion Control Part 

Item Specifications 

Number of axes controlled 8 axes: Select from the following. 
8 real axes, 7 real axes + 1 virtual axis, 6 real axes + 2 virtual axes 

Interpolation control 2-axis linear interpolation control, 2-axis arc interpolation control,  
3-axis linear interpolation control and 3-axis spiral interpolation control. 

Autom
atci operation 

Position C
ontrol 

Position setting mode Absolute, increment 

Position setting unit 

pulse 
µm (Min. unit of instruction selectable between 0.1 µm and 1 µm) 
inch (Min. unit of instruction selectable between 0.00001 inch and 0.0001 
inch) 
degree (Min. unit of instruction selectable between 0.1 degree and 
1degree) 

Position setting range 

pulse:‐2,147,482,624-2,147,482,624 pulse 

µm(0.1 μm):‐214,748,262.4-214,748,262.4 μm 

µm(1 μm):‐2,147,482,624-2,147,482,624 μm 

inch(0.00001 inch):‐21,474.82624-21,474.82624 inch 

inch(0.0001 inch):‐214,748.2624-214,748.2624 inch 

degree(0.1 degree):‐214,748,262.4-214,748,262.4 degree 

degree(1 degree):‐2,147,482,624-2,147,482,624 degree 

Speed reference range 

pulse:1-2,147,482,624 pps 
µm:1-2,147,482,624 µm/s 
inch:0.001-2,147,482.624 inch/s 
degree:0.001-2,147,482.624 rev/s 

Acceleration and 
deceleration method Linear acceleration/deceleration, S shape acceleration/deceleration 

Acceleration time 0 - 10,000 ms (Settable by 1 ms) 
Deceleration time 0 - 10,000 ms (Settable by 1 ms) 
No. of positioning tables Each axis: 600 points in standard area and 89 points in extended area 

 
Control 
method 

Independent PTP control (E-point control, C-point control), CP control (P-point control), 
JOG positioning control (J-point control) 

2-axis linear 
interpolation E point, P point, C point controls, Composite speed or Long axis speed 

2-axis circular 
interpolation E point, P point, C point controls, Center point or Pass point 

3-axis linear 
interpolation E point, P point, C point controls, Composite speed or Long axis speed 

3-axis spiral 
interpolation E point, P point, C point controls, Center point or Pass point 

Startup time Standard area: 3 ms or less, Extended area: 5 ms or less 
Other functions Dwell time: 0-32,767ms (Settable by 1 ms) 
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Item Specifications 

Synchronous operation 

No. of axes 

No. of 
synchronous 
groups 

4 groups 

Master axis Selectable from real axes, virtual axes and pulse inputs. 
Slave axis Max. 8 axes per master axis 

Electronic 
gear 

Operation setting Gear ratio setting 
Operation method Direct method, linear acceleration/deceleration method 

Electronic 
clutch 

Trigger type 
Clutch ON trigger: Contact method, Clutch OFF trigger: Contact input, The 
contact input +phase specification contact method can be selected from the 
edge and level types.  

Connection 
method Direct method, linear slide method 

Electronic 
cam 

Cam pattern Select from 20 types. Multiple curves can be specified within phase (0 to -
100%) 

Resolution 1024, 2048, 4096, 8192, 16384, 32768 
No. of cam 
patterns 4-16 (According to resolution) 
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Item Specifications 

M
anual operation 

JOG 
operation 

Speed 
reference 
range 

Pulse:  1-2,147,482,624 pps 
µm; 1-2,147,482,624 µm/s 
inch: 0.001-2,147,482.624 inch/s 
degree: 0.001-2,147,482.624 rev/s 

Acceleration/
deceleration 
method 

Linear acceleration/deceleration, S acceleration/deceleration 

Acceleration 
time 0-0,000ms (Settable by 1 ms) 

Deceleration 
time 0-10,000ms (Settable by 1 ms) 

Home return 

Speed 
reference 
range 

pulse： 1-2,147,482,624 pps 
µm： 1-2,147,482,624 µm/s 
inch： 0.0010-2,147,482.624 inch/s 
degree： 0.001-2,147,482.624 rev/s 

Acceleration/
deceleration 
method 

Linear acceleration/deceleration 

Acceleration 
time 0-10,000 ms (Settable by 1 ms) 

Deceleration 
time 0-10,000 ms (Settable by 1 ms) 

Return 
method 

DOG method (3 types), Limit method (2 types), Data set method, Z phase 
method, Stop-on-contact method (2 types) 

Pulsar 
operation 
(Note 1) 

Number of 
channels Max. 4 channels (Used in combination with the high-speed counter function.) 

Speed 
reference 
range 

Operates synchronously with pulsar input. (Note 1) 

Stop 
function 

Stop operation type System stop, emergency stop, limit stop, error stop, deceleration stop, pause 

Stop deceleration time 
The system stops when the deceleration time of all axes reaches 1 ms. 
The deceleration time of emergency stop, limit stop, error stop, deceleration 
stop and pause is 0 to 10,000 ms. (Settable by 1 ms.) 

High-speed 
counter function 
(Note 1) 

Number of 
channels Max. 4 channels (Used in combination with the pulsar input.) 

Maximum 
counting 
speed 

1 MHz (when multiplied by 4: 4 MHz) (note 2) 

Counting 
range Counting range: -2,147,483,648 - 2,147,483,647 pulses 

Input mode Phase difference input, Direction discrimination input, Individual input 
(transfer multiple available for each.) 

Memory backup Parameters and positioning data are saved in the flash memory. (Batteryless) 

Other functions 

Software limit, current value update, target speed change, target position 
change, tool operation, torque monitor, actual speed monitor, torque limit, 
AMP parameter R/W, AMP status monitor, RTEX general-purpose monitor 
input (max. 2 points), RTEX operation output (max. 2 points) 

(Note 1): The pulsar input function and high-speed counter function use the same pulse input terminal. Therefore, the 
both functions cannot be used simultaneously. 

(Note 2): Multiplied when 2-phase input mode and "4 multiple setting" (x4) are set using the pulse input function. 
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26.2 Communication Specifications 

26.2.1 Communication Specifications of Control Unit 

 USB port (for tool software) 
Item Specifications 
Specification USB2.0 Fullspeed 
Communication function MEWTOCOL-COM (slave) 
Connector shape USB miniB type 

 COM0 port 
Item Specifications 
Interface Three-wire RS-232C x 1 channel 

Trasmission distance 15 m (Note 1) 

Baud rate 2400, 4800, 9600, 19200, 38400, 57600, 115200, 230400 bit / s 

Communication method Half-duplex transmission 

Synchronous method Start stop synchronous system 

Communication format Data lenght: 7 bits/8 bits, Stop bit: 1 bit/2 bits, Parity: None/Odd/Even 
Start code: STX/No STX, End code: CR/CR+LF/None/ETX 

Data transmission order Transmits from bit 0 character by character. 

Communication functions 

PLC link 
MEWTOCOL-COM (Master/Slave) 
MODBUS RTU (Master/Slave) 
General-purpose communication 
Modem initialization 

(Note 1) When communication is performed at a baud rate of 38400 bit/s or higher, use the cable not longer than 3 m. 
For wiring the RS232C, a shielded wire must be used to increase noise suppression. 

 Communication specifications of motion control part 
Item Specifications 
Physical layer 100BASE-TX （IEEE802.3） 

Baud rate 100 Mbps 
Trasmission distance Between nodes: Max. 100 m, Total length: Max. 200 m 

Topology Ring 
Applicable cable STP cable (category 5e or higher) 
Connector 9-pin RJ45 x 2 
Communication cycle 0.5 ms 
Position command update 1 ms 
No. of connected slaves Max. 8 slaves 

Coonnected slave Panasonic AC Servo Motor A6N series/A5N series 
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26.2.2 Specifications of Communication Cassette 

 RS-232C / RS-422 / RS-485 interface 

Item 
Specifications 

AFPX-COM1 
AFPX-COM5 AFPX-COM2 AFPX-COM3 AFPX-COM4 AFPX-COM6 

Interface RS-232C x 1ch 
(Note 1) 

RS-232C (3-
wire type) x 2 
chs 

RS-485/RS-422 
x 1 ch 
(Note 2)(Note 3) 

RS-485 x 1 ch,  
RS-232C  
(3-wire type) x  
1 ch 
(Note 3) 

RS-485 x 2 chs 
(Note 3) 

Trasmission 
distance 

RS-232C: Max. 15 m (Note 4) 
When using RS-422: Max. 400 m 
When using RS-485: Max. 1,200 m (Note 5) (Note 6) 

Baud rate 2400, 4800, 9600, 19200, 38400, 57600, 115200, 230400 bit/s 

Communication 
method Half-duplex transmission 

Synchronous 
method Start stop synchronous system 

Communication 
format 

Data lenght: 7 bits/8 bits, Stop bit: 1 bit/2 bits, Parity: None/Odd/Even 
Start code: STX/No STX, End code: CR/CR+LF/None/ETX 

Data 
transmission 
order 

Transmits from bit 0 character by character. 

Communication 
function and no. 
of connected 
units 

PLC link: Max. 16 units 
MEWTOCOL-COM (Master/Slave): Max. 99 units 
MODBUS RTU (Master/Slave): Max. 99 units 
General-purpose communication: Max. 99 units 
Modem initialization 

(Note 1): The AFPX-COM1 is a 5-wire type. When using it as a 3-wire type, short-circuit the RS-CS terminal. 
(Note 2): It can be switched between RS-485 and RS-422 by switching the dip switches on the cassette. 
(Note 3): When connecting a commercially available device that has an RS485 interface, please confirm operation 

using the actual device. In some cases, the number of units, transmission distance, and baud rate vary 
depending on the connected device. 

(Note 4): When communication is performed at a baud rate of 38400 bit/s or higher, use the cable not longer than 3 m. 
For wiring the RS232C, a shielded wire must be used to increase noise suppression. 

(Note 5): The transmission distance is limited by the baud rate and the number of connected units when setting RS-
485 as follows. For the baud rate of 38400 bit/s or less, the distance is up to 1200 m, and the number of 
connected units is 99. When using in combination with the C-NET adapter, the maximum number of connected 
units is limited to 32, and the baud rate is limited to 19200 bit/s or less. 

 
(Note 6): The converter SI-35 manufactured by Lineeye Co., Ltd. is recommendable for the RS-485 at the computer 

side. 
(Note 7): For information on usable functions and restrictions on the combination, refer to 1.4.4 Restrictions on 

Communication Function. 



Specifications 

26-10 

 Ethernet port 

Item 
Specifications 
AFPX-COM5 

Interface IEEE802.3u, 100BASE-TX / 10BASE-T 

Baud rate 100 Mbps, 10 Mbps (Note 1) 

Transmission 
system Baseband 

Max. segment 
length 100 m (Note 2) 

Communication 
cable UTP cable (Category 5) 

Communication 
protocol TCP/IP, UDP/IP, ICMP, ARP, DHCP 

Functions 
Auto-negotiation function 
MDI/MDI-X Auto-crossover function 

Communication 
functions 

MEWTOCOL-COM (Master/Slave) 
Max. 1 connection (Client) 
Max. 3 connections (Server) 

General-purpose communication Max. 1 connection (Client) 

(Note 1): Switching between different speeds is done automatically by auto negotiation function. 
(Note 2): The standards cite 100 m as the maximum, but noise resistance measures such as attaching a ferrite core 

may be necessary in some cases, depending on the usage environment. Also, if the hub is positioned close to a 
control board, we recommend using it at a distance of 10 m or less. 
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26.3 Operation Memory Areas 

 List of operation memory areas 
Item Specifications 

R
elays 

External input (X) (note 1) 2272 points (X0 - X141F) 
External output (Y) (note 1) 2272 points (Y0 - Y141F)  

Internal relay (R) 8192 points (R0-R511F)  
Link relay (L) 2048 points (L0 - L127F) 

Timer / counter (T/C) (note 3) 

1024 points (timer 1008 points: T0-T1007, counter 16 points: C1008-
C1023） 
Timer measures (1msec/10msec/100msec/1sec units) × 32767 
Counter measures 1-32767 

Special internal relay (R) 256 points (R9000 - R915F) 

M
em

ory area 

External input (WX) (note 1) 142 words (WX0 - WX141) 
External output (WY) (note 1) 142 words (WY0 - WY141) 

Internal relay (WR) 512 words (WR0 - WR511) (note 2) 
Link relay (WL) 128 words (WL0 - WL127) 

Data register (DT) 65533 words (DT0-DT12284)/32765 words (DT0-DT32764)/12285 
words (DT0-DT65532) (note 3) 

Special data register (DT) 500 words (DT90000 - DT90499) 
Link data register (LD) 256 words (LD0 - LD255) 
Timer/counter set value area (SV) 1024 words (SV0 - SV1023) 
Timer/counter elapsed value area 
(EV) 1024 words (EV0 - EV1023) 

Index register (I) 14 words (I0 - ID) 

C
onstant 

Decimal constant (K) K-32,768 - K32,767 (16-bit operation) 
K-2,147,483,648 - K2,147,483,647 (32-bit operation) 

Hexadecimal constant (H) H0-HFFFF (16-bit operation) 
H0-HFFFFFFFF (32-bit operation) 

Floating-point type real numbers 
(f) 

F-1.175494×10-38 - F-3.402823×1038 
F 1.175494×10-38 - F 3.402823×1038 

(Note 1): The number of points noted above is the number of points of operation memory. The number of points 
actually used as input/output is determined by the hardware configuration. 

(Note 2): The number of timer/counter points can be changed by the setting of the system register no.5. Points can be 
increased with the auxiliary timer. 

(Note 3): When changing the system register no.0 (sequence program capacity setting), the data register (DT) 
capacity will also change. 

Program capacity 24K 32K 40K 
Data register 
capacity 65533 words 32765 words 12285 words 

(Note 4): For details on hold/non-hold area, refer to "21.1.2 Operation Memory Backup". 
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26.4 Positioning Memory 

26.4.1 Entire Configuration of Positioning Memory 

Positioning memory consists of 6 areas 

Area 
no.0 Area name Offset 

Address Individual name of each area 

0 Common area H85- 
H389 

Setting parameter control area 
Operation speed rate area 
Axis group setting area 
Current value update data area 

Torque limit area 
Positioning table setting area 
Positioning control area 
Error announciation & clear area 
Warning announciation & clear area 
Synchronous control monitor area 

System operation setting area 
AMP monitor & cotnrol area 
Pulse input setting area 
Pulse count control area 
Pulse input monitor area 

1 
Each axis 
information area 
(Note) 

H0-H3F 

Axis 1 Each axis information & monitor area 

Axis 2 Each axis information & monitor area 
Axis 3 Each axis information & monitor area 
Axis 4 Each axis information & monitor area 
Axis 5 Each axis information & monitor area 
Axis 6 Each axis information & monitor area 
Axis 7 (virtual) Each axis information & monitor area 

Axis 8 (virtual) Each axis information & monitor area 

. 
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Area 
no.0 Area name Offset 

Address Individual name of each area 

2 Each axis 
setting area 

H0- 
H27FF 

Axis 1 
Parameter setting area 
Positioning data setting area (600 standard points and 
89 expansion points) 

Axis 2 
Parameter setting area 
Positioning data setting area (600 standard points and 
89 expansion points) 

Axis 3 
Parameter setting area 
Positioning data setting area (600 standard points and 
89 expansion points) 

Axis 4 
Parameter setting area 
Positioning data setting area (600 standard points and 
89 expansion points) 

Axis 5 
Parameter setting area 
Positioning data setting area (600 standard points and 
89 expansion points) 

Axis 6 
Parameter setting area 
Positioning data setting area (600 standard points and 
89 expansion points) 

Axis 7 
(virtual) 

Parameter setting area 
Positioning data setting area (600 standard points and 
89 expansion points) 

Axis 8 
(virtual) 

Parameter setting area 
Positioning data setting area (600 standard points and 
89 expansion points) 

3 Cam pattern 
editing area 

H0- 
H5F Cam pattern setting area 
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Area 
no.0 Area name Offset 

Address Individual name of each area 

4 Synchronous 
control setting area H0-H6F 

Axis 1 

Synchronous control common setting area 
Electronic gear setting area 
Clutch setting area 
Electronic cam setting area 

Axis 2 

Synchronous control common setting area 

Electronic gear setting area 
Clutch setting area 
Electronic cam setting area 

Axis 3 

Synchronous control common setting area 
Electronic gear setting area 
Clutch setting area 

Electronic cam setting area 

Axis 4 

Synchronous control common setting area 
Electronic gear setting area 
Clutch setting area 
Electronic cam setting area 

Axis 5 

Synchronous control common setting area 

Electronic gear setting area 
Clutch setting area 
Electronic cam setting area 

Axis 6 

Synchronous control common setting area 
Electronic gear setting area 
Clutch setting area 

Electronic cam setting area 

Axis 7 
(virtual) 

Synchronous control common setting area 
Electronic gear setting area 
Clutch setting area 
Electronic cam setting area 

Axis 8 
(virtual) 

Synchronous control common setting area 

Electronic gear setting area 
Clutch setting area 
Electronic cam setting area 
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Area 
no.0 Area name Offset 

Address Individual name of each area 

5 
Positioning 
operation 
change area 

H0-HF 

Axis 1 Setting area 
Axis 2 Setting area 
Axis 3 Setting area 
Axis 4 Setting area 
Axis 5 Setting area 

Axis 6 Setting area 
Axis 7 (virtual) Setting area 
Axis 8 (virtual) Setting area 

6 AMP parameter 
area H0-H3F AMP parameter setting area 

 

 
• Be sure not to execute writing in the reserved areas for the system. 

• For reading each axis information area with the program, check if the link 
establishment annunciation flag (X1100) turns ON before reading it. 
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26.4.2 Common Area (Memory Area No.0) 

 Setting parameter control area 
Offset 

Address Name Default Description 

H85 
Recalculation 
starting table 
number 

K1 

When the recalculation request signal (Y1170) turns on, the control unit 
will recalculate the positioning data of all the axes from this table 
number to no. 600. 
Setting Range: K1-K600 

 Operation speed setting area 
Offset 

Address Name Default Description 

H88 Operation speed 
rate K100 

All operations relating to axes (positioning, JOG, home return) can be 
performed at the specified rate. 
Setting Range: K1-K100 
Unit: ％ 
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 Axis group setting area 
Offset 

Address Name Default Description 

HB0 Group-A axis setting 

H0 

Set either independent or interpolation for each axis in this area. In 
case of interpolation, each axis belongs to any group A to D. For 
example, the axes 1, 2 and 3 belong to group A and are 3-axis 
interpolation, set the corresponding 3 bits to 1 in the interpolation axis 
setting of group A. 
The max. number of interpolation in each group is 3, the same axis 
cannot be set repeatedly in different groups. 
bit Name Default Description 

0 Group attribute of 
axis 1 0 

0: Not belong to the interpolation 
group 
1: Belong to the interpolation group. 
 
If there are over 4 bits in the group 
set to 1, or the same axis being set 
to 1 repeatedly in other groups, an 
error occurs. 
Also, an error occurs if an axis that 
has been set as a virtual axis by 
Configurator PM7 is set. 

1 Group attribute of 
axis 2 0 

2 Group attribute of 
axis 3 0 

3 Group attribute of 
axis 4 0 

4 Group attribute of 
axis 5 0 

5 Group attribute of 
axis 6 0 

6 Group attribute of 
axis 7 0 

7 Group attribute of 
axis 8 0 

15-8 － － － 
 

HB1 Group-B axis setting 

HB2 Group-C axis setting 

HB3 Group-D axis setting 

HB4 Independent axis 
setting H0 

Please set the object bit to 1 for independent axis not belonging to the 
interpolation group. 

bit Name Default Description 

0 Attribute of axis 1 0 

0: Belong to the interpolation group, 
or not set as used axes. 

1: Independent axis (not belonging to 
the interpolation group). 

An error may occur when setting the 
interpolation group. 

1 Attribute of axis 2 0 

2 Attribute of axis 3 0 

3 Attribute of axis 4 0 

4 Attribute of axis 5 0 

5 Attribute of axis 6 0 

6 Attribute of (virtual) 
axis 7 0 

7 Attribute of (virtual) 
axis 8 0 

15-8 － － － 
 

HB5-HBF Reserved for system － － 
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 Current value update area 
Offset 

Address Name Default Description 

HC0 
Current value update 
request 
flag 

H0 

Only when the bit corresponding to each axis changes to 1 from 0, 
the current values controlled by the control unit are changed to the 
following values. 
After the change, the control unit will automatically clear the 
corresponding bit. 

bit Name Default Description 

0 Current value update 
request for axis 1 0 

0: Unchanged 
1: Update the 

current value of 
the object axis 

1 Current value update 
request for axis 2 0 

2 Current value update 
request for axis 3 0 

3 Current value update 
request for axis 4 0 

4 Current value update 
request for axis 5 0 

5 Current value update 
request for axis 6 0 

6 Current value update 
request for (virtual) axis 7  0 

7 
Current value update 
request for (virtual) axis 
78 

0 

15-8 － － － 
 

HC1-HC7 Reserved for system － － 

HC8-HC9 Current value update 
coordinate of axis 1 K0 

Stores the coordinate value to be preset by the current value update 
function. 

HCA-HCB Current value update 
coordinate of axis 2 K0 

HCC-HCD Current value update 
coordinate of axis 3 K0 

HCE-HCF Current value update 
coordinate of axis 4 K0 

HD0-HD1 Current value update 
coordinate of axis 5 K0 

HD2-HD3 Current value update 
coordinate of axis 6 K0 

HD4-HD5 
Current value update 
coordinate for (virtual) 
axis 7 

K0 

HD6-HD7 
Current value update 
coordinate for (virtual) 
axis 8 

K0 
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 Torque limit area 
Offset 

Address Name Default Description 

HD8 Torque limit enable 
flag H0 

Set whether to enable or disable the execution of the torque limit for 
each axis. For enabling the torque limit, set the corresponding bits to 
1. 

bit Name Default Description 

0 Torque limit of axis 1 0 0: Torque limit 
disabled (Default) 

1: Torque limit 
enabled 

1 Torque limit of axis 2 0 

2 Torque limit of axis 3 0 

3 Torque limit of axis 4 0 

4 Torque limit of axis 5 0 

5 Torque limit of axis 6 0 

6 Torque limit of axis 7 0 

7 Torque limit of axis 8 0 

15-8 - - - 
 

HC9-HDF Reserved for 
system - - 

HE0 Torque limit value 
of axis 1 K3000 

Set the torque limit value for each axis. 
Setting range: K1-K5000 
Unit: 0.1 % 

HE1 Torque limit value 
of axis 2 K3000 

HE2 Torque limit value 
of axis 3 K3000 

HE3 Torque limit value 
of axis 4 K3000 

HE4 Torque limit value 
of axis 5 K3000 

HE5 Torque limit value 
of axis 6 K3000 

HE6 Torque limit value 
of axis 7 K3000 

HE7 Torque limit value 
of axis 8 K3000 
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 Positioning control starting table number setting area 
Offset 

Address Name Default Description 

H100 
Position control 
starting table 
number of axis 1 

K1 
Stores the position control starting table number. 
Setting range: 1-600, 10001-10089 

H101 
Position control 
starting table 
number of axis 2 

H102 
Position control 
starting table 
number of axis 3 

H103 
Position control 
starting table 
number of axis 4 

H104 
Position control 
starting table 
number of axis 5 

H105 
Position control 
starting table 
number of axis 6 

H106 

Position control 
starting table 
number of (virtual) 
axis 7 

H107 

Position control 
starting table 
number of (virtual) 
axis 8 

 

 Positioning control area 
Offset 

Address Name Default Description 

H108 Positioning repeat 
count of axis 1 

K0 

Stores the number of times for repeating the operation starting from 
the position control starting table number until the E point. 
When 255 is stored, the positioning control is repeated unlimitedly 
until the operation is stopped. 
Setting range: 0-255 

H109 Positioning repeat 
count of axis 2 

H10A Positioning repeat 
count of axis 3 

H10B Positioning repeat 
count of axis 4 

H10C Positioning repeat 
count of axis 5 

H10D Positioning repeat 
count of axis 6 

H10E 
Positioning repeat 
count of (virtual) 
axis 7 

H10F 
Positioning repeat 
count of (virtual) 
axis 8 
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 Error annunciationn & clear area 
Offset 

Address Name Description 

H110 Reserved for system - 

H111 Error clear individual axis 
setting 

Executes the error clear for each axis. 
bit Name Default Description 
0 Error clear for axis 1 0 0: Not clear errors 

0 to 1: clear errors 
(After execution, the control unit 
will automatically change the 
value to 0.) 

1 Error clear for axis 2 0 
2 Error clear for axis 3 0 
3 Error clear for axis 4 0 
4 Error clear for axis 5 0 
5 Error clear for axis 6 0 
6 Error clear for (virtual) 

axis 7 
0 

7 Error clear for (virtual) 
axis 8 

0 

15-8 － － － 
 

H112 
- H128 Reserved for system － 

H129 No. of error occurrences of axis 
1 Notifies the number of occurrences of errors at axis 1. 

H12A 
H12B 

Error code annunciation buffer 
1 of axis 1 

Stores the latest error codes in order from buffer 1. 

H12C 
H12D 

Error code annunciation buffer 
2 of axis 1 

H12E 
H12F 

Error code annunciation buffer 
3 of axis 1 

H130 
H131 

Error code annunciation buffer 
4 of axis 1 

H132 
H133 

Error code annunciation buffer 
5 of axis 1 

H134 
H135 

Error code annunciation buffer 
6 of axis 1 

H136 
H137 

Error code annunciation  buffer 
7 of axis 1 

H138 Reserved for system － 

H139 No. of error occurrences of axis 
2 Notifies the number of occurrences of errors at axis 2. 

H13A 
H13B 

Error code annunciation buffer 
1 of axis 2 

Stores the latest error codes in order from buffer 1. 

H13C 
H13D 

Error code annunciation buffer 
2 of axis 2 

H13E 
H13F 

Error code annunciation buffer 
3 of axis 2 

H140 
H141 

Error code annunciation buffer 
4 of axis 2 

H142 
H143 

Error code annunciation buffer 
5 of axis 2 

H144 
H145 

Error code annunciation buffer 
6 of axis 2 

H146 
H147 

Error code annunciation  buffer 
7 of axis 2 
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Offset 
Address Name Description 

H148 Reserved for system － 

H149 No. of error occurrences of axis 
3 Notifies the number of occurrences of errors at axis 3. 

H14A 
H14B 

Error code annunciation buffer 1 
of axis 3 

Stores the latest error codes in order from buffer 1. 

H14C 
H14D 

Error code annunciation buffer 2 
of axis 3 

H14E 
H14F 

Error code annunciation buffer 3 
of axis 3 

H150 
H151 

Error code annunciation buffer 4 
of axis 3 

H152 
H153 

Error code annunciation buffer 5 
of axis 3 

H154 
H155 

Error code annunciation buffer 6 
of axis 3 

H156 
H157 

Error code annunciation  buffer 7 
of axis 3 

H158 Reserved for system － 

H159 No. of error occurrences of axis 
4 Notifies the number of occurrences of errors at axis 4. 

H15A 
H15B 

Error code annunciation buffer 1 
of axis 4 

Stores the latest error codes in order from buffer 1. 

H15C 
H15D 

Error code annunciation buffer 2 
of axis 4 

H15E 
H15F 

Error code annunciation buffer 3 
of axis 4 

H160 
H161 

Error code annunciation buffer 4 
of axis 4 

H162 
H163 

Error code annunciation buffer 5 
of axis 4 

H164 
H165 

Error code annunciation buffer 6 
of axis 4 

H166 
H167 

Error code annunciation  buffer 7 
of axis 4 

H168 Reserved for system － 
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Offset 
Address Name Description 

H169 No. of error occurrences of axis 
5 Notifies the number of occurrences of errors at axis 5. 

H16A 
H16B 

Error code annunciation buffer 1 
of axis 5 

Stores the latest error codes in order from buffer 1. 

H16C 
H16D 

Error code annunciation buffer 2 
of axis 5 

H16E 
H16F 

Error code annunciation buffer 3 
of axis 5 

H170 
H171 

Error code annunciation buffer 4 
of axis 5 

H172 
H173 

Error code annunciation buffer 5 
of axis 5 

H174 
H175 

Error code annunciation buffer 6 
of axis 5 

H176 
H177 

Error code annunciation  buffer 7 
of axis 5 

H178 Reserved for system － 

H179 No. of error occurrences of axis 
6 Notifies the number of occurrences of errors at axis 6. 

H17A 
H17B 

Error code annunciation buffer 1 
of axis 6 

Stores the latest error codes in order from buffer 1. 

H17C 
H17D 

Error code annunciation buffer 2 
of axis 6 

H17E 
H17F 

Error code annunciation buffer 3 
of axis 6 

H180 
H181 

Error code annunciation buffer 4 
of axis 6 

H182 
H183 

Error code annunciation buffer 5 
of axis 6 

H184 
H185 

Error code annunciation buffer 6 
of axis 6 

H186 
H187 

Error code annunciation  buffer 7 
of axis 6 

H188 Reserved for system － 

 



Specifications 

26-24 

 

Offset 
Address Name Description 

H189 No. of error occurrences of 
(virtual) axis 7 Notifies the number of occurrences of errors at axis 7. 

H18A 
H18B 

Error code annunciation buffer 1 
of (virtual) axis 7 

Stores the latest error code from the buffer number 1 in order. 

H18C 
H18D 

Error code annunciation buffer 2 
of (virtual) axis 7 

H18E 
H18F 

Error code annunciation buffer 3 
of (virtual) axis 7 

H190 
H191 

Error code annunciation buffer 4 
of (virtual) axis 7 

H192 
H193 

Error code annunciation buffer 5 
of (virtual) axis 7 

H194 
H195 

Error code annunciation buffer 6 
of (virtual) axis 7 

H196 
H197 

Error code annunciation buffer 7 
of (virtual) axis 7 

H198 Reserved for system － 

H199 No. of error occurrences of 
(virtual) axis 8 Notifies the number of occurrences of errors at axis 8. 

H19A 
H19B 

Error code annunciation buffer 1 
of (virtual) axis 8 

Stores the latest error code from the buffer number 1 in order. 

H19C 
H19D 

Error code annunciation buffer 2 
of (virtual) axis 8 

H19E 
H19F 

Error code annunciation buffer 3 
of (virtual) axis 8 

H1A0 
H1A1 

Error code annunciation buffer 4 
of (virtual) axis 8 

H1A2 
H1A3 

Error code annunciation buffer 5 
of (virtual) axis 8 

H1A4 
H1A5 

Error code annunciation buffer 6 
of (virtual) axis 8 

H1A6 
H1A7 

Error code annunciation buffer 7 
of (virtual) axis 8 
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 Warning annunciation & clear area 
Offset 

Address Name Description 

H1A8 Reserved for system - 

H1A9 Warning clear individual axis 
setting 

Executes the error clear for each axis. 
bit Name Default Description 
0 Warning clear for axis 1 0 0: Not clear warnings 

0 to 1: clear warnings 
(After execution, the control unit 
will automatically change the 
value to 0.) 

1 Warning clear for axis 2 0 
2 Warning clear for axis 3 0 
3 Warning clear for axis 4 0 
4 Warning clear for axis 5 0 
5 Warning clear for axis 6 0 
6 Warning clear for (virtual) 

axis 7 
0 

7 Warning clear for (virtual) 
axis 8 

0 

15-8 － － － 
 

H1AA 
- H1C0 Reserved for system － 

H1C1 No. of warning occurrences of 
axis 1 Notifies the number of occurrences of warnings at axis 1. 

H1C2 
H1C3 

Warning code annunciation 
buffer 1 of axis 1 

Saves the latest warning codes in order from buffer 1. 

H1C4 
H1C5 

Warning code annunciation 
buffer 2 of axis 1 

H1C6 
H1C7 

Warning code annunciation 
buffer 3 of axis 1 

H1C8 
H1C9 

Warning code annunciation 
buffer 4 of axis 1 

H1CA 
H1CB 

Warning code annunciation 
buffer 5 of axis 1 

H1CC 
H1CD 

Warning code annunciation 
buffer 6 of axis 1 

H1CE 
H1CF 

Warning code annunciation  
buffer 7 of axis 1 

H1D0 Reserved for system － 

H1D1 No. of warning occurrences of 
axis 2 Notifies the number of occurrences of warnings at axis 2. 

H1D2 
H1D3 

Warning code annunciation 
buffer 1 of axis 2 

Saves the latest warning codes in order from buffer 1. 

H1D4 
H1D5 

Warning code annunciation 
buffer 2 of axis 2 

H1D6 
H1D7 

Warning code annunciation 
buffer 3 of axis 2 

H1D8 
H1D9 

Warning code annunciation 
buffer 4 of axis 2 

H1DA 
H1DB 

Warning code annunciation 
buffer 5 of axis 2 

H1DC 
H1DD 

Warning code annunciation 
buffer 6 of axis 2 

H1DE 
H1DF 

Warning code annunciation  
buffer 7 of axis 2 



Specifications 

26-26 

Offset 
Address Name Description 

H1E0 Reserved for system － 

H1E1 No. of warning occurrences of 
axis 3 Notifies the number of occurrences of warnings at axis 3. 

H1E2 
H1E3 

Warning code annunciation 
buffer 1 of axis 3 

Saves the latest warning codes in order from buffer 1. 

H1E4 
H1E5 

Warning code annunciation 
buffer 2 of axis 3 

H1E6 
H1E7 

Warning code annunciation 
buffer 3 of axis 3 

H1E8 
H1E9 

Warning code annunciation 
buffer 4 of axis 3 

H1EA 
H1EB 

Warning code annunciation 
buffer 5 of axis 3 

H1EC 
H1ED 

Warning code annunciation 
buffer 6 of axis 3 

H1EE 
H1EF 

Warning code annunciation  
buffer 7 of axis 3 

H1F0 Reserved for system － 

H1F1 No. of warning occurrences of 
axis 4 Notifies the number of occurrences of warnings at axis 4. 

H1F2 
H1F3 

Warning code annunciation 
buffer 1 of axis 4 

Saves the latest warning codes in order from buffer 1. 

H1F4 
H1F5 

Warning code annunciation 
buffer 2 of axis 4 

H1F6 
H1F7 

Warning code annunciation 
buffer 3 of axis 4 

H1F8 
H1F9 

Warning code annunciation 
buffer 4 of axis 4 

H1FA 
H1FB 

Warning code annunciation 
buffer 5 of axis 4 

H1FC 
H1FD 

Warning code annunciation 
buffer 6 of axis 4 

H1FE 
H1FF 

Warning code annunciation  
buffer 7 of axis 4 

H200 Reserved for system － 
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Offset 
Address Name Description 

H201 No. of warning occurrences of 
axis 5 Notifies the number of occurrences of warnings at axis 5. 

H202 
H203 

Warning code annunciation 
buffer 1 of axis 5 

Saves the latest warning codes in order from buffer 1. 

H204 
H205 

Warning code annunciation 
buffer 2 of axis 5 

H206 
H207 

Warning code annunciation 
buffer 3 of axis 5 

H208 
H209 

Warning code annunciation 
buffer 4 of axis 5 

H20A 
H20B 

Warning code annunciation 
buffer 5 of axis 5 

H20C 
H20D 

Warning code annunciation 
buffer 6 of axis 5 

H20E 
H20F 

Warning code annunciation  
buffer 7 of axis 5 

H210 Reserved for system － 

H211 No. of warning occurrences of 
axis 6 Notifies the number of occurrences of warnings at axis 6. 

H212 
H213 

Warning code annunciation 
buffer 1 of axis 6 

Saves the latest warning codes in order from buffer 1. 

H214 
H215 

Warning code annunciation 
buffer 2 of axis 6 

H216 
H217 

Warning code annunciation 
buffer 3 of axis 6 

H218 
H219 

Warning code annunciation 
buffer 4 of axis 6 

H21A 
H21B 

Warning code annunciation 
buffer 5 of axis 6 

H21C 
H21D 

Warning code annunciation 
buffer 6 of axis 6 

H21E 
H21F 

Warning code annunciation  
buffer 7 of axis 6 

H220 Reserved for system － 
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Offset 
Address Name Description 

H221 No. of warning occurrences of 
(virtual) axis 7 Notifies the number of occurrences of warnings at axis 7. 

H222 
H223 

Warning code annunciation 
buffer 1 of (virtual) axis 7 

Stores the latest warning code from the buffer number 1 in order. 

H224 
H225 

Warning code annunciation 
buffer 2 of (virtual) axis 7 

H226 
H227 

Warning code annunciation 
buffer 3 of (virtual) axis 7 

H228 
H229 

Warning code annunciation 
buffer 4 of (virtual) axis 7 

H22A 
H22B 

Warning code annunciation 
buffer 5 of (virtual) axis 7 

H22C 
H22D 

Warning code annunciation 
buffer 6 of (virtual) axis 7 

H22E 
H22F 

Warning code annunciation 
buffer 7 of (virtual) axis 7 

H230 Reserved for system － 

H231 No. of warning occurrences of 
(virtual) axis 8 Notifies the number of occurrences of warnings at axis 8. 

H232 
H233 

Warning code annunciation 
buffer 1 of (virtual) axis 8 

Stores the latest warning code from the buffer number 1 in order. 

H234 
H235 

Warning code annunciation 
buffer 2 of (virtual) axis 8 

H236 
H237 

Warning code annunciation 
buffer 3 of (virtual) axis 8 

H238 
H239 

Warning code annunciation 
buffer 4 of (virtual) axis 8 

H23A 
H23B 

Warning code annunciation 
buffer 5 of (virtual) axis 8 

H23C 
H23D 

Warning code annunciation 
buffer 6 of (virtual) axis 8 

H23E 
H23F 

Warning code annunciation 
buffer 7 of (virtual) axis 8 
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 Synchronous control monitor area 
Offset 
address Name Default Description 

H240 
-H2AF Reserved for system － － 

H2B0 
Synchronous master 
axis information monitor 
of axis 1 

HF 

Stores the setting status of the master axis under synchronous 
control. 

Stored value 
Master axis Synchronizing Canceling 

synchronization 
FFFFH FFFFH No synchronous setting 
0000H 8000H The target axis for 

monitoring is the master 
axis. 

0001H 8001H Axis 1 
0002H 8002H Axis 2 
0003H 8003H Axis 3 
0004H 8004H Axis 4 
0005H 8005H Axis 5 
0006H 8006H Axis 6 
0007H 8007H Axis 7 (virtual) 
0008H 8008H Axis 8 (virtual) 
0021H 8021H Pulse input 1 
0022H 8022H Pulse input 2 
0023H 8023H Pulse input 3 
0024H 8024H Pulse input 4 

 

H2B1 
Synchronous output 
function selection status 
monitor of axis 1 

H0 

Stores the status of the synchronous operation function set for 
the axes. 

bit Function Setting 
0 Electronic gear operation settings 0: Use 

1:  Not use 1 Clutch operation setting 
2 Electronic operation setting 
3 Advance angle correction 

synchronous setting 
15-4 － － 

 

H2B2 
Synchronous master 
axis information monitor 
of axis 2 

HF Refer to the description for the axis 1 

H2B3 
Synchronous output 
function selection status 
monitor of axis 2 

H0 Refer to the description for the axis 1 

H2B4 
Synchronous master 
axis information monitor 
of axis 3 

HF Refer to the description for the axis 1 

H2B5 
Synchronous output 
function selection status 
monitor of axis 3 

H0 Refer to the description for the axis 1 

H2B6 
Synchronous master 
axis information monitor 
of axis 4 

HF Refer to the description for the axis 1 

H2B7 
Synchronous output 
function selection status 
monitor of axis 4 

H0 Refer to the description for the axis 1 

H2B8 
Synchronous master 
axis information monitor 
of axis 5 

HF Refer to the description for the axis 1 

H2B9 
Synchronous output 
function selection status 
monitor of axis 5 

H0 Refer to the description for the axis 1 
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Offset 
address Name Default Description 

H2BA 
Synchronous master axis 
information monitor of 
axis 6 

HF Refer to the description for the axis 1 

H2BB 
Synchronous output 
function selection status 
monitor of axis 6 

H0 Refer to the description for the axis 1 

H2BC 
Synchronous master axis 
information monitor of 
(virtual) axis 7 

HF Refer to the description for the axis 1 

H2BD 
Synchronous output 
function selection status 
monitor of (virtual) axis 7 

H0 Refer to the description for the axis 1 

H2BE 
Synchronous master axis 
information monitor of 
(virtual) axis 8 

HF Refer to the description for the axis 1 

H2BF 
Synchronous output 
function selection status 
monitor of (virtual) axis 8 

H0 Refer to the description for the axis 1 

 

 System operation setting area 
Offset 
address Name Default Description 

H2C0 
-H388 Reserved for system － － 

H389 Deceleration stop 
operation K0 

Specify the operation when setting the deceleration stop request 
signal to "Active" (from OFF to ON). 
0: Deceleration stop 
When performing the repeat operation, stops after reaching E 
point that is targeted for the repeat operation. 
1: Pause 
・Performs the deceleration stop, and restarts the positioning 
operation when turning "Deceleration stop request signal" to 
OFF from ON. 

・Also, performs the same operation as the deceleration stop in 
all states except during the positioning operation. 
・When performing the repeat operation, stops after reaching E 
point that is targeted for the repeat operation, and restarts the 
positioning operation when turning "Deceleration stop request 
signal" to OFF from ON. 
・If a system stop or emergency stop is executed while the 
positioning unit is paused, the pause state will be canceled and 
the operation will not restart with the deceleration stop request 
signal is canceled (turned OFF). 

H38A 
-H38F Reserved for system － － 
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 AMP monitor & control area 
Offset 
address Name Default Description 

H390 AMP ID number K1 
Specify the target axis number (AMP ID no.) to monitor AMP 
parameters. 
Setting range: K1-K8 

H391 Control flag H0 

Specify the type code of the item to be monitored. (Note) 
The FP-XH M8N control unit executes the monitoring 
processing requested by the flag after detecting the change of 
this flag from H0 to Hxx. The unit changes the flag to H0 (no 
request) simultaneously with the completion of the processing. 

H392 Status H0 

Stores the processing state of the AMP monitor. The FP-XH 
M8N control unit changes this area to H1 simultaneously with 
the start of the processing. After that, it stores the processing 
result and change the control flag to H0. 
H0: No operation 
H1: Being processed 
H2: Normal end 
H3: Abnormal end 
H4: ID error (AMP ID no. unconnected) 
H5: Disabled (Network is disconnected, etc.) 

H393 Reserved for system － － 

H394 
Monitor data － Stores the monitoring result of the requested monitoring item. 

H395 

H396～ 
H39F Reserved for system － － 

(Note): For the type codes, refer to "17.14 AMP Monitoring Function". 
 



Specifications 

26-32 

 Pulse input setting area 
Offset 
address Name Default Setting range and description 

H3A0 Pulse input 
mode of CH1 H20 

Set the pulse input function. 
bit Name Description 

0 Rotation 
direction 

Set the rotation direction of pulse input. 
0: Forward 
1: Reverse  

1 － － 

3-2 Pulse input 
mode 

Set the input method of pulse input. 
Bit3 Bit2 
 0  0:  2-phase input 
 0  1:  Direction distinction input 
 1  0:  Individual input 
 1  1:  Reserved for system (When set, it will be 2-
phase input.) 

5-4 Input 
transfer 
multiple 

Set the multiple when setting the pulse input mode 
(Bit2-3) to "2-phase input". 
Bit5 Bit4 
 0  0: x1 (1 multiple)） 
 0  1: x2 (2 multiple) 
 1  0: x4 (4 multiple) 
 1  1: Reserved for system (When set, it will be 4 
multiple.) 

7-6 Pulse input 
purpose 

Specify the purpose of pulse input for each axis. 
・Pulsar: Connect a manual pulsar to the pulse input. 
・High-speed counter 
Bit7 Bit6 
 0  0: Pulsar 
 0  1: Reserved for system (When set, it will be 
pulsar.) 
 1  0: High-speed counter 
 1  1: Reserved for system (When set, it will be 
pulsar.) 

10-8 Pulse input 
time 
constant 

Set the time constant of each pulse input signal.The 
pulse inputs A and B of the same axis are the same 
input time constant.。 
Bit10 Bit9   Bit8 
 0   0        0 ：No input time constant 
 0   0        1: 0.1 µs 
 0   1        0: 0.5 µs 
 0   1        1: 1.0 µs 
 1   0        0: 2.0 µs 
 1   0        1: 10.0 µs 
 1   1        0: No input time constant 
 1   1        1: No input time constant 

15-11 － － 
 

H3A1 Pulse input 
mode of CH2 H20 

Refer to the description for the axis 1 H3A2 Pulse input 
mode of CH3 H20 

H3A3 Pulse input 
mode of CH4 H20 
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 Pulse count control area 
Offset 
address Name Default Description 

H3A8 Pulse count 
enable flag H0 

When the corresponding bit to each axis turns to 0, the count of pulse input 
will start. 
This flag is available only when setting the pulse input purpose to "High-
speed counter". 

bit Name Default Description 

0 Enable pulse count of CH1 0 

0: Count pulse input 

1: Not count pulse input 
1 Enable pulse count of CH2 0 

2 Enable pulse count of CH3 0 

3 Enable pulse output of CH4 0 

15-4 － － － 
 

H3A9 
Pulse count 
value change 
request flag 

H0 

When the corresponding bit to each axis changes to 1 from 0, the pulse 
input will be changed to the pulse count change value that the pulse input 
count value has been set. 
This flag is an edge trigger. Always change this flag to 1 from 0 before 
change. 

bit Name Default Description 

0 Change pulse count of CH1 0 0: Not change pulse 
count values. 

0→1: Change pulse count 
values. 

1 Change pulse count of CH2 0 

2 Change pulse count of CH3 0 

3 Change pulse count of CH4 0 

15-4 － － － 
 

H3AA 
～H3AF Reserved for system － 

H3B0 
H3B1 

Pulse input 
change value 
of CH1 

K0 

Set the pulse input values to be changed for each axis. 
Range: ‐2,147,483,628 to 2,147,483,627 

H3B2 
H3B3 

Pulse input 
change value 
of CH2 

K0 

H3B4 
H3B5 

Pulse input 
change value 
of CH3 

K0 

H3B6 
H3B7 

Pulse input 
change value 
of CH4 

K0 

 Pulse input monitor area 
Offset 
address Name Description 

H3C0 
H3C1 Pulse input value of CH1 

Stores the pulse input values (pulsar, counter) according to the pulse input 
purposes. The pulse input value is stored by integrating the pulse input 
values until changing the pulse input purpose or clearing the pulse input. 
Unit: Pulse 

H3C2 
H3C3 Pulse input value of CH2 

H3C4 
H3C5 Pulse input value of CH3 

H3C6 
H3C7 Pulse input value of CH4 
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26.4.3 Each Axis Information Area (Memory Area No. 1) 

Offset 
address Name Description 

H0-H7 
System ID 
(Brand name or vendor 
name) 

Stores the brand name or vendor name. 
It is stored as the ASCII code upt to 16 bytes (max. 16 characters). 

H8-HF System ID 
(Model code of AMP) 

Stores the model code of AMP. 
It is stored as the ASCII code upt to 16 bytes (max. 16 characters). 

H10-H17 System ID 
(Version of firmware) 

Stores the firmware version of AMP. 
It is stored as the ASCII code upt to 16 bytes (max. 16 characters). 

H18-H1F System ID 
(Model code of motor) 

Stores the model code of motor. 
It is stored as the ASCII code upt to 16 bytes (max. 16 characters). 

H20-H21 Phase of slave axis 

Stores the phase of slave axis after clutch control. 
In this area, the target axis is  set for the slave axis, and it is stored when 
using the electronic cam function. 
- The unit system of the master axis is used. For using phase information in 
percent, perform the following calculation. 
Phase (%) = Phase after clutch control / Master cycle of synchronous 
operation x 100 
- The phase of slave axis will be cleared at the following timing; 
- when the unit is activated. 
- when the slave axis setting is canceled. 
- when it is not in the synchronous state. 

H22-H23 Reserved for system － 

H24-H25 Advance angle 
correction amount 

Stores the advance angle correction amount. Stores values converted with 
the unit system (pulse, µm, inch, degree) selected for the master axis. 

H26-H2F Reserved for system － 

H30 Status display 

Stores the status of AMP. 
bit Name Default Description 

0 Imposition 0 

0: Deviation counter is outside of the 
imposition range. 

1: Deviation counter is in the 
imposition range. 

1 － － － 

2 Home return 
done 0 

0: Home return has not completed. 

1: Home return has completed. 

3 Torque limit 0 
0: Normal 

1: Contact detection (Torque limit) 

4 Warning 0 
0: Normal 

1: Warrning occurred 

5 Alarm 0 
0: Normal 

1: Alarm occurred 

6 Servo ready 0 
0: State that cannot shift to the servo-
on state. 

1: Servo ready 

7 Servo active 0 
0: Servo off 

1: Servo on 

15-8 － － － 
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Offset 
address Name Description 

H31 External terminal input 
monitor 

Stores the information of I/O connected to AMP. 

bit Name Default Description 

0 CWL 0 

0: Non active 

1: Active 

1 CCWL 0 

2 HOME (Proximity) 0 

3 EX-IN1 0 

4 EX-IN2 0 

5 EX-IN3 0 

6 EX-SON/EX-IN4 0 

7 EMG-STP 0 

15-8 － － － 
 

H32 Torque monitor 
Stores the torque monitor values. 
Range: 0-5000 
Unit: 0.1 % 

H33 Speed monitor 
Stores the actual speed monitor values. 
Unit: rpm 

H34-H35 Position deviation Stores the deviation between the current position managed in the control 
unit and the AMP current position fed back from the AMP. 

H38 Active or execution 
done table 

Stores the number of active positioning table or when the operation 
completed. 

H39 Auxiliary output code Stores the auxiliary output code. 

H3A Repeat count set value 

Stores the setting value of positioning repeat count. Stores 1 when no 
repeat operation is performed. Stores 255 when the repeat count is 
unlimited. 
Unit: Times 

H3B Repeat count current 
value 

Stores the repeat count during the operation. Stores 1 when no repeat 
operation is performed. Returns to "0" when the repeat count exceeds the 
upper limit. 
Unit: Times 

H3C-H3D Current value 

Stores the current value based on a mechanical origin in pulse units. 
It will be reset to "0" on the completion of home return. 
The value will not be updated when the current value update function is 
executed. 
Unit: pulse 

H3E-H3F Unit system conversion 
current value 

Stores the current value based on a electric origin (value set as home 
position coordinate). Values converted with the unit system (pulse, µm, 
inch, degree) selected in each axis setting area are stored. 
When the home return is completed, the value set as home position 
coordinate will be stored. When "0" is set as home position coordinate, it 
will be reset to "0". 
This area is also updated when the current value update function is used. 
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26.4.4 Each Axis Setting Area (Memory Area No. 2) 

 Positioning parameters of each axis 
Data in the following formats are stored from the starting address of positioning parameters of 
each axis. 

Offset 
address Name Default Setting range and description 

H0 Unit setting H0 

Sets the unit system of movement amounts of the positioning 
control for each axis. The same unit system should be set for all 
interpolation axes. 
H0: Pulse 
H100: µm (Min. position command 0.1 μm) 
H101: µm (Min. position command 1 μm) 
H200: inch (Min. position command 0.1 inch) 
H201: inch (Min. position command 1 inch) 
H300: degree (Min. position command 0.1 degree) 
H301: degree (Min. position command 1 degree) 
Any other settings will be errors. 

H1 Reserved for system － － 

H2-H3 Pulse number per 
rotation K1 

Sets the pulse number per rotation. It is necessary for the 
conversion of the pulse number in the settings of mm, inch and 
degree. 
Range: K1-K16,777,215 
Any other settings will be errors. 

H4-H5 Movement amount 
per rotation K1 

Set the movement amount per rotation. It is necessary for the 
conversion of the pulse number in the settings of mm, inch and 
degree. 
Range: K1-K16,777,215 
Any other settings will be errors. 
The ranges vary depending on the unit settings as below. 
µm: 1 μm 
inch: 1/10,000 inch 
degree: 1 degree 

H6 Reserved for system － － 
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Offset 
address Name Default Setting range and description 

HB 
Software limit 
enabled/disabled 
setting 

H0 

Enables or disables the software limit on each control. 
bit Name Default Description 

0 Enable/disable 
the software 
limit in the 
positioning 
control. 

0 0: Disables the software limit 
in positioning control 

1: Enables the software limit 
in positioning control 

1 Enable/disable 
the software 
limit in the 
home return 

0 0: Disables the software limit 
in home return. 

1: Enables the software limit 
in home return. 

2 Enable/disable 
the software 
limit in JOG 
operation 

0 0: Disables the software limit 
in JOG operation. 

1: Enables the software limit 
in JOG operation. 

15-3 － － － 
 

HC-HD Upper limit of 
software limit K2147482624 

Set the upper limit of the software limit for absolute coordinates. 
Range:‐2,147,482,624 to 2,147,482,624 

Any other settings will be errors.The ranges vary depending on 
the unit settings as below. 
pulse: ‐2,147,482,624 to 2,147,482,624 pulse 
μm (0.1 μm):‐214,748,262.4 to 214,748,262.4 μm 
μm (1 μm): ‐2,147,482,624 to 2,147,482,624 μm 
inch (0.00001 inch): ‐21,474.82624 to 21,474.82624 inch 
inch (0.0001 inch): ‐214,748.2624 to 214,748.2624 inch 
degree (0.1 degree): ‐214,748,262.4 to 214,748,262.4 degree 
degree (1 degree): ‐2,147,482,624 to 2,147,482,624 degree 

HE-HF Lower limit of 
software limit K-2147482624 

Set the lower limit of the software limit for absolute coordinates. 
Range: ‐2,147,482,624 to 2,147,482,624 

Any other settings will be errors.The ranges vary depending on 
the unit settings as below. 
pulse: ‐2,147,482,624 to 2,147,482,624 pulse 
μm (0.1 μm):‐214,748,262.4 to 214,748,262.4 μm 
μm (1 μm): ‐2,147,482,624 to 2,147,482,624 μm 
inch (0.00001 inch): ‐21,474.82624 to 21,474.82624 inch 
inch (0.0001 inch): ‐214,748.2624 to 214,748.2624 inch 
degree (0.1 degree): ‐214,748,262.4 to 214,748,262.4 degree 
degree (1 degree): ‐2,147,482,624 to 2,147,482,624 degree 

 



Specifications 

26-38 

 
Offset 
Address Name Default Setting range and description 

H10-H11 System reserved － － 

H12 Auxiliary output 
mode HA00 

Sets to enable/disable auxiliary output contacts and auxiliary output 
codes. The ON time of auxiliary output contacts is determined by the 
following auxiliary output ON time. 

bit Name Default Description 

7-0 Auxiliary output 
mode H0 

0000H: Disable auxiliary output 
function (auxiliary output 
contacts and auxiliary 
output codes). 

0001H: Use With mode 
0002H: Use Delay mode 

15-8 Auxiliary output 
ON time HA Setting range: 00H (0 ms) - FFH 

(255 ms) 
 

H13 Auxiliary output  
Delay ratio K0 

Sets the ratio of output in the Delay mode during auxiliary output. The 
setting range is 0 (%) -100 (%), if set to 50%, the auxiliary output will be 
executed when the position control movement exceeds 50%. 

H14 AMP operation 
setting H1 

Sets to enable/disable the limit input of AMP, or sets  the movement 
direction and limit connection method, etc. 
Note) This setting should be written to the EEPROM within the AMP, 
and the AMP should be restarted after changing the setting. 

bit Name Default Description 

0 Limit 
enabled/disabled 

0 0: Uses the input of limit signal. 

1: Ignores the input of limit signal. 

1 CW/CCW moving 
direction 

0 0: CW+/CCW- 

1: CCW+/CW- 

2 Limit connection 0 0: Standard connection (Forward: 
CWL, Reverse: CCWL) 

1: Reverse connection (Forward: 
CWL, Reverse: CCWL) 

15～3 － － － 
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Offset 
Address Name Default Setting range and description 

H1A 
-H1B Completion width K10 

Turns on the completion flag when the current value of the AMP 
becomes within this completion width after the movement of a 
specified amount during the positioning control, JOG operation.  
Setting range: 0 to 2,147,482,624 (Pulse) 

H1C Monitor value error 
setting － 

The judgement values for torque monitor values and execution speed 
of each axis can be set to announce errors or warnings. 

bit Name Default Description 

0 Torque judgment 
value enabled 0 

0: Disables the torque 
judgment value. 

1: Enables the torque 
judgment value. 

1 

Torque judgment 
value 
error/warning 
setting 

0 

0: Announces an error when it 
is enabled. 

1: Announces a warning when 
it is enabled. 

2 
Actual speed 
judgment value 
enabled 

0 

0: Disables the actual speed 
judgment value. 

1: Enables the actual speed 
judgment value. 

3 

Actual speed 
judgment value 
error/warning 
setting 

0 

0: Announces an error when it 
is enabled. 

1: Announces a warning when 
it is enabled. 

15-4 － － － 
 

H1D Torque judgement 
value K5000 

Set the limit of the torque. 
Setting range: 0-5000 (0.1%) 

H1E 
H1F 

Actual speed 
judgement value K5000 

Set the limit of the actual speed. 
Setting range: 0-5000 (rpm) 

 



Specifications 

26-40 

 
Offset 
Address Name Default Setting range and description 

H20 Home return setting 
code K0 

Set the pattern of home return. 
0: DOG method 1 
1: DOG method 2 
2: DOG method 3 
3: Limit method 1 
4: Limit method 2 
5: Z-phase method 
6: Stop-on-contact method 1 
7: Stop-on-contact method 2 
8: Data set 
Any other settings will be errors. 

H21 Home return 
direction K0 

Set the operation direction of home return. 
0: Elapsed value decreasing direction (Limit - direction) 
1: Elapsed value increasing direction (Limit "+" direction) 
Any other settings will be errors. 

H22 Home return 
acceleration time 

K100 

Set the acceleration/deceleration time when performing the home 
return. At the beginning of the home return, accelerates for the 
specified acceleration time, decelerates for the specified deceleration 
time after the proximity input and changes to the creep speed. 
Setting range: 0-10,000 (ms) 
Any other settings will be errors. 

H23 Home return 
deceleration time 

H24-H25 Home return target 
speed K1000 

Set the target speed when performing the home return. When there 
is no proximity input after starting the home return, accelerates to the 
target speed. 
Range: 1-2,147,482,624 
Any other settings will be errors. The ranges vary depending on the 
unit settings as below. 
pulse: 1-2,147,482,624 pps 
μm: 1-2,147,482,624 μm/s 
inch: 0.001-2,147,482.624 inch/s 
degree: 0.001-2,147,482.624 rev/s 

H26-H27 Home return creep 
speed K100 

Set the speed to search the home position after the proximity input. 
Set the value lower than the home return target speed. 
Range: 1-2,147,482,624 
Any other settings will be errors. The ranges vary depending on the 
unit settings as below. 
Pulse: 1-2,147,482,624 pps 
μm: 1-2,147,482,624 μm/s 
inch: 0.001-2,147,482.624 inch/s 
degree: 0.001-2,147,482.624 rev/s 
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Offset 
Address Name Default Setting range and description 

H29 JOG operation 
setting code H0 

Sets the mode of the JOG operation. 
bit Name Default Description 

0 － － － 

1 Acceleration/deceler
ation pattern setting 0 

0: Linear 
acceleration/deceleration 

1: S-shaped 
acceleration/deceleration 

15-2 － － － 
 

H2A JOG operation 
acceleration time 

K100 

Sets the acceleration/deceleration time when performing the JOG 
operation. At the beginning of the JOG operation, accelerates for the 
specified acceleration time, decelerates for specified deceleration time 
when the starting contact of the JOG operation turns off, and stops. 
Setting range: 0-10,000 (ms) 
Any other settings will be errors. 

H2B JOG operation 
deceleration time 

H2C-H2D JOG operation 
target speed K1000 

Set the target speed for performing the JOG operation. After starting 
the JOG operation, accelerates to the target speed while the starting 
contact of the JOG operation is on. After reaching the target speed, 
operates at the target speed. 
Range: 1-2,147,482,624 
Any other settings will be errors. The ranges vary depending on the 
unit settings as below. 
pulse: 1-2,147,482,624 pps 
μm: 1-2,147,482,624 μm/s 
inch: 0.001-2,147,482.624 inch/s 
degree: 0.001-2,147,482.624 rev/s 
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Offset 
Address Name Default Setting range and description 

H2E-H32 Reserved for 
system － － 

H33 Emergency stop 
deceleration time K100 

When the emergency stop is requested by I/O, it will be valid, and the 
deceleration operation will complete in this deceleration time. 
Setting range: 0-10,000 (ms) 
Any other settings will be errors. 

H34 Reserved for 
system － － 

H35 Limit stop 
deceleration time K100 

When the limit is input, the deceleration operation will complete in this 
deceleration time. 
Setting range: 0-10,000 (ms) 
Any other settings will be errors. 

H36 Reserved for 
system － － 

H37 Error stop 
deceleration time K100 

When an error occurs, it will be valid, and the deceleration operation 
will complete in this deceleration time. 
Setting range: 0-10,000 (ms) 
Any other settings will be errors. 

H38 Pulsar operation 
setting code K0 

Select the channels of the pulse input circuit that will be the input for 
the pulsar operation. 
0: Pulse input CH1 
1: Pulse input CH2 
2: Pulse input CH3 
3: Pulse input CH4 
Any other settings will be errors. 

H39 Pulsar operation 
ratio numerator K1 

Sets the multiplier for the input pulse string in the pulsar operation. 
(Number of command pulses) = (Pulse strings of input from pulsar) x 
(Numerator of ratio of pulsar operation) / (Denominator of ratio of 
pulsar operation). 
Retting range: K1-K32767 
Any other settings will be errors. 

H3A Pulsar operation 
ratio denominator K1 

Sets the divisor for the input pulse string in the pulsar operation. 
(Number of command pulses) = (Pulse strings of input from pulsar) x 
(Numerator of ratio of pulsar operation) / (Denominator of ratio of 
pulsar operation). 
Setting range: K1-K32767 
Any other settings will be errors. 

 



26.4 Positioning Memory 

 
26-43 

 
Offset 
Address Name Default Setting range and description 

H3B Pulsar operation 
method K0 

Sets the single and interpolation patterns for the positioning operation. 
0: Standard operation 
1: Speed limit (Pulse held) 
Speed limit (Round down) 
Any other settings will be errors. 

H3C Reserved for 
system － － 

H3D 
Home return stop-
on-cotnact torque 
value 

K100 

It is used when the stop-on-contact method 1 or 2 has been specified 
for the home return method. It is regarded as a criterion for judging the 
home return once the torque value of the AMP exceeded this set value 
by the stop-on-contact. 
 Setting range: 0-5000 (0.1%) 

H3E 
Home return stop-
on-contact 
judgment time 

K100 

It is used when the stop-on-contact method 1 or 2 has been specified 
for the home return method. 
It is regarded as a criterion for judging the home return once this set 
time has passed after the torque value of the AMP exceeded the 
“home return stop-on-contact torque value” by the stop-on-contact. 
Setting range: 0-10000 (ms) 

H3F-H40 Reserved for 
system － － 

H41 J-point control 
code H0 

Sets the control code for the J point control. 
bit Name Default Description 
0 － － － 

1 
Acceleration/ 
deceleration pattern 
setting 

0 

0: Linear 
acceleration/deceleration 
1: S-shaped 
acceleration/deceleration 

15-2 － － － 
 

H42 J-point 
acceleration time 

K100 

Sets the acceleration/deceleration time when performing the J-point 
control. 
Setting range: 0-10,000 (ms) 
Any other settings will be errors. 

H43 J-point 
deceleration time 

H44-H45 J-point target 
speed K1000 

Set the target speed when performing the J-point control. 
Setting range: 1-2,147,482,624 
Any other settings will be errors. The ranges vary depending on the 
unit settings as below. 
pulse: 1-2,147,482,624 pps 
μm: 1-2,147,482,624 μm/s 
inch: 0.001-2,147,482.624 inch/s 
degree: 0.001-2,147,482.624 rev/s 

H46-H47 Reserved for 
system － － 

H48-H49 Pulsar operation 
maximum speed K0 

The maximum speed when selecting the speed limit for the pulsar 
operation method. When the speed calculated by multiplying the pulsar 
input by (Pulsar operation numerator / Pulsar operation denominator) 
is over the specified maximum speed, the operation is performed at 
the maximum speed. 
Unit: Setting unit X1000/s 
Input range: 0-2,147,482,624 

H4A-H4B Coordinate origin － Stores coordinate origin after home return. 

H4C-H4 F Reserved for 
system － － 
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 Positioning data setting area 
For details of the starting addresses of each positioning table, refer to the list on page 26-46 
and after. 

Offset 
Address Name Default Setting range and description 

H0 Control code H0 

Sets the position setting mode and acceleration/deceleration pattern 
for the positioning operation. 

bit Name Default Description 

0 Increment/absolute 
setting H0 0: Increment mode 

1: Absolute mode 

1 Acceleration/deceler
ation pattern setting H0 

0: Linear 
acceleration/deceleration 
1: S-shaped 
acceleration/deceleration 

15-2 － － － 
 

H1 Operation pattern H0 

Sets the single and interpolation patterns for the positioning 
operation.The relation of the interpolation depends on the settings in 
the axis group setting area in the common area of the positioning unit 
memory. In the interpolation operation, the setting for the axis with the 
smallest number in an axis group is effective. 

bit Name Default Description 

7-0 Control 
pattern H0 

H0: E-point control (End point control) 
H1: P-point control (Pass point control) 
H2: C-point control (Continuance point 
control) 
H3: J-point control (Speed point control) 
Any other settings will be errors. 

15-8 
Inter-
polation 
setting 

H0 

H0: Linear interpolation (Composite 
speed) 
H1: Linear interpolation (Long axis speed) 
H10: Circular interpolation (Center 
point/CW direction) 
H11: Circular interpolation (Center 
point/CCW direction) 
H20: Circular interpolation (Pass point): 
H50: Spiral interpolation (Center point/CW 
direction/X-axis movemet) 
H51: Spiral interpolation (Center 
point/CCW direction/X-axis movemet) 
H52: Spiral interpolation (Center point/CW 
direction/Y-axis movemet) 
H53: Spiral interpolation (Center 
point/CCW direction/Y-axis movemet) 
H54: Spiral interpolation (Center point/CW 
direction/Z-axis movemet) 
H55: Spiral interpolation (Center 
point/CCW direction/Z-axis movemet) 
H60: Spiral interpolation (Pass point/X-
axis movement) 
H61: Spiral interpolation (Pass point/Y-
axis movement) 
H62: Spiral interpolation (Pass point/Z-
axis movement) 
Any other settings will be errors. 

 

H2-H3 Reserved for 
system － － 

H4 Positioning 
acceleration time 

K100 

Sets the acceleration and deceleration time for the positioning 
operation. The acceleration time and deceleration time can be set 
individually. In the interpolation operation, the setting for the axis with 
the smallest number in an axis group is effective. 
Setting range: 0-10,000 (ms) 
Any other settings will be errors. 

H5 Positioning 
deceleration time 
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Offset 
Address Name Default Setting range and description 

H6-H7 

Positioning target 
speed 
(Interpolation 
speed) 

K1000 

In case of the individual operation (no interpolation), it is the target 
speed of the corresponding axis. In case of the interpolation operation, 
it is the target speed of the interpolation. In the interpolation operation, 
the setting for the axis with the smallest number in an axis group is 
effective. 
Range: 1-2,147,482,624 
Any other settings will be errors. The ranges vary depending on the 
unit settings as below. 
pulse: 1-2,147,482,624 pps 
μm: 1-2,147,482,624 μm/s 
inch: 0.001-2,147,482.624 inch/s 
degree: 0.001-2,147,482.624 rev/s 

H8-H9 
Positioning 
movement 
amount 

K0 

Sets the movement amount for the positioning operation. The 
interpretation changes between the increment movement amount and 
absolute coordinate depending on the control code setting. 
Range: -2,147,482,624-2,147,482,624 
Any other settings will be errors. The ranges vary depending on the 
unit settings as below. 
pulse: ‐2,147,482,624-2,147,482,624 pulse 
μm (0.1 μm):‐214,748,262.4-214,748,262.4 μm 
μm (1 μm): ‐2,147,482,624-2,147,482,624 μm 
inch (0.00001 inch): ‐21,474.82624-21,474.82624 inch 
inch (0.0001 inch): ‐214,748.2624-214,748.2624 inch 
degree (0.1 degree): ‐214,748,262.4-214,748,262.4 degree 
degree (1 degree): ‐2,147,482,624-2,147,482,624 degree 

HA-HB Auxiliary point K0 

Sets the auxiliary points (center point, pass point coordinates) in case 
of the circular interpolation or spiral interpolation control. 
Range: -2,147,482,624-2,147,482,624 
Any other settings will be errors. The ranges vary depending on the 
unit settings as below. 
pulse: ‐2,147,482,624-2,147,482,624 pulse 
μm (0.1 μm):‐214,748,262.4-214,748,262.4 μm 
μm (1 μm): ‐2,147,482,624-2,147,482,624 μm 
inch (0.00001 inch): ‐21,474.82624-21,474.82624 inch 
inch (0.0001 inch): ‐214,748.2624-214,748.2624 inch 
degree (0.1 degree): ‐214,748,262.4-214,748,262.4 degree 
degree (1 degree): ‐2,147,482,624-2,147,482,624 degree 

HC Dwell time K0 

After the completion of the positioning control of this table, when the 
mode is C: Continuation point, stops the motor operation for the dwell 
time and starts the operation of the next table. When the mode is P: 
Pass point, this setting is ignored. When the mode is E: End point, the 
operation done flag will turn on after waiting for the dwell time. 
Setting range: 0-32,767 (ms) 
Any other settings will be errors. 

HD Auxiliary output 
code K0 

Sets the data to be output to the auxiliary output code in each axis 
information & monitor area by the setting of the auxiliary output mode 
in the parameter setting area. 

HE-HF Reserved for 
system － － 

KEY POINTS
 

• The positioning memory address allocated to each item of the positioning 
table comprises the address allocated to each axis and each table and the 
offset address. 
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 Starting addresses of positioning tables (Standard tables 1 to 200) 
Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

1 H50 41 H2D0 81 H550 121 H7D0 161 HA50 
2 H60 42 H2E0 82 H560 122 H7E0 162 HA60 
3 H70 43 H2F0 83 H570 123 H7F0 163 HA70 
4 H80 44 H300 84 H580 124 H800 164 HA80 
5 H90 45 H310 85 H590 125 H810 165 HA90 
6 HA0 46 H320 86 H5A0 126 H820 166 HAA0 
7 HB0 47 H330 87 H5B0 127 H830 167 HAB0 
8 HC0 48 H340 88 H5C0 128 H840 168 HAC0 
9 HD0 49 H350 89 H5D0 129 H850 169 HAD0 
10 HE0 50 H360 90 H5E0 130 H860 170 HAE0 
11 HF0 51 H370 91 H5F0 131 H870 171 HAF0 
12 H100 52 H380 92 H600 132 H880 172 HB00 
13 H110 53 H390 93 H610 133 H890 173 HB10 
14 H120 54 H3A0 94 H620 134 H8A0 174 HB20 
15 H130 55 H3B0 95 H630 135 H8B0 175 HB30 
16 H140 56 H3C0 96 H640 136 H8C0 176 HB40 
17 H150 57 H3D0 97 H650 137 H8D0 177 HB50 
18 H160 58 H3E0 98 H660 138 H8E0 178 HB60 
19 H170 59 H3F0 99 H670 139 H8F0 179 HB70 
20 H180 60 H400 100 H680 140 H900 180 HB80 
21 H190 61 H410 101 H690 141 H910 181 HB90 
22 H1A0 62 H420 102 H6A0 142 H920 182 HBA0 
23 H1B0 63 H430 103 H6B0 143 H930 183 HBB0 
24 H1C0 64 H440 104 H6C0 144 H940 184 HBC0 
25 H1D0 65 H450 105 H6D0 145 H950 185 HBD0 
26 H1E0 66 H460 106 H6E0 146 H960 186 HBE0 
27 H1F0 67 H470 107 H6F0 147 H970 187 HBF0 
28 H200 68 H480 108 H700 148 H980 188 HC00 
29 H210 69 H490 109 H710 149 H990 189 HC10 
30 H220 70 H4A0 110 H720 150 H9A0 190 HC20 
31 H230 71 H4B0 111 H730 151 H9B0 191 HC30 
32 H240 72 H4C0 112 H740 152 H9C0 192 HC40 
33 H250 73 H4D0 113 H750 153 H9D0 193 HC50 
34 H260 74 H4E0 114 H760 154 H9E0 194 HC60 
35 H270 75 H4F0 115 H770 155 H9F0 195 HC70 
36 H280 76 H500 116 H780 156 HA00 196 HC80 
37 H290 77 H510 117 H790 157 HA10 197 HC90 
38 H2A0 78 H520 118 H7A0 158 HA20 198 HCA0 
39 H2B0 79 H530 119 H7B0 159 HA30 199 HCB0 
40 H2C0 80 H540 120 H7C0 160 HA40 200 HCC0 
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 Starting addresses of positioning tables (Standard tables 201 to 400) 
Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

201 HCD0 241 HF50 281 H11D0 321 H1450 361 H16D0 
202 HCE0 242 HF60 282 H11E0 322 H1460 362 H16E0 
203 HCF0 243 HF70 283 H11F0 323 H1470 363 H16F0 
204 HD00 244 HF80 284 H1200 324 H1480 364 H1700 
205 HD10 245 HF90 285 H1210 325 H1490 365 H1710 
206 HD20 246 HFA0 286 H1220 326 H14A0 366 H1720 
207 HD30 247 HFB0 287 H1230 327 H14B0 367 H1730 
208 HD40 248 HFC0 288 H1240 328 H14C0 368 H1740 
209 HD50 249 HFD0 289 H1250 329 H14D0 369 H1750 
210 HD60 250 HFE0 290 H1260 330 H14E0 370 H1760 
211 HD70 251 HFF0 291 H1270 331 H14F0 371 H1770 
212 HD80 252 H1000 292 H1280 332 H1500 372 H1780 
213 HD90 253 H1010 293 H1290 333 H1510 373 H1790 
214 HDA0 254 H1020 294 H12A0 334 H1520 374 H17A0 
215 HDB0 255 H1030 295 H12B0 335 H1530 375 H17B0 
216 HDC0 256 H1040 296 H12C0 336 H1540 376 H17C0 
217 HDD0 257 H1050 297 H12D0 337 H1550 377 H17D0 
218 HDE0 258 H1060 298 H12E0 338 H1560 378 H17E0 
219 HDF0 259 H1070 299 H12F0 339 H1570 379 H17F0 
220 HE00 260 H1080 300 H1300 340 H1580 380 H1800 
221 HE10 261 H1090 301 H1310 341 H1590 381 H1810 
222 HE20 262 H10A0 302 H1320 342 H15A0 382 H1820 
223 HE30 263 H10B0 303 H1330 343 H15B0 383 H1830 
224 HE40 264 H10C0 304 H1340 344 H15C0 384 H1840 
225 HE50 265 H10D0 305 H1350 345 H15D0 385 H1850 
226 HE60 266 H10E0 306 H1360 346 H15E0 386 H1860 
227 HE70 267 H10F0 307 H1370 347 H15F0 387 H1870 
228 HE80 268 H1100 308 H1380 348 H1600 388 H1880 
229 HE90 269 H1110 309 H1390 349 H1610 389 H1890 
230 HEA0 270 H1120 310 H13A0 350 H1620 390 H18A0 
231 HEB0 271 H1130 311 H13B0 351 H1630 391 H18B0 
232 HEC0 272 H1140 312 H13C0 352 H1640 392 H18C0 
233 HED0 273 H1150 313 H13D0 353 H1650 393 H18D0 
234 HEE0 274 H1160 314 H13E0 354 H1660 394 H18E0 
235 HEF0 275 H1170 315 H13F0 355 H1670 395 H18F0 
236 HF00 276 H1180 316 H1400 356 H1680 396 H1900 
237 HF10 277 H1190 317 H1410 357 H1690 397 H1910 
238 HF20 278 H11A0 318 H1420 358 H16A0 398 H1920 
239 HF30 279 H11B0 319 H1430 359 H16B0 399 H1930 
240 HF40 280 H11C0 320 H1440 360 H16C0 400 H1940 
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 Starting addresses of positioning tables (Standard tables 401 to 600) 
Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

401 H1950 441 H1BD0 481 H1E50 521 H20D0 561 H2350 
402 H1960 442 H1BE0 482 H1E60 522 H20E0 562 H2360 
403 H1970 443 H1BF0 483 H1E70 523 H20F0 563 H2370 
404 H1980 444 H1C00 484 H1E80 524 H2100 564 H2380 
405 H1990 445 H1C10 485 H1E90 525 H2110 565 H2390 
406 H19A0 446 H1C20 486 H1EA0 526 H2120 566 H23A0 
407 H19B0 447 H1C30 487 H1EB0 527 H2130 567 H23B0 
408 H19C0 448 H1C40 488 H1EC0 528 H2140 568 H23C0 
409 H19D0 449 H1C50 489 H1ED0 529 H2150 569 H23D0 
410 H19E0 450 H1C60 490 H1EE0 530 H2160 570 H23E0 
411 H19F0 451 H1C70 491 H1EF0 531 H2170 571 H23F0 
412 H1A00 452 H1C80 492 H1F00 532 H2180 572 H2400 
413 H1A10 453 H1C90 493 H1F10 533 H2190 573 H2410 
414 H1A20 454 H1CA0 494 H1F20 534 H21A0 574 H2420 
415 H1A30 455 H1CB0 495 H1F30 535 H21B0 575 H2430 
416 H1A40 456 H1CC0 496 H1F40 536 H21C0 576 H2440 
417 H1A50 457 H1CD0 497 H1F50 537 H21D0 577 H2450 
418 H1A60 458 H1CE0 498 H1F60 538 H21E0 578 H2460 
419 H1A70 459 H1CF0 499 H1F70 539 H21F0 579 H2470 
420 H1A80 460 H1D00 500 H1F80 540 H2200 580 H2480 
421 H1A90 461 H1D10 501 H1F90 541 H2210 581 H2490 
422 H1AA0 462 H1D20 502 H1FA0 542 H2220 582 H24A0 
423 H1AB0 463 H1D30 503 H1FB0 543 H2230 583 H24B0 
424 H1AC0 464 H1D40 504 H1FC0 544 H2240 584 H24C0 
425 H1AD0 465 H1D50 505 H1FD0 545 H2250 585 H24D0 
426 H1AE0 466 H1D60 506 H1FE0 546 H2260 586 H24E0 
427 H1AF0 467 H1D70 507 H1FF0 547 H2270 587 H24F0 
428 H1B00 468 H1D80 508 H2000 548 H2280 588 H2500 
429 H1B10 469 H1D90 509 H2010 549 H2290 589 H2510 
430 H1B20 470 H1DA0 510 H2020 550 H22A0 590 H2520 
431 H1B30 471 H1DB0 511 H2030 551 H22B0 591 H2530 
432 H1B40 472 H1DC0 512 H2040 552 H22C0 592 H2540 
433 H1B50 473 H1DD0 513 H2050 553 H22D0 593 H2550 
434 H1B60 474 H1DE0 514 H2060 554 H22E0 594 H2560 
435 H1B70 475 H1DF0 515 H2070 555 H22F0 595 H2570 
436 H1B80 476 H1E00 516 H2080 556 H2300 596 H2580 
437 H1B90 477 H1E10 517 H2090 557 H2310 597 H2590 
438 H1BA0 478 H1E20 518 H20A0 558 H2320 598 H25A0 
439 H1BB0 479 H1E30 519 H20B0 559 H2330 599 H25B0 
440 H1BC0 480 H1E40 520 H20C0 560 H2340 600 H25C0 
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 Starting addresses of positioning tables (Expansion tables 10001 to 10089) 
Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

Table 
no. 

Starting 
address 

10001 H2670 10021 H27B0 10041 H28F0 10061 H2A30 10081 H2B70 
10002 H2680 10022 H27C0 10042 H2900 10062 H2A40 10082 H2B80 
10003 H2690 10023 H27D0 10043 H2910 10063 H2A50 10083 H2B90 
10004 H26A0 10024 H27E0 10044 H2920 10064 H2A60 10084 H2BA0 
10005 H26B0 10025 H27F0 10045 H2930 10065 H2A70 10085 H2BB0 
10006 H26C0 10026 H2800 10046 H2940 10066 H2A80 10086 H2BC0 
10007 H26D0 10027 H2810 10047 H2950 10067 H2A90 10087 H2BD0 
10008 H26E0 10028 H2820 1048 H2960 10068 H2AA0 10088 H2BE0 
10009 H26F0 10029 H2830 10049 H2970 10069 H2AB0 10089 H2BF0 
10010 H2700 10030 H2840 10050 H2980 10070 H2AC0   
10011 H2710 10031 H2850 10051 H2990 10071 H2AD0   
10012 H2720 10032 H2860 10052 H29A0 10072 H2AE0   
10013 H2730 10033 H2870 10053 H29B0 10073 H2AF0   
10014 H2740 10034 H2880 10054 H29C0 10074 H2B00   
10015 H2750 10035 H2890 10055 H29D0 10075 H2B10   
10016 H2760 10036 H28A0 10056 H29E0 10076 H2B20   
10017 H2770 10037 H28B0 10057 H29F0 10077 H2B30   
10018 H2780 10038 H28C0 10058 H2A00 10078 H2B40   
10019 H2790 10039 H28D0 10059 H2A10 10079 H2B50   
10020 H27A0 10040 H28E0 10060 H2A20 10080 H2B60   
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26.4.5 Cam Pattern Editing Area (Memory Area No. 3) 

 Cam pattern setting area 
Offset 
address Name Default Description 

H0 Cam pattern no. K0 

When reading: Set a cam pattern number to be read out. When 
rewriting: Set a cam pattern number to be rewritten. The setting 
range varies depending on resolutions. 
Pattern resolution Settable range 
1024, 2048, 4096, 8192 K1-K16 
16384 K1- K8 
32768 K1-K4 

 

H1 Reserved for 
system － － 

H2 
No. of cam 
pattern setting 
sections  

K0 

When reading, stores the number of setting sections of the read 
cam pattern table. When rewriting, stores the number of setting 
sections of the rewritten cam pattern table. 
Setting range: K1-K20 

H3 Shift amount K0 

When reading, stores the shift amount of the read cam pattern 
table. When rewriting, stores the shift amount of the rewritten 
cam pattern table. 
Setting range: K0-K10000 x (0.01%) 

H4 Start phase of 
section 1 K0 

・When reading, stores the start phase in the section 1 of the 
read cam pattern table. The read value is always 0. 
・When rewriting, stores the start phase in the section 1 of the 
rewritten cam pattern table. When any value other than 0 is set 
in the section 1, it cannot be rewritten correctly. 
Setting range: (Decimal) 0-10000 (x0.01%) 
When reading, stores it truncating the numbers beyond the 
third decimal point. When writing, regsiters it after calculating 
the numbers beyond the third decimal point by the unit. 

H5 Displacement of 
section 1 K0 

・When reading, stores the displacement in the section 1 of the 
read cam pattern table. 

・When rewriting, stores the displacement in the section 1 of the 
rewritten cam pattern table. 
Setting range: (Decimal): -10000-10000 (x0.01%) 
When reading, stores it truncating the numbers beyond the 
thrid decimal point. When writing, stores it filling the numbers 
beyond the third decimal point with 0. 
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Offset 
address Name Default Description 

H6 Cam pattern of 
section 1 K0 

When reading, stores the cam pattern number of the read cam 
pattern table. When rewriting, sets the cam pattern number of 
the rewritten cam pattern table. 

Set 
value 

Cam pattern 
name 

Set 
value Cam pattern name 

K10 Constant speed K43 One-dwell cycloid m=1 

K11 
Constant 
acceleration K44 One-dwell cycloidl 

m=2/3 

K12 
Simple harmonic 
motion K45 One-dwell modified 

trapezoid m=1 

K22 Cycloid K46 One-dwell modified 
trapezoid (Ferguson) 

K25 
Modified 
trapezoid K47 One-dwell modified 

trapezoid m=2/3 
K26 Modified sine K48 One-dwell modified sine 

K27 
Modified uniform 
velocity K49 One-dwell trapecloid 

K33 
Asymmetric 
cycloid K51 No-dwell modified 

trapezoid 

K34 
Asymmetric 
modified 
trapezoid 

K52 No-dwell modified 
uniform velocity 

K35 Trapecloid K92 NC2 curve 
 

H7 Reserved for 
system － － 

H8-HB Area for section 2 － 

Just like the area for the section 1, one word each is allocated 
to the start phase, displacement, cam pattern and the system 
area. 

 Start 
phase in 
section 

Displace
ment in 
section 

Cam 
pattern in 
section 

Reserved 
for 
system 

The end of 
offset 
address 

Hx0 Hx1 Hx2 Hx3 

Hx4 Hx5 Hx6 Hx7 

Hx8 Hx9 HxA HxB 

HxC HxD HxE HxF 
 

HC-HF Area for section 3 － 

H10-H13 Area for section 4 － 

H14-H17 Area for section 5 － 

H18-H1B Area for section 6 － 

H1C-H1F Area for section 7 － 

H20-H23 Area for section 8 － 

H24-H27 Area for section 9 － 

H28-H2B Area for section 10 － 

H2C-H2F Area for section 11 － 

H30-H33 Area for section 12 － 

H34-H37 Area for section 13 － 

H38-H3B Area for section 14 － 

H3C-H3F Area for section 15 － 

H40-H43 Area for section 16 － 

H44-H47 Area for section 17 － 

H48-H4B Area for section 18 － 

H4C-H4F Area for section 19 － 

H50-H53 Area for section 20 － 

H54-H57 Reserved for 
system －  
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 Cam pattern reading/rewriting execution confirmation area 
Offset 
address Name Default Description 

H58 Cam pattern reading 
result H0 

Stores the result of reading processing (response code).  
H0: Normal end 
Other than H0: Abnormal end 

H59 Cam pattern rewriting 
result H0 

Stores the result of rewriting processing (response code). 。 

H0: Normal end 
Other than H0: Abnormal end 

(Note): In the case of abnormal end, the codes in the following table are stored. 
A: Available, -: Not available 

Code Name Description 
Object 

Countermeasures 
Read Write 

H FF01 Cam pattern number 
setting error 

The set value of the 
cam pattern number 
is out of the settable 
range. 

A A Check the set value of the 
cam pattern number. 

H FF02 
Number of cam 
pattern setting 
sections setting error 

The set number of 
cam pattern setting 
sections is out of the 
settable range. 

- A Check the set number of 
setting sections. 

H FF03 Shift amount setting 
error 

The set shift amount 
is out of the settable 
range. 

- A Check the set value of the 
shift amount. 

H FF05 Start phase setting 
error 1 

The set start phase is 
out of the settable 
range. 

- A Check the set value of the 
start phase in each section. 

H FF06 Start phase setting 
error 2 

The set start phase is 
the same as or 
smaller than the start 
phase of the previous 
section. 

- A 

Check if the relation between 
the start phases of each 
section is (Start phase of 
section n-1) < (Start phase of 
section n). 

H FF07 Start phase setting 
error 3 

The set start phase of 
the section 1 is not 0. - A Always set the start phase of 

the section 1 to 0. 

H FF0A Displacement setting 
error 

The set value of the 
displacement is out of 
the settable range. 

- A Check the set value of the 
phase in each section. 

H FF0B Cam pattern number 
setting error 

The set cam pattern 
number is out of the 
settable range. 

- A 
Check the set value of the 
cam pattern number in each 
section. 

H FF10 Cam pattern reading 
not executable error 1 

An axis in 
synchronous 
operation exists. 

A - 
Cancel the synchronous 
operation and execute the 
reading. 

H FF11 Cam pattern reading 
not executable error 2 

An operating axis 
exists. A - Execute the reading when no 

operating axis exists. 

H FF20 Cam pattern rewriting 
not executable error 1 

An axis in 
synchronous 
operation exists. 

- A 
Cancel the synchronous 
operation and execute the 
rewriting. 

H FF21 Cam pattern rewriting 
not executable error 2 

An operating axis 
exists. - A Execute the rewriting when 

no operating axis exists. 

H FF22 Cam pattern rewriting 
not executable error 3 

The reading request 
and rewriting request 
turned on 
simultaneously. 

- A 

Check if the reading request 
and rewriting request do not 
turn on simultaneously. 
When the reading request 
and rewriting request turn on 
simultaneously, the reading 
request takes priority. 
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Unit 
memory 
No. (Hex) 

Name Default Description 

H5A Cam pattern 
update flag HFFFF 

Announces the valid cam pattern table data.  
Bits are allocated to the cam pattern numbers 1 to 15. 
All the bits of bit0 to bit15 turn to "1" when the mode of the 
unit changes to the RUN mode and the configuration data 
set by the tool software becomes valid. When a cam pattern 
is rewritten by a user program, the bit of a corresponding 
cam pattern number turns to "0". 
(*) Do not rewrite this area. If rewritten, the condition cannot 
be announced properly. 
bit no. Name Default Description 
0 Cam pattern No.1 valid 

condition 
1 0: Cam pattern 

table after 
rewriting by 
user program is 
valid. 

1: Configuration 
data by tool 
software is 
valid. 

1 Cam pattern No.2 valid 
condition 

1 

2 Cam pattern No.3 valid 
condition 

1 

3 Cam pattern No.4 valid 
condition 

1 

4 Cam pattern No.5 valid 
condition 

1 

5 Cam pattern No.6 valid 
condition 

1 

6 Cam pattern No.7 valid 
condition 

1 

7 Cam pattern No.8 valid 
condition 

1 

8 Cam pattern No.9 valid 
condition 

1 

9 Cam pattern No.10 valid 
condition 

1 

10 Cam pattern No.11 valid 
condition 

1 

11 Cam pattern No.12 valid 
condition 

1 

12 Cam pattern No.13 valid 
condition 

1 

13 Cam pattern No.14 valid 
condition 

1 

14 Cam pattern No.15 valid 
condition 

1 

15 Cam pattern No.16 valid 
condition 

1 
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26.4.6 Synchronous Control Area (Memory Area No. 4) 

 Synchronous control common setting area 
Offset 
address Name Default Description 

H0 

Synchronous 
master axis 
selection of each 
axis 

H0 

Set the master axis for each axis. 
Set value Master axis 
H0 No synchronous master axis or the setting target axis 

is the master axis. 
H1 Axis 1 
H2 Axis 2 
H3 Axis 3 
H4 Axis 4 
H5 Axis 5 
H6 Axis 6 
H7 Axis 7 (virtual) 
H8 Axis 8 (virtual) 
H21 Pulse input 1 
H22 Pulse input 2 
H23 Pulse input 3 
H24 Pulse input 4 

 

H1 

Synchronous 
output function 
selection of each 
axis 

H0 

Stores the status of the synchronous operation function set for 
the axes. 
bit Function Setting 
0 Electronic gear operation settings 0: Not use 

1: Use 1 Clutch operation setting 
2 Electronic operation setting 
3 Advance angle correction 

synchronous setting 
15-4 Reserved area for the system 

 

H2 

Synchronous 
slave single 
deceleration stop 
deceleration 
method of each 
axis 

H0 

Set the deceleration method when performing the deceleration 
stop during the synchronous operation. 

bit Name Default Description 
0 Not used   
1 Deceleration 

method 
H0 0: Linear 

1: S-shaped 
15-2 Reserved area 

for the system 
－ － 

 

H3 

Synchronous 
slave single 
deceleration stop 
deceleration time 
of each axis 

H0 

Set the deceleration time when performing the deceleration 
stop during the synchronous operation. 
Setting range: 0-10,000 (ms) 
Any other settings will be errors. 

H4-HF Reserved for 
system － － 

 Electronic gear setting area 
Offset 

Address Name Initial 
value Description 

H10-H11 
Gear ratio 
numerator of each 
axis 

K1 K1-K 2147483647 

H12-H13 
Gear ratio 
denominator of 
each axis 

K1 K1-K2147483647 

H14 Gear ratio change 
time of each axis K1 K1-K10000 

H15-H1F Reserved for 
system － － 
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 Clutch setting area 
Offset 
address Name Default Description 

H20 Clutch ON trigger type H0 H0: I/O clutch ON request 

H21 Clutch ON edge 
selection H0 

Set the valid condition of trigger signals. 
H0: Level 
H1: Leading edge 
H2: Trailing edge 

H22-H27 Reserved for system － － 

H28 Clutch OFF trigger type H00 H00: I/O clutch OFF request 
H11: I/O + Phase after clutch control clutch OFF 

H29 Clutch OFF edge 
selection H0 

Set the valid condition of trigger signals. 
H0: Level 
H1: Leading edge 
H2: Trailing edge 
When selecting "H0: Level" for the clutch ON edge 
selection (offset address H21), set "H0: Level" in this area 
(offset address H29). 

H2A Clutch OFF phase ratio H0 

Set the ratio for the phase at which the clutch turns OFF 
when selecting "I/O + Phase after clutch control" for the 
clutch off trigger type. 
Setting range: 0-99 (%) 

H2B-H2F Reserved for system   

H30 Clutch ON method H0 H0: Direct 
H1: Slip 

H31 Reserved for system － － 

H32 Clutch ON slip method H0 H0: Slip time setting 
H33 Clutch ON slip time K1 1-10000 ms 

H34-H35 Reserved for system － － 

H36 Clutch ON slip curve 
selection H0 H0: Linear 

H37-H3F Reserved for system － － 

H40 Clutch OFF method H0 H0: Direct 
H1: Slip 

H41 Reserved for system － － 

H42 Clutch OFF slip method H0 H0: Slip time setting 

H43 Clutch OFF slip time K1 1-10000 ms 

H44-H45 Reserved for system － － 

H46 Clutch OFF slip curve 
selection H0 H0: Linear 

H47-H4F Reserved for system － － 
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 Electronic cam setting area 
Offset 
address Name Default Description 

H50-H51 
Cam control 
synchronous master 
axis cycle 

K1 Set the cam control synchronous master cycle. 
K1 -K 2147483647 

H52 Reserved for system － － 

H53 Used cam pattern 
number K1 

Set the registered cam pattern number to be used. 
1 - (16) 
The upper limit of the usable cam pattern numbers 
depends on the resolution. 

H54-H55 Cam stroke amount 1 Set the upper limit of displacement for cam control. 
K1 - K2147483647 

H56-H57 
Advance angle 
correction reference 
amount 

0 

Set the correction reference amount for calculating the 
advance angle correction amount when using the advance 
angle correction function. 
Setting range: K-2,147,482,624-K2,147,482,624 
The unit follows the unit system of the master axis. 
pulse: -2,147,482,624-2,147,482,624 pulse 
µm (0.1 µm): -214,748,262.4-214,748,262.4  µm 
µm (1 µm): -2,147,482,624-2,147,482,624µm 
inch (0.00001 inch): -21,474.82624-21,474.82624 inch 
inch (0.0001 inch): -214,748.2624-214,748.2624 inch 
degree (0.1 degree): -214,748,262.4-214,748,262.4degree 
degree (1 degree): -2,147,482,624-2,147,482,624 degree 

H58-H59 
Advance angle 
correction reference 
speed 

100 

Set the reference speed for calculating the advance angle 
correction amount when using the advance angle 
correction function. 
Setting range: 1-2,147,482,624 (Specified unit system) 
The unit follows the unit system of the master axis. 
pulse: 1-2,147,482,624 pps 
μm: 1-2,147,482,624 μm/s 
inch: 0.001-2,147,482.624 inch/s 
degree: 0.001-2,147,482.624 rev/s 

H5A 
Advance angle 
correction parameter 
change time 

100 

Set the time required until a changed value is reflected 
when the parameter related to advance angle correction 
(advance angle correction reference speed or advance 
angle correction reference amount) is changed during the 
electronic cam operation. 
 Setting range: 1-10000ms 

H5B-H6F Reserved for system － － 
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26.4.7 Positioning Operation Change Setting Area (Memory Area No. 5) 

Offset 
address Name Default Description 

H0 

Positioning speed 
change 
Ratio 
specification(Override) 

K100 

Area for setting the change ratio (override) to the command 
speed for the positioning speed change. The speed 
change request by I/O is not necessary, and the change 
becomes valid when the set value (ratio) is set. 
Setting range: 1-300 (%) 

H1 
Positioning speed 
change 
Change mode selection 

H0 

Area for setting the range of the positioning speed change. 
0000H: Active table only 
0001H: Active table to E point table (until the completion of 
the operation) 
In the case of other values, the unit operates as the setting 
of 0000H (Active table only). 

H2-H3 
Positioning speed 
change 
Change speed 

K100 

Area for setting a change speed for changing the 
positioning speed. Set using unit system conversion 
values. 
Setting range: 1-2,147,482,624 (Specified unit system) 

H4-H9 Reserved for system － － 

HA-HB 

Positioning movement 
amount change 
Change movement 
amount 

K0 

Area for setting a change movement amount for changing 
the positioning movement amount. Set using unit system 
conversion values. 
Setting range: K-2,147,482,624-K2,147,482,624 

HC-HF Reserved for system － － 
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26.4.8 AMP Parameter Control Area (Memory Area No. 6) 

Offset 
address Name Default Description 

H0 AMP ID number K1 
Specify the target axis number (AMP ID no.) to perform each 
operation such as changing parameters. 
Setting range: K1-K8 

H1 Control flag H0 

Specify the process of AMP parameters.This area will be set 
to 0H when the FP-X M8N Control Unit completes the 
processing. 
Setting range: K0-K6 
H0: No request 
H2: Read request 
H4: Write request 
H5: EEPROM request 
H6: AMP reset request 

H2 Status H0 

Stores the processing state of AMP parameters. 
H0: No operation 
H1: Being processed 
H2: Normal end (Read / Write / EEPROM / Reset) 
H3: Abnormal end (Read / Write / EEPROM / Reset) 
H4: ID error 
H5: Parameter error 
H6: Request execution disabled 

H3 Parameter classification K0 

Specify the classification codes of the parameters for 
read/write. 
Setting range: K0-K8 
No writing is required in this area when executing EEPROM 
write or AMP reset. 

H24 Individual parameter no. H0 

Specify the parameter numbers for read/write. 
Setting range: H0-H7F 
Specify the parameter numbers in the classification code. 
No writing is required in this area when executing EEPROM 
write or AMP reset. 

H26-H27 Parameter data K0 
Stores the data of parameters. 
When reading: Stores the parameter values of AMP. 
When writing: Stores the parameter values to be updated. 
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26.5 Table of System Registers 
 No. Name Default Sets value range and description 

M
em

ory 
allocation 

0 Sequence program area size 32 24, 32, 40 K words (note 1) 

H
old / N

on-hold 

4 Leading edge differential during MC 
holds the previous value Hold Hold / non-hold 

5 Counter starting address 1008 0 - 1024 

6 Hold type area staring address for 
timer/counter 1008 0 - 1024 

7 Hold type area staring address for 
internal relay 504 0 - 512 

8 
Hold type area staring address for 
data registers 
(Note 2) 

11970, 
32450, 
65218 

0-12285 
0-32765 
0-65533 

10 
Hold type area staring address 
setting for link relays for PLC link 
W0-0 

64 0 - 64 

11 
Hold type area staring address 
setting for link relays for PLC link 
W0-1 

128 64 - 128 

12 
Hold type area staring address 
setting for link data registers for PLC 
link W0-0 

128 0 - 128 

13 
Hold type area staring address 
setting for link data registers for PLC 
link W0-1 

256 128 - 256 

14 Selection of hold / non-hold in the 
step ladder diagram program Non-hold Hold / non-hold 

Action on error 
20 Selection of dual output (disable / 

enable) Disable Disable / enable 

23 
Selection of operation mode 
(stop/run) in case of I/O verification 
error 

Stop Stop / run 

24 Operation stop upon Initial error of 
the motion part Stop Stop / run 

25 
Selection of operation mode in case 
of position control operation error 
(stop / run) 

Run Run/stop 

26 Selection of operation mode in case 
of operational error (stop / run) Stop Stop / run 

28 
Mode (stop/run) in case of AMP 
communication error of the motion 
part 

Run Stop / run 

4 Selection of operation mode in case 
of battery error 

Not 
execute 

Not 
execute: 

Do not notify the self-diagnostic 
error when the battery is abnormal, 
the ERR.LED does not flash. 

Execute: 
Do not notify the self-diagnostic 
error when the battery is abnormal, 
the ERR.LED flashes. 
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(Note 1): System register no. 0: can set the sequence program area capacity only in off-line editing. To make the 
setting effective, you need to download it to the control unit. 

(Note 2): System register no.0: if you change the sequence program area capacity, the capacity of the data register 
DT will be changed. 

(Note 3): System registers no.4-no.14: The data within the setting range of the register can be kept only when 
equipped with the optional battery. Use the initial values directly when the battery is not installed. 

 

 

 No. Name Initial 
value Sets value range and description 

Tim
e setting 

31 Waiting time for managing multiple 
frame 6500.0 ms 10 - 81900 ms (unit: 2.5 ms) 

32 SEND/RECV, RMRD/RMWT 
Instruction Waiting Time 1000.0 ms 10 - 81900 ms (unit: 2.5 ms) 

34 Constant scan time Normal 
scanning 

0: normal scanning (unit: 0.5 ms) 
0 - 350 ms: scan once at a specified time 
interval 

36 Expansion unit recognition time 0 0 - 10 seconds (unit: 0.1 second) 
0: no waiting time 

37 Task time priority setting (note 1) Normal Normal /Operation 

PC
 Link W

 0 
 0 Setting 

40 Size of link relay 0 0 - 64 words 

41 Size of link register 0 0 - 128 words 

42 Send area starting word address of 
link relay 0 0 - 63 

43 Size of link relays used for send area 0 0 - 64 words 

44 Send area starting word address link 
data register 0 0 - 127 

45 Size of link data registers used for 
send area 0 0 - 127 words 

46 PLC link 0 and 1 allocation setting Standard Normal / reverse 

47 MEWNET-W0 
PLC link max unit no. 16 1 - 16 

48 PLC link baud rate (note 2) 115200 bps 115200bps/230400bps 
PC

 Link W
 0 

 1 Setting 
50 Size of link relay 0 0 - 64 words 

51 Size of link register 0 0 - 128 words 

52 Send area starting word address of 
link relay 64 64 - 127 

53 Size of link relays used for send area 0 0 - 64 words 

54 Size of link data registers used for 
send area 128 128 - 255 

55 Size of link data registers used for 
send area 0 0 - 127 words 

57 MEWNET-W0 
PLC link max unit no. 16 1 - 16 

(Note 1): When the system register no. 37 task time is set as "Operation" preferentially, after every scan, the time 
required for the communication process is reduced to 1 port, the operation processing has priority. 

(Note 2): The system register no. 48 PLC link baud rate is set in the same dialog box that the COM0 port and COM1 
port setting used. 
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 No. Name Initial value Sets value range and description 

M
aster input setting 1 (H

SC
) 

400 High-speed counter settings 
(X0-X3) 

CH0: 
Not set X0 as 
High-speed 
counter 

Not set X0 as High-speed counter 
addition input (X0) 
subtraction input (X0) 
2-phase input (X0, X1) 
one input (X0, X1) 
direction distinction (X0, X1)  

CH1:  
Not set X1 as 
High-speed 
counter 

Not set X1 as High-speed counter 
addition input (X1) 
subtraction input (X1)  

CH2:  
Not set X2 as 
High-speed 
counter 

Not set X2 as High-speed counter 
addition input (X2) 
subtraction input (X2) 
2-phase input (X2, X3) 
one input (X2, X3) 
direction distinction (X2, X3)  

CH3:  
Not set X3 as 
High-speed 
counter 

Not set X3 as High-speed counter 
addition input (X3) 
subtraction input (X3)  

M
aster input setting 2 (H

SC
) 

401 High-speed counter settings 
(X4-X7) 

CH4:  
Not set X4 as 
High-speed 
counter 

Not set X4 as High-speed counter 
addition input (X4) 
subtraction input (X4) 
2-phase input (X4, X5) 
one input (X4, X5) 
direction distinction (X4, X5) 

CH5:  
Not set X5 as 
High-speed 
counter 

Not set X5 as High-speed counter 
addition input (X5) 
subtraction input (X5) 

CH6:  
Not set X6 as 
High-speed 
counter 

Not set X6 as High-speed counter 
addition input (X6) 
subtraction input (X6) 
2-phase input (X6, X7) 
one input (X6, X7) 
direction distinction (X6, X7) 
Reset input of the high-speed counter CH0 

CH7:  
Not set X7 as 
High-speed 
counter 

Not set X7 as High-speed counter 
addition input (X7) 
subtraction input (X7) 
reset input of high-speed counter CH2 

(Note 1): When the high-speed counter CH0, CH2, CH4 and CH6 are set to one of 2-phase, individual and direction 
distinction, the setting of CH1, CH3, CH5 and CH7 are invalid. 

(Note 2): The high-speed counter hardware reset input can only use CH0 and CH2. X6 and X7 can be allocated for 
CH0 and CH2 respectively. 

(Note 3): When the same input is set to one of high-speed counter, pulse catch and interrupt input, the priority order is 
high-speed counter → pulse catch → interrupt input. 
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No. Name Initial value Sets value range and description 

Interruption and pulse catch setting 

403 Pulse catch input setting 
(X0-X7) Normal input 

Normal input  
Input pulse 

X0 X1 X2 X3 X4 X5 X6 X7
Controller input  
The contact pressed is set as pulse catch input. 

404 Interrupt input setting 
(X0-X7) Normal input 

Normal input  
Interrupt input 

X0 X1 X2 X3 X4 X5 X6 X7
Controller input  
The contact pressed is set as pulse catch input. 

Interrupt pulse edge setting 

405 Interrupt edge setting 
(X0-X7) Rising edge 

Rising edge  
Falling edge  
rising and falling edges 

X0 X1 X2 X3 X4 X5 X6 X7

X0 X1 X2 X3 X4 X5 X6 X7
Rising edge

Rising edge  
The contact pressed is set as rising edge and 
falling edge. 

(Note 1): When the same input is set to one of high-speed counter, pulse catch and interrupt input, the priority order is 
high-speed counter → pulse catch → interrupt input. 
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 No. Name Initial value Sets value range and description 

C
O

M
0

／C
O

M
1

／C
O

M
2

／C
O

M
3 Port setting 

410 
411 

Unit number 1 1 - 99 

412 
Communication mode Computer link 

Computer link 
General-purpose communication 
PC (PLC) link 
MODBUS RTU 

Modem enabled Not execute Conduct / not conduct 

413 
414 

Communication format 
Data length: 8 bit 
Parity: odd 
Stop bit: 1 bit 

Data length: 7 bit / 8 bit 
Parity: none / odd / even 
Stop bit: 1 / 2 
Terminator selection: code / time 
End code: CR / CR＋LF / none 
Start code: No STX / STX 

415 Baud rate setting 9600 bps 
2400 bps, 4800 bps, 9600 bps, 19200 bps 
38400 bps, 57600 bps, 115200 bps,  
230400 bps 

416 
(COM1) Staring address for 
data received of serial data 
communication mode 

0 0 - 65532 

417 
(COM1) Buffer capacity setting 
for data received of serial data 
communication mode 

2048 0 - 2048 

418 
(COM2) Staring address for 
data received of serial data 
communication mode 

2048 0 - 65532 

419 
(COM2) Buffer capacity setting 
for data received of serial data 
communication mode 

2048 0 - 2048 

420 
(COM0) Staring address for 
data received of serial data 
communication mode 

4096 0 - 65532 

421 
(COM0) Buffer capacity setting 
for data received of serial data 
communication mode 

2048 0 - 2048 

422 
(COM3) Staring address for 
data received of serial data 
communication mode 

6144 0 - 65532 

423 
(COM3) Buffer capacity setting 
for data received of serial data 
communication mode 

2048 0 - 2048 

424 
(COM0) 
Terminator judgment time 
(×0.01ms) 

0 

0-100000 or 1-10000 (0.01ms-100ms) 
When designated to 0, the transmission time is 
the time needed to transmit 4 bytes. 

425 
(COM1) 
Terminator judgment time 
(×0.01ms) 

0 

426 
(COM2) 
Terminator judgment time 
(×0.01ms) 

0 

427 
(COM3) 
Terminator judgment time 
(×0.01ms) 

0 
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(Note 1): No. 412: when you select a computer link or MODOBUS RTU in the communication mode, the No. 413 
transmission format and No. 415 baud rate can be set. 

(Note 2): No. 412: when selecting only the general-purpose communication in the communication mode, you can set 
no. 413: transmission format terminal selection, end and start codes. In addition, when selecting the terminal as 
time only through no. 413, you can select no. 424 to no. 427. 

(Note 3): The PC (PLC) link function is only available for COM0 or COM1 port. Data length for transmission format: 8 
bits,  
Parity: odd, stop bit: fixed to 1. In addition, select the communication speed in PC link W0-0 system register No. 
48 item. 

(Note 4): The COM4 port only supports MEWTOCOL-COM communication. In addition, the communication 
parameters (unit number, communication format, baud rate) when the power is ON are same as the settings of 
the COM3 port. After RUN, you can also change the conditions by SYS1 instruction. 

 
 No. Name Initial value Sets value range and description 

Tim
e constant setting of C

PU
 input 

430 
Time constant setting of CPU 
1 
X0-X3 

No 

No 
1 ms 
2 ms 
4 ms 
8 ms 
16 ms 
32 ms 
64 ms 
128 ms 
256 ms 

431 
Time constant setting of CPU 
1 
X4-X7 
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26.6 Table of Special Internal Relays 
WR900 (specified in word) 

Relay 
number Name Description 

R9000 Self-diagnostic error flag When an error flag self-diagnostic error occurs, it is ON.  
→ Self-diagnostic result stored in DT90000. 

R9001 Unused  

R9002 Function cassette I/O error 
flag 

When an abnormality is detected in the I/O type function cassette, 
it is ON. 

R9003 Function cassette error flag When an abnormality is detected in the function cassette, it is ON. 

R9004 I/O verification error flag When an I/O verification error is detected, it is ON. 

R9005 Backup battery error flag 
(current type) 

When a battery error is detected, it turns to ON.  
Even if you choose not to notify battery error in the system 
register, it is also ON when the battery runs out. 

R9006 Backup battery error flag 
(hold) 

When a battery error is detected, it turns to ON.  
Even if you choose not to notify battery error in the system 
register, it is also ON when the battery runs out.  
When a battery error is detected, it is maintained after the reset.  
→OFF when the power is cut. 

R9007 Operation error flag (hold) 
(ER flag) 

When you start running, it is ON if an error occurs, and it is 
maintained during operation.  
→The address where an error occurred stored in DT90017. 
(Display the operation error occurred initially.) 

R9008 Operation error flag (latest) 
(ER flag) 

It is ON whenever an operation error occurs.  
→The address where an error occurred stored in DT90018. Every 
time a new error occurs, the content will be updated. 

R9009 Carry flag (CY flag) 
When the operation result overflows or underflows, or when 
performing the result of the shift system instruction, the flag 
resets. 

R900A > Flag Execute comparison instruction, if the comparison result is large, 
it is ON. 

R900B = Flag 

Execute comparison instruction, if the comparison result is equal, 
it is ON.  
Execute operation instruction, if the comparison result is 0, it is 
ON. 

R900C < Flag Execute comparison instruction, if the comparison result is small, 
it is ON. 

R900D Auxiliary timer contact 
Execute auxiliary timing instruction (F137 / F138), it turns to ON 
after a set time. If the execution condition turns to OFF, the flag is 
OFF. 

R900E 
(R9130) 

COM0 port communication 
error 

When using COM0 port, if it detects a communication error, it is 
ON. 

R900F Constant scan error flag 
When performing constant scanning, if the scan time exceeds the 
value of the set timer (system register No. 34), it is ON.  
In the system register No. 34, it also turns to ON when 0 is set. 

(Note 1): The special internal relay in parentheses is also allocated the same function. 
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WR901 (specified in words) 
Relay 

number Name Description 

R9010 Always on relay Always on. 
R9011 Always off relay Always off. 
R9012 Scan pulse relay Turns on and off alternately at each scan. 

R9013 Initial (on type) pulse relay  Goes on for only the first scan after operation (RUN) has been 
started, and goes off for the second and subsequent scans. 

R9014 Initial (off type) pulse relay  Goes off for only the first scan after operation (RUN) has been 
started, and goes on for the second and subsequent scans. 

R9015 Step ladder initial pulse 
relay (on type) 

Turns on for only the first scan of a process after the boot at the 
step ladder control. 

R9016 Not used  
R9017 Not used  

R9018 0.01 s clock pulse relay Repeats on/off operations in 0.01 sec. 
cycles. 0.01 seconds  

R9019 0.02 s clock pulse relay Repeats on/off operations in 0.02 s. 
cycles. 0.02 seconds  

R901A 0.1 s clock pulse relay Repeats on/off operations in 0.1 s. 
cycles. 0.1 seconds  

R901B 0.2 s clock pulse relay  Repeats on/off operations in 0.2 s. 
cycles. 0.2 seconds  

R901C 1 s clock pulse relay Repeats on/off operations in 1 s. cycles. 
1 second  

R901D 2 s clock pulse relay Repeats on/off operations in 2 s. cycles. 
2 seconds  

R901E 1 min clock pulse relay Repeats on/off operations in 1 min. 
cycles. 

1 minute  
R901F Not used  
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WR902 (specified in word) 
Relay 

number Name Description 

R9020 RUN mode flag Turns off while the mode selector is set to PROG. 
Turns on while the mode selector is set to RUN. 

R9021 Not used  

R9022 Not used  

R9023 Not used  

R9024 Not used  

R9025 Not used  

R9026 Message flag Turns on while the F149 (MSG) instruction is executed. 

R9027 Not used  

R9028 Not used  

R9029 Forcing flag Turns on during forced on/off operation for input/output relay 
timer/counter contacts. 

R902A Interrupt enable flag Turns on while the external interrupt trigger is enabled by the 
ICTL instruction. 

R902B Interrupt error flag Turns on when an interrupt error occurs. 

R902C Sample point flag Sampling by the instruction=0 
Sampling at constant time intervals=1 

R902D Sample trace end flag  When the sampling operation stops=1, 
When the sampling operation starts=0 

R902E Sampling stop trigger flag  When the sampling stop trigger activates=1 
When the sampling stop trigger stops=0 

R902F Sampling enable flag When sampling starts=1 
When sampling stops=0 
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WR903 (specified in word) 
Relay 

number Name Description 

R9030 Unused  

R9031 Unused  

R9032 
(R9139) COM1 port operation mode flag 

When using the general communication function, it is ON.  
When using a function outside of the general communication 
function, it is OFF. 

R9033 Print instruction executing flag OFF: not executed.  
ON: executing 

R9034 Program editing flag in RUN 
mode 

The special internal relay that is ON only at the first scan 
cycle after program editing completed in RUN mode. 

R9035 Unused  

R9036 Unused  

R9037 
(R9138) 

COM1 port communication error 
flag 

When performing data communication, if a transmission error 
occurs, it is ON.  
When requesting for sending via the F159 (MTRN) 
instruction, it is OFF. 

R9038 
(R913A) 

Reception completion flag for 
COM1 port general-purpose 
communication 

For general communication, if the end character is received, it 
is ON. 

R9039 
(R913B) 

Sending completion flag for 
COM1 port general-purpose 
communication 

For general-purpose communication, if end the transmission, 
it is ON.  
For general-purpose communication, if transmitting is 
required, it is OFF. 

R903A Unused  

R903B Unused  

R903C Unused  

R903D Unused  

R903E 
(R9132) 

Reception completion flag for 
COM0 port general-purpose 
communication 

For general-purpose communication, if the end character is 
received, it is ON. 

R903F 
(R9133) 

Sending completion flag for 
COM0 port general-purpose 
communication 

For general-purpose communication, if end the transmission, 
it is ON.  
For general-purpose communication, if transmitting is 
required, it is OFF. 

(Note 1): R9030 - R903F will change even during one scanning cycle. In addition, the special internal relay in 
parentheses is also allocated the same function. 
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WR904 (specified in word) 
Relay 

number Name Description 

R9040 
(R9131) COM0 port operation mode flag 

When using the general-purpose communication function, it is 
ON.  
When using a function outside of the general-purpose 
communication function, it is OFF. 

R9041 
(R913E) COM1 port PC (PLC) link flag When using the PC (PLC) link function, it is ON. 

R9042 
(R9141) COM2 port operation mode flag 

When using the general-purpose communication function, it is 
ON.  
When using a function outside of the general-purpose 
communication function, it is OFF. 

R9043 Unused  

R9044 
(R913C) 

COM1 port 
SEND / RECV instruction 
executable flag 

Indicates the instruction with respect to the F145 (SEND) or 
F146 (RECV) instruction of the COM1 port is executable / 
non-executable.  
OFF: non-executable (instruction executing) 
ON: executable 

R9045 
(R913D) 

COM1 port 
SEND / RECV instruction 
execution completion flag 

Indicates the status with respect to the F145 (SEND) or F146 
(RECV) instruction of the COM1 port.  
OFF: normal completion 
ON: abnormal completion (a communication error occurs) 
The error code is stored to DT90124. 

R9046 Unused  

R9047 
(R9140) 

COM2 port communication error 
flag 

When performing data communication, if a transmission error 
occurs, it is ON.  
When requesting for sending via the F159 (MTRN) 
instruction, it is OFF. 

R9048 
(R9142) 

Reception completion flag for 
COM2 port general-purpose 
communication 

For general communication, if the end character is received, it 
is ON. 

R9049 
(R9143) 

Sending completion flag for 
COM2 port general-purpose 
communication 

For general-purpose communication, if end the transmission, 
it is ON.  
For general-purpose communication, if transmitting is 
required, it is OFF. 

R904A 
(R9144) 

COM2 port 
SEND / RECV instruction 
executable flag 

Indicates the instruction with respect to the F145 (SEND) or 
F146 (RECV) instruction of the COM2 port is executable / 
non-executable.  
OFF: non-executable (instruction executing) 
ON: executable 

R904B 
(R9145) 

COM2 port 
SEND / RECV instruction 
execution completion flag 

Indicates the status with respect to the F145 (SEND) or F146 
(RECV) instruction of the COM2 port.  
OFF: normal completion 
ON: abnormal completion (a communication error occurs) 
The error code is stored to DT90125. 

R904C- 
R904F Unused  

(Note 1): R9040 - R904F will change even during a scanning cycle. In addition, the special internal relay in 
parentheses is also allocated the same function. 

WR905 (specified in word) 
Relay 

number Name Description 

R9050 
MEWNET-W0 
PC (PLC) link transmission error 
flag 

When using MEWNET-W0 
When a transmission error sent through the PC (PLC) link, it is ON.  
When the setting of the PC (PLC) link area is abnormal, it is ON. 

R9051- 
R905F Unused  
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WR906 (specified in word) 
Relay 

number Name Description 

R9060 

MEWNET-W0 
PC (PLC) link 0 
transmit guarantee 
relay 

Unit  
No. 1 

Unit no.1 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9061 Unit  
No. 2 

Unit no.2 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9062 Unit  
No. 3 

Unit no.3 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9063 Unit  
No. 4 

Unit no.4 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9064 Unit  
No. 5 

Unit no.5 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9065 Unit  
No. 6 

Unit no.6 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9066 Unit  
No. 7 

Unit no.7 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9067 Unit No. 
8 

Unit no.8 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9068 Unit  
No. 9 

Unit no.9 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9069 Unit  
No. 10 

Unit no.10 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R906A Unit  
No. 11 

Unit no.11 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R906B Unit  
No. 12 

Unit no.12 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R906C Unit  
No. 13 

Unit no.13 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R906D Unit  
No. 14 

Unit no.14 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R906E Unit  
No. 15 

Unit no.15 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R906F Unit  
No. 16 

Unit no.16 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 
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WR907 (specified in word) 
Relay 

number Name Description 

R9070 

MEWNET-W0 
PC (PLC) link 0 
operation mode relay 

Unit  
no. 1 

When the unit no. 1 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9071 Unit  
no. 2 

When the unit no. 2 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9072 Unit  
no. 3 

When the unit no. 3 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9073 Unit  
no. 4 

When the unit no. 4 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9074 Unit  
no. 5 

When the unit no. 5 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9075 Unit  
no. 6 

When the unit no. 6 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9076 Unit  
no. 7 

When the unit no. 7 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9077 Unit  
no. 8 

When the unit no. 8 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9078 Unit  
no. 9 

When the unit no. 9 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9079 Unit  
no. 10 

When the unit no. 10 is in RUN mode: ON.  
When in PROG mode: OFF. 

R907A Unit  
no. 11 

When the unit no. 11 is in RUN mode: ON.  
When in PROG mode: OFF. 

R907B Unit  
no. 12 

When the unit no. 12 is in RUN mode: ON.  
When in PROG mode: OFF. 

R907C Unit  
no. 13 

When the unit no. 13 is in RUN mode: ON.  
When in PROG mode: OFF. 

R907D Unit  
no. 14 

When the unit no. 14 is in RUN mode: ON.  
When in PROG mode: OFF. 

R907E Unit  
no. 15 

When the unit no. 15 is in RUN mode: ON.  
When in PROG mode: OFF. 

R907F Unit  
no. 16 

When the unit no. 16 is in RUN mode: ON.  
When in PROG mode: OFF. 
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WR908 (specified in word) 
Relay 

number Name Description 

R9080 

MEWNET-W0 
PC (PLC) link 1 
transmit guarantee 
relay 

Unit  
no. 1 

Unit no.1 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9081 Unit  
no. 2 

Unit no.2 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9082 Unit  
no. 3 

Unit no.3 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9083 Unit  
no. 4 

Unit no.4 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9084 Unit  
no. 5 

Unit no.5 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9085 Unit  
no. 6 

Unit no.6 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9086 Unit  
no. 7 

Unit no.7 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9087 Unit  
no. 8 

Unit no.8 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9088 Unit  
no. 9 

Unit no.9 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R9089 Unit  
no. 10 

Unit no.10 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R908A Unit 
no. 11 

Unit no.11 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R908B Unit  
no. 12 

Unit no.12 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R908C Unit  
no. 13 

Unit no.13 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R908D Unit  
no. 14 

Unit no.14 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R908E Unit  
no. 15 

Unit no.15 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 

R908F Unit  
no. 16 

Unit no.16 
For normal communication in the PC (PLC) link mode: ON 
When stopping, error occurs or PC (PLC) is not linked: OFF 
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WR909 (specified in word) 
Relay 

number Name Description 

R9090 

MEWNET-W0 
PC (PLC) link 1 
operation mode relay 

Unit  
no. 1 

When the unit no. 1 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9091 Unit  
no. 2 

When the unit no. 2 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9092 Unit  
no. 3 

When the unit no. 3 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9093 Unit  
no. 4 

When the unit no. 4 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9094 Unit  
no. 5 

When the unit no. 5 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9095 Unit  
no. 6 

When the unit no. 6 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9096 Unit  
no. 7 

When the unit no. 7 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9097 Unit  
no. 8 

When the unit no. 8 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9098 Unit  
no. 9 

When the unit no. 9 is in RUN mode: ON.  
When in PROG mode: OFF. 

R9099 Unit  
no. 10 

When the unit no. 10 is in RUN mode: ON.  
When in PROG mode: OFF. 

R909A Unit  
no. 11 

When the unit no. 11 is in RUN mode: ON.  
When in PROG mode: OFF. 

R909B Unit  
no. 12 

When the unit no. 12 is in RUN mode: ON.  
When in PROG mode: OFF. 

R909C Unit  
no. 13 

When the unit no. 13 is in RUN mode: ON.  
When in PROG mode: OFF. 

R909D Unit  
no. 14 

When the unit no. 14 is in RUN mode: ON.  
When in PROG mode: OFF. 

R909E Unit  
no. 15 

When the unit no. 15 is in RUN mode: ON.  
When in PROG mode: OFF. 

R909F Unit  
no. 16 

When the unit no. 16 is in RUN mode: ON.  
When in PROG mode: OFF. 
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WR910 - WR912 (specified in word) 
Relay 

number Name Description 

R9100- 
R910F Unused  

R9110 

High-speed 
counter 
control flag 

HSC-CH0 

When using high-speed counter function, it is ON during the 
execution of F166 (HC1S) and F167 (HC1R) instructions. It is 
OFF when the action is completed.  

R9111 HSC-CH1 

R9112 HSC-CH2 

R9113 HSC-CH3 

R9114 HSC-CH4 

R9115 HSC-CH5 

R9116 HSC-CH6 

R9117 HSC-CH7 

R9118 
-R912F Unused   
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WR913 (specified in word) 
Relay 

number Name Description 

R9130 
(R900E) 

COM0 port communication error 
flag 

When performing data communication, if a transmission error 
occurs, it is ON.  
When requesting for sending via the F159 (MTRN) 
instruction, it is OFF. 

R9131 
(R9040) COM0 port operation mode flag 

When using the general-purpose communication function, it is 
ON.  
When using a function outside of the general-purpose 
communication function, it is OFF. 

R9132 
(R903E) 

Reception completion flag for 
COM0 port general-purpose 
communication 

For general-purpose communication, if the end character is 
received, it is ON. 

R9133 
(R903F) 

Sending completion flag for 
COM0 port general-purpose 
communication 

For general-purpose communication, if end the transmission, 
it is ON.  
For general-purpose communication, if transmitting is 
required, it is OFF. 

R9134 
COM port 
SEND / RECV instruction 
executable flag 

Indicates the status with respect to the Executable/Non-
executable status of F145 (SEND) or F146 (RECV) instruction 
of the COM0 port.  
OFF: non-executable (instruction executing) 
ON: executable 

R9135 
COM0 port 
SEND / RECV instruction 
execution completion flag 

Indicates the status with respect to the execution status of 
F145 (SEND) or F146 (RECV) instruction of the COM0 port.  
OFF: normal completion 
ON: abnormal completion (a communication error occurs) 
The error code is stored to DT90123. 

R9136 COM0 port 
PC (PLC) link flag When using the PC (PLC) link function, it is ON. 

R9137 Unused  

R9138 
(R9037) 

COM1 port communication error 
flag 

When performing data communication, if a transmission error 
occurs, it is ON.  
When executing via F159 (MTRN) instruction, if transmitting is 
required, it is OFF. 

R9139 
(R9032) COM1 port operation mode flag 

When using the general-purpose communication function, it is 
ON.  
When using a function outside of the general-purpose 
communication function, it is OFF. 

R913A 
(R9038) 

Reception completion flag for 
COM1 port general 
communication 

For general-purpose communication, if the end character is 
received, it is ON. 

R913B 
(R9039) 

Sending completion flag for 
COM1 port general 
communication 

For general-purpose communication, if end the transmission, 
it is ON.  
For general-purpose communication, if transmitting is 
required, it is OFF. 

R913C 
(R9044) 

COM1 port 
SEND / RECV instruction 
executable flag 

Indicates the status with respect to the Executable/Non-
executable status of F145 (SEND) or F146 (RECV) instruction 
of the COM0 port.  
OFF: non-executable (instruction executing) 
ON: executable 

R913D 
(R9045) 

COM1 port 
SEND / RECV instruction 
execution completion flag 

Indicates the status with respect to the execution status of 
F145 (SEND) or F146 (RECV) instruction of the COM1 port.  
OFF: normal completion 
ON: abnormal completion (a communication error occurs) 
The error code is stored to DT90124. 

R913E 
(R9041) COM1 port PC (PLC) link flag When using the PC (PLC) link function, it is ON. 

R913F Unused  
(Note 1): R9130 - R913F will change even during one scanning cycle. In addition, it is compatible with the older model 

FP-X control unit, the special internal relay in parentheses also can be allocated the same function. 
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WR914 (specified in word) 
Relay 

number Name Description 

R9140 
(R9047) 

COM2 port communication error 
flag 

When performing data communication, if a transmission error 
occurs, it is ON.  
When executing via F159 (MTRN) instruction, if transmitting is 
required, it is OFF. 

R9141 
(R9042) COM2 port operation mode flag 

When using the general-purpose communication function, it is 
ON.  
When using a function outside of the general-purpose 
communication function, it is OFF. 

R9142 
(R9048) 

Reception completion flag for 
COM2 port general-purpose 
communication 

For general-purpose communication, if the end character is 
received, it is ON. 

R9143 
(R9049) 

Sending completion flag for 
COM2 port general-purpose 
communication 

For general-purpose communication, if end the transmission, 
it is ON.  
For general-purpose communication, if transmitting is 
required, it is OFF. 

R9144 
(R904A) 

COM2 port 
SEND / RECV instruction 
executable flag 

Indicates the status with respect to the Executable/Non-
executable status of F145 (SEND) or F146 (RECV) instruction 
of the COM0 port.  
OFF: non-executable (instruction executing) 
ON: executable 

R9145 
(R904B) 

COM2 port 
SEND / RECV instruction 
execution completion flag 

Indicates the status with respect to the execution status of 
F145 (SEND) or F146 (RECV) instruction of the COM2 port.  
OFF: normal completion 
ON: abnormal completion (a communication error occurs) 
The error code is stored to DT90125. 

R9146 Unused  
R9147 Unused  

R9148 COM3 port communication error 
flag 

When performing data communication, if a transmission error 
occurs, it is ON.  
When executing via F159 (MTRN) instruction, if transmitting is 
required, it is OFF. 

R9149 COM3 port operation mode flag 

When using the general-purpose communication function, it is 
ON.  
When using a function outside of the general-purpose 
communication function, it is OFF. 

R914A 
Reception completion flag for 
COM3 port general 
communication 

For general communication, if the end character is received, it 
is ON. 

R914B 
Sending completion flag for 
COM3 port general-purpose 
communication 

For general-purpose communication, if end the transmission, 
it is ON.  
For general-purpose communication, if transmitting is 
required, it is OFF. 

R914C 
COM3 port 
SEND / RECV instruction 
executable flag 

Indicates the status with respect to the Executable/Non-
executable status of F145 (SEND) or F146 (RECV) instruction 
of the COM0 port.  
OFF: non-executable (instruction executing) 
ON: executable 

R914D 
COM3 port 
SEND / RECV instruction 
execution completion flag 

Indicates the status with respect to the execution status of 
F145 (SEND) or F146 (RECV) instruction of the COM3 port.  
OFF: normal completion 
ON: abnormal completion (a communication error occurs) 
The error code is stored to DT90127. 

R914E Unused  
R914F Unused  

(Note 1): R9140 - R914F will change even during a scanning cycle. In addition, it is compatible with the older model 
FP-X control unit, the special internal relay in parentheses also can be allocated the same function. 
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WR915 (specified in word) 
Relay 

number Name Description 

R9150 COM4 port communication error 
flag 

When performing data communication, if a transmission error 
occurs, it is ON.  
When requesting for sending via the F159 (MTRN) 
instruction, it is OFF. 

R9151 COM4 port operation mode flag 

When using the general-purpose communication function, it is 
ON.  
When using a function outside of the general-purpose 
communication function, it is OFF. 

R9152 
Reception completion flag for 
COM4 port general-purpose 
communication 

For general-purpose communication, if the end character is 
received, it is ON. 

R9153 
Sending completion flag for 
COM4 port general-purpose 
communication 

For general-purpose communication, if end the transmission, 
it is ON.  
For general-purpose communication, if transmitting is 
required, it is OFF. 

R9154 
COM4 port 
SEND / RECV instruction 
executable flag 

Indicates the status with respect to the Executable/Non-
executable status of F145 (SEND) or F146 (RECV) instruction 
of the COM0 port.  
OFF: non-executable (instruction executing) 
ON: executable 

R9155 
COM4 port 
SEND / RECV instruction 
execution completion flag 

Indicates the status with respect to the execution status of 
F145 (SEND) or F146 (RECV) instruction of the COM4 port.  
OFF: normal completion 
ON: abnormal completion (a communication error occurs) 
The error code is stored to DT90128. 

R9156 
-R915F Unused  
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Number Name Description R W 

DT90000 Self-diagnostic error code When a self-diagnostic error occurs, the error code 
is stored. ○ × 

DT90001 Unused  × × 

DT90002 Function cassette I/O error 
occurring location 

When an error occurs in the function cassette, the 
corresponding bit is ON. 

7 3 2 1 0 (Bit No.)

2 1 (Expansion No.)

15 11

ON(1)：Abnormal　OFF(0)：Normal  

○ × 

DT90003 
-DT90005 Unused  × × 

DT90006 Function cassette error 
occurring location 

When an error occurs in the function cassette, the 
corresponding bit is ON. 

7 3 2 1 0 (Bit No.)

2 1 (Expansion No.)

15 11

ON(1)：Abnormal　OFF(0)：Normal  

○ × 

DT90007 System register error number 
When there is mismatch in the setting content of the 
system register, save the object system register 
number. 

○ × 

DT90008 Communication error flag 
COM4 port 

Save error contents when using the COM4 port. ON 
(1): Error, OFF (0): Normal 

bit no. 15 0
0 0 0 0 0 0 0 0 0 0 0 0

8 7

COM4 Ultra-limit running error
COM4 Framing error
COM4 Parity error
COM4 Overflow error

H00 Fixed

 

○ × 

DT90009 Communication error flag 
COM2 port / COM3 port 

Save error contents when using the COM2 / COM3 
port.  
ON (1): Error, OFF (0): Normal 

bit no. 15 0
0 0 0 0 0 0 0 0

8 7

COM2 Ultra-limit running error
COM2 Framing error
COM2 Parity error
COM2 Overflow error

COM3 Ultra-limit running error
COM3 Framing error
COM3 Parity error

COM3
Overflow error

 

○ × 

DT90010 
FP-X Expansion I/O Unit 
verify mismatched unit 
position 

When the FP-X expansion I/O unit installation state 
turns to power ON, the corresponding bit to the unit 
number is ON (1). Monitor with BIN display. 

7 3 2 1 0 (Bit No.)

(Expansion No.)

15 11

ON(1)：Abnormal　OFF(0)：Normal

456

7 3 2 1 0456

 

○ × 
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Register 
Number Name Description R W 

DT90011 Add-on cassette verify 
mismatched unit position 

When the FP-X add-on cassette installation state 
turns to power ON, the corresponding bit to the add-
on cassette number is ON (1). Monitor with BIN 
display. 

7 3 2 1 0 (Bit No.)

2 1 (Expansion No.)

15 11

ON(1)：Abnormal　OFF(0)：Normal  

○ × 

DT90012 
-DT90013 Unused  × × 

DT90014 
Operation auxiliary register 
of the data shift 
instruction 

After executing the data shift instruction F105 (BSR) 
or F106 (BSL), the 1 digit data removed out is saved 
to the bit 0 - 3.  
Execute F0 (MV) instruction, values can be read and 
write. 

○ ○ 

DT90015 

Operation auxiliary register 
of the division instruction 

When executing 16-bit division instruction F32 (%), 
F52 (B%), the 16 bit of the remainder is saved to 
DT90015.  
When executing 32-bit division instruction F33 (D%), 
F53 (DB%), the 32 bit of the remainder is saved to 
DT90015-DT90016. Execute F1 (DMV) instruction, 
values can be read and write. 

○ ○ 

DT90016 

DT90017 Operation error address 
(hold) 

After running, the address occurs an operation error 
first is stored. Please use decimalism display to 
perform monitoring. 

○ × 

DT90018 Operation error address 
(latest) 

The address where an error occurred is stored. 
Update when each time an error occurs. Please use 
decimalism display to perform monitoring. 

○ × 

DT90019 2.5 ms RING counter (Note 2) 

The stored value is increased by 1 every 2.5 ms. (H0-
HFFFF) 
The difference between 2 points (absolute value) × 
2.5 ms = elapsed time between 2 points 

○ × 

DT90020 10 µs RING counter (note2. 3) 

Saved value +1 every 10.00 µs.  (H0-HFFFF) 
The difference between 2 points (absolute value) × 
10.00 µs＝(elapsed time between 2 points) 
note) the correct value is 10.00 µs. 

○ × 

DT90021 Unused  × × 

DT90022 Scanning time (current 
value) (note1) 

The current value of the scanning time is saved.  
[Saved value (decimal)] × 0.1 ms 
(Example) For K50, it indicates within 5 ms. 

○ × 

DT90023 Scanning time (min) (note 1) 
The minimum value of the scanning time is saved.  
[Saved value (decimal)] × 0.1 ms 
(Example) For K50, it indicates within 5 ms. 

○ × 

DT90024 Scanning time (max) (note 1) 
The maximum value of the scanning time is saved.  
[Saved value (decimal)] × 0.1 ms 
(Example) For K125, it indicates within 12.5 ms. 

○ × 

(Note 1): The scanning time and operation cycle time only display in RUN mode. The scanning time of the operation 
is not displayed in PROG. mode. When the maximum and minimum value are shifted between RUN mode and 
PROG. mode, they are temporarily cleared. 

(Note 2): During one scan, it is updated once at the beginning. 
(Note 3): DT90020 is also updated when executing F0 (MV), therefor, it can be used to measure the time interval. 
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Number Name Description R W 

DT90025 Interrupt enable (mask) 
state (INT0 - 7) 

The content set by the ICTL instruction is saved.  
Monitor with BIN display. 

7 3 0 (Bit No.)

(INT No.)

15 11
1: Allowed
0: Disable

13

7 3 01113  
INT0 - INT7: interrupt input X0 - X7 
INT0 - INT7: high-speed counter match interrupt CH0 
- CH7 

○ × 

DT90026 Unused  × × 

DT90027 Timer interrupt interval 
(INT24) 

The content set by the ICTL instruction is saved.  
K0: do not use the timer interrupt.  
K1-K3000: 0.1 ms-0.35 s or 0.5 ms-1.5 s 
or 10 ms-30 s 

○ × 

DT90028 Sampling and tracking 
interval 

K0: changed to sampling performed according to the 
SMPL instruction.  
K1 - K3000 (× 10ms): 10 ms - 30 s 

○ × 

DT90029 Unused  × × 

DT90030 

Character storage by F149 
MSG instruction 

Stores contents set through the information display 
instruction (F149) (character). ○ × 

DT90031 
DT90032 
DT90033 
DT90034 
DT90035 

DT90036 
Status error occurrence 
position of FP-X expansion 
unit/add-on cassette 

Stores the corresponding number upon abnormal 
status. 
High byte: FP-X expansion unit 
Low byte: add-on cassette 
(E.g.) The cassette installation part 2 is abnormal for 
0001h. 

○ × 

DT90037 Work 1 for search instruction When executing F96 (SRC) instruction, the number 
that is consistent with the search data is saved. ○ × 

DT90038 Work 2 for search instruction When executing F96 (SRC) instruction, a consistent 
relative position is saved. ○ × 

DT90039 Unused  × × 

DT90040 Potentiometer input 
Stores potentiometer value (K0 - K4000).  
Read to the data register by the user program, and it 
can be used in the analog timer. 

○ × 

DT90041 
-DT90043 Unused  × × 

DT90044 System job Used in the system. ○ × 
DT90045 
-DT90051 Unused  × × 
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Register 
Number Name Description R W 

DT90052 High-speed counter control 
flag 

When using high-speed counter function, the high-
speed counter reset, count prohibition and instruction 
execution cancellation are controlled by writing in 
values with the MV instruction (F0). 

bit no. 15 0

Soft reset

0 0 0 0 0 0 0 0
8 7

0：Not execute1：Execute

H00：Fixed

Counting 0：Allowed 1：Disable

External reset input 0：Available1：Unavailable

High-speed counter
instruction 0：Continue1：Cancel

Channel assignment
H0～H7：CH0～CH7

 

○ ○ 

 
-
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Number Name Description R W 

DT90053 Real-time clock monitoring 
(hour and minute) 

Saves the hour and minute data of the real-time 
clock.  
You can only read, can not write. 

High byte Low byte

Hour dataH00～H23 Minute dataH00～H59  

○ × 

DT90054 Real-time clock 
(minute and second) 

Saves the month, day, hour, minute, second, day and 
week data of the real-time clock. The built-in real time 
clock is applicable until 2099, also applicable for leap 
years.  
The real-time clock can be set (time adjustment) by 
using the programming tool or transfer instruction 
(F0) program to write in values. 

High byte Low byte

DT90054

DT90055

DT90056

DT90057

Minute data
(H00～H59)

Day data
(H01～H31)

Year data
(H00～H99)

Second data
(H00～H59)
Hour data

(H00～H23)
Month data
(H01～H12)
Week data

(H00～H06)ー
 

The week data is not automatically set. Allocate any 
value within the range of H0 - 6. 

○ ○ 

DT90055 Real-time clock 
(day and hour) 

DT90056 Real-time clock 
(year and month) 

DT90057 Real-time clock 
(week) 

DT90058 
Real-time clock time setting 
and 30 seconds correction 
register 

Time adjustment for real-time clock. 
●Use the program to adjust the time 
If the highest bit of the DT90058 MSB is set to 1, it 
turns to the time written into the DT90054 - DT90057 
by the instruction F0. After executing time 
adjustment, the DT90058 is cleared. (You can not 
execute instructions other than F0.) 
<Example> When X0 is ON, adjust the time to 5 days 
12 hours 0 minute 0 second. 

F0 MV, H  0, DT90054 Set 0 minutes 0 seconds

Set 5 days 12 hours

Time alignment

F0 MV, H 512, DT90055

F0 MV, H8000, DT90058

DF
X0

 
●Correct the error within 30 seconds 
If the lowest bit of the DT90058 MSB is set to 1, it will 
increase or decrease and turn to 0 second.  
After performing the correction, the DT90058 is 
cleared. 
<Example> When X0 is ON, correct it to 0 second. 

F0 MV, H  1, DT90058 Corrected to 0 secondDF
X0

 
Decrease when the execution time is 0-29 seconds, 
increase when it is 30-59 seconds. In the above 
example, if the time is 5 minutes and 29 seconds, it 
turns to 5 minutes 0 seconds. If the time is 5 minutes 
and 35 seconds, it turns to 6 minutes 0 seconds. 

○ ○ 

(Note 1): If you use the programming tool to rewrite the value of DT90054 - DT90057, the time is adjusted to the time 
written at the time of rewriting. Therefore, do not execute DT90058 writing. 
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Number Name Description R W 

DT90059 Communication error code 
COM0 port / COM1 port 

When a communication error occurs, the error 
code is saved.  
ON (1): Error, OFF (0): Normal 

bit no.15 0
0 0 0 0 0 0 0 0

8 7

COM0 Ultra-limit running error
COM0 Framing error
COM0 Parity error
COM0 Overflow error

COM1 Ultra-limit running error
COM1 Framing error

COM1 Parity error

COM1 
Overflow error

 

○ × 

DT90060 Step ladder process (0-15) 

It indicates the starting status of the step ladder 
diagram program process. When the process 
starts, the bit corresponding to its process number 
is ON.  
Monitor with BIN display. 

7 3

7 3

0 （BitNo.）

0 （ProcessNo.）

15<Example>
DT90060

11

15 11
1：Starting　 0：During stop  

The data can be written using a programming tool. 

○ ○ 

DT90061 Step ladder process (16-31) 
DT90062 Step ladder process (32-47) 
DT90063 Step ladder process (48-63) 
DT90064 Step ladder process (64-79) 

DT90065 Step ladder process (80-95) 
DT90066 Step ladder process (96-111) 
DT90067 Step ladder process (112-127) 
DT90068 Step ladder process (128-143) 
DT90069 Step ladder process (144-159) 
DT90070 Step ladder process (160-175) 

DT90071 Step ladder process (176-191) 
DT90072 Step ladder process (192-207) 
DT90073 Step ladder process (208-223) 
DT90074 Step ladder process (224-239) 
DT90075 Step ladder process (240-255) 
DT90076 Step ladder process (256-271) 

DT90077 Step ladder process (272-287) 
DT90078 Step ladder process (288-303) 
DT90079 Step ladder process (304-319) 
DT90080 Step ladder process (320-335) 
DT90081 Step ladder process (336-351) 
DT90082 Step ladder process (352-367) 

DT90083 Step ladder process (368-383) 
DT90084 Step ladder process (384-399) 
DT90085 Step ladder process (400-415) 



Specifications 

26-84 

 

Register 
Number Name Description R W 

DT90086 Step ladder process (416-431) 

It indicates the starting status of the step ladder 
diagram program process. When the process 
starts, the bit corresponding to its process number 
is ON.  
Monitor with BIN display. 

7 3 0 （Bit No.）

（Process No.）

15<Example>
DT90100

11

655
1：Starting　 0：During stop

651 647 643 640

 
The data can be written using a programming tool. 

○ ○ 

DT90087 Step ladder process (432-447) 
DT90088 Step ladder process (448-463) 
DT90089 Step ladder process (464-479) 

DT90090 Step ladder process (480-495) 
DT90091 Step ladder process (496-511) 
DT90092 Step ladder process (512-527) 
DT90093 Step ladder process (528-543) 
DT90094 Step ladder process (544-559) 
DT90095 Step ladder process (560-575) 

DT90096 Step ladder process (576-591) 
DT90097 Step ladder process (592-607) 
DT90098 Step ladder process (608-623) 
DT90099 Step ladder process (624-639) 
DT90100 Step ladder process (640-655) 
DT90101 Step ladder process (656-671) 

DT90102 Step ladder process (672-687) 
DT90103 Step ladder process (688-703) 
DT90104 Step ladder process (704-719) 
DT90105 Step ladder process (720-735) 
DT90106 Step ladder process (736-751) 
DT90107 Step ladder process (752-767) 

DT90108 Step ladder process (768-783) 
DT90109 Step ladder process (784-799) 
DT90110 Step ladder process (800-815) 
DT90111 Step ladder process (816-831) 
DT90112 Step ladder process (832-847) 
DT90113 Step ladder process (848-863) 

DT90114 Step ladder process (864-879) 
DT90115 Step ladder process (880-895) 
DT90116 Step ladder process (896-911) 
DT90117 Step ladder process (912-927) 
DT90118 Step ladder process (928-943) 
DT90119 Step ladder process (944-959) 

DT90120 Step ladder process (960-975) 
DT90121 Step ladder process (976-991) 

DT90122 Step ladder process (992-999) 
(High byte not used) 
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DT90123 COM0  
SEND / RECV end code 

If an error occurs when executing SEND / RECV 
instruction, the error code is saved. 

○ × 

DT90124 COM1  
SEND / RECV end code ○ × 

DT90125 COM2  
SEND / RECV end code ○ × 

DT90126 Force I/O active unit No. Used in the system. ○ × 

DT90127 COM3  
SEND / RECV end code If an error occurs when executing SEND / RECV 

instruction, the error code is saved. 

○ × 

DT90127 COM4  
SEND / RECV end code ○ × 

DT90128-
DT90139 Unused  × × 
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DT90140 

MEWNET-W0 
PC (PLC) link 0 
status 

PC (PLC) link0 number of times of reception 

○ × 

DT90141 PC(PLC) link 0 reception interval (current value) (x2.5ms) 
DT90142 PC(PLC) link 0 reception interval (minimum value) (x2.5ms) 
DT90143 PC(PLC) link 0 reception interval (maximum value) (x2.5ms) 
DT90144 PC (PLC) link0 number of times of transmission 

DT90145 PC (PLC) link0 transmission interval (current value) (x 2.5ms) 
DT90146 PC (PLC) link0 transmission interval (minimum value) (x 2.5ms) 
DT90147 PC (PLC) link0 transmission interval (maximum value) (x 2.5ms) 
DT90148 

MEWNET-W0 
PC (PLC) link 1 
status 

PC (PLC) link0 number of times of reception 

○ × 

DT90149 PC(PLC) link 0 reception interval (current value) (x2.5ms) 
DT90150 PC(PLC) link 0 reception interval (minimum value) (x2.5ms) 

DT90151 PC(PLC) link 0 reception interval (maximum value) (x2.5ms) 
DT90152 PC (PLC) link0 number of times of transmission 
DT90153 PC (PLC) link0 transmission interval (current value) (x 2.5ms) 
DT90154 PC (PLC) link0 transmission interval (minimum value) (x 2.5ms) 
DT90155 PC (PLC) link0 transmission interval (maximum value) (x 2.5ms) 
DT90156 MEWNET-W0 

PC (PLC) link 0 status 
PC (PLC) link0 work for measuring reception interval 

○ × 
DT90157 PC (PLC) link0 work for measuring transmission interval 
DT90158 MEWNET-W0 

PC (PLC) link 1 status 
PC (PLC) link1 work for measuring reception interval 

○ × 
DT90159 PC (PLC) link1 work for measuring transmission interval 

DT90160 MEWNET-W0 
PC (PLC) link 0 unit no. The PC (PLC) link 0 unit no. is saved. ○ × 

DT90161 MEWNET-W0 
PC (PLC) link 0 error flag The error content of PC (PLC) link 0 is saved. ○ × 

DT90162- 
DT90169 Unused  × × 

DT90170 

MEWNET-W0 
PC (PLC) link 0 
status 

PC(PLC) link address duplicate destination 

○ × 

DT90171 No. of missing tokens 
DT90172 No. of duplicate tokens 
DT90173 No. of no signal states 
DT90174 No. of times of receptions of undefined commands 
DT90175 No. of sum check errors for reception 

DT90176 No. of received data format error 
DT90177 No. of transmission errors 
DT90178 No. of procedure errors 
DT90179 No. of duplicate master units 
DT90180 
-DT90218 Unused  × × 
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DT90219 Unit number switch of 
DT90220 - DT90251 0: Unit number 1-8, 1: Unit number 9-16 ○ × 

DT90220 

PC (PLC) 
link 
unit no. 1 or 
9 

System 
registers 40 
and 41 

The Settings of the system register related to each 
unit number PC (PLC) link function are saved as 
following. 

＜Example＞ 
When the DT90219 is 0 

High byte Low byte

Set content of
system registers
40, 42, 44, 46

Set content of
system registers
41, 43, 45, 47

DT90220～
DT90223

（Station number 1）

 
If the master unit system register 46 is standard 
setting, 46 and 47 on the left will copy the value of 
the master unit.  
If the master unit system register 46 is set 
reversely, it indicates the left master unit part 40-45 
and 47 are set to 50-55 and 57, 46 remain 
unchanged.  
In addition, it indicates the other unit part 40-45 are 
set to values after correcting the received values, 
while 46 and 47 are set to 46 and 57 of the master 
unit. 

○ × 

DT90221 
System 
registers 42 
and 43 

DT90222 
System 
registers 44 
and 45 

DT90223 
System 
registers 46 
and 47 

DT90224 

PC (PLC) 
link 
unit no. 2 or 
10 

System 
registers 40 
and 41 

DT90225 
System 
registers 42 
and 43 

DT90226 
System 
registers 44 
and 45 

DT90227 
System 
registers 46 
and 47 

DT90228 

PC (PLC) 
link 
unit no. 3 or 
11 

System 
registers 40 
and 41 

DT90229 
System 
registers 42 
and 43 

DT90230 
System 
registers 44 
and 45 

DT90231 
System 
registers 46 
and 47 

DT90232 

PC (PLC) 
link 
unit no. 4 or 
12 

System 
registers 40 
and 41 

DT90233 
System 
registers 42 
and 43 

DT90234 
System 
registers 44 
and 45 

DT90235 
System 
registers 46 
and 47 
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DT90236 

PC (PLC) 
link 
unit no. 5 or 
13 

System 
registers 40 
and 41 

The Settings of the system register related to each 
unit number PC (PLC) link function are saved as 
following. 

＜Example＞ 
When the DT90219 is 0 

High byte Low byte

Set content of
system registers
40, 42, 44, 46

Set content of
system registers
41, 43, 45, 47

DT90220～
DT90223

（Station number 1）

 
If the master unit system register 46 is standard 
setting, 46 and 47 on the left will copy the value of 
the master unit.  
If the master unit system register 46 is set 
reversely, it indicates the left master unit part 40-45 
and 47 are set to 50-55 and 57, 46 remain 
unchanged.  
In addition, it indicates the other unit part 40-45 are 
set to values after correcting the received values, 
while 46 and 47 are set to 46 and 57 of the master 
unit. 

○ × 

DT90237 
System 
registers 42 
and 43 

DT90238 
System 
registers 44 
and 45 

DT90239 
System 
registers 46 
and 47 

DT90240 

PC (PLC) 
link unit no.6 
or 14 

System 
registers 40 
and 41 

DT90241 
System 
registers 42 
and 43 

DT90242 
System 
registers 44 
and 45 

DT90243 
System 
registers 46 
and 47 

DT90244 

PC (PLC) 
link 
unit no. 7 or 
15 

System 
registers 40 
and 41 

DT90245 
System 
registers 42 
and 43 

DT90246 
System 
registers 44 
and 45 

DT90247 
System 
registers 46 
and 47 

DT90248 

PC (PLC) 
link 
unit no. 8 or 
16 

System 
registers 40 
and 41 

DT90249 
System 
registers 42 
and 43 

DT90250 
System 
registers 44 
and 45 

DT90251 
System 
registers 46 
and 47 

DT90252 
-DT90299 Unused  × × 
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DT90300 Elapsed 
value area 

Low word 

HSC-CH0 

The counting area of the high-speed 
counter controller input CH0 (X0) or (X0, 
X1). 

○ ○ 

DT90301 High word ○ ○ 

DT90302 Target value 
area 

Low word When executing the F166 (HC1S) and 
F167 (HC1R) instruction, the target 
value is saved. 

○ ○ 

DT90303 High word ○ ○ 

DT90304 Elapsed 
value area 

Low word 

HSC-CH1 

The counting area of the high-speed 
counter controller input (X1). 

○ ○ 

DT90305 High word ○ ○ 

DT90306 Target value 
area 

Low word When executing the F166 (HC1S) and 
F167 (HC1R) instruction, the target 
value is saved. 

○ ○ 

DT90307 High word ○ ○ 

DT90308 Elapsed 
value area 

Low word 

HSC-CH2 

The counting area of the high-speed 
counter controller input (X2) or (X2, X3). 

○ ○ 

DT90309 High word ○ ○ 

DT90310 Target value 
area 

Low word When executing the F166 (HC1S) and 
F167 (HC1R) instruction, the target 
value is saved. 

○ ○ 

DT90311 High word ○ ○ 

DT90312 Elapsed 
value area 

Low word 

HSC-CH3 

The counting area of the high-speed 
counter controller input (X3). 

○ ○ 

DT90313 High word ○ ○ 

DT90314 Target value 
area 

Low word When executing the F166 (HC1S) and 
F167 (HC1R) instruction, the target 
value is saved. 

○ ○ 

DT90315 High word ○ ○ 

DT90316 Elapsed 
value area 

Low word 

HSC-CH4 

The counting area of the high-speed 
counter controller input (X4) or (X4, X5). 

○ ○ 
DT90317 High word ○ ○ 

DT90318 Target value 
area 

Low word When executing the F166 (HC1S) and 
F167 (HC1R) instruction, the target 
value is saved. 

○ ○ 

DT90319 High word ○ ○ 

DT90320 Elapsed 
value area 

Low word 

HSC-CH5 

The counting area of the high-speed 
counter controller input (X5). 

○ ○ 

DT90321 High word ○ ○ 
DT90322 Target value 

area 

Low word When executing the F166 (HC1S) and 
F167 (HC1R) instruction, the target 
value is saved. 

○ ○ 

DT90323 High word ○ ○ 

DT90324 Elapsed 
value area 

Low word 

HSC-CH6 

The countingarea of the high-speed 
counter controller input (X6) or (X6, X7). 

○ ○ 

DT90325 High word ○ ○ 

DT90326 Target value 
area 

Low word When executing the F166 (HC1S) and 
F167 (HC1R) instruction, the target 
value is saved. 

○ ○ 

DT90327 High word ○ ○ 

DT90328 Elapsed 
value area 

Low word 

HSC-CH7 

The counting area of the high-speed 
counter controller input (X7). 

○ ○ 

DT90329 High word ○ ○ 

DT90330 Target value 
area 

Low word When executing the F166 (HC1S) and 
F167 (HC1R) instruction, the target 
value is saved. 

○ ○ 

DT90331 High word ○ ○ 

DT90332 
-DT90379 Unused    × × 

(Note 1): Only F1 (DMV) instruction can perform the reading and writing of elapsed value area. 
(Note 2): When executing the high-speed counter target value consistent instruction F166 (HC1S) or F167 (HC1R) 

instruction, the target value area is set. It can not be written by the user program. 
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Register 
Number Name Description R W 

DT90380 

High-speed counter 
function 
control flag monitoring 
area 

HSC-CH0 When using the high-speed counter function, 
the contents set into the system register 
DT90052 by F0 (MV) instruction are saved to 
each channel. 

bit no. 15 0

Soft reset

0 0 0 0 0 0 0 0 0 0 0 0
8 7

0：Not execute1：Execute

H000：Fixed

Counting 0：Allowed 1：Disable

External reset input0：Available 1：Unavailable

High-speed counter
instruction 0：Continue 1：Cancel

 

○ × 

DT90381 HSC-CH1 ○ × 

DT90382 HSC-CH2 ○ × 

DT90383 HSC-CH3 ○ × 

DT90384 HSC-CH4 ○ × 

DT90385 HSC-CH5 ○ × 

DT90386 HSC-CH6 ○ × 

DT90387 HSC-CH7 ○ × 

DT90388 
-DT90499 Unused   × × 
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26.8 Table of Error Codes 

26.8.1 Table of Syntax Check Errors 

Error Codes 1-8 
Code Name Run Error content and handling method 

E1 Syntax error Stop 
 A sequencer with syntax errors has been written in. 
 Switch to PROG. mode and correct the error. 

E2 
Duplicate Use 
(Definition) Error 
(note 1) 

Stop 

 The same relay was used repeatedly in the output instruction 
and hold instruction. It also happens when using the same timer / 
counter number. 
 Please switch to PROG. mode and modify the program to 
ensure that 1 relay is only outputted once in 1program. Or, select 
to allow dual output by the system register No. 20. However, 
even in the choice of running dual output, a timer / counter 
instruction reuse definition error is still detected. 

E3 Not paired error Stop 

 Executing of the instruction used by matching (JP and LBL 
etc.) is not possible due to one is missing or there is a wrong 
positioning relation. 
 Please switch to PROG. mode and enter the 2 instructions for 
matching into the correct position. 

E4  Parameter mismatch 
error Stop 

 An instruction word inconsistent with the system register 
settings was written in. The range setting of the timer / counter is 
inconsistent with the number assignment in the program. 
 Switch to PROG. mode to confirm the contents of the system 
register, and reconcile the setting and instruction word. 

E5 Program area error 
(note 1) Stop 

 The instruction to determine executable area (main program 
area, deputy program area) is written into a position outside of 
the area (the subroutine SUB - RET etc. were recorded before 
the ED instruction). 
 Switch to PROG. mode, and enter the instruction into the 
specified area. 

E6 Compile memory full Stop 
 Unable to compile all programs. 
 Switch to PROG. mode to reduce the total number of steps of 
the program. 

E7 High-level instruction 
type error Stop 

 The executing for each scan type and differential execution 
type are mixed in multiple application instructions that perform 
continuous writing. 
 Concentrate the executing for each scan type and differential 
execution type and add individual execution condition. 

E8 
High-level instruction 
operand combination 
error 

Stop 
 The combination instruction is determined by multiple 
operands (unify types etc.), and the combination is wrong. 
 Please log in to the operands with the correct combination. 

(Note 1): The E2 and E5 error codes mean errors than can be detected even it is required to correct a syntax in the 
RUN mode. In this case, the control unit does not write anything and continues to run. 
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26.8.2 Table of Self-diagnostic Errors 

Code Name Run Error content and handling method 

E20 Watchdog timer timeout Stop 

 The watchdog timer is started, but the running stops. A 
hardware error or operation stagnation has occurred. 
 Please check if there is a infinite loop in the control instructions 
(JP, LOOP, etc.) used to change the program handling process. 
If the program itself is OK, it may be due to a hardware error. 

E21 Motion part startup error Stop  It may be due to a hardware error. Please contact our 
company. 

E22 Hardware error Stop  It may be due to a hardware error. Please contact our 
company. 

E25 Inconsistent master 
memory models Stop  The master memory models are inconsistent. Use a master 

memory created by the same model. 

E26 User ROM error Stop 

 When installing the master memory cassette, the master 
memory may be corrupted.  
 Remove the master memory cassette to check for errors. If 
there is no error, the contents of the master memory may be 
corrupted. 
 Use it after rewriting the master memory. If the error cannot be 
cleared, please contact our company. 

E27 Unit installation is 
restricted. Stop 

 The unit installation number exceeds the limits. 
 Please turn off the power to confirm whether the combination 
unit is within the limit range. 

E29 Configuration parameter 
error Stop  It may be due to a hardware error. Please contact our 

company. 

E34 Abnormal I/O status Stop 
 An abnormal unit is installed. 
 Confirm the slot number by DT90036, replace the abnormal 
unit with a normal one. 

E40 I/O error Select 

 The function cassette may be abnormal. Confirm its location 
through the data register DT90002 and repair it. 
 You can use the tool software to confirm it by the [I/O Error] 
button in the status display dialog box. 

E41 Special unit collapse Select 

 It may be due to abnormal high function unit. Confirm its 
location through the special data register DT90006 and repair it. 
 You can use the tool software to confirm it by the [Special 
Error] button in the status display dialog box. 

E42 I/O check error Select 

 The connection status of the input and output unit (expansion 
unit) is different from that when the power is turned on. 
 Verify the input and output unit whose connection status 
changed through the special data registers DT90010 and 
DT90011. Or, verify the engagement of the expansion connector. 
 You can use the tool software to confirm it by the [Check Error] 
button in the status display dialog box. 

E43 Initial error of the motion 
part Select  It may be due to a hardware error. Please contact our 

company. 
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Code Name Run Error content and handling method 

E44 
A position control 
operation error 
occurred 

Select 

 Parameter settings may be incorrect, or there was a limit 
error. 
 Check if the parameters are within the range that can be 
specified. 
 Check the AMP error code for the channel on which the 
positioning operation error occurs and the content on the data 
monitor of Configurator PM7. 

E45 Operation error 
occurred Select 

 An operation error cannot be performed occurred. 
 The operation error address can be confirmed by one of the 
special register DT90017 and DT90018. You can use the tool 
software to confirm it by the [Operation Error] button in the 
status display dialog box. 

E47 Motion part AMP 
communication error Select 

 An error in the communication with the servo amplifier 
occurred. 
 Check the connection. 
 Check the AMP error code on the data monitor of 
Configurator PM7. 

E48 Abnormal system 
register setting 

Stop 
running 

 The settings of the system register are abnormal. Check the 
settings again. Example) If the data register and internal relay 
ranges set by the system register No. 0 and No. 1 are not 
matched with the setting of the system register No. 7 and No. 8 
hold / non-hold area and the setting of the system register No. 
416-No. 423 universal communication buffer area, an error will 
occur. 
 Verify the number of the system register through the special 
register DT90007. 

E49 Abnormal expansion 
power sequence 

Stop 
running 

 The power of the expansion Unit is turned on later than the 
control unit. Make sure it is powered on before the control unit 
or at the same time. 

E50 
Abnormal battery 
(battery fall off or 
voltage reduced) 

continues 
operation 

 The backup battery voltage is lower than the specified 
voltage, or the control unit is not connected to the battery. 
Verify the backup battery, pay attention to the replacement and 
connection work. 
 You can set whether to notify the self-diagnostic error 
through the system register No. 4. 

E100- 
E199 Self-diagnosis error set 

by F148 

Stop 
 An error set by the application instruction F148 occurred. 
 Handle it according to the detection conditions set. E200- 

E299 
Operation 
continues 
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26.8.3 Table of MEWTOCOL-COM Communication Errors 

Code Name Description 

! 26 Unit number setting error An instruction can not be used in the global area (station number FF) 
is received. 

! 40 BCC error A transmission error occurs in the received data. 
! 41 Format error An instruction inconsistent with the format is received. 
! 42 NOT support error An unsupported instruction is received. 

! 43 Multiple frames procedure 
error In the multi-frame processing, another instruction is received. 

! 60 Parameter error The specified parameter content does not exist or can not be used. 

! 61 Data error There is an error in the contact, data area, data number assignment, 
size assignment, range and format assignment. 

! 62 Registration over error Exceeds login times or operate without logging in. 
! 63 PC mode error An instruction can not be processed was executed in RUN mode. 

! 64 External memory error 

Bad hardware. The built-in ROM (F-ROM) / master memory may be 
abnormal. 
Designated content exceeds the stipulated capacity during ROM 
transmission. 
A read / write error occurred. 

! 65 Protection error 
A write operation of the program or system register was performed 
under the protection status (password setting) or with the master 
memory cassette installed. 

! 66 Address error 
There is an error in the code format of the address data. In addition, 
there is an error in the range assignment when it is exceeded or 
insufficient. 

! 67 Missing program 
error/Missing data error 

It is not possible to read due to the program area has no program or 
abnormal memory contents. Or you want to read an unregistered 
data. 

! 68 Can not rewrite in RUN error 
Edit instructions cannot be rewritten in RUN (ED, SUB, RET, INT, IRET  
SSTP, 
STPE). Nothing has written into the control unit. 

! 71 Exclusive control error Execution of the instruction can not be processed simultaneously with 
the instructions in process. 
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26.9 Dimensions 

26.9.1 Dimensions 

 FP-XH M8N16PD control unit 

220 82

90
4  

Unit: mm 

26.9.2 Installation Dimensions 

8

L

H

2-M4 or 2-φ5  
Model L H 
M8N 212 82 

Unit: mm 
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